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Preface
For details, see the following topics:

• About this documentation

• Notation conventions

• Aurea global support

About this documentation
This guide is par t of the documentation set for Aurea CRM.

Notation conventions
This document uses the following notation conventions:

MeaningConvention

Fixed-width font indicates code, path names, file names, envi-
ronment variable names, parameter names, command names,
machine names, URLs.

Fixed-width

Bold Fixed-width  font is used to indicate user input or to
emphasize cer tain lines of code.

Bold Fixed-
width

Italic Fixed-width font indicates a placeholder for which you
must supply a value.

Italic Fixed-width

Bold sans serif typeface indicates the names of graphic user
interface elements such as dialog boxes, buttons, and fields.

Bold Sans serif

In text, italic serif typeface indicates the first use of an impor-
tant term. The term is defined in the glossary.

Italic serif

Underlined text in command lines and parameter descriptions
indicate that you only have to enter the underlined part of the
command or parameter name. For example, if you use
the-LOGFILE parameter in a command, you only need to enter
-LOGF.

Underlined

Brackets enclose optional arguments.[ ]

Braces enclose two or more items. You can specify only one
of the enclosed items. Vertical bars represent OR separators.
For example, you can specify a or b or c.

{ a | b | c }

15AUREA CONFIDENTIAL



MeaningConvention

Three consecutive periods indicate that you can repeat the
immediately previous item. In code examples, they can be
horizontal or ver tical to indicate omissions.

...

An angle bracket between two menu items indicates that you
should choose an item from a menu. For example, the notation
File >  > Exit means: "Open the File menu and choose Exit."

Menu > Choice

Links to related information in other chapters or documents are
indicated using the >> symbol.

>>

Aurea global support
If you encounter a problem while using an Aurea product or require assistance with
downloading the software or upgrading a product release, please open a ticket on
Aurea Support Central. Preferably, search the ar ticles on the Aurea Knowledge
Base for solutions to your issues before opening a ticket.

Information about the support organization is available on Support Central. The
product documentation is available athttps://help.aurea.com/crm/#.

For information about purchasing an upgrade or professional services, contact your
account executive. If you do not know who your account executive is, or for other
queries, contact us through our website.
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1
General Functions
Learn about the General functions for Aurea CRM.Web Business Logic.

Below topics explain the general functions:

Aurea CRM web
Aurea CRM web is a web-based application that accesses the Aurea CRM database
and that include a large number of standard CRM processes. Employees can use
Aurea CRM to manage customer-related activities, search for and edit their contact
persons and check current revenues. Aurea CRM is a fully-fledged CRM solution.
The data displayed by the system depends on your role. Access rights are defined
by your administrator.

Aurea CRM web's user interface is easy to use. This document provides an overview
of the design and the basic function in Aurea CRM web.

Aurea CRM web's interface is fully customizable and can be adapted to meet your
requirements by your administrator. For example, info areas can be added, tabs
can be renamed etc. As a result, the screenshots in this manual may differ from
your version.

Aurea CRM web can be customized to meet your individual requirements (e.g. info
areas can be added and the names of tabs can be changed), therefore, examples
in this manual may differ from your own interface, >> CRM.designer Manual.

Aurea CRM web allows additional data sources to be linked to the Aurea CRM web
user interface, e.g. your local Intranet.

This manual contains a description of the user interface's key elements, as well as
descriptions of key functions such as searching, entering data and configuring user-
specific settings.

Note: Note: The online user manual accessible in Aurea CRM web only covers the
basics. For more detailed information on functions, processes and info areas, refer
to the product-specific manuals. Manuals can be downloaded from the Support area
on Aurea's website at https://support.aurea.com.
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Typographical Conventions
The following formatting is used in this manual:

• Gray and bold: Menu commands, menu names, titles of dialog boxes, check boxes,
radio buttons, info area names, names of fields and buttons are written like this.

• Menu commands: "Select New > New Person from the context menu" means that
you should first select New and then New Person from the record's context menu.

• Bold: Particularly important information is written in bold.

• Keyboard shortcuts: Simultaneous key strikes are identified by placing a plus sign
between the key designations, e.g. Alt+D.

• Notes and tips:

Note: Note: Notes and tips are displayed like this in the text.

• Related information: Links to related information in other chapters or documents
are indicated using the >> symbol.

Login
Learn how to login to Aurea CRM and perform various login related settings according
to your profile.

You can access data in Aurea CRM according to your user rights. You need to log
on with your user name and password. You can change your password later.

Note: Your administrator can define that your Windows login (user name and
password) also apply to Aurea CRM web, in which case you do not need to log in
to Aurea CRM web. This setting is especially useful in conjunction with CRM.phone.

Selecting Your Language

You can choose the language version from the login screen. The application is then
star ted in the selected language. German and English are supported out of the box.

Note: Note: Your administrator can assign a default language to you which is used
if you do not select a language when logging on to Aurea CRM web.

Starting Aurea CRM web

You can access data in Aurea CRM according to your user rights. You need to log
on with your user name and password. You can change your password later.
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Note: Your administrator can define that your Windows login (user name and
password) also apply to Aurea CRM web, in which case you do not need to log in
to Aurea CRM web. This setting is especially useful in conjunction with CRM.phone.

To star t Aurea CRM web:

1. Enter the address (URL) of Aurea CRM in your browser.

The Login page is displayed.

Note:  Please ask your administrator for the correct address.

2. Enter your user name and password.

3. Click on More Options to select a different language.

Note: Your administrator can determine that the More Options button is not
displayed.

4. Click on Log In. Your personal star t page is displayed.

Selecting Roles

Your administrator can define roles and assign specific access rights to them. Your
administrator can also determine whether you can select which roles to log in with
or whether your roles are fixed.

To select a role:

1. Click on More Options on the Login page. The extended login page is displayed.

1. Enable Select roles and click on Log In. The dialog used to select your roles is
displayed.

2. Select the role(s) you want to log in with. You can select multiple roles.

3. Click on OK to log on.
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Note: Note: If single sign-on is enabled on your system (i.e. you are automatically
logged on based on your Windows login), your administrator is responsible for
defining which role(s) you are logged on with.Roles can also be specified in links.
If a user clicks on a link that includes a specific role, the user is logged on the
system using that role.

Switching between Telephone Profiles

If you also have access to CRM.phone, you can switch between profiles if several
profiles have been defined for you. The selected profile is only active for the current
session; next time you log on to Aurea CRM web, your default profile is used again.

The name of the telephone profile in use is displayed in the system information.

To change your telephone profile:

1. Click on More Options on the Login page.

Further options are displayed.

1. Enter your user name and password.

2. Click on Log In.

The Select Settings for this Session dialog box is displayed.

1. Select the desired profile from the Telephone Profile drop-down list. By default,
Do not show phone toolbar is selected.

2. Click on OK.

3. Aurea CRM web is star ted and CRM.phone uses the selected profile.

Adding your Telephone Profile as a Bookmark

Your administrator can determine that telephone profiles can be specified in Aurea
CRM's URL. For example, a sales rep may require different telephone profiles for
desk work and when in the field. The appropriate URLs can be stored as bookmarks
in your browser. Select the bookmark to star t the application using the corresponding
telephone profile.

Logging Out

For security reasons, always exit Aurea CRM web by clicking on  and selecting
Log Out from the menu.

The login screen is then displayed again.

Selecting Your Language
You can choose the language version from the login screen. The application is then
star ted in the selected language. German and English are supported out of the box.

Note: Note: Your administrator can assign a default language to you which is used
if you do not select a language when logging on to Aurea CRM web.
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Starting Aurea CRM web
You can access data in Aurea CRM according to your user rights. You need to log
on with your user name and password. You can change your password later, >> 
on page 37.

Note: Note: Your administrator can define that your Windows login (user name and
password) also apply to Aurea CRM web, in which case you do not need to log in
to Aurea CRM web. This setting is especially useful in conjunction with CRM.phone.

To star t Aurea CRM web:

1. Enter the address (URL) of Aurea CRM in your browser.

The Login page is displayed.

Note: Note: Please ask your administrator for the correct address.

2. Enter your user name and password.

3. Click on More Options to select a different language.

Note: Note: Your administrator can determine that the More Options button is
not displayed.

4. Click on Log In.

Your personal star t page is displayed.

Selecting Roles
Your administrator can define roles and assign specific access rights to them, >> 
on page 4. Your administrator can also determine whether you can select which
roles to log in with or whether your roles are fixed.

To select a role:

1. Click on More Options on the Login page. The extended login page is displayed.

1. Enable Select roles and click on Log In. The dialog used to select your roles is
displayed.
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2. Select the role(s) you want to log in with. You can select multiple roles.

3. Click on OK to log on.

Note: Note: If single sign-on is enabled on your system (i.e. you are automatically
logged on based on your Windows login), your administrator is responsible for
defining which role(s) you are logged on with.Roles can also be specified in links.
If a user clicks on a link that includes a specific role, the user is logged on the
system using that role.

Switching between Telephone Profiles
If you also have access to CRM.phone, you can switch between profiles if several
profiles have been defined for you. The selected profile is only active for the current
session; next time you log on to Aurea CRM web, your default profile will be used
again.

The name of the telephone profile in use is displayed in the system information, >> 
on page 37.

To change your telephone profile:

1. Click on More Options on the Login page.

Further options are displayed.

1. Enter your user name and password.

2. Click on Log In.
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The Select Settings for this Session dialog box is displayed.

1. Select the desired profile from the Telephone Profile drop-down list. By default,
Do not show phone toolbar is selected.

2. Click on OK.

3. Aurea CRM web is star ted and CRM.phone uses the selected profile.

Adding your Telephone Profile as a Bookmark
Your administrator can determine that telephone profiles can be specified in Aurea
CRM's URL. For example, a sales rep may require different telephone profiles for
desk work and when in the field. The appropriate URLs can be stored as bookmarks
in your browser. Select the bookmark to star t the application using the corresponding
telephone profile.

Logging Out

For security reasons, always exit Aurea CRM web by clicking on  and selecting
Log Out from the menu.

The login screen is then displayed again.

Roles and CRM Processes
Depending on their current tasks, employees often assume different roles, e.g.
working as a member of the sales team in some cases, and as a member of the
support team in others.

A member of the sales team may require access to data that provide details on the
probability of selling a par ticular product to a par ticular customer, in order to coor-
dinate sales activities. A member of the support team requires information on service
agreements etc. For this reason, the user interface (e.g. available menu options)
differs for each role, as does the data displayed.

Your administrator is responsible for defining roles that are used in your company,
and assigns the necessary CRM processes to the roles that require them.

The role(s) you require to complete your tasks are then assigned to you. If you have
been assigned to several roles (e.g. the head of marketing requires access to mar-
keting data, as well as other data only available to management), you can decide
which role(s) to log on to the system with (provided you have not been assigned
fixed roles), >>  on page 2.
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Depending on your current role, the CRM processes assigned to the role and the
assigned rights you can execute various functions:

• Your role may grant you the right to add new activities or edit existing ones, for
example.

• If you are not permitted to execute a par ticular function, the corresponding buttons
or menu options are unavailable.

• If your role only grants read access to cer tain info areas, you are unable to edit
data in these areas.

Note: Note: Certain administrative functions can also be assigned to user roles.
These additional functions are not described in this manual. For more details,
>> Aurea CRM web Administrator Guide and CRM.core Administrator Guide.

Example:

• Should you try to access an activity record that is a child record of an info area
to which you have not been granted access, your role may determine that you
cannot edit the activity. For example, you may need to add activities for your
colleagues in the field as part of your duties. Depending on your role, you might
only be able to view activities added by a service rep for a contact person in a
ticket, even though you can normally also edit activities. In such cases, you also
only have read access to all the activity's related areas as well.

Info Areas
The areas used to collect data are called info areas in Aurea CRM. Info areas
correspond to a table in the database.

Wherever an info area record is displayed in Aurea CRM web, your administrator
can determine that data from related info areas is displayed in both masks and lists.

Info areas can be independent (i.e. have no parent info areas, such as the Company
info area) or be a child of another info area. Records in child info areas must always
be added to a record in the parent info area, e.g. an activity must always be added
for either a person or company.

User Interface
Your administrator can define the appearance of your user interface.

Access can be denied to menu entries, queries can be predefined and much more.
Some of the options available to you depend on your access rights. For example,
your administrator can determine that you cannot add new records, in which case
the appropriate menu options are unavailable. If you cannot add records, an appro-
priate message is displayed if you click the  (New) button.
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Areas
The Aurea CRM web user interface consists of:

• The sidebar (on the left)

• The working area (to the right)
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Start Page
Your star t page is displayed once you have logged on.
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The star t page's content depends on your current role (e.g. the star t page for mar-
keting employees is different from that for service technicians) and the configuration
defined by your administrator.

You can customize the layout of your star t page. Drag an area to the desired position
and release the mouse button. Click on  to close an area. You can determine which
areas are displayed and how many columns each area spans, >> on page 22.

Sidebar
The sidebar is displayed on the left of the screen. Use the sidebar to access data
in the various info areas, execute functions and processes, define settings, configure
your favorites, view system messages etc.

Aurea CRM Menu
The following options are available in the Aurea CRM menu:

• Start Page: Switches to Aurea CRM web's star t page.

• Refresh Working Area: Refreshes the current screen.

• Log Out: Closes Aurea CRM web. For security reasons, always exit Aurea CRM
web using this option.

• User Guide: Opens the user manual.

• About update.CRM: Displays information such as the version number etc.

• Affiliation View: This option is available if your administrator has granted access
to the affiliation view. For more information on the affiliation view, refer to your
product-specific manual.

Navigation
Navigation icons are displayed in the sidebar below the Aurea CRM menu.

Each menu is accessible by clicking on its icon (e.g.  for the Accounts menu).
Click on the icon and select the desired option:
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History
Use the History section to quickly access the records and pages you have recently
viewed.

Note: Note: The history is only saved if you log out using the Log Out option in
the Aurea CRM menu and the Save history option is enabled in your user settings,
>> on page 34. If you simply close your browser, the history is not saved.

Your administrator defines which entries are displayed in the history:

• Only the records you have accessed, e.g. companies, persons etc.

• Only the functions you have accessed, e.g. search pages, star t page, tree view
etc.

• Both (default setting)

The history is displayed in the left frame or in the application menu, depending on
your configuration, >>  on page 34.

To access an entry in your history:

1. Click on  (History).
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Your history is divided into two sections:

• The most recently accessed areas are listed at the top.

• The most recently accessed records are listed at the bottom.

2. You can also navigate in the history.

Note: Note: Depending on your configuration, you can also access the records you
have opened recently from the corresponding menu, >>  on page 59.

Favorites
You can add the records you require most frequently to your favorites. Your admin-
istrator determines which types of records (i.e. which info areas) you can add to
your favorites.

Quick links are also displayed here, >> on page 9.

Displaying your Favorites

To view your favorites list:

1. Click on  (Favorites).

Your favorites are displayed.

The top section displays your quick links. Your favorites are displayed below the
quick links, grouped by info area.

2. You can access the context menu ( ) and quick view ( ) for all entries in the
list. Double-click on a record to open it in the default view.

3. If you have added records to your list of favorites, you can also access these
records from the corresponding menu entry (e.g. you can access your favorite
companies from the Companies menu):
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Adding Records to your Favorites

To add a record to your favorites:

1. Switch to the desired record, >>  on page 39.

2. Select Add to Favorites from the record's context menu.

A message is displayed, confirming that the record has been added to your fa-
vorites.

Removing Records from your Favorites

To remove a record from your favorites:

1. Either:

• Open your favorites

• Switch to the desired record

2. Select Remove from Favorites from the record's context menu.

The selected record is removed from your favorites.

Quick Links
You can add the areas you use regularly to your quick links.

Customizing Quick Links

If you have not yet defined any quick links, the Quick Links area is not displayed.

To add quick links:

1. Click on  (Favorites).

2. Click on Click here to add your favorite pages if you have not yet defined any

quick links. Otherwise click on  (Modify Quick Links) in the header.

The My Quick Links dialog is displayed.
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3. Click on the  icon under All actions next to one of the sections.

All available menu options are displayed.

4. Select an entry and click on Add to Quick Links.

The entry is displayed under My Quick Links.

5. Use the Up and Down buttons to determine the desired position of the entry.

6. To delete an entry, select it and click on Delete.Use the Delete All button to
delete all entries in the list.

7. Click on Save to accept your settings. Click on Reset to revert to the default
settings.

Inbox
Your inbox contains various types of messages that inform you of specific events.
Some messages are displayed for a defined period of time before being closed au-
tomatically.
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To display your inbox:

1. Click on  (Inbox).

Your inbox is opened.

The following tabs are displayed:

• My Tasks: Tasks that have been assigned to you are listed here. You can also
add new tasks.

• My Messages: Messages you have received are listed here.

You receive messages to inform you that a background query has been com-
pleted or that mass updates have been performed on the server, for example.

• My Open To-Dos: Your open To-Dos are listed here.

To-Dos can be displayed for due activities, tasks, absences and marketing ac-
tivities.

• My Reminders: Your reminders are displayed here.
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Reminders can be defined for activities, tasks and absences and are displayed
at the scheduled time in this tab.

• System: System messages, such as error messages, are listed here. If you
have received a new system message, the inbox icon is displayed with an

exclamation mark ( ).

2. Switch to the desired tab.

3. If not all tabs are displayed, click on  (Scroll tabs right). Alternatively, click on
 and select the desired entry from the list.

Working Area
The working area's contents depend on the current function and the data you are
working with. For example, it may display a calendar, a search mask with the list of
results or a mask allowing you to edit records.

You can display data in the working area in a number of ways, for example:

• Using the search, where you can use search criteria to define which records are
displayed.

• Using your favorites, >> on page 8.

• From a query's results list, >> on page 77.

• From your history of recently accessed records or search results, >> on page 7.

Buttons
Buttons are available in Aurea CRM web:

Buttons are displayed in the working area between the header and the record:

Some buttons, e.g. Save, are only displayed following cer tain actions:

Your administrator can group buttons together. For example, in Aurea CRM web's
default configuration, the export functions in result lists are grouped together:

Depending on the configuration defined by your administrator, buttons and icons
can be displayed with or without accompanying text.

Navigation Bar
The following navigation bars are available:

• For records:
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To switch between records:

• Click on  (Next) to switch to the next record.

• Click on  (Previous) to switch to the previous record.

• Click on  (Show/Hide) to display the records in a drop-down list. Select the
desired record from the drop-down list.

This navigation bar is only available when opening a record from a results list
(not when opening the record in a new tab).

• In result lists:

• Click on  (Previous) to switch to the previous page of results.

• Click on  (Next) to switch to the next page of results.

• Click on (First) to switch to the first page of results.

• Click on  (Last) to switch to the last page of the loaded results.

The number of records displayed in the results list is determined by the following
user settings (>> on page 34):

• Records per page: Determines the number of records displayed per page of
search results.

Example:

20 records are displayed per page.

• Records per query step: Determines the number of records initially loaded
from the server. If the list contains more records, additional records are loaded
incrementally as you navigate in the list. Each batch of records transferred
from the server corresponds to a query step.

Example:

50 records are returned by the server in each query step. The + icon indicates
that additional results are available but have not been loaded yet.

Your administrator can override your settings for all or for individual lists.

Breadcrumbs
The breadcrumb trail is located to the top of the screen, and provides you with an
overview of your current position.
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Click on a parent record in the breadcrumb trail to switch to that record.

Search Area
The search area allows you to search for records using search criteria, >>  on page
39.

Ghost Text
For some fields, so-called ghost test has been defined to help you input data. This
text is displayed in light gray in input fields and provides additional information on
what you can enter in text fields.

Example:

Find as You Type
If find as you type function is available for link fields (fields where you can select
data from other info areas using  (Select)), all hits that contain the characters you
have entered are immediately displayed in a drop-down list. The more characters
you enter, the shorter the list becomes. Click on the desired entry to enter it in the
field.

Views
There are various views available in Aurea CRM web:

• Tab view displays the information stored in a record, >>  on page 13. In addition,
child records are displayed under Related Data, >>  on page 20.

• The tree view is only available in cer tain areas, and provides a hierarchical
overview of related data. The tree view can depict multi-tiered hierarchies and
you can edit child records, >>  on page 14.

By default, data is displayed in view mode. To edit the data in a record, click on 
(Edit) or double-click in the working area.
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Note: Depending on your configuration either the tab or the tree view is displayed
after double-clicking on an item in a list.

Tab View

Use the tab view to view all relevant information relating to a record at a glance.
You can edit the data and access all related information quickly.

To display a record in the tab view:

1. Select Tab View from the context menu in the results list.

The record is opened in tab view. The following screenshot displays the tab view
for a visit:

The lower por tion of the mask contains links to related records. Click on a link to
switch to the record.

Changing the Order of Tabs

In tab view, the most important information is displayed in the upper area of the
screen, additional information is displayed in the groups and tabs below.

Example:

You can change each tab's position using drag&drop, for example drag the Address
tab to the right of the Position tab to move the Address tab:
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You can also drag a tab to the upper area to display the contents of the tab as a
group, e.g. dragging the Address tab to the upper area changes the display as fol-
lows:

When moving a tab, the gray area indicates the tab's new position; release the
mouse to place the tab here:

Note: Note: You can also change the order of the tabs/groups displayed in the
Related Data area in the same way.

Tree View

Use the tree view to display all relevant information concerning a record in a single
view and to access related information.
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The tree view can depict a multi-tier hierarchy; e.g. you can view all the offers stored
for a person, and in turn all of the items in these offers.

A separate context menu is available for each info area displayed in the tree view.
Use the menu to add new records, or display the records in a list. The appropriate
context menu is also available for linked records displayed in the tree view.

To display the tree view:

1. Switch to the desired record and select Tree View from the context menu.

The record is displayed in the tree view.

Example: Tree view for a company:

Note: Note: Your administrator determines the maximum number of records per
node in the tree. If more records are present than can be displayed, the entry "..."
is displayed below the last record. Click on this entry to display fur ther records (up
to the maximum defined by your administrator). You can continue in this manner
until you have displayed all available records.Your administrator can also determine
that the  icon is always displayed, or only if child records are present.Select Display
all records from the context menu to display all related records in an info area (and
not only the predefined number). This can however be a very time-consuming process
when working with large volumes of data.

Quick View

The  (Quick View) button is available in most areas. Click on this button to display
an overview of the record's key data without closing the current record.

You can open multiple quick views one after another. For example, if you open
person entered in a ticket in the quick view, you can then long click on the link to
the company in the quick view of the person.

To display the quick view:

1. Either:

• Click on  (Quick View) in a list.

• Click on a link in a list or on a tab and keep pressing the mouse button ("long
click").

The quick view is opened:
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The record's details are displayed in the center (and cannot be edited).

2. If you want to edit the data displayed in the quick view, use the context menu
(displayed on the left) to open the records in tab or tree view, for example. You
can also add new child records using the menu

3. Click on  and  to hide or show the right and left areas.

Breadcrumb Trail in the Quick View

The breadcrumb trail is also available in the quick view:

• Click on  in the breadcrumb trail to and select an info area to display all records
added for the current record in that info area.
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The child records are displayed

• Click on a record in the breadcrumb trail to display that record's details in the
quick view.

Map View

Your administrator can define that locations are displayed on a map, e.g. companies
or the address of a property.

Example:
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If fields are available that contain geographic coordinates, this data is used to display
the location (even if the coordinates differ from the address). If no geographic coor-
dinates are available, the address data entered in the database is used to determine
the location.

Click on the orange marker to display details concerning the address:

The map view for activities or calendar entries displays records at the location of
the person or company the activity was added for.

If a meeting room is added to an activity as a par ticipant, the location of the meeting
room is displayed.
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Displaying Multiple Addresses on the Map

Your administrator can define that you can select multiple entries in results lists or
the calendar and display these entries on the map. This makes it easier for sales
reps to plan their route for the day, for example.
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The header in the map displays the number of activities displayed on the map.

Lists
You can edit records directly in the results list, export the data, or display a record's
important details in the MiniDetails.

The following functions are available in lists; move the mouse cursor over the record
to display the icons:

•  (Quick View): Displays the quick view, >> on page 15.

•  (Show Menu): Displays the record's context menu, >> on page 24.

•  (Display Details): Displays the record's details, >> on page 19.

Result Lists

The following screenshot shows the results of a search:

If the list contains a large number of columns, the text in the column headers and
cells may be shortened with "..." displayed at the end of the text. Move the mouse
cursor over the cell to display a tooltip containing the contents of the cell.

Your administrator can determine that the first row in a list is automatically selected.

You can edit records in the results list as well in lists displayed under Related Data,
>>  on page 60.

Switch between pages of results using the arrows above and below the results list
( ), >> on page 11.
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If configured, related data is displayed for the selected record below the results list
(e.g. all activities added for a person). Related data is only displayed in those areas
where it makes sense to access child info areas, >>  on page 20.

Double-click on a row to carry out the default action defined by your administrator;
in most cases the record is displayed in tab view.

Your administrator can determine that numeric values (e.g. order values) are totaled
if all search results fit on the first page.

Displaying Details

You can display an overview of the most important details stored in a record dis-
played in a list:

Click on  (Show Details) to the left of the desired record to display the details.

• Click on  (Hide Details) next to the desired record to hide the details of that
record.

Color Codes and Icons in Lists

Your administrator can determine that entries in the list are displayed in different
colors or with specific icons to indicate the status of records. Icons can be included
in fields alongside text, or text entries can be replaced by corresponding icons.

Tickets are sor ted by the time they were added, but recognizing which tickets have
a high priority is not necessarily easy at first glance. Entries with a high priority can
be indicated using an appropriate icon or displaying the with a specific background
color (e.g. red).

Examples:

By default, Aurea CRM web displays an exclamation mark in the Subject column
for tickets with a "high" priority:

Total Lines

In some areas, such as analyses and orders, sum totals can be calculated and dis-
played. For example, if an analysis analyzes the offers in a business area, the sum
total of the value of all offers can be displayed.

Your administrator is responsible for defining whether the total line is displayed.

Related Data
Related data is displayed in the list, tab and tree views. Child data can be displayed
in the Related Data area using a variety of views:

• Lists display related records, e.g. a person's activities

• Maps display data such as the address of a company or property

• Graphical views are used to display information on campaigns or relationships,
for example.
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You can customize the view of related data, >> on page 22.

You can edit related data by opening the record in tab view or directly in a list, >>
on page 60.

To display related data, e.g. for search results:

1. Select the record you want to view additional information on from the results list
or open the desired record in tab view.

2. Click on the corresponding tab.

A list of all child records is displayed (e.g. all persons in a company).

To switch between tabs:

• Using the mouse: Click on the desired tab.

• Using the keyboard: Press Alt+0 to activate the Related Data area. Then press
Alt+Number to switch to the desired tab. Example: In the screenshot above, the
Activities tab is the second tab. Press Alt+2 to switch to this tab.

Note: Note: Your administrator can define alternative keyboard shortcuts.

Filter Masks
Filter masks are dynamic masks that can differ depending on the data in a record.

Filter masks can be used to differentiate between different types of records (e.g.
private and corporate customers), or display different contents depending on the
situation (e.g. different fields for telephone calls and letters in the Activity info
area).

Note: Note: Your administrator is responsible for defining filter masks.

Live Tiles
Your administrator can define that the results of queries can be displayed in a live
tile, e.g. on your star t page. By default, the star t page includes a query applied to
ongoing opportunities in the current quarter:
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The live tile consists of two elements:

• The header displays the number of records (e.g. the opportunities in the current

quarter). Click on the number of hits ( ) or  to open the query's search results.
This button is only displayed when your mouse cursor is placed over the header.

• The records returned by the query are listed on after another in the area below
the header. By default, each record is displayed for a few seconds.

• Move your mouse over the record to stop the display from switching between
records. Navigation buttons (  and ) are displayed to the left and right of the
record. Click on these buttons to switch between records.

Once you move the mouse cursor away from the live tile, the live tile begins
automatically switching between records again.

• Click in  (Show Menu) to open the record's context menu.

• Double-click on the record to open it in tab view.

Your administrator can determine that the lower section is not displayed.

Your administrator can define if the live tile is displayed when no hits are returned
by the query,

Displaying Records in Multiple Tabs
You can display different records in separate tabs within Aurea CRM web. For ex-
ample, you can add a child record using the context menu, and choose to display
the input mask for the new record (or be guided through the process of adding the
record) in a separate tab within the Aurea CRM web window.

Note: Note: This option is not available for all context menu options. For example,
options that simply open a dialog box cannot be opened in a new tab. Your
administrator can define that menu options always open data in a new tab.
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To open a record or page in a new tab:

1. Hold down Ctrl and select the desired entry from the menu or context menu.

The selected option (e.g. Tab View, Timeline etc.) is displayed in a new tab within
the Aurea CRM web window.

1. Click on a tab at the top of the screen to switch to that tab.

If you open more tabs than can be displayed on the screen at once (the number
is dependent on your screen resolution and the browser's size), use the  (Previ-
ous) and  (Next) buttons to scroll. Click on  (Show all tabs) to display a list
of all open tabs:

Select an entry from the list to switch to that tab.

2. Click on  (Close) to close the current tab.

Your administrator can define that when opening the same area again, the currently
opened tab is displayed. Your administrator can also determine that the contents
of the tab is refreshed when it is reopened.

Example:

The calendar is already opened in a tab. When configured accordingly, reopening
the calendar with Ctrl held down does not open a new tab, but instead the existing
calendar tab is displayed.

Refreshing the Work Area
The working area is not always refreshed automatically after applying cer tain
changes, e.g. in the list view, tree view or maps. The process arrows in cer tain
guided processes are also not always automatically refreshed.

Select  > Refresh Working Area to refresh current view.

Changing the Order of Elements on the Start Pages
and in Related Data
You can configure the layout of areas on the screen.
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To change the layout:

1. Click on  and choose an option:

•  (one column): Areas are displayed beneath one another spanning the entire
width.

•  (two columns): Areas are split over two columns.

Example:
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•  (tabbed): Displays the areas in separate tabs.

•  (Select Items): Click on this icon to display a list of all available areas.
Enable the check box next to the areas you wish to display. Click on Reset to
revert to the default settings.
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Your administrator can define that cer tain areas cannot be hidden or that cer tain
areas are not active by default.

To change the order of areas:

1. Click on an area and drag it to the desired position while holding the mouse button.

2. Release the mouse button.

Links
Various fields are displayed as links in Aurea CRM web. For example, links can be
used to link to records in a parent or child records. E-mail addresses and URLs can
be entered as links that are opened in the associated application.

By default, links are displayed underlined.

Click on the link to carry out the action associated with the link type:

• If the link references another record, the record is opened in the default view.

• If the link is an e-mail address, your default mail client is opened. Depending on
the settings configured by your administrator, you may need to add a new activity
before you can write the e-mail.

• If the link is a URL, the web page is opened in a new browser window.

• If the link references a document, the document is opened in the associated
application.

• Reps entered in rep fields are displayed in the quick view, where you can view
information on the rep (e.g. e-mail address, telephone number).

• Telephone numbers are either opened in CRM.phone (if installed) or the application
associated with the
tel:

protocol.

Assigning Icons to Links
Your administrator can determine that an icon is displayed instead of specific URLs.
Click on the icon to open the URL.

Example:

If you have entered links to contact persons' Facebook or XING profiles, the plat-
form's logo can be displayed instead of the URL.

The following social media icons are available by default:
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Context Menu
The context menu is available in list view, tree view and tab view.

You can access the context menu in the following ways:

• Click on  (Menu).

• Press Ctrl+M on your keyboard in the tab or tree view. You can also use the cursor
keys to navigate within the menu.

• Hold down Ctrl and click on an entry in the context menu to open the corresponding
view in a new tab within the current window, >>  on page 21.

The following screenshot shows the context menu for tickets:

The menu contains fur ther sub-menus which are displayed automatically when the
cursor is positioned over the relevant menu entry:

Displays the selected record in the mask viewTab View

Displays the selected record in the tree viewTree View

Deletes the selected recordDelete

Adds the selected record to your favoritesAdd to Fa-
vorites
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Adds a new linked record. Use the sub-menu to determine which
kind of record to add.

New

Displays related records. Use the sub-menu to determine which
kind of related records to display.

Go to All Relat-
ed

Date Picker
The date picker is available in the calendar views and in date fields to choose a
date.

You can use the arrows on either side of the month and year in the calendar header
to move back one month (left arrow) or forward one month (right arrow). Alternatively,
click on the month or year in the header to select the month and the year from a
drop-down list.

The calendar week is displayed in the W column. If you click on the week number
in a calendar view, this week is displayed.

Click on a date to highlight it in the calendar and switch the daily or weekly display
to this date or enter the date in a field. The current date is displayed in bold, and
can be selected by clicking on Today directly below the calendar.

Sundays and holidays are color-coded according to the holidays defined in the cal-
endar selected in the settings, >>  on page 36.

Field Types
The following chapters describe the field types that are used to enter data:

Your administrator can define the following for fields:

• Keyboard shortcuts used to navigate directly to a specific field.

• The field formatting, which can differ depending on the field's content, e.g. negative
numbers can be displayed in red.

• Whether catalog and percentage fields are displayed graphically or numerically,
>>  on page 29.

53AUREA CONFIDENTIAL

User Interface



Text Fields
You can enter strings containing any characters in text fields.

Your administrator can define that text fields are displayed spanning multiple rows.
If the text is longer than the space available to the field, a scroll bar is displayed.
Your administrator can also determine that the  button is displayed. Click on this
button to increase the size of the text field to display the full contents.

Numeric Fields
You can only enter digits (0-9), commas (,) and decimal points (.) in numeric fields.

Catalog Fields (Drop-down Lists)
Catalogs are displayed as drop-down lists.

Note: Note: Whether you can add new catalog values, depends on your access
rights.

Your administrator can determine how catalogs are sor ted:

• Alphabetically

• By catalog number

• Using a sor t order defined by your administrator

Note: Note: Your administrator can determine that catalog values are sor ted
differently in different languages.

To select an option from a drop-down list:

1. Click on  to open the drop-down list.
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2. Select the option you want to enter in the field. Alternatively you can navigate in
the drop-down list by typing the first character (e.g. typing 'F' highlights the
"Finland" entry). If you select a value, the drop-down list is closed.

Adding Catalog Values

To add catalog values:

1. Click on the icon  (Add/Find Catalog Values) next to a catalog field.

The Find or add catalog value dialog box is displayed:

1. Enter the new catalog value in the text field.

2. Click on New to add the entry to the catalog.

The new entry is displayed at the end of the list. The catalog is only sor ted alpha-
betically the next time you log on to Aurea CRM web.

Note: Note: Tenant numbers are displayed in parentheses alongside catalog values
if tenants have been configured for your system.

You can also use the dialog box to search for specific entries in long catalogs.

Note: Note: When adding new catalog values in your language, you also need to
enter the value in the catalog base language if you are logged on to the system
using another language than the catalog base language. If you have the necessary
access rights, Go to Catalog Maintenance is displayed as a link below the list of
catalog values. Click on this link to switch to the Catalog Maintenance area where
you can manage all catalog values.

Multiple Catalog Values in a Field

Some catalog fields in the database are defined as so-called array fields. You can
enter multiple values in these fields. Array fields contain the ghost text "Add X more",
indicating the number of catalog values that can still be entered in the field.
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To enter multiple catalog values:

1. Click on the catalog field or the downwards arrow next to the field.

2. The drop-down list is displayed.

3. Select the desired entry.

Depending on your access rights, you may also be able to add new catalog values
when needed. To do so, click on  (Add/Find Catalog Values).

4. Repeat the process if you want to add additional entries. The number of entries
you can still add is displayed in light gray.

Date Fields
You can enter the date in date fields directly or use the pop-up calendar, >>  on
page 25.

If you enter the date directly, you can only enter the following characters:

• Digits

• The date separator defined in your user configuration, >>  on page 36.

If your date format uses four digits for the year, the current year is entered automat-
ically.

Use the Date Picker to select the desired date, >> on page 25.

The pop-up calendar is closed once a date is selected.

Note: Note: Use the pop-up calendar to ensure that dates are always entered in
the correct format (e.g. day/month/year). If you enter dates manually, ensure you
enter the date in the correct format.
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Note:  Note: To disable auto-completion of the year field, contact your Aurea
administrator.

Time Fields
You can enter times directly in time fields. The following characters are permitted:

• Digits

• The time separator defined in your user configuration, >>  on page 36.

• "am" and "pm" if you are using the 12 hour format.

• Spaces

Note: Note: Your administrator can determine that the current time is automatically
entered in time fields, e.g. as the star t time of an activity.

Rep Fields
Reps are selected using rep fields. You can either select a rep from a dialog box
listing all reps, or enter a por tion of the rep's name in the field, >>  on page 67.

Mandatory Fields
Mandatory fields must be filled in before you can save the record. Your administrator
can determine that mandatory fields are highlighted. In the default configuration,
mandatory fields are displayed in orange and indicated with an asterisk or exclama-
tion mark.

If data has not been entered in all mandatory fields when saving a record, the cursor
is moved to the first mandatory field that is missing data.

In the example below, a currency must be entered in the Currency field before the
record can be saved.

Note: Note: If you are working in tab view, tabs containing mandatory fields that
have not yet been filled in are formatted differently. Your administrator defines the
appearance of these fields.
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Boolean Fields
Boolean fields can only store Boolean values (i.e. false/true or 0/1 or check mark/no
check mark).

Link Fields
Link fields are fields linked to records in other info areas.

Link fields are displayed as links in view mode. In edit mode, the  (Select) icon
is displayed to the right of the field:

Click on  to access the search mask for the linked info area and search for and
select the desired record.

Your administrator can determine that

• selecting a child record (such as a person) causes any related parent data (such
as the person's company) to be entered.

Example: If a person is entered in the End Customer Person in the Ticket info
area, the End Customer Company can be entered automatically.

• a link can be removed by clicking on  (Remove Link).

Note: Note: If you delete a link to a parent record, links to related child records
are also deleted.

Displaying Percentage and Catalog Fields Graphically
You can display the contents of percentage and catalog fields (e.g. "High", "Medium"
and "Low" priority) graphically, as well as enter values using the graphical display.

Catalog Field Examples:

Your administrator can also determine which colors or icons are used for which
values and whether only the icon, the value, or both are displayed.

or

or
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• Click on the desired icon to enter a new value.

• Move the mouse cursor over the icon to display the value.

Percentage Field Examples:

By default, a slider is used to enter percentage values, however your administrator
can deactivate the slider. Your administrator can also determine whether you can
enter negative values using the slider. Positive and negative values are differentiated
by color.

Default slider:

media/image100.png

Slider for positive and negative values:

To enter a percentage value:

• Enter a value in the numeric field.

• Use the mouse to drag the colored bar to the desired position.

HTML Fields
HTML fields allow you to enter and format content using an HTML editor. Your ad-
ministrator can add HTML fields to info areas.

The most common formatting options, e.g. bold, italics, numbered lists etc. are
available.

When sending e-mails the text is sent as HTML.

Note: Note: This option is only available if e-mails are sent by the server.

Example:
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Field Data Types
In some dialog boxes, the field type is also displayed along with the field name and
number.

The following data types are available:

• B = Boolean

• C = Character string

• D = Date

• F = Floating point number

• K = Variable catalog

• L = Long integer

• S = Short integer

• T = Time

• X = Fixed catalog

• Z = Write-protected/decoded fields whose values are entered automatically by
the business logic, e.g. system and link fields.

Displaying Content from Multiple Fields in a Single Field
In some views, such as the tab view or the mini details view, your administrator can
combine multiple fields' contents in a single field. For example, an address field
can be defined that contains the contents of the Street, Postal Code, City and
Country fields:

The fields are displayed separately in edit mode:
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Field Help
Aurea software provides an Excel file that contains descriptions of the fields in the
default version of the software. This Excel file can be customized by your adminis-
trator to reflect your system's configuration and can be imported into the Aurea CRM
database. In this case, you can access the online field help.

If you move your mouse cursor over a field name, a tooltip is displayed containing
information on the data stored in the field.

Example:

Write-protected Records and Field Access
Your user rights determine which data you can access. If e. g. you have only been
granted read access to cer tain fields or info areas, you can access and display the
data stored there, but cannot edit the data.

Access to data is indicated as follows:

Access denied is displayed in fields to which access is denied in list view.

If access is denied to the entire record, an icon is displayed on the left border whose
tooltip is "[info area name] cannot be edited."

You can only move the cursor to those fields that you are allowed to edit.

Messages when Executing Triggers
Your administrator can define triggers that are executed automatically when specific
actions are carried out (e.g. adding or deleting a record). Depending on how your
administrator has configured your system, you can also execute triggers using buttons
or entries in the context menu.

When an action is executed, status messages (such as error messages) are sent
to your inbox, >>  on page 10.
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However, if a trigger initiates a second trigger, and an error occurs while executing
the second trigger, no error message may be displayed for technical reasons. No
messages are displayed in the message area whenever follow-up triggers edit, add
or delete records. Changes (e.g. to field contents) are only displayed once the view
has been refreshed.

System Lock Messages
Your administrator can define system locks. If a system lock has been defined, you
receive a message informing you of the system lock, and are automatically logged
off. You cannot log in again for the entire duration of the system lock.

This type of message is valid for the duration defined by your administrator. Your
client needs to poll the server for messages. The interval with which Aurea CRM
web polls for messages is defined by your administrator.

If your administrator defines an immediate system lock, i.e. you are immediately
unable to access the system, the message is only displayed if the system polls for
a message while the system lock is in effect (which may not happen if the system
is locked for less than the polling interval).

Sending E-mails
You can send e-mails directly from within Aurea CRM web:

• Click on an e-mail address in a customer record to send an e-mail to that address.

• Click on  (Send as E-mail) in a record.

If you send a record using this option, cer tain data is automatically transferred
from the source record to the e-mail. For example, the following are transferred
when sending an activity:

• To: The name of the contact person and the name of additional par ticipants
(e.g. in an appointment) and the responsible rep.

• Cc: The current rep (the one sending the e-mail)

• Subject: The activity's subject

• Text: The contents of the Text field in the activity record.

When sending e-mails via the server:

• All linked documents are included as attachments

• The e-mail is sent automatically; you cannot edit it

• Unicode characters are supported
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When sending e-mails from your client:

• No attachments can be sent

• HTML mails are not supported

Notifying Reps
You can send a link to a specific record to internal reps and external par ticipants
by e-mail, e.g. a link to an activity.

To notify reps:

1. Switch to the desired record, e.g. an activity.

2. Select Notify Rep from the context menu.

The following dialog box is displayed:

1. The following recipients are suggested by the system:

• Recipients: The rep entered in the record and the contact person or company's
e-mail address

• Cc: All required participants

• Bcc: All additional par ticipants (optional and for information)

2. You can enter Additional internal recipients, >> on page 67.

3. You can enter Additional external recipients by entering their e-mail addresses.

4. The Subject and Body are transferred from the record. You can edit these fields.

5. Determine whether to inser t a link to a record or request a receipt using the Insert
Aurea CRM web link, Insert Aurea CRM win link, Request a delivery Receipt
and Request a read receipt check boxes.

Note:  Note: The “Insert Aurea CRM web link” check box can be checked by
default, if your administrator has set it that way. You can uncheck it, and in
subsequent notifications to this recipient it remains unchecked.

6. Click on  (Insert Signature) to include your signature in the e-mail (provided a
signature has been defined in your rep record).

7. Click on Send to send the e-mail.

63AUREA CONFIDENTIAL

User Interface



Hiding/Showing the CRM.phone toolbar

If you are using Aurea CRM web with CRM.phone, a telephone icon ( ) is dis-
played in the sidebar:

1. Click on  to display the CRM.phone toolbar.

2. Click on  (Close) to hide the toolbar.

Your administrator can determine whether the CRM.phone toolbar is displayed au-
tomatically when an incoming call is received. The toolbar is not automatically hidden
when the phone call is completed.

For more information on CRM.phone, >> CRM.phone User Manual.

Touch Devices
You can use Aurea CRM web on touch devices. Aurea CRM web is capable of de-
tecting whether you are using a touch device.

If you are using a touch device that also supports a mouse, you can choose whether
to use the mouse, your fingers, or both. You choice is stored in your browser cache
and is reused the next time you log on. You can however switch to a different mode
at any time.

For information on which browsers are recommended for which operating system,
refer to the system requirements available from the Aurea’s support page at
https://support.aurea.com.

Common touch gestures are supported, such as:

• Navigating in lists: Swipe in the desired direction. The  and  icons
indicate the direction in which you are navigating.

• Sorting data in lists: Tap on a column header to sor t entries by the value in that
column in ascending order. Tap again to sor t the data in descending order.
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• Drag&drop: You can use drag&drop, for example in the calendar to reschedule
appointments.

• Vir tual keyboard: The available keys depend on the type of field. A numeric keypad
is displayed for numeric fields, whereas the @ character is available when entering
e-mail addresses.

Settings
Use the Settings menu to determine your configuration, change your password, or
display system information.

User Configuration
Select User Configuration from the Settings menu to change your user settings,
such as your star t page format or the number of records displayed per page in lists.

Your administrator can define access to these settings.

To change your user configuration:

1. Select Settings > User Configuration from the menu.

2. Switch to the corresponding tab. The following tabs are displayed:

• Layout, >>  on page 34.

• Handling, >>  on page 34.

• Activities, >>  on page 36.

• Date & Time, >>  on page 36.

3. Configure your settings.

4. Save your settings

Note: Note: Not all of the changes are applied immediately after saving. Instead
they are applied the next time you log on to Aurea CRM web.

Layout Tab
Use the Layout tab to configure the following:
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• Start page: Select the star t page here; i.e. the page that should be displayed
after you have logged on to Aurea CRM web. You can choose to display generic
pages (e.g. the company search) as well as predefined star t pages (e.g. marketing
home page, sales home page).

Handling Tab

Use the Handling tab to configure the following:

• Base Currency: You can choose a base currency to be used in Aurea CRM web.
Currency values can be converted to the base currency using the exchange rate
table and displayed where appropriate (for example the value of orders in the
local currency). In order to display values in this currency, fields need to be added
to the masks by your administrator.

The base currency is also used for calculating costs for marketing activities and
campaigns.

• Records per page: The number of records that should be displayed per page in
result lists. Up to 50 records can be displayed per page. If more results are
returned, the navigation bar is displayed, >> on page 11.

• Records per query step: The number of records returned by the server for each
request.

• Check for new records every min: Enter the frequency with which Aurea CRM
web checks for new records such as reminders or messages.
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• Sort order of fields in query and filter designer: Use this option to determine
the order that fields are listed in when creating filters or queries. The entries can
be sor ted alphabetically or using their index.

• Default view for rep selection: Determines the default view used to select reps.
You can choose between list view or tree view.

• Search: Go to details view when search result is one record: Enable this
check box to automatically switch to the detailed view if a search only returns
one record.

• New Records: Use field values from last data entry: Determines whether the
data entered in the last record added is automatically transferred to subsequent
new records:

• Default (do not transfer the last input): No data is entered in new records.

• Use all values from last data entry: The data in the last record you have
added is automatically entered.

• Use admin-defined values from last data entry: Your administrator can define
fields whose values are set to the value entered in the last new record.

• Save history: Determines whether the history is saved and available the next
time Aurea CRM web is star ted, >> on page 7.

• Remember last search criterion for queries and analyses: The last search
criterion is displayed when you re-open the search mask.

• Activate browser on incoming call: If the browser is currently in the background
(i.e. you are working in another application), the browser is sent to the foreground
when receiving a call.

• Display the administrator information in the field help: If information for
administrators is available, this information is displayed in the field help.

• Remember search and filter criteria based on last user input: The last search
and filter criteria are stored and reloaded when the search is reopened.
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Activities Tab

Use the Activities tab to configure the following:

• Start of work day (hh:mm): Enter the time the working day star ts. The time
between the star t of the day and the end of the day is highlighted in the calendar.

• End of work day (hh:mm): Enter the time the working day finishes.

• Collision check: Enable this check box if you want the system to check whether
new activities clash with existing activities.

Note: Note: If you add activities in the calendar, the collision check is not
activated, as you can tell whether another appointment is scheduled at the time
in the calendar itself.

• First year in date picker: Enter the earliest year that is available in the calendar.

• Last year in date picker: Enter the last year that is available in the calendar.

• First week of the year must contain: Enter the day of the month that the first
calendar week must contain.

• Number of days selected when selecting a week: Enter the number of days to
be displayed when displaying a week in the calendar.

• Items displayed in the calendar sidebar: Determines which records you can
display in the calendar's sidebar.
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Date & Time Tab
Use the Date & Time tab to configure the following:

• Holiday calendar: Determines which days are displayed as holidays in the
calendar.

• Date format: Determines how dates are displayed.

• Date separator: Determines the character used to separate days, months and
years in dates. You can choose between "/". "-", "." or Server.

• Year format: Determines how years are displayed (2 digits, 4 digits or determined
by the server).

• Time format: Defines how the time is displayed (24-hour clock, 12-hour clock or
determined by the server).

• Time separator: Defines the separator used between hours, minutes and seconds
(:, . or Server).

• Decimal separator: Determines the character used as a decimal point. You can
choose between ".", "," and Server.

• Digit grouping symbol: Determines the character used to separate millions,
thousands etc. You can choose between ",", ".", "'", Space and Server.

• Time zone: Defines your time zone. This setting is used to convert times to your
time zone. For example, if you set your time zone to San Francisco, 15:00 CET
is displayed as 6:00 in the calendar. Select the Client option to display the
calendar using the time zone configured in the system settings on your local
computer. You need to close your browser and restar t it before the Client setting
is applied to the calendar.
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Changing Passwords
To change your password directly from within Aurea CRM web:

1. Select  (Settings) > Change Password from the menu.

2. Enter your current password in the Old Password field and enter and confirm
your new password in the fields below.

3. Click the Change Password button.

A message appears informing you that your password has been changed success-
fully.

System Information
Use the system information to access information such as your user name, rep and
database version. If you are experiencing problems with the system, you can mail
this information directly to the e-mail address specified at the bottom. The text field
allows you to describe the problem in greater detail.

To send the system info to the specified e-mail address:

1. Select  (Settings) > System Information.

The system information dialog box is displayed.

2. Describe your problem in the Additional Description field.
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3. Click the Send button to send the e-mail.

Note: Note: Your administrator can define which information is displayed here.

Info Area Rights
Your administrator can determine that you can display a table containing all the info
areas in Aurea CRM web that you can access as well as your access rights for the
info areas (read, edit, new, delete).
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To display your info area rights, select  (Settings) > Info Area Rights from the
menu.

A "Y" in the Read, Edit, New and Delete columns indicates that you can view, edit,
add or delete records in that info area. An "N" indicates that you cannot view, edit,
add or delete records in that info area.

Note: Note: Contact your supervisor if you require changes to your access rights.

Searching
In many cases, the search function provides the star ting point for accessing the
data you require. You can define search criteria to restrict the amount of results
returned by the search so as to quickly access the data you need.
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Search Area
The search area is displayed whenever you open an info area from the menu (e.g.

by selecting  (Accounts) > Companies):

The search area can be displayed or hidden as required using the Show and Hide
(  and ) buttons.

If you have hidden the search area after performing a search, the header indicates
whether filters are applied to the search:

Your administrator can configure cer tain options defined for the search area, e.g.

determine whether the following options are available when clicking on  (Settings):

• Clear Search Criteria: Removes all search criteria. If you have added additional
fields to the search mask, those fields continue to be displayed.

• Reset Search Settings: Resets the search mask to the default settings defined
by your administrator. The search criteria you have entered are removed and any
fields you have added to the search mask are also removed.

Searching For Data
Use search criteria to narrow your search according to your needs. The available
search fields depend on the info area (Company, Person etc.).

The most important fields are included in the search mask by default. You can
however add other fields in order to fur ther restrict your search. Which fields you
are allows to add to the search depend on your access rights.

If you are searching for text, e.g. a company name, and you do not know the exact
name or do not wish to enter the full name, enter the first few characters followed
by the wildcard "*". For example, if you search for "Aurea*", then your results includes
"Aurea software". If, on the other hand, you were to leave out the wildcard, then the
exact match is searched for (i.e. a search for "Aurea" only delivers results if there
is a company whose name corresponds exactly to "Aurea").
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To search for records:

1. Switch to the search area.

2. Enter your search criteria.

3. Your administrator can determine that you can access the With me option to
restrict the results to those records where you are entered as the rep.

4. Choose the number of results to be displayed on a page of the results list. The
maximum is 50.

You can define the default number of records per page in the user configuration.

5. Click the Start Search button. The results of your query are displayed in the
results list below the search area.

Adding Additional Search Fields
Your administrator can determine whether you can add additional fields as search
criteria. To do so:

1. Click on  next to Add more.

2. Select the desired field and click on  (Add) to add the field to the search mask.

3. If the field you want to use is not in the list, select More Fields from the list. A
dialog containing all fields you can access is displayed.
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4. Select the desired field and click on Apply.

Searching in Combined Fields
If the search mask contains combined fields (i.e. fields that combine data from
several fields such as a person's Name), the system searches for your search term
in all these fields. The fields that are combined in the search field are displayed as
ghost text:

If you enter a search criteria in a combined field, the system searches for matches
in both fields:
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You can enter multiple search terms (e.g. first and last name) in the combined field.

You can also enter a sub-string (e.g. the first few letters of a name). In this case,
separate the search terms using a comma and enter the terms in the same order
as the fields are listed in the ghost text. The system then searches for the first
search term in the first field (e.g. First Name) and for the second term in the second
field (e.g. Last Name) etc.

Searching by Postal Code
You can restrict the search to a specific range of postal codes, e.g. in the company
search.

As some countries (e.g. the UK) use combinations of letters and numbers to form
postal codes, the From ZIP and To ZIP fields are alphanumeric.

If you restrict the postal code to a range, the postal codes entered in the two fields
must be of the same length, e.g. search for customers with a postal code between
1010 and 1090 (4 characters). Comparing postal codes that contain a combination
of letters and numbers can lead to unwanted results.
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Phonetic Search
Your administrator can determine that you can search the database for similar
company and person names based on their sound. Certain letters are treated as
similar-sounding by the system, allowing you to search for similar names such as
"Wild" and "Wilde".

If the phonetic search is available for a field,  (Phonetic Search) is displayed next
to it. Click on the icon to use the phonetic search for that field. The icon changes
to .

Note the following:

• The phonetic search is based on international phonetics, and does not take English
spelling into account. It also ignores the idiosyncrasies of English spelling.

• You can enter sub-strings as search terms.

• Vowels are completely ignored by the search, and only consonants play a role.
Consonants are divided into categories based on phonetic similarity:

• B=F=P=V

• C=G=J=K=Q=S=X=Z

• D=T

• M=N

• vowels=W=Y=H.

• To search for compound names, enter both names. A single name is not enough
to find a compound name.

• You can only search phonetically in one field at a time; if the phonetic search is
available for multiple fields, you need to choose which field to enable the phonetic
search for.

• The wildcard '*' can be used in a phonetic search. For example, searching for
"Wil*" can return "Wilde".

Selecting Records
Click on a record in the results list to select it. The selected record is highlighted.

You can edit the selected record directly in the list, open the record in the tab or
tree view or display additional details in the details view, >> on page 13 and on
page 60. Child records related to the selected record are displayed under Related
Data, >> on page 60 and on page 13.
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Filters
You can use filters to store commonly used search criteria, and load them to fur ther
narrow down your search. For example, you could define a condition specifying that
all persons at a cer tain address should be displayed.

Conditions can be defined for all search areas in Aurea CRM web.

If a filter is active, the name is displayed in the search mask.

Note: Note: Your administrator can determine that you are not allowed to define
filters, but can only select from pre-defined filters.

Selecting Filters
If filters have been defined, you can select a filter to restrict the results of a search.

To select a filter:

1. The available filters can be accessed from the drop-down field below the search
fields. Select the desired filter from the drop-down list.

2. Click on  (Add) to add the filter to the search criteria.

The filter is applied when searching.
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Defining Filters
To define a filter:

1. Click on Add more or click on  next to the field and select More Filters from the
list.

The Filter dialog is displayed.

1. Click on  (New) to define a new filter. Click on Load to load an existing filter.

You can define filters in two ways:

• As AQL (Aurea Query language) in the AQL Syntax field. For more information
on the AQL syntax, >> Aurea CRM web Administrator Guide.

• Using the graphical user interface to select fields and enter filter criteria. This
method is described in this manual.

2. Select Add Condition from the info area or condition’s context menu to define a
condition.

The Select Fields in Info Area: <Info Area> dialog is displayed. All available fields
in the info area are listed.

1. Click on a column heading to sor t the list by the entries in that column.

2. Click on  (Show/Hide Columns) to determine which columns are displayed in
the list.

3. You can search for a specific field by entering a por tion of its name in the Search
Field Name field.

• Enter one or two letters to list all fields whose name begins with those letters.

• Enter three or more letters to list all fields whose name contains the text you
have entered.

You can also search for fields by field number.

4. Select a field and click on Next.

5. Define the condition. The conditions you can define depend on the Field Type
(as for queries):
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• Text fields, >>  on page 89

• Date fields, >>  on page 88 and on page 90

• Catalog fields, >>  on page 85 and on page 87

• Numeric fields, >>  on page 89

• Boolean fields, >>  on page 88

• Time fields, >>  on page 89

• Rep fields, >>  on page 89 and on page 90

6. Click on OK.

The filter you have defined is displayed:

1. Define any additional conditions:.

a. Click on  next to an existing condition and select Add Condition from the
context menu.

b. The new condition is linked to the existing condition. To change the logical
operator used to link the conditions (AND/OR), click on  next to the operator
and select Change to AND/OR from the context menu.

2. You can apply the filter without saving it, however it is then not be available in
future (after clicking on Reset or selecting a different filter).

To save the filter so it can be reused later, enter a name in the Filter name field
and click on Save.
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Note: Note: If you have unsaved changes, an asterisk (*) is displayed after the
filter’s name.

3. Click on Apply. The filter is activated and the search is star ted automatically.

All results are listed.

Adding Info Areas

Filters can contain conditions applied to more than one info area.

To add an additional info area:

1. Load the desired filter, >> on page 42.

2. Click on  (Add Info Area).

Note: Note: All info areas linked to the current info area in the data model and
that you are allowed to access are listed in the dialog. Your administrator is
responsible for defining which info areas you can access.

3. Select the desired info area or enter a por tion of its name in the Search Info Area
Name field. Click on Select.

4. A dialog is displayed. Select the type of relationship between the two info areas.

5. Enable the Optional check box to link these conditions to conditions applied to
other child areas with a logical OR. Records are returned if they meet all
non-optional conditions and at least one optional condition.

6. Click on Continue.

The filter you have defined is displayed:

Quick Search
Use the Quick Search function at the top right of the screen to quickly search in
the most frequently used info areas (which info areas the quick search applies to
is defined by your administrator):

To star t the quick search:

1. Click in the search field and enter your search criteria. The "Find as you type"
function immediately lists matching records:
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A maximum of 5 hits per info area are displayed in the quick search. Click on the
number next to the info area name (5+) to display all hits.

2. The info areas that are searched (in the above example, companies, persons and
activities) are determined by your administrator.

3. Click on  to define the info areas that are searched in.

4. The system searches in the info areas where the check box is enabled. Use the
check boxes to choose which info areas to search.

Results List
The results of a search are displayed below the search area in a list.
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If a query returns more results than can be displayed on a single page, use the
navigation bar to scroll through the rest of the list, >> on page 11.

Note: Note: If only one record is found and the Search: Go to details view when
search result is one record option is enabled in the user settings, the record is
automatically opened in tab view, >>  on page 34.

Column Settings
You can define the position of the columns (fields) in the list.

Sorting Lists

You can sor t your result lists in Aurea CRM web by column in either ascending or
descending order.

The column used to sor t the entries in the list is color-coded.

A small arrow is displayed in columns you can use to sor t entries when moving the
mouse cursor over the column header.

To sor t entries in a list:

1. Click on the field you want to sor t by in the list header, for example, the Country
column.
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The entries are sor ted in ascending order indicated by an upwards arrow.

2. Click again on the header to sor t the entries in descending order.

A downwards arrow is displayed in the Country column if you hover the mouse
over its heading.

Changing Column Order

You can change the order of the columns in lists using drag & drop. Drag the desired
column to the desired position. Two orange arrows show the column's new position.

In the following example, the Street column is inser ted to the left of the City column:

1. Click on the Street column header, and drag it to the left of the City column. Two
gray arrows are displayed at the column's new position.
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Changing Column Width

The column width is based by default on the length of the fields in the database.
You can change the width of your columns.

To change the column width:

1. Position the cursor over the field separator.

2. Drag the separator to the desired position.

Selecting the Fields in the List

You can determine which fields are displayed in the list.

To select fields:

1. Click on  (Modify List Fields).

The Modify List Fields dialog is displayed:
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The info area that you accessed the search for is entered in the Select Info Area
field.

2. Determine which fields to display in the list and the order of the columns:

• Select Info Area: Select the info area whose fields you want to display and
sort records by. To do so:

Click on  to display a list of the linked info areas:

More than one link may exist between linked info areas, e.g. the Ticket info
area is linked to the Person info area several times. A person can be linked to
a ticket as the end customer, contact person or billing address. Select the de-
sired link from the drop-down list to the right of the info area.

If only one link is available, only the default option is available.

• Available Fields: All fields in the selected info area are listed here.

Click on the By No. or Alph. buttons to list the fields by field number or alpha-
betically. Click on the desired field and click on  (Add Field), or double-click
on the field to add the selected field to the list of Output Fields.

• Output Fields: This area lists the fields that are displayed in the list.

Select a field in the list and click on  (Remove Field) to remove a field from

the list of Output Fields. Click on  (Remove All) to remove all fields from
the list. Click on  (Move Up) and  (Move Down) to change the order of the
fields.

• Sort by: This area contains the fields that records are automatically sor ted by.
To transfer a field from the list of Output Fields, select the field and click on

 (Add Field).
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To remove a field, select the field and click on  (Remove Field). Click on 
(Remove All) to remove all fields from the list. Click on  (Move Up) and 
(Move Down) to change the sor t order.

The icon next to sor t fields indicates whether the entries are sor ted in ascending
( ) or descending ( ) order by default. Double-click on a search field to change
the sor t order.

Note: Note: If no sor t fields are defined (or only one sor t field is defined and
several records contain the same value in this field), the same records are
sometimes displayed when switching between pages in the results list. To prevent
this, define sor t fields such that the sor t criteria is unique.

3. Click on OK to apply your settings.

Click on Restore Defaults to restore the default settings. Click on Cancel to
discard your changes.

Telephone and E-mail Search
This area allows you to search for telephone numbers (e.g. for incoming calls) and
e-mail addresses of companies/persons and to display and add company and/or
person information as well as additional information.

To search for companies or persons using their phone number or e-mail address:

1. Select  (Accounts) > Phone & E-mail Search from the menu.

The Phone & E-mail Search is displayed.

1. Enter the phone number or e-mail address you wish to search for.

2. Enable the Original number check box if you wish to automatically add the
appropriate country and area codes entered in your telephone profile.

3. Click on Start Search.

The records found are listed.

Note: Note: The complete address must be entered in order to search for e-mail
addresses. You can enter non-ASCII characters supported by IDN (e.g. é).

4. Edit the record as necessary. Use the context menu in the results list to access
the same options as in the company and person result lists.
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Telephone Number Search Method
Aurea CRM web recognizes whether the number you are searching for is an internal
extension, a local number, a domestic number or an international number and
completes any missing portions of the number based on your telephone profile set-
tings.

Examples:

A short number is interpreted as an internal extension of another
rep (the rep must be present as a person in the database). Your
country code, area code and your company’s telephone number are
added to the star t of the telephone number.

100

Longer numbers without a leading zero are interpreted as local
numbers. Your country code and area code are added to the star t
of the telephone number.

3334567

A number with a leading zero is interpreted as a domestic number.
The leading zero is removed and replaced by your country code.

07323334567

A number with two leading zeros or a + at the star t is interpreted as
an international number. The 00 or + is removed.

0049893334567

The number is then searched for in the database. If no person is found, up to 3
digits (by default) are removed from the end and the search is repeated. For example,
if an extension is not found, but the company’s number is found, the company’s is
listed instead.

Note: Note: The maximum number of digits that are removed from telephone
numbers is defined by your administrator in your telephone profile.

The search ends:

• If a matching number is found

• After the maximum number of digits have been removed (default = 3)

• If the number only has six digits after removing the last digits

Adding Records
Depending on your user type and access rights, you can add various types of infor-
mation to the Aurea CRM database.
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Adding new Records
There are several ways in which you can add records to Aurea CRM web. In general,
it is possible to differentiate between independent records (such as companies or
campaigns; i.e. those records with no parent records) and child records (such as
activities).

Adding new Independent Records
Independent records can be added using the menu options (e.g. New Company)
or using the New button in the list view. The mask used to add new records is dis-
played.

In cer tain info areas, such as Company or Person (or Company in Person), Aurea
CRM web matches up new data with existing records to prevent duplicate records
from being added to Aurea CRM's database, >>  on page 57.

Example: Adding a new company

This example illustrates how new independent records are added and can be applied
to any info area.

1. Select (Accounts)> New Company from the menu to open the search area.

2. Click on Search.

3. Click on  (New)in company search's results list.

The New: Company page is displayed.

1. Enter all the relevant information.

2. Click on  (Save). Aurea CRM web automatically checks whether the company
is already stored in the database, >>  on page 57.

The company is displayed in the default view after being saved.

Adding new Child Records
Records that are associated with a parent record (e.g. persons in a company) can
be added in two ways:

• From the parent record, >>  on page 52.

• From any info area, >>  on page 53.

• In the tree view of the parent record, >>  on page 54.

Adding Child Records from the Parent Record

If you are currently viewing a parent record (e.g. a company), you can use the
context menu to add a new child record, e.g. a new person or activity.
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As it is clear which record is the parent record in this case, you are immediately
switched to the mask where you can enter the new record's data. Proceed as with
independent records, >>  on page 51.

Example: Adding a new Person within a Company

To add a new person to a company:

1. Select New > New Person from the company's context menu. Alternatively, click
the New button in the list view when displaying all the persons in a company. The
New Person mask is displayed.

2. Enter the person's data.

3. Save the record. The record is displayed in the default view.

Adding Child Records from Anywhere

Child records can also be added without accessing the parent record. If you select
Accounts > New Person or New Activity, for example, the system guides you
through the necessary steps.

Example: Adding new Persons from any info area

You can add any number of persons to an existing company. Before you enter a
new person, you must select the associated company.

To add a person:

1. Select (Accounts)> Persons from the menu to open the search area.

2. Click on Search.

3. Click on  (New)in search's results list.
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The Create Person process is displayed.

1. Search for the desired company or add a new one.

2. Select the desired company in the results list to add the person to the company.

The New Person in Company mask is displayed.

3. Enter the relevant data.
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4. Click Save to add the new person.

5. The record is displayed in the default view.

Adding Child Records in the Tree View

You can add new child records in the tree view of a record (e.g. a company) using
the child info area or child records' context menu (e.g. a person).

As the parent record is uniquely identified, the input mask is displayed immediately.
Proceed as with independent records, >>  on page 51.

Example: Adding a new person to a company in the tree view

To add a new person to a company:

1. Switch to the tree view.

2. Select New from the Person ( ) context menu.

3. The New: Person mask is displayed.
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4. Enter the person data.

5. Click on Save.

The record is displayed in the tree view.

Copying Search Criteria to New Records
If you search for a record that cannot be found, you may want to add a corresponding
new record.

Your administrator can determine that you can automatically transfer your search
criteria to the new record.

Adding new Records Supported by a Process
You are guided through the steps of adding new records in various info areas, in
particular if new records cannot be added directly due to a lack of information. For
example, an activity can only be added if a company or person has been selected.

You are guided through the entire process and the necessary options are provided,
e.g. linking an activity to a person.

Example: Adding a new activity

To add a new activity:

1. Select  (Collaboration) > New Activity from the menu.

2. The New Activity process is displayed.

3. Choose the desired parent info area. In this example, we want to add an activity
for a person. Click on Person.
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The person search is displayed, allowing you to search for the desired record.

4. Search for the desired person.

5. Enter the desired data, for example any additional par ticipants.
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6. Click Save.

Copying Records
Your administrator can determine that you can copy data from a similar existing

record when adding a new record. If a record can be copied, the  (Copy) button
is displayed in tab view.
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To copy a record:

1. Open the record you want to copy.

2. Click on  (Copy) in the tab view.

3. Switch to the desired record or add a new one.

4. Click  (Paste).

The data from the copied company is transferred to the record.

Note: Note: Only data that does not depend on a specific record can be copied.
For example, the name, variant and key fields of a marketing activity are not
copied. Date fields are sometimes shifted accordingly. For example, if the star t
date of the copied marketing activity is 1.10.2013, and the end date is 3.10.2013,
then the new marketing activity's star t date is automatically set to the current
date, and the end date set to 2 days later. Data in the source record that you
have only been granted read access to is not copied from the source to the target
record.

5. Make the desired changes.

6. Save.

Match-up
To prevent duplicate records from being added to the database, new records are
matched up with existing records in the database.

Your administrator can define:

• That similar sounding names are listed (phonetic match-up)

• That new records are always saved without being matched up.

• Whether persons are matched up with all persons in the database, or only those
in the same company.

If a similar record is found in the database, the Duplicates Found window is dis-
played. If more than five similar records are found in the database, use the navigation
bar to switch between records, >>  on page 11.
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Select one of the available actions and click on OK.

Address Verification
Your administrator can define that addresses entered are verified using an external
application.

Whenever an address is edited or entered in a company, person, additional address
or property, the Address Check dialog is displayed. The address you entered is
displayed at the top followed by a list of suggested addresses returned by the exter-
nal application.

Double-click on a suggestion (or select the suggestion and click on OK) to apply
the suggested address to the current record.
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Note: Note: If the suggested address contains a catalog value that is not present
in the database, you cannot select the suggestion.

Depending on the external application, the suggestions may be rated. Suggestions
in the list are sor ted according to this rating in descending order (i.e. better sugges-
tions are at the top). Differences between your entries and the suggestions are
color-coded:

Green: Data that matches the value you entered

Orange: Data that differs from the value you entered

Light green: Data you did not enter but was returned by the external application

Gray: Catalog values that are not present in the Aurea CRM database (these sug-
gestions cannot be used)

Your administrator can define that suggestions exceeding a cer tain rating threshold
are applied automatically without displaying the list of suggestions.

Transferring Contact Details from Signatures and
Websites
Information on prospective customers is often available from contact information
on a website or e-mail signatures. Your administrator can determine that you can
copy and paste this information when adding and/or editing company and/or person
records. Aurea CRM web analyzes the data and assigns them to various fields such
as Name, Street, Postal Code etc.

To transfer data from a signature or website to a new record:

1. Copy the contact details from the source to your clipboard.

2. Switch to the input mask, in this case a company:
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3. Select the option configured by your administrator to copy signature or website
information.

The Copy from Signature or Website dialog is displayed:

4. Paste the data you copied to the clipboard and click on Analyze.

The system assigns the contact information to the available fields. Use the drop-
down lists to change the fields that data is assigned to if the automatic settings
are incorrect.

5. Click on Apply to transfer the data to the record once the information has been
assigned correctly.

Editing, Viewing and Deleting records
Records can be edited, displayed or deleted.
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You can display records as follows:

• Star t the search, enter search criteria and search for the record you wish to
display.

• Depending on your configuration, you can open your favorites and recent records
from the navigation bar, >> on page 8 and on page 7.

You can edit records in list and tab view. You are asked to confirm the deletion of
records, >>  on page 60, on page 59 and on page 63.

Note: Note: Whether you are able to edit or delete records depends on your access
rights, defined in your Aurea CRM web profile.

By default, data is displayed in view mode to prevent unwanted changes to data.

To edit the data, click on  (Edit) or double-click on the record.

Editing Records in Tab View
To edit data in tab view:

1. Select the record you want to update in the results list.

2. Double-click on the record or select Tab View from the context menu left of the
selected record.

Note: Note: If configured accordingly, the record is displayed below the results
list.

3. The record is displayed in the tab view.
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4. Switch to edit mode using the following options:

• Click on  (Edit).

• Double-click on a field or field name in the mask. The field is automatically
given focus.

5. You can now update the record or simply view the details in the tab view.

6. Click on the Save button.

Feedback on User Actions
Aurea CRM web informs you about actions as they are performed, e.g. that a record
was saved or that data is missing in a mandatory field. These messages are displayed
under the header containing the buttons.
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Additional messages such as system messages or information that a record has
been added to your favorites are displayed in the inbox, >> on page 10.

Buttons in the Tab View
The following functions are available for cer tain fields in tab view:

• Click on the e-mail icon  to the right of the e-mail address to send an e-mail.

This does not work if you are using unicode character sets, in which case your
e-mails need to be sent by the server. If you have configured you system to send
e-mails from the client, you need to write and send your Unicode e-mails in your
e-mail client and add the corresponding activity records to Aurea CRM web
manually.

You cannot add attachments to e-mails sent by the client.

• Click on a URL to access the company's website entered in the company record.

• Click on  to enter a rep using the rep catalog.

• Click on  (Make Call) while in edit mode to call the number using CRM.phone.
CRM.phone must be installed to use this button.

If several telephone numbers have been entered for a company or person, your
administrator can determine that you can select the desired number from a list.

• Click on  to link the current record with a record in another info area. The
search dialog is opened, allowing you to search for the record you want to link
to. Double-click on the desired record or choose Select from the context menu
to confirm the link.

• Click on  (Find or Add Catalog Values) to search for or add catalog values.

• Click on  (Select Date) next to a date field to open the date picker.

Editing Records in List View
To edit records in list view:

1. Click on  (Edit list)in the list header to edit the selected record directly in the
list view. Alternatively, you can click slowly on the field twice in succession to
switch to edit mode.
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The first editable field in the list or the field you clicked on twice is automatically
displayed in edit mode, and you can make any necessary changes. The following
input methods are available for the following field types:

• Select catalog values from the drop-down list, >>  on page 25.

• Select reps from the dialog box, >>  on page 28.

• Use the small calendar to enter dates, >>  on page 27.

• Click on  (Select) next to a link field to select a record in another info area,
>> on page 28.

2. Click on the Save button ( ) to the left of the record you are currently editing

to save your changes, or click on the Cancel button ( ) if you wish to cancel any
changes.

Note: Note: Your administrator can disable editing records by clicking twice.

Editing Multiple Records in the List Simultaneously
You can select, edit and delete multiple records in the list.

Selecting Multiple Records

There are two way of selecting multiple records, as in Windows:

• Press the Ctrl key and select the desired records using the mouse.

• Press the Shift key to select all records between the current record and the record
you subsequently click on.

Note: Note: Selecting multiple records is only possible for records displayed on
the same page in the results list. You cannot navigate to other pages using the
cursor keys without losing the current selection.

Editing Multiple Records

To edit multiple records in a list:

1. Select the desired records, >>  on page 61.

2. Click on  (Show Menu) next to one of the selected records.

The context menu for editing multiple records is opened.

3. Select Edit from the menu.

The fields displayed in the list view are displayed:
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If all selected records contain the same value in a field, the vale is displayed.
Otherwise the field is empty.

4. Change the content of the desired fields.

The check box to the left of a field is enabled if you change the field's value. If
you do not want to apply the change, disable the check box.

Move the mouse cursor over the check box to display the original value as a
tooltip.

To delete the values in a field in all records, enable the check box (and delete
the value in the field if necessary).

5. Click on Modify records.

The changes are applied to all selected records.

Deleting Multiple Records

To delete several records in the list at once:

1. Select the desired records, >>  on page 61.

2. Click on  (Show Menu) next to one of the highlighted records.

3. Select Delete from the menu.

The selected records are deleted from the database.

104AUREA CONFIDENTIAL

Chapter 1: General Functions



Editing Data in Predefined Processes
Your administrator can define processes used to add or edit data. For example,
opportunities progress through a number of phases which differ by industry and the
business processes in your company.

Your administrator can divide a process into individual phases and assign tasks to
these phases. Some of these tasks can be mandatory, which means that the oppor-
tunity cannot proceed to the next phase until these tasks have been completed.
Opportunities tend to be structured in phases such as identification, qualification,
offer and conclusion.

When editing data, only one phase is currently active. The active phase is displayed
in the process's header in orange.

Depending on your configuration, you may be able to switch back and for th between
phases, or you may only be able to proceed to the next phase once you have com-
pleted all the necessary steps.

Your administrator can define help texts and icons for each phase and for the whole
process that provide you with information on the current status and what tasks need
to be completed.
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Metrics can be displayed for individual phases (in the arrows) as well as for the
entire process (on the far right). These metrics provide feedback on key data relating
to the process.

Your administrator can determine that the arrows representing inactive phases
and/or all phases prior to the current phase are minimized.

Linking Records
You can enter links to other records in some info areas, e.g. enter a link to a ticket
in an activity. Which records you can link to is defined by your administrator.

To search for the linked record:

• Enter all or a por tion of the record’s name in the link field. Any matching results
in the target info area are listed.

• Click on  (Select) to search for the desired record. Select the search context
before star ting the search. Your administrator can determine whether you can
choose to search for the target record in the current context (i.e. a record related
to the current record or its parent record) or in the entire database.

In the following example, the current record is "Mr. Jonne Aaron" and the parent
record is "Krist Intl. OY":
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Deleting Records
To delete records:

1. In the results list, select the record you want to delete.

2. Click on  (Show Menu)to the left of the desired record to open the context
menu.

3. Select Delete from the menu.

4. Confirm that you want to delete the record.

The record is deleted and is no longer displayed in the results list.

Copying the Link to a Record to the Clipboard
You can copy the link to a record to the clipboard, for example to include it in an e-
mail.

Your administrator is responsible for determining which types of links to records
you can copy to the clipboard.

To copy a link to the clipboard:

1. Switch to the desired record (in tab view) or select the desired record in list view.

2. Select Copy Link to Clipboard from the context menu.

3. You can then paste the link from the clipboard into another application.

Note: Note: For security reasons, not all browsers permit you to copy data to the
clipboard. If you are not permitted to copy data to the clipboard, a popup message
is displayed that contains the link (already selected). You can then use Ctrl+C to
copy the link from the popup to the clipboard.
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Displaying a Record's History
Your administrator can define whether a history can be displayed for records. By
default, the history is configured for the following info areas:

• BTB: Installed Base

• FS: Product Overview

• OTC: Sample

If the history function has been enabled, you can display changes made to records
(provided you have the necessary access rights). The history include all changes
including those made automatically by the system (e.g. as a result of importing data).

The history is displayed in the Related Data area for those info areas where the
history has been enabled by your administrator. For performance reasons, the his-
tory is not always updated immediately after each change.

To display the history:

1. Switch to a record in an info area that includes a history (Installed Base in the
following example).
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Your administrator can determine that only the most important data, such as the
modification date and time, field, previous and new value are displayed.

2. Click on History under Related Data.

The history of changes is displayed. The following options are available:

Exporting
Aurea CRM web allows you to export records in various formats such as Excel or
PDF files.

Note: Note: Your administrator is responsible for determining which export formats
are available in which views and info areas.
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Examples:

•  Microsoft Excel (current page)

•  Microsoft Excel (all records)

•  Microsoft Word

•  HTML (corresponds to a web-based print preview)

•  PDF (the document cannot be edited).

All fields (including empty fields) are exported.

Exporting from Tab View
You can export the data displayed in tab view in some info areas. The following
options are available to export data:

• Click an export button, e.g.  (Microsoft Excel).

• Click on a button used to generate a predefined report, e.g. the Customer Fact
Sheet button in the tab view of a company.

Exporting from a List
When exporting data from a list, only those records displayed in the list are exported,
with the exception of the Export all options for MS Excel and CSV files. If 50 records
are displayed in the list, the export file thus contains these 50 records.

If you mark one or more records in a list and click on an export button, only the
marked records are exported. If no record are marked, all records are exported.

To export data in a list:

1. Search for the records you want, e.g. all companies in Austria.

2. The default export functions are available by clicking on .

3. Click on  and select the desired option, e.g.  (Export (MS Excel).

4. Save the file.

5. Enter a name for the file and choose the desired directory to save it in.

6. Click Save.

The records are exported to the file.

Export Examples
Example: HTML export of a person record in tab view:
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Example: PDF export from the person results list:
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Reps
Reps are persons (usually the employees of your company) that edit CRM data in
the system. Reps can be entered in various fields in record, depending on their
tasks. For example, a rep may be entered in an activity as a sales rep or the creator
of the record.

Selecting Reps
Reps are entered using the Select Reps dialog box. Click on a rep icon to open the
dialog. You can choose to display the available reps as a list, tree structure or (if
configured) hierarchy. The list is displayed by default.

To reduce load times, your administrator can define the maximum number of reps
that are displayed in the dialog box. If the number of reps available exceeds the
maximum number that are loaded, "..." is listed at the end of the list of reps. Click
on this entry to display fur ther reps.

Your administrator can also define which reps you can select. Only those reps you
can select are listed. Reps set as internal (system) reps are not listed by default.

Inactive reps or rep groups are displayed in light gray. Inactive reps can only be
selected for the following functions: search, conditions, queries, analyses and in
the resource view.
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Selecting Reps from the List
When entering a rep in a rep field, you can select the rep from either the list or tree
view. By default the list view is displayed.

To select a rep from the list view:

1. Click on the  (Select Rep) icon to the right of the field.

The Select Reps dialog box is displayed.

2. Click on a letter or enter the star t of the rep's name and click on Find.

3. Double-click on an entry or choose Select from the rep's context menu to enter
the rep in the field.

Note: Note: If you search for a rep in the tree or hierarchy view, the results are
displayed as a rep list.If a filter has been applied to the rep selector, your favorites

( )are unavailable.

Selecting Reps with the "Find as you type" Function
If you enter a por tion of a rep's name into a rep field, only those reps are listed
whose names contain the string you entered. Your administrator can determine the
minimum number of characters you need to enter to search for reps by name.
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To search for a rep by entering a por tion of the rep's name:

1. Enter all or a por tion of the rep's name in the Rep field. Depending on your
configuration, the following entries are listed:

• Reps whose names begin with these letters

• Reps whose name contains the text

A list containing all matches is displayed.

1. Click on a name, if more than one rep meets the search criteria.

The selected name is entered in the rep field.

Selecting Reps from the Tree View
To select a rep from the tree view:

1. Click on the  (Select Rep) icon to the right of the field.

The Select Reps dialog box is displayed.

2. Click on the Tree tab.

1. The reps are displayed in tree view. Each rep is accessible from the group they
have been assigned to. Use the  and  to expand or contract the tree structure
and display the reps allocated to a group.

2. Double-click on the entry or choose Select from the rep's context menu to enter
the rep in the Rep field.

Selecting Reps in the Rep Hierarchy
The hierarchy view displays reps in according to your internal hierarchy. Each rep
is listed under their immediate superior (as defined using hierarchy codes by your
administrator). Your administrator can determine that reps without a superior are
grouped in the "Unassigned" group.

Note: Note: Your administrator needs to enable the hierarchy view for it to be
available.

To select a rep in the hierarchy view:

1. Click on  (Rep) to the right of the field.

The Select Rep dialog is displayed.

2. Switch to the Hierarchy tab.
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Reps are displayed below their immediate superior in the hierarchy. Click on 
(Expand) or  (Collapse) to expand or collapse the tree.

3. Double-click on the desired rep or choose Select from the context menu to transfer
the rep to the rep field.

Rep Favorites
If you require a cer tain rep regularly (e.g. yourself for internal activities, or co-
workers that you regularly represent), you can use your favorites to access these
reps quickly.

To add a rep to your favorites:

1. Search for the rep.

2. Select Add to Favorites from the context menu.

The rep is now added to your favorites, and is displayed in the Favorites group.

Participants and Roles
Participants can be added to records in several info areas in Aurea CRM web, e.g.
to tickets, service contracts, installed bases, properties, opportunities etc. The
participants are assigned roles, e.g. as a contact person or end customer. Depending
on the info area the participants are added to, additional information can be entered,
for example you can enter the attitude or position of an opportunity par ticipant.

Your administrator is responsible for determining which participants are added au-
tomatically to which info areas.

115AUREA CONFIDENTIAL

Participants and Roles



Different roles can be defined for par ticipants. Some roles are predefined in the
default version, e.g.:

• Ticket: Contact par tner, end customer and billing address

• Service Contract: Billing address and service contractor

• Installed Base: Location

Participants can also be added to properties, opportunities, offers, orders, offer
items, order items, service contract items and installed base items.

For example, if you assign a ticket par ticipant the role of contact par tner and uncheck
Inactive (i.e. set the participant to active), the participant is automatically entered
in the Contact Company or Contact Person field in the ticket.

If you add a fur ther ticket par ticipant with the same role of contact par tner, the
previous participant is not removed. The previous contact par tner continues to be
displayed, however the Inactive check box is enabled indicating that the participant
is no longer active. The values in the Active from and Active to fields are entered
automatically based on when the Inactive check box is enabled or disabled. This
allows you to track who was active in which role in which process.

Depending on the info area, newly added participants are automatically set as the
active participant in that role, i.e. the Inactive check box is unchecked.

Your administrator can define how roles and participants are handled in Aurea CRM
web:

• Which roles are available in which info areas

• Whether par ticipants are automatically transferred to child info areas

• Whether you are allowed to add participants

• etc.

In the default version of Aurea CRM web, all par ticipants entered for a service
contract are also automatically copied to service offers along as any items.

You can delete individual par ticipants.

Adding Participants
To add a new participant:

1. Switch to the record (e.g. ticket, service contract, installed base, opportunity,
offer, order) you want to add a new participant to.

2. Click on  (New Participant) on the Participants tab under related data or select
New > Participant from the context menu.

The New Participant wizard is star ted.
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3. Choose whether to add a company, person or record in your favorites as the new
participant. Once you have selected the desired record, enter the participant’s
role.

4. Depending on the info area you are adding the participant to, you can enter
additional information concerning the participant, e.g. their position at their
company.

5. Depending on the info area the new participant is displayed in the list of
par ticipants and is set to the active participant for the selected role. If another
participant was previously assigned to this role, the Inactive field is enabled in
the previously assigned participant record, setting the previous participant to
inactive.

Note: Note: Only one participant can be active in a specific role. Your
administrator can determine whether you are allowed to add additional par ticipants.

Changing the Status of Participants
Participants (e.g. in tickets, service contracts or installed bases) may change over
time, for example if a contact person leaves the company they work for.

By setting participants to inactive, the participant continues to be stored and can
later be set to active again if necessary.

To change a participant’s role:

1. Switch to the desired record and switch to the Participants tab.

2. Enable the Inactive check box in the list view for those participants whose status
you want to change, >> on page 60.

3. Disable the Inactive check box for the participant who should be set as the active
participant in their role.

Note: Note: Only one participant can be active in a specific role. Your
administrator can determine whether you are allowed to add additional par ticipants.

Default Values
The standard version of Aurea CRM web includes default values for various info
areas. You administrator can define fur ther default values for all other info areas.
If you have the necessary privileges, you can edit these default values yourself or
define new ones. For example, if most of your contact with customers is by e-mail,
you can define them as the default activity type.
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Your administrator can define that the language you select when logging on is entered
as a default value, for example in search masks or when adding texts.

Defining Default Values
To define default values, for example for activities:

1. Click on  (Default Values) in the activity search.

2. Define the default values.

3. Click on  (Save) to save the default values.

The Save default values dialog box is displayed.

Enable the Lock check box to save your default values as read-only.

Enable the Private check box to prevent other users from accessing the default
values (i.e. they only apply to you).

4. Enter a Name and click on Save.

The default values are saved, and you are asked if you wish to activate the defaults
you just saved.

5. Click on Yes to automatically apply these values to new activities.

Note: Note: Default values must be saved under unique names. If you save two
sets of default values for different info areas under the same name, the default
values is no longer displayed correctly.

Applying Default Values
To apply a previously defined set of default values:

1. Click on  (Default Values) in the search mask.

2. Click on  (Load) in the Default Value dialog box.

The Load default values dialog box is displayed.

3. Select the set of default values from the list and click on Load.

4. Click on  (Apply) to use the default values automatically in future when adding
new records.
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Resetting Default Values
To remove default values that have been defined:

1. Click on  (Default Values) in the search mask.

2. Click on  (Reset).

3. Confirm the prompt with Yes to continue working without default values.

The default values are reset to the standard settings.

Calendar
The calendar displays activities, tasks, absences and To-Dos.

You can define which holidays are displayed in your calendar, the data displayed
in the left sidebar etc. in the user configuration, >> on page 34.

Note: Note: For a more detailed description of the calendar and information on
adding activities can be found in the Appointment Management chapter of the
Business Logic Manual for your ver tical.

The calendar in Aurea CRM web contains the following elements:
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• Different types of appointment are indicated using different icons (for telephone
calls, visits etc.).

• You can determine that cer tain entries are color-coded, e.g. based on the type

of appointments or status (  (Edit Settings)).

• Click on the entries in the header to determine whether to display a Day, Work
Week, full Week or Month in the calendar.

• The orange cursor in the time bar indicates the current time.

• If appointments have been entered that cannot be displayed in the visible area,
the following icon is displayed at the bottom edge of the visible area:
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• Appointments lasting all day or spanning several days are displayed in a bar at
the top of the calendar (below the date).

• Concurrent appointments cannot be displayed in the week view of the calendar.
Click on "..." to display these appointments in a new window.

• Only a limited number of appointments can be displayed per day in the monthly
view. Click on + x more to display all the appointments in a separate window.

• You can display or hide the sidebar:

Your upcoming activities, tasks and any absences are displayed in the left sidebar
by default. You can also select and define filter sets or rep groups.

• Holidays are color-coded.

Navigating in the Calendar
You can navigate in the calendar using the following options:

• Use the arrows to switch between pages in the calendar:
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• You can use the calendar in the sidebar to:

• Click on a day to switch the view to just that day.

• Click on a calendar week to display that work week.

• Click on the month or year and select an entry from the drop-down list update
the calendar accordingly (the view type remains unchanged).

• Use the arrows to move forward or back one month

• When in the day view, hold down Ctrl and click on days in the calendar to
display multiple days at once.

• Click on Today to display the current date in the day view.

• Click on  (Daily & Weekly Planning) to open the daily and weekly planner, >>
on page 74.

Daily and Weekly Planning
You create appointments using drag&drop in the daily and weekly planning area.
By default, the daily and weekly planning area displays the person search, results
list and calendar.

Click on  (Daily and Weekly Planning) in the calendar to switch to the Daily and
Weekly Planning area.

Resources
The resource view allows you to view the workload of reps. This makes planning
activities (especially internal meetings) much easier. Reps’ absences (holidays and
sick leave) are also displayed here.
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To open the resource view:

1. Select  (Collaboration) > Resources.

The current date and time is indicated by a ver tical line. Holidays are color-coded.

If a rep’s working hours have been defined, this time is color-coded.

You can customize the resource view, >> on page 75.

You can edit the displayed activities and absences and add new ones.

Customizing the Resource View
You can customize the resource view as follows:

• You can display or hide the sidebar by clicking on the arrow:

• To configure the time period that is displayed:

• Click on the desired day or star t of the time period in the small calendar in the
sidebar.

• Select the time period that is displayed using the slider in the header:
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Note: Note: When displaying quarters or longer time periods, only appointments
lasting a whole day or longer are displayed.

• Use the arrows in the header to switch between time periods.

• Select general or rep filters from the drop-down lists in the sidebars to determine
which reps/appointments are displayed. You can define your own filters.

• You can select additional criteria used to group reps from the Group reps by
drop-down list: Department (Org. Group ID field in the rep record), Country,
Skill or No grouping.

• Click in the Reps column in the header to sor t the reps displayed in the resource
view within their group.

• Click on  (Edit Settings):

• Select the Color Coding criteria used to color activities.

• Enable the Show working hours only option to restrict the display to the time
period defined as working hours by your administrator.

• Enable the Show group column option to display reps’ groups in a separate
column.

Note: Note: The time period, reps and grouping options are stored and applied
again the next time you open the resource view (including if you log off in the
meantime).

Timeline
The timeline allows you to display an overview of your contact with customers
chronologically, e.g. activities, offers etc.

The selected records are displayed along a time axis in so-called "bubbles". You
can configure the overview to display different types of records using different colors,
icons and text.

By default, the Timeline is available for both companies and persons, and the
Marketing Timeline if available for persons. Your administrator can however con-
figure additional timelines.

To display a timeline:

1. Switch to the desired company or person, >> on page 39.

2. Select Timeline or Marketing Timeline from the context menu.

The timeline is displayed.
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3. Click on  to select the time period that is displayed in the timeline: Month,
Quarter, Year or All.

4. You can navigate forwards and backwards in time as follows:

• Click on  (Previous) or  (Next) to switch to the previous or next time period.

• Click on the gray bar to change the time period:

• If you are displaying the entire time period (All) or the yearly view, the display
switches to the quarterly view.

• If you are displaying the quarterly of monthly view, the view switches to the
previous quarter or month.

• Drag the  icon in the scroll bar to the left or right.

• Click on the date at the far left or right of the scroll bar to move to the previous
or next time period.

• Use your mouse wheel to zoom in or out.

5. Click on a bubble to display the details of the record beneath the timeline.

Note: Note: Your administrator can determine that bubbles containing only a
single record are color-coded. Example: All bubbles containing data from
marketing-related info areas are displayed with a blue border.
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If a bubble contains multiple records, a list of all records in the bubble is displayed
on the left beneath the timeline. The currently selected record’s details are dis-
played on the right.

6. Click on a bubble containing one or multiple records to display all the records in
the bubble on the timeline.

Adding Insights
You can add notes concerning any insights gleaned from the timeline.

To add an insight:

1. Open the timeline.

2. Click on  (Add Insight) and enter the text.

3. Save.
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Queries
You can define, load and execute complex queries in Aurea CRM web and define
queries for other users. Queries can be applied to data across multiple info areas.
Your administrator can determine that fields in other info areas are displayed as
links. Click on a link to switch to the default view of the associated record.

CRM does not perform linking on the database server for 1-N links. The workaround,
in this case, is to modify the query statement. For more details, see 1-N links handled
on data access layer

Rights
Global and private queries are available. Your administrator defines which ones you
are allowed to execute.

Query Structure
A query can consist of the following elements:

• A main info area

• Conditions applied to the main info area's fields (e.g. Country = Austria and Lead
Status = Customer)

• Several related info areas, each of which is linked to the main info area or other
related tables

• Various options for linking info areas (e.g. show companies with / without persons)

• Conditions applied to the fields in these info areas

Aurea Query Language (AQL)
The Aurea Query Language (AQL) allows you to define queries in the AQL Syntax
field and is similar in syntax to SQL (which is commonly used to define database
queries). AQL uses a specific syntax which is described in detail in the Aurea CRM
web Administrator Guide, >> AQL (Aurea Query Language) in the Aurea CRM web
Administrator Guide.

The input field for AQL statements is located at the top of the query window:
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The lower area allows you to define conditions using the Aurea CRM web GUI. When
defining conditions using the UI, The corresponding AQL statement is displayed in
the AQL Syntax area. This helps you familiarize yourself with AQL.

Defining a New Query
You can define queries in two ways:

• Using AQL (Aurea Query Langauge), entered in the AQL Syntax field. For more
information on the AQL syntax, refer to the Aurea CRM web Administrator Guide.

• Using Aurea CRM web's GUI, which allows you to select the desired filter criteria.
This is the method described in this manual.

To define a new query:

1. Click on  (Queries & Analyses) and select New Query from the menu.

The New: Query page is displayed.

1. Enter a name for the query in the Query name field. Define the query as either
a Private query or a Public query. Private queries can only be accessed by the
rep that created the query.
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Note: Note: You can however provide other users with private queries, >>  on
page 95.

2. Enable the Include Affiliations option (if available) to return records added for
affiliates in the results. For more information, >> Affiliation View in your
product-specific manual that can be downloaded from https://support.aurea.com.

3. Click on  (Add Info Area) to open the Select Info Area dialog box.

Note: Note: All info areas that you can access are listed. Your administrator is
responsible for determining which info areas you can access.

4. Select an info area. The Select Fields dialog box is opened.

5. Select the fields from this info area that you want to display.

• Available Fields: This box lists all fields in this info you can access. Your
administrator is responsible for defining access to fields. You can also enter a
portion of the desired name in the Field name field. The field number and type
is displayed in parentheses following the field name, >>  on page 30.

• Use the By No. and Alph. button to sor t the field names alphabetically or by
field number. Select the desired fields by clicking on them and click on the 
button to transfer the field to the list of Output Fields.

• Output Fields: This area lists the fields that are displayed in the list of results.
Each field is displayed in a separate column.
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Select the desired fields in the list of output fields and click on the  button to

remove the fields from the list of output fields. The  button removes all of the
fields from the Output Fields list. Use the  and  buttons, to change the order
of the fields.

• Sort Fields: Select a field in the list of Output Fields and click on  to add
the field to the Sort Fields list. These fields are used to automatically sor t the
results. Double-click on a field to change the sor t order (ascending or
descending).

Click  to remove the selected field. Click  to remove all the sor t fields from
the list. Use the  and  buttons, to change the sor t order of the fields.

Note: Note: You can select multiple fields by pressing the Ctrl key, >>  on page
61.

6. Click the Add to Query button to add your selection to the query.

7. Define the conditions in the query, >>  on page 84.

8. Save the query.

Note:  Enabling Use for Mail Merge field allows the query to be available in Office
Add-in, to be used for Mail Merge.

Editing Queries
If you edit an existing query (e.g. add info areas, fields or conditions), an asterisk
(*) is displayed following the name of the query in the header. The asterisk continues
to be displayed until you save the changes.

If you save an edited query under the same name, the query is overwritten immedi-
ately. If you change the name of the query and another query with the same name
exists, you are asked whether you wish to overwrite the existing query.

Loading Queries
To load an existing query:

1. Select  (Queries & Analyses) > Queries.

The Queries page opens. The State column indicates whether the query is private
or public.

1. Enter search criteria to restrict the queries displayed.

2. Use the context menu or double-click on a query to open it.
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The query is loaded.

1. Edit the query by adding or removing info areas and conditions.

2. Define the maximum number of rows displayed by the query.

3. Click Run Query to run the query.

The results are listed at the bottom of the page. The number of results displayed
per page depends on your settings, >>  on page 34. The default value is 50 hits
per page. If more results are returned than are displayed per page, use the navi-
gation arrows to switch between pages.

4. Click on Save as Query Snapshot to save the results list. Define the maximum
number of rows to be saved and whether the result should be saved as public or
private.

5. Click  (Export (MS Excel)) to export your query to an Excel file, >>  on page
64.

Executing Queries
You can execute queries in two ways: immediately or in the background. When ex-
ecuting a query immediately, you need to wait until the query has executed before
you can continue working. You should therefore only execute a query if you are sure
that you have defined a query that returns the desired results or is quick to execute.

Note: Note: As queries can be complex, executing them can impact on the system's
performance. Your administrator can therefore defined that queries are always
executed in the background at a specific time (e.g. at night), >>  on page 96.

To execute a query:

1. Load the desired query, >>  on page 80.

2. You can execute the query in two ways:

• Click  (Run Query). The query is executed immediately and you can only
continue working once it has finished executing.

• Click on  (Run Query in Background). You can continue working with the
application and the query is scheduled for execution in the background. You
receive a message when the query has executed.

If the query is executed immediately, the results are listed at the bottom of the
page. The number of results displayed per page depends on your settings, >> 
on page 34. The default value is 50 hits per page. If more results are returned
than are displayed per page, use the navigation arrows ( ) to
switch between pages.
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Note: Note: Your administrator can also determine that the results of the query
are not displayed on the screen but are directly exported to a Microsoft Excel file
or report.

Deleting Queries
You can delete queries in two ways:

• Select Delete from the context menu in the results list

• Click on  (Delete) in tab view when viewing the query.

To prevent the deleted query from being displayed, you need to reopen the view or
invalidate your cache.

Adding Info Areas
You can define queries that are applied to multiple related info areas.

Note: Note: You can add a maximum of 65 info areas to a query.

Aurea CRM has a range of predefined links between info areas:

• A company can be linked to any number of persons

• Each activity is linked to a company or person, and any number of activities can
be linked to the same company/person

• Each company and person can be linked with any number of activities

Note: Note: A company is also linked to all activities, sales groups etc. to which
persons in the company are linked.

Once you have defined the parent info area, you can add fur ther child info areas to
a condition.

To add a child info area:

1. Load a query, >>  on page 80.

2. Select Add Info Area from the context menu of the parent info area.

A window is displayed listing all info areas linked to the parent info area.

The Quick Links contains a list of the most frequently used info areas. Click on
an info area in this list to add it without needing to search.

Note: Note: Only those info areas you have access to are listed. Your
administrator is responsible for defining which info areas you can access.
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3. Select the info area from the list.

The Relationship Type dialog box opens.

4. Select the desired relationship type. The following relation types are available
for activities and persons:

• Activity PLUS Person returns the activity, even if no person is linked to the
activity

• Activity WITH Person returns the activity, if at least one person is linked to
the activity

• Activity HAVING Person returns the activity if at least one person is linked to
the activity. You can define extended conditions. This option needs to be
configured by your administrator.

• Activity WITHOUT Person returns the activity, only if no person is linked to
the activity
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• Activity PLUS SUMMED Person returns the activity, even if no summed
person(s) is/are linked to the activity

• Activity WITH SUMMED Person returns the activity, if at least one summed
person is linked to the activity

Similar options are available in other info areas, although some info areas may
provide fewer options.

The SUMMED option returns the sum total rather than individual records. In the
case of activities and persons, the number of person records added for the activ-
ity is returned.

Note: Note: Sort fields are only available for the relation types PLUS and WITH.
Sort fields cannot be defined for WITHOUT, PLUS SUMMED or WITH SUMMED.
Furthermore, no fields are available for WITHOUT.Only numeric fields can return
summed values when using the SUMMED options. Other fields cannot be totaled
and therefore cannot be selected from the Available Fields list.If you select the
relation type WITH but do not select any fields, the child info area is only used
to check the criteria. For example, if you select all companies with persons but
do not select any fields, a list of all companies to which persons are assigned is
shown, but not the information about the persons.

5. Enable the Optional check box to determine that the related info area is optional
when using several child info areas. In this case, only conditions for info areas
not marked as Optional need to be met, as well as for at least one Optional info
area.

This check box is available for the relation types WITH, WITHOUT, HAVING and
WITH SUMMED.

6. You can restrict the number of records that are output. Enter the number of lines
available to the child info area in the results list in the Max. X Records of [A]
per [B]. This function is not available for the SUMMED options.

7. Click Continue.

The Select Fields dialog box opens.

1. Define the output and sor t fields, >>  on page 48.

2. Click Add to Query.

You are returned to the query overview.

3. Define your conditions, >>  on page 84.

4. From here, you can execute the query using the Run button, >> on page 81.
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Selecting Links between Info Areas
Several relationships can exist between two info areas. For example, there are
multiple links between the Ticket and Person info areas: a person can be linked to
a ticket as a person, contact person, end customer or billing recipient.

If you wish to add a fur ther info area to a query, and more than one relationship
exists between the two info areas, your administrator is responsible for determining
which descriptions are displayed for the individual links.

Example:

A query is defined for the Ticket info area. The Person info area is added to the
query. Four links are available for selection between the Ticket and Person info
area.

The area surrounded by the frame in the screenshot above lists the relationships
between the Ticket and Person info areas.
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The link type is displayed in the query as follows:

Conditions
You can define conditions for the fields in a selected info area. For example,
"Country = Australia, City = Sidney OR Perth", or "Date > 1 January 2013 and Date
< 7 November 2013".

Alternatively, you add determine that the comparison need be specified by the user
when executing the query. This allows you to define queries where users only need
to specify the comparison values, >>  on page 94.

Note: Note: Conditions can be applied to fields that you cannot access based on
your access rights. These conditions are still taken into account by the query,
however the contents of the field cannot be displayed in the results list.

Defining Conditions
To add a new condition to a query:

1. Load a query, >>  on page 80.

2. Click on  to the left of Conditions and select Add Condition from the menu.

The followingwindow opens:

1. Click on a column heading to sor t the list.

2. Select a field and click on Next.

You can also enter par t of the name of the field in the Field name field:

• Enter one or two letters to list all the fields that begin with those letters.

• Enter more than two letters to list all fields that contain the sub-string in their
name.

3. Define your condition. Depending on the Field Type, you can define the following
conditions:

• Text field; >>  on page 89.

• Date field; >>  on page 88 and on page 90.

• Catalog field; >>  on page 85 and on page 87.

• Numeric field; >>  on page 89

• Logical (Boolean) field; >>  on page 88.
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• Time field; >>  on page 89.

• Rep field; >>  on page 89 and on page 90.

4. Click on OK.

This condition displayed in the overview.

Conditions for Catalogs

To define a condition for a catalog:

1. Select a catalog field.

A dialog box is opened, allowing you to define the condition for the field.

1. Choose the appropriate operator, e.g. = (equal) to determine that the condition
should return records where the value of the catalog field matches the comparison
value.

2. Select Fixed to compare the contents of the field with a fixed value from the list
of entries. Select Field to compare the contents of a field, >>  on page 91. The
Text option is also available for variable catalogs, >> on page 86.

3. Double-click on an entry under Available fields to use it as a comparison value.

The entry is moved to the right under Selected Fields.

4. Double-click on an item in the right area to remove it.

5. Click on OK to return to the query.

Conditions for Variable Catalogs

When applying conditions to variable conditions, you can also use wildcards in
comparison values. This allows you to apply conditions to substrings. To do so:

1. Select a variable catalog field.

The dialog used to define the condition is displayed.

1. Click on Text.

2. An input field is displayed. Enter the comparison value here. You can use the *
(any number of characters) and ? (single character) wildcards.

Note:  Note: You can use literal character values of ‘*‘ and ‘?’ using the escape
sequences ‘\*’ and ‘\?’.

All catalog values that match your comparison value are returned by the query.

Conditions for Child Catalogs

When defining a condition applied to a child catalog (e.g. the Interest field in the
Interest info area), you need to specify the parent catalog value (e.g. Interest
Group) before you can define the condition for the child catalog.
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The following example uses the Interest field in the Interest info area:

Conditions applied to child catalogs are otherwise defined the same as for all other
catalogs, >> on page 85.

Conditions for Boolean Fields

To define a condition for a Boolean field:

1. Select a Boolean field.

2. Specify the type of comparison (equal, not equal).

3. Select Fixed to compare the contents of the field with a fixed value from the list
of entries. Select Field to compare the contents of a field, >>  on page 91.
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4. Select either Yes, (true) No (false) or Use as parameter as the comparison value,
>>  on page 94.

5. Click on OK to return to the query overview.

Conditions for Date Fields

To define a condition applied to a date field:

1. Select a date field.

2. Select the type of comparison (equal, not equal etc.).

3. Date fields allow you to use fixed and variable comparison values. Use the Fixed
option to compare the value with a specific date or to a value entered by the user
(if the Use as Parameter option is enabled). Use the Variable option to enter a
date relative to the date the query is executed on. Select Field to compare the
value with the contents of another field, >>  on page 90, on page 91 and on page
94.

4. Click on OK to return to the query overview.

Conditions for Numeric, Alphanumeric and Time Fields

To define a condition applied to a numeric, text or time field:

1. Select either a numeric, text or time field.
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2. Define the type of comparison (equal, greater etc.).

3. Determine what to compare the contents of the field with. Choose between Fixed,
Variable, Field (compare with the contents of another field), >>  on page 90 and
on page 91. If you select Fixed, you can enable Use as parameter (requires
user input) to allow users to enter the comparison value when executing the
query, >> on page 94.

4. Enter the comparison value in the Value field.

5. Enable the Use as Parameter option if you want the comparison value to be
entered by the user upon star ting the query, >>  on page 94.

Wildcards (*, ?) may also be used for text fields.

Note:  Note: You can use literal character values of ‘*‘ and ‘?’ using the escape
sequences ‘\*’ and ‘\?’.

6. Click on OK to return to the query overview.

Conditions for Rep Fields

To apply a condition to a rep field:

1. Select a rep field.
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2. Specify the type of comparison (equal, not equal).

3. You can define both Fixed and Variable conditions for reps. Use the Field option
to compare the rep to an entry in another rep field, >>  on page 91. Enable the
Use as Parameter option if you want a comparison value to be entered by the
user upon star ting the query, >>  on page 94.

If you have selected Fixed, you need to select the rep used in the condition.

Note: Note: You can select several reps as comparison values. The reps are
linked with a logical OR.

Select the rep(s), >> on page 67.

The selected reps are listed in the rep field. Reps are separated using a semicolon.

Variable Conditions

If the same query is used by various reps or is carried out regularly, you can define
variable conditions that are applied to rep and date fields (e.g. the current rep or
current date).

Variable Reps

To define a variable condition applied to rep field:

1. Select a rep field and enable the Variable option.
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2. Select an option from the drop-down list.

The appropriate user is used by the query as a comparison value when it is exe-
cuted.

Variable Date Fields

Variable dates are dates relative to the date on which the query is executed, e.g.
40 days from today.

To define a variable condition for a date field:

1. Select a date field and enable the Variable option.

2. Select the reference date from the drop-down list.

3. Determine time period added (Plus) or subtracted (Minus) from the reference
date.
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Variable Time Fields

The time at which the query is executed can be used to define the comparison value
for time fields.

To define a variable condition for a time field:

1. Select a time field and choose the desired comparison type.

2. Select the desired time format from the drop-down list.

Comparing Field Contents

When defining conditions, you can choose to compare the value stored in fields in
a record.

You can compare the following fields:

• Fields of the same type, e.g. two numeric fields

• Catalog fields that access the same catalog

To define a condition that compares the contents of two fields:

1. Define a condition.

2. Select the Field option.

3. Click on  (Select). All fields of the same type in the info area are listed.

4. Select the desired field for the comparison.
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Conditions in the Overview
Once you have defined the conditions for an info area, they are displayed in the
query overview.

Click on  to edit the info area and conditions using the appropriate context menu
entries, or click on the linked field name.

Linking Conditions
You can change the operator (AND or OR) used to link conditions. Two options are
available:

• Select Change to AND or Change to OR from the context menu next to the
operator.

• Select the condition whose link operator you want to change and click on  (Group
AND) or  (Group OR). Only the currently inactive option is available for selection.

Grouping criteria corresponds to placing them within brackets in a logical expression:
For example, if you have defined the condition "A OR B OR C", and link the B and
C sub-criteria with a logical AND, this results in the expression "A OR (B OR C).

You can also define conditions hierarchically and thus link multiple conditions. In
the following example, the individual tiers of the hierarchy are indented:
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Each condition is evaluated separately and then combined when the other linked
conditions using the appropriate operator (AND/OR).

Examples of Linked Conditions

The following examples use queries applied to the Activity info area.

Comparing the contents of one or more fields with a value

Field1 = Value1 AND/OR Field2 = Value2 AND/OR Field3 = Value3 etc.

Example: To display your own and Mona Market’s completed visits, define the fol-
lowing condition:

Type = "Visit" AND Status = "Completed" AND (Rep = "Current Rep" OR Rep =
"Mona Market").

Note: Note: The conditions in parentheses (Rep = "Current Rep" OR "Rep = "Mona
Market) need to be linked with each other using a logical OR. This ensures that
activities are returned where either the current rep or Mona Market are entered in
the Rep field.
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Comparing the value in a catalog field to one or more values

CatField1 = Value1a OR Value1b OR Value1c

Example: You want to list all scheduled activities of the types "Visit", "Letter" and
"E-mail". Define the following condition:

Type = "Visit" OR "Letter" OR "E-mail"

AND Status = 'Scheduled'

Comparing the contents of a field (not a catalog field) to more than one value

Field1 = Value1 AND Field2 < Value2 AND Field2 > Value2a AND Field3 = Value3
etc.

Example: You want to list all visits in the week from the 10th to 14th of November
2014. Define the following condition:

Type = "Visit" AND Star ts on >= "10.11.2014" AND Star ts on <= "14.11.2014"

Advanced Conditions
Advanced conditions are only available for info areas that are linked with either the
"HAVING" or "WITHOUT" relationships. You can use advanced conditions to use
sum totals to restrict your query results. For example, you can list all companies
with more than 10 employees exist using advanced conditions.
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Defining Advanced Conditions

To define an advanced condition:

1. Link two info areas in a query using either HAVING or WITHOUT, >> on page 78
and on page 81.

In this example, the Person info area is linked to the Activity info area using a
HAVING relationship.

1. Select Add Advanced Condition from the context menu.

The Select Field(s) in Info Area: [Info Area] dialog is displayed. Only those
fields that are available in advanced conditions are displayed.

2. Select a field and click on Next.

The Value(s) of Sum [Field] in the [Info Area] Info Area dialog is displayed.

1. Click on OK.

The query overview is displayed.

Parameters and Predefined Queries
Most users needs to define complex queries. The use of a pre-defined query where
the comparison values can be specified should generally suffice. These queries are
defined using parameters. When the query is executed, you then only need to enter
comparison values for the parameters.

To allow users to enter parameters when executing a query, select Use as param-
eter (requires user input) as the comparison value when defining the query, >>
on page 84.

To define the values to be used by parameters in a query:

1. Open a query, >>  on page 80.
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2. The conditions defined using parameters are listed under Parameters. Enter the
desired comparison values for the parameters, or select the value from the
drop-down list. One field is available for each condition defined using a parameter.

3. Click on Run Query to execute the query using the values you have specified.

Tips:

• If a catalog is defined as a parameter, only one catalog value can be selected. If
you want to be able to select several catalog values, you need to define separate
parameters. Any parameters not required must be deleted before executing the
query.

• If a child catalog is defined as a parameter, your administrator needs to ensure
that the parent catalog is either predefined or available for selection too. Otherwise
you cannot define a parent catalog for the query.

Sending a Query Definition to another Rep
If you have defined private queries, you can make these queries available to other
reps. The query is copied to the rep's configuration in the process.

To make a query available to another rep:

1. Load a query (>>  on page 80) or select a query in the list of queries.

2. Click  (Send to Reps).

A dialog box is displayed.

3. Click on  (Select Rep) to select the desired reps or groups in the Recipient(s)
field, >>  on page 28.

Note: Note: If you select a group, the query is sent to all members of the group.

4. The selected query's name is displayed in the Query name field. You can rename
the query.
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5. Enable Notify Rep(s) to determine that the recipients should receive a message
informing that they have received the query.

6. Enable the Overwrite existing query definition option to overwrite any queries
with the same name owned by the recipients.

7. Click Send Query.

A private query is generated for the recipient with the name you specified.

Saving, Loading and Exporting Query Results
Depending on your configuration, you can save query results and load them at a
later date.

• Click on  (Save as Query Snapshot) to save the results list as a query snapshot.

• Select Queries & Analyses > Query Snapshots from the menu to list the available
snapshots.

• Click  (Export (MS Excel)) to export the results of the query.

Background Queries
Queries may take some time to execute, depending on the volume of data that needs
to be searched. In order to be able to continue working with Aurea CRM web while
the query executes, you can execute queries in the background. Note that executing
complex queries may impact negatively on the performance of the server.

Your administrator can determine that queries are always executed in the background
at a specific time (e.g. at night). The results are then available the next day.

A To-Do record is created for each background query with the type set to "Calcula-
tion". The server is either executed by the server immediately or at a point in time
set by your administrator using the rep's access rights. The rep is sent a message
once the query has finished executing.

To display To-Dos for background queries:

1. Select Queries & Analyses > Background Queries from the menu

The To-Dos stored for background queries are listed. Queries that have already
been executed are indicated by a tick ( ) in the Status column.

2. Click in the Link column to display the results of the query.
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1-N links handled on data access layer
CRM does not perform linking on the database server for 1-N links and instead it
treats each table in the query as a separate query then link the results in the data
access layer of the CRM.Core. The workaround in this case is to modify the query
statement as explained below:

UQL:

select (Company, Country, CountryCode, WR.BeginDate) from (FI)
plus (WR)
orderby (WR.BeginDate)

SQL

Note:  In case of SQL, two separate queries are used and their results are combined
together in the CRM.Core:

SELECT TOP 101 Firma,Land,FTZ,Ftz1,Ftz2,ID FROM CRM_FI WHERE LosKZ=0

SELECT TOP 101 Vertragsbeginn,ID,ID_FI,ID_PE FROM CRM_WR WHERE
ID_FI=8589934592001 AND LosKZ=0 ORDER BY Vertragsbeginn

This method has some limitation and performance impact. One limitation is that the
sorting process is not applied to the final result, which leads to unexpected outcome
in some cases.

The workaround, in this case, is to modify the UQL query statement to be N-1. For
example, in the above UQL, do the following changes:

select (Company, Country, CountryCode, WR.BeginDate) from (WR)
plus (FI)
orderby (WR.BeginDate)

Quick Query (Enterprise CRM)
Quick Query is an enterprise querying tool that provides easy access to Aurea CRM
data and information without requiring a deep technical knowledge of the querying
tools. Quick Queries is designed to improve your productivity whether you are a
sales, marketing, management, or a service personnel.
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Quick Queries are designed to:

• Simplify query composition

• Help you easily complete all relevant steps required to create effective queries,
by providing guided process flows.

• Provide the convenience of easy access to key information, required to perform
day to day activities, and render decisions.

A few of the many possible user tasks that could benefit from the use of Quick
Queries are described below:

• As a marketing specialist responsible for planning and conducting campaigns,
you could query for select target groups, for a complete campaign execution.

• As a sales personnel, you could query for potential candidates satisfying several
different criteria, to make a sales call.

• As a manager, you want to create queries and analysis to supervise the
performance of your sales representatives.

Understanding Quick Queries
Aurea CRM allows customers with enterprise versions to allow their users to create
Quick Queries. Users can then share their queries with others or save them as private
queries. Searching for a quick query is similar to searching for the standard queries
as explained in the previous chapter Queries.

A Quick Query definition process generally consists of the following stages:

1. Composing a query

2. Enhancing the query

3. Query Execution

4. Finalizing the Query

Each of these stages can be accessed without any pre-conditions. You can move
between the stages as you work on defining your query. For example, it is not nec-
essary to enhance a query that you composed. You can execute the query, and fi-
nalize it. Later you can open the query, enhance it, and save it again. Quick Queries
can also be enhanced with standard queries to improve their capabilities.

The following screenshot shows the New Quick Query window, displaying the
Compose tab of a quick query definition.
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Note:  Note: The Compose tab allows you to implement the Compose and Enhance
stages of a quick query definition.

During the composition stage, a Quick Query star ts with some preconditions and
allows some functions as listed below:

• A quick query can be composed with the base info areas of Company (FI), Person
(PE), and Contact Person (CP). Hence a Quick Query always returns a list of
customers. It is mandatory to select one of the info areas.

• You are allowed the relationship type of “With” or “Without” when selecting a
related or linked info area.

• Allows enhancement of the standard query with addition or subtraction of other
queries (Quick Queries as well as standard queries.

• Allows you to execute the query immediately to test the query.

In the Enhance stage, you can enhance your composed query with additional
statements already composed. The preconditions and allowed functions at this stage
are listed below:

• All queries that refer to the root info areas Company (FI), Person (PE), and Contact
Person (CP) are available for enhancement.

• Queries defined by you and public queries are made available.

• You can delete expendable conditions.

• You can execute the enhanced query to test the results.

The query execution stage allows you to run the query composed and/or enhanced
so far.
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The Finalize stage allows you to save the query and define the rights restrictions
on the query. You can make it a public query and make it available to other users.
As a private query it is available only to you.

Creating a Quick Query
To create a quick query, perform the following steps:

1. From the Queries and Analysis menu select Queries. The Queries window
displays.

Note:  Note: The list of queries displayed contains both Quick Queries and
standard queries. The Quick Queries in the Queries list are tagged with the
icon.

2. Click New Quick Query to open the window at the Compose tab.

3. Select the Root Info Area of the query you want to create from the drop down
list. You have the following choices: Company; Person, Contact Person. The
Relationship Type column is activated.
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4. Select the Relationship Type from the drop down list for the linked info area.

The Where Field activates and is populated with applicable fields for the linked
info area. In the screenshot example, the root info area is company, and the rela-
tionship type With for the Linked Info Area Opportunities.

Note:  Note: It is not necessary to add a Relationship Type to another info area.
You can directly create conditions on the root info area. In such case, you can
directly select a Where Field and ignore the Relationship Field and Linked Info
Area fields.
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5. After that select the Linked Info area from the drop down list. The following
screenshot shows the Company info area, and the relationship type With for the
Linked Info Area Opportunities. The Where Field drop down list is populated
with fields from the linked info area.

Note:  Note: The Where Field column gets activated and shows the fields from
the linked info area, in this case the Company fields.

6. Scroll down and select the required info area field from the Where Field drop
down list.

The Logical Operator field column activates. In this example screenshot, Comple-
tion Date is selected.

7. Select the applicable Logical Operator from the drop down list. You have the
following options: Equals (=); Not equals; Is empty; Is not empty; Is true; Is not
true; Is smaller than; Is greater than; Is between; Is current date.

Note:  Note: The options populated in the Logical Operator depends on the data
type of the Where Field. For example, a Boolean field type gets the operators:
Is true; Is not true.
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The Condition Fields column activates and the drop down list is populated with
the available values. In this case it displays the available country names. In this
example screenshot, the Logical Operator Is between is selected and in the
Condition Fields the star t and end dates between which the completion dates
for opportunities are set is selected.

8. To Add Another Condition, select one of the following from the drop down list:

• Add records that meet the following conditions

• Add records from the following query

• Subtract records that meet the following conditions

• Subtract records from the following query
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9. Click Run Query to test the results.

10.Depending on your choice, perform the following sub-steps.

Note:  Note: At this point you move into the enhance stage of a query definition,
adding or subtracting records from another query. You can add the standard
queries or quick queries to enhance your base query you are composing. You
can also continue with composition by adding or subtracting records with more
conditions.

a. For the options to Add records that meet the following conditions or Subtract
records that meet the following conditions, repeat the instructions in steps
3 to 7 above. The example screenshot shows the Add records that meet the
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following conditions. Companies with Opportunities and Where the Project
Manager is a specific person.

Note:  Note: The above screenshot shows the Finalize tab with a green dot.
This demonstrates that you can move between different stages of a Quick Query
independently. In this case, the Quick Query was finalized after adding the
above records. Now we can move to the Enhance stage of a Quick Query
definition, and use the remaining two options of adding or subtracting records
from other queries.

b. Click Run Query to evaluate the results of your quick query.
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Note:  Note: In this run additional records are added to the run on the base
query run in step 9 above.

c. To Add a record from the following query or Subtract a record from the
following query perform the following:

Select Subtract records from the following query.

Click Run Query to view the results of the new enhancement.

To Add a record from the following query type the name of the query in the search
box.

1. To finalize a Quick Query, click the Finalize tab.

Note:  Note: You can finalize a quick query at any stage of the query definition.

a. Check Private Key to save the Quick query for your personal use or check
Public Query to share the Quick Query with others.

b. Enter a name for the Quick Query in the Save as… text field.

c. Click Save to finalize the Quick Query.
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Note:  Note: Click Back to Query List to show a list of queries with the finalized
quick query highlighted.

Change Notifications Service (Enterprise CRM)
Aurea CRM change notification service notifies you about changes to records and
events of interest to you. You can track the changes on your dashboard, as well as
use other notification types like Email, Popup, and Record. You can add items of
interest to your personal Watchlist.

To enable change notifications service on an infoarea, request your CRM system
administrator to add the watchlist menu to the infoarea’s context menu.

Note:  Note: Change Notification Service is an enterprise feature.

Overview of Watchlists and Notifications
Aurea CRM users can set up their personal Watchlist of items to be notified about
changes. For example, an accounts manager might be interested in knowing when
a change occurs with his key accounts and he can add the accounts to his watchlist
and set the notification types.

The following screenshot shows the list of watchlist items subscribed by all users:
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For a given record or infoarea the Watchlist context menu initially allows you to add
a Watchlist item. For example, the screenshot below shows the Add Item to
Watchlist and View all Watchers sub-menu items for the Company infoarea.
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After adding an item to the Watchlist the Watchlist context menu allows you to per-
form the following tasks:

• Delete items from the watchlist.

• View all watchers.

• Deactivate watchlist items.

• View change notifications.

• Edit watchlist item.

• See the screenshot below:

•

A notification is generated when one of the following condition is fulfilled:

• A notification request is set for any change to the record of interest and a change
is made to the record.

• A notification request is set for changes made to specific fields of a record and
one or more of the specified fields are changed.

• The following screenshot shows the change notifications visible on the Dashboard:
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•

• The following screenshot shows a popup change notification:

•

• The remaining sections describe the various tasks required to create and work
with Watchlist items.

Adding items to the Watchlist
To add items to a watch list perform the following steps:

1. Open the infoarea and search for the record that you are interested in adding to
the watchlist.

The record window displays. For example, the following screenshot shows the
Lamplanet Company record infoarea.
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2. From the context menu items, select Menu > Watchlist > Add Items to Watchlist.

The Add Item to Watchlist window displays.
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Note:  Note: You have to select at least one Notification Type and also specify
a Notify On event to successfully add a watchlist item.

3. Specify the notification types and notification even as described below:

• Click on the checkbox to select one or more Notification Types from the
following list:

• Dashboard Notification—Change notifications is displayed on the dashboard.
Two widgets for recent changes and today’s changes are displayed. They
also display the number of change notifications.

• Popup Notification—Change notification pops ups when you login, displaying
the change details.

• Email Notification—Change notification is sent by email.

• Record Only—Change notification is persisted in the database, but no popup,
email, or dashboard notifications are displayed. You can view the change
notifications from the watchlist context menu of the watched record.

4. Specify the Notify on event from the following:

• Every change—you are notified when any of the record’s field is modified.

• Change on Specific Fields—you are notified when the fields of interest in a
record are changed.

To specify the field of interest perform the following steps:

Select Change on Specific Fields from the Notify On dropdown list.

Select the fields of interest that you want to be notified, on change. You can enter
the field name in the search box to quickly find the fields of interest. You can select
multiple fields.

1. Click Save.

2. The record is successfully added to the watchlist. Notice that now the Watchlist
menu provides you with fur ther submenu items.
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Editing Watchlist Item
You can edit an existing watchlist item on a record and change the notification types
and event details that generate the notifications.

To edit a watchlist item, perform the following steps:

1. Open the record to which you have added the watchlist item.

2. Select Menu > Watchlist > Edit Watchlist Item.

The Edit Watchlist Item window displays.

3. Select or unselect the Notification Types.
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Note:  Note: Ensure that at least one Notification Type and Notify On even is
specified.

4. Modify the Notify On event as described below:

• Every change—you are notified when any of the record’s field is modified.

• Change on Specific Fields—you are notified when the fields of interest in a
record are changed.

To specify the field of interest perform the following steps:

Select Change on Specific Fields from the Notify On dropdown list.

Select the fields of interest that you want to be notified, on change. You can enter
the field name in the search box to quickly find the fields of interest. You can select
multiple fields.

1. Click Save.

The changes are saved to the watchlist item.

Deleting an Item from the Watchlist
You can delete a watchlist item added to a record, if you no longer wish to watch
the changes to the record.

To delete an item from a watchlist, perform the following steps:

1. Open the record to which you have added the watchlist item.

2. Select Menu > Watchlist > Delete Item from Watchlist.

A confirmation window displays.

3. Click OK.

The item is removed from the watch list.

View all Watchers of a Watchlist item
To view all watchers subscribed to a watchlist item:

1. Open the record to which containing the watchlist item.

2. Select Menu > Watchlist > View all Watchers.
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The View Watchers window displays the list of subscribers to the watchlist item.

Activate/Deactivate watchlist subscription item
To stop a watchlist item from generating change notifications, you can deactivate
the watchlist item. Similarly, you can activate the watchlist item when you want to
receive change notifications. You can activate or deactivate a watchlist item from
two locations. You can search for watchlist item from the Watchlist subscriptions
search page and deactivate or activate it from there. On the other hand if you know
the record for which watchlist item was created, then you can deactivate it from the
record’s watchlist context menu.

Activate/Deactivate from watchlist subscription search page
To deactivate or activate watchlist item from the watchlist subscription search page,
perform the following steps:

1. Select Collaboration > Watchlist > Watchlist Subscriptions.

The Watchlist Subscription Search page displays.

2. Populate the required search filters and click Search.
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The search results displays.

Note that the Is Active column shows if a watchlist item is active or not. A check
mark indicates that the watchlist item is active. A blank check box shows that the
watchlist item is deactivated.

3. To deactivate an active watchlist item:

a. Click the Actions context menu.

The Actions menu displays.

b. Select Deactivate Watchlist Item.

The watchlist item is marked as inactive.

4. To activate a watchlist item:

a. Click the Actions context menu.

The Actions menu displays.

b. Select Activate Watchlist item.

The watchlist item is marked as active.
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Activate/Deactivate from record’s context menu
To deactivate or activate watchlist item from the watchlist context menu of a record:

1. Search corresponding infoarea and open the required record.

2. To deactivate the watchlist item:

a. Select Menu > Watchlist > Deactivate Watchlist item.

A confirmation window displays.

b. Click OK.

The watchlist item is deactivated.

3. To activate the watchlist item:

a. Select Menu > Watchlist > Deactivate Watchlist item.

A confirmation window displays.

b. Click OK.

The watchlist item is activated.

Search watchlist subscriptions
To search the watchlist subscriptions, perform the following steps:

1. Select Collaboration > Watchlist > Watchlist Subscriptions.

The Watchlist Subscription Search page displays.

170AUREA CONFIDENTIAL

Chapter 1: General Functions



2. Select the search filters from the following list:

• Creator —Filter watchlist subscriptions created by the specified subscriber.

Only one person can be selected. If select the filter, the search is
restricted to watchlist items created by you.

• Watched Info Area—Filter watchlist subscriptions on records from the selected
infoarea. The Selected Fields filter is activated and populated with selected
fields to be watched when the watch list was created.

• Selected Fields—Specify the selected fields to be watched when the watch
list was created.

Note:  Note: The fields populated in this filter depends on the infoarea selected
in the Watched Info Area filter. In the example, in the screenshot in step 1,
the Watched Info Area is person in company, and the corresponding fields
for the infoarea is displayed.

• Date of Change from—Select the star t date from which you want to view the
subscriptions created.

• Date of Change to—Select the end date before which you want to view the
subscriptions created.

3. Select the notification type and read status filters of the watchlist subscriptions.
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Note:  Note: If multiple filters are selected, then search would select a notification
type if it satisfies any one of the criteria.

These filters can toggle between the following three states, indicated by the
changing icon. You can click on a filter to toggle between the states. The states
and their effect on the filter is described below:

• —In this state, the filter is ignored and not included in the search.

• (Blank checkbox)—In this state, the filter is added as false. This means the
notification is selected if the filter item value is false. For example, for the Is
Read filter, this would mean that a notification is selected if it is marked as not
read.

• (selected checkbox)—In this state, the filter is added as true. This means the
notification is selected if the filter item value is true. For example, for the Is
Read filter, this would mean that a notification is selected if it is marked as
read.

To select an item perform the following:

a. To activate a filter item, click .

The icon changes to a checkbox( ).

b. To set the value of the filter as true, click the checkbox ( ). Leave the checkbox
empty ( ) to set the filter as false. For example, for the Dashboard Notification
filter, setting it to true ( ) would mean a notification is included in the watchlist
item, if the dashboard notification type was configured in the watchlist item
generating the notification.

4. Click Search.

The search result is displayed in the bottom pane.

Searching Notifications
You can search the set of all notifications issued on all the subscribed records in
the CRM database.
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To search the history of all change notifications, perform the following steps:

1. Select the Collaboration > Watchlist > Change Notifications. Open the record to
which you have added the watchlist item.

2. Select Menu > Watchlist > Change Notifications.

The Change Notification page displays.
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3. To search for specific notifications you can select the filters from the following
list:

• Author—Filter notifications issued to the specified subscriber. Only one person
can be selected.

• Changed Infoarea—Filter notifications issued to all subscribed records of the
selected infoarea from the dropdown list.

• Date of Change from—Select the star t date from which you want to view
notifications issued.

• Date of Change to—Select the end date before which you want to view
notifications issued.

• Changed Fields—Filter the notifications issued for changed to specific fields.
You can select multiple fields from the listed fields.

Note:  Note: When you select multiple filters, the search would select
notifications that satisfy all the selected criteria.
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4. Select the notification type and read status filters from the list of items.

Note:  Note: If multiple filters are selected, then search would select a notification
if it satisfies any one of the criteria.

These filters can toggle between the following three states, indicated by the
changing icon. You can click on a filter to toggle between the states. The states
and their effect on the filter is described below:

• —In this state, the filter is ignored and not included in the search.

• (Blank checkbox)—In this state, the filter is added as false. This means the
notification is selected if the filter item value is false. For example, for the Is
Read filter, this would mean that a notification is selected if it is marked as not
read.

• (selected checkbox)—In this state, the filter is added as true. This means the
notification is selected if the filter item value is true. For example, for the Is
Read filter, this would mean that a notification is selected if it is marked as
read.

To select an item perform the following:

a. To activate a filter item, click .

The icon changes to a checkbox( ).

b. To set the value of the filter as true, click the checkbox ( ). Leave the checkbox
empty ( ) to set the filter as false. For example, for the Dashboard Notification
filter, setting it to true ( ) would mean a notification is included in the search
result, if the dashboard notification type was configured in the watchlist item
generating the notification.

5. Click Search.

The search result is displayed.

6. For each item in the search list, you can perform the following tasks:

a. Marking the notification item as read.

To mark the item as read:

• Click the Action context menu, and select Mark as Read.
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A check mark appears in the Is Read column for the notification.

b. Viewing the change notification details.

To view the details of a change notification:

• Click the Action context menu, and select View Change Notification Details.

• The Change Notifications Details window displays.

Notice that the changed fields are displayed in the window and you can also
mark the notification as read from this window too.
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Viewing Change Notifications for a Record
You can view the history of change notifications issued for a specific record or
watchlist subscribed item. Similarly you can view the change notifications for all
watchlist item subscriptions. This topic describes how to view change notifications
issued to all subscribers of a watchlist item.

To view change notifications for a record, perform the following steps:

1. Open the record to which you have added the watchlist item.

2. Select Menu > Watchlist > View Change Notifications.

The search notification page displays.

Note:  Note: The Changed Infoarea field is locked to the record for which you are
searching for notifications. This field cannot be changed because this function
was called from the record’s watchlist menu.

3. To search for specific notifications you can select the filters from the following
list:

• Author—Filter the notifications issued to the specified subscriber. Only one
person can be selected.

• Changed Infoarea—Not editable. This is restricted to the record you selected.
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• Date of Change from—Select the star t date from which you want to view
notifications issued.

• Date of Change to—Select the end date before which you want to view
notifications issued.

• Changed Fields—Filter the notifications issued for changed to specific fields.
You can select multiple fields from the listed fields

Note:  Note: When you select multiple filters from the above list, the search
would select notifications that satisfy all the selected criteria.

4. Select the notification type and read status filters from the list of items.

Note:  Note: If multiple filters are selected, then search would select a notification
if it satisfies any one of the criteria.

These filters can toggle between the following three states, indicated by the
changing icon. You can click on a filter to toggle between the states. The states
and their effect on the filter is described below:

• —In this state, the filter is ignored and not included in the search.

• (Blank checkbox)—In this state, the filter is added as false. This means the
notification is selected if the filter item value is false. For example, for the Is
Read filter, this would mean that a notification is selected if it is marked as not
read.

• (selected checkbox)—In this state, the filter is added as true. This means the
notification is selected if the filter item value is true. For example, for the Is
Read filter, this would mean that a notification is selected if it is marked as
read.

To select an item perform the following:

a. To activate a filter item, click .

The icon changes to a checkbox( ).

b. To set the value of the filter as true, click the checkbox ( ). Leave the checkbox
empty ( ) to set the filter as false. For example, for the Dashboard Notification
filter, setting it to true ( ) would mean a notification is included in the search
result, if the dashboard notification type was configured in the watchlist item
generating the notification.
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5. Click Search.

The search result is displayed.

6. For each item in the search list, you can perform the following tasks:

a. Marking the notification item as read.

To mark the item as read:

• Click the Action context menu, and select Mark as Read.

A check mark appears in the Is Read column for the notification.

b. Viewing the change notification details.

To view the details of a change notification:

• Click the Action context menu, and select View Change Notification Details.

• The Change Notifications Details window displays.

179AUREA CONFIDENTIAL

Change Notifications Service (Enterprise CRM)



Notice that the changed fields are displayed in the window and you can also
mark the notification as read from this window too.

Marking Change Notification as Read
Once you have read a notification, you can mark it as read. You have to mark the
notification as read only once from any of the notification channels: dashboard,
popup, or record only.

To mark a change notification from the dashboard, double the notification and the
Change Notification Details window displays. In this window click Mark as Read
to mark the notification.
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You can also mark a change notification from the change notification search page.
To do this:

1. Select Collaboration > Watchlist > Change Notifications.

The Change notification search page displays.

2. Enter the required search filters and click Search.

The search results displays.
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3. For the required change notification, you can mark it as read in one of the following
ways:

a. Marking the notification item as read.

To mark the item as read:

• Click the Action context menu, and select Mark as Read.

A check mark appears in the Is Read column for the notification.
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b. Marking the item as read from the change notification details window.

• Click the Action context menu, and select View Change Notification Details.

• The Change Notifications Details window displays.

• Click Mark as Read.

For email notifications, opening the email automatically marks it as read. Unlike
conventional emails, marking an email notification in the mail client as unread, does
not change the status of the notification to unread in the Aurea CRM server. The
following screenshot shows a sample email change notification for a company record.
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Change Notifications on the Dashboard
The dashboard can display two types of change notifications, recent change notifi-
cations and today’s change notifications. See the screenshot below.

Note:  Note: What you see on the dashboard is mostly configured by your CRM
administrator. If you do not see the above, please contact your CRM administrator
to enable the notifications.
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The Today’s Notification widget shows you all the change notifications generated
today till the current time. This widget is live and gets updated as soon as subscribed
watchlist item is changed. The Recent Notification widget shows you all the notifi-
cations in the previous 30 days, including today. The number of days is configured
by the CRM administrator.

When you hover the mouse over either of the widgets, the scroll buttons are activat-
ed. Click the scroll buttons to move forward (>) or backward (<) through the list of
change notifications.

Double a change notification to open the Change Notification Details window. You
can mark a change notification as read, by clicking the Mark as Read button in this
window.

Analyses
Analyses are based upon queries and display the resulting records in an aggregated
form including a graphical representation of relationships, >>  on page 77. You can
choose criteria used to display the results graphically as well as taking a drill-down
approach to differentiate subtle differences using fur ther criteria.

Your administrator can determine that fields from other info areas are displayed as
links. Click on the link to switch to the default view of the linked record.

It should not be viewed as a fully-fledged business intelligence tool, such as
CRM.intelligence.

Loading an Analysis
To load a previously defined analysis:

1. Select  (Queries & Analyses)> Analyses from the menu.

All available analyses are listed. You can use search criteria to restrict the anal-
yses displayed.

2. Select Tab View from the context menu.

The details of the analysis are displayed.

You can:

Executing an Analysis
To execute an analysis:

1. Load an analysis, >>  on page 96.
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The Result tab displays the values defined in the analysis.

2. Select the desired category from the drop-down list.

3. Click on Add to add a new value. Click on Edit to edit an existing value.

• Use the Type drop-down list to determine whether the sum or the number of
values should be analyzed, or whether a maximum, minimum or the mean should
be calculated.

• Enter data for the filters in the corresponding fields.

4. To execute the analysis:

• Click on  (Start). The analysis is executed using the values you last entered
(Category, Values, Filters). The analysis need not be saved.

• Click on  (Run Analysis) to execute the saved analysis.

• Press Enter.

You can also execute analyses directly from the list (after accessing the page by

selecting  (Queries & Analyses) > Analyses). Select Run from the context
menu.

The results of the quick analysis are displayed to the right of the mask.

1. Click on Export ( ) to export the data as either CSV or XML, depending on your
settings, >>  on page 34.

Note: Note: If you execute an analysis and then edit data in the analysis in another
tab, the analysis is not automatically updated. For performance reasons, the results
of the analysis is cached. Clicking on Run Analysis accesses the data in the cache.In
order to update the analysis results, select a different filter and then run the analysis
again.

Changing the Result Categories
You can change the result categories or filter them according to cer tain criteria.

To change the category:

1. Load an analysis, >>  on page 96.

2. Select the desired category from the Category drop-down list on the left.

If your analysis includes a date as a category, you can list the sum totals of data in
the analysis by month, quarter or year.

1. If fields have been defined as filters in the analysis, you can define filter criteria
in order to restrict the results of the analysis.
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2. Click Start to execute the analysis again.

Cumulative Analyses
Your administrator can define (in CRM.designer) that the highest value in a column
is displayed in the sum total, instead of the actual total.

Displaying Results as Charts
You can display the results of your analysis graphically. You can choose between
bar or pie charts.

To display your results graphically:

1. Execute the analysis, >>  on page 96.

2. Click on the Show Chart tab.

3. Use the drop-down list to determine the type of chart, e.g. a bar or pie chart. The
chart is displayed.
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Defining Analyses
To define an analysis:

1. Select  (Queries & Analyses) > New Analysis.

2. The New: Analysis window is displayed.

3. Enter the name of the analysis. You must enter a name to save the analysis.

4. Determine whether the analysis is Private (only you can access it) or Public
(anyone can access it).

5. Click on  (Select) next to the Query name field and select the query to base
your analysis on.
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Various settings are displayed:

6. Configure the settings as desired. The following options are available:

• Categories, >> on page 99

• Values, >> on page 100

• Filters, >> on page 100

• List, >> on page 101

7. Save the analysis.

Defining Analysis Categories
To define the categories in an analysis:

1. Define an analysis, >>  on page 98 or load an existing one.

2. Define the categories in the Categories area:
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3. The following options are available:

• The output fields in the query are listed. Enable the check box on the left to
determine the fields by which values in the analysis should be grouped.

• Disable sorting of results: If this option is enabled, values are not sor ted.

If this check box is disabled, the results categories in the analysis are sor ted
according to the size of the result (sum total / average of the field values or
number or records).

This check box is only available for catalog values and date fields.

• Show all values (even if value is 0): Enable this check box to display
categories even if their value is zero.

Note:  Note: If this option is checked, the output result set also includes records
that do not have a relevant record id. Example of such records include, left
outer joins or group by aggregations (with optional, plus, plus summed).

Defining Analysis Values
To define the values in an analysis:

1. Define an analysis, >>  on page 98 or load an existing one.

2. Define the values in your analysis in the Values area.

Only numeric values are listed, as only numeric values can be displayed in the
analysis.
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The following options are available:

• Use the check box to the left of the values to determine which values data can
be analyzed by.

• Percentage-dependent: Enable this check box if you want to total all weighted
values. You need to have selected a Percentage Field from the drop-down
under Define Defaults Values for this setting to be applied.

• Currency-dependent: Enable this check box if you want to convert the contents
of currency fields to the currency used by the analysis. You need to have
selected a Currency Field from the drop-down list under Define Default Values
for this setting to be applied.

Defining Analysis Filters
To define filters for an analysis:

1. Define an analysis, >>  on page 98 or load an existing one.

2. Define the fields that can be used as filter criteria in the analysis in the Filters
area.

3. The following options are available:

• Enable the check box to the left of a field to allow the field to be used a filter
criteria in the analysis.

• Filter must be selected: Enable this check box if a value must be selected for
the criteria selected under Filter before the analysis is executed. Otherwise
you are informed that the analysis cannot be executed.

Use this option if too many records would otherwise be included in the analysis,
in which case the analysis may take a long time to execute.

Defining the Analysis List View
After executing the analysis, you can select Display Details from the context menu
in the results list to view a list containing the results of the analysis. You need to
define which fields are displayed in this list beforehand.
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To define the list view for an analysis:

1. Define an analysis, >>  on page 98 or load an existing one.

2. Click on the List tab.

3. Define which fields are displayed in the list and their properties.

The following columns are available:

• No. in List: Enter the position (column number) of the value in the list.

• Width: Enter the column width as a percentage of the total width. The sum
total of all widths should be 100%.

Editing the Analysis
To edit an existing analysis:

1. Load the analysis, >>  on page 96.

2. Click on  (Show/Hide) in the header.

The area used to define the analysis is displayed.

3. Edit the analysis.

4. Save your changes.

If you save an edited analysis under the same name, the analysis is overwritten
immediately. If you change the name of the analysis and another analysis with
the same name exists, you are asked whether you wish to overwrite the existing
analysis.

Note: Note: If you edit an existing analysis (i.e. change the info areas, fields and/or
conditions), an asterisk (*) is displayed in the header after the name of the analysis
until you save the analysis.
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Drill-Down and Drill-Up
You can analyze a value in the analysis fur ther and proceed downwards step by
step (drill-down). Conversely you can return from lower levels to higher levels (drill-
up). Only the category fields selected in the analysis are available here (apart from
those that are analyzed at the top-most level).

Note: Note: If your analysis contains locked catalog values, and your administrator
has determined that you cannot display locked catalog values, the results of drilling
down may differ from the results displayed beforehand.

To drill down step-by-step:

1. Execute an analysis, >>  on page 96.

2. Select Drill-Down from the context menu to fur ther analyze a value according to
fur ther criteria. You can also click on a bar or pie in the graphic to display the
context menu.

You can choose from the selected catalog fields in the analysis (apart from those
that are analyzed at the top level of the analysis).

3. Select a field.

The details for this field are displayed.

1. Click on the Drill-Up button to move up a level within the analysis or use the
breadcrumb trail to navigate to the desired level.
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Displaying the Details of an Analysis
To display the details of an analysis, you need to determine the fields that are dis-
played when defining the analysis, >> on page 101.

To display the details:

1. Select Display Details from the context menu.

2. A list containing the results of the analysis is displayed. The values you selected
in the List tab when defining the analysis are displayed here.

3. Click on  (Display Details) to display an entry's MiniDetails.

Bubble Charts
Bubble charts are analyses where data is displayed in the form of bubbles on an X-
Y axis, with the size of the bubbles corresponding to a third value.

You can display bubble charts, but you cannot define parameters such as which
values and categories are displayed.

By default, Aurea CRM web includes two bubble charts:

• Opportunity Bubble Chart

• Ticket Bubble Charts

Opportunity Bubble Chart example:
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Your administrator can define additional charts.

Key Performance Indicators Dashboard
(Enterprise CRM)
The KPI dashboard provides a quick measure of your business metrics primarily
focusing on customer development and management. It shows the current state of
your sales for existing and new customers. This would be very useful in monitoring
open calls, new customers of interest and other related information without having
to be informed by e-mail.

The following screenshot shows the KPI dashboard.
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You can find the following metrics displayed in the KPI dashboard under various
categories:
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DescriptonName on the
dashboard

TypeKPI Cate-
gory

Number of new potential customers (leads)
developed per 90 days.

New leadsQueryGeneral

Number of new opportunities in the last 90
days.

New Opps. last 90
days

QueryGeneral

Number of new customers (have placed 1
order) in the last 90 days.

New CustomersQueryGeneral

Number of customers have placed total or-
ders greater than X in the last 12 months.

Note:  Note: The size of an order in the
query is defined by your management. Con-
tact your administrator to reset the order
size according to your requirement.

Customers With
Orders

QueryGeneral

Average Customer satisfaction score of all
customers this year and value from the pre-
vious year (measured per calendar year).

Average Customer
Satisfaction

3D
Bar

General

Average customer satisfaction score in A
customers and the value from the previous
year.

Average A-cus-
tomer satisfaction

3D
Bar

General

Mean number of visits for the opportunities
won in the last 12 months.

Mean visits for won
opps. 12 month

3D
Bar

General

Number of visits planned for this week for
the current sales representative.

Planned visits this
week

QuerySales Rep

Number of leads (potential customers) for
the current sales representative.

LeadsQuerySales Rep

Number of visits planned for this week for
the current sales representative.

Planned activities
this week

QuerySales Rep

Number of new persons planned for the
current sales represenative.

PersonsQuerySales Rep
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DescriptonName on the
dashboard

TypeKPI Cate-
gory

Number of tickets for the current sales rep-
resentative.

TicketsQuerySales Rep

Number of opportunities for the current sales
representative.

OpportunitiesQuerySales Rep

Number of won opportunities for this year
for the current sales representative.

Won Opps. YearQuerySales Rep

Number of unfinished visit reports for this
week for the current sales representative.

Unfinished visit re-
ports week

QuerySales Rep

Number of finished visit reports this week
for the current sales representative.

Finished visit re-
ports week

QuerySales Rep

Number of visits planned for the current
sales representative.

VisitsQuerySales Rep

Number of offers for the current sales repre-
sentative.

OffersQuerySales Rep

Number of won opportunities for rep's sales
team (org group) can be used to compared
to other teams (gamification).

Won Opps. GroupQuerySales Rep

Number of appointments planned for the
current sales representative.

Planned activitiesQuerySales Rep

Number of new customers for the current
sales representative.

New customersQuerySales Rep

Number of leads (potential customers) for
the current sales representative.

LeadsQuerySales Rep

Number of visits planned for this week.Planned visits this
week

QueryService
Rep

Number of visits done by the service repre-
sentative.

Number of visitsQueryService
Rep
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DescriptonName on the
dashboard

TypeKPI Cate-
gory

Number of assigned tickets.Assigned ticketsQueryService
Rep

Graph depicting the median of the duration
of each opportunity.

Median Opps Dura-
tion

3D
Bar

Manage-
ment

Note:  Note: If you wish to have KPIs that show more custom information, contact
your Aurea CRM administrator to configure your custom KPI queries and Analyses.

Quick Add
The quick add function allows you to easily enter items (e.g. in offers or orders)
without needing to add item records individually.

To use the quick add function, you first need to add the parent record (e.g. an order)
and then add the items. Items can be selected from the item master.

Depending on the info area, various items are listed. You can restrict the number
of items listed.

Each time you enter an item using the quick add function, a corresponding item
record is added to the parent record.

The quick add function is available by default in a number of areas in Aurea CRM
web, e.g. offers and orders. If the quick add function is available for an area, the
Quick Add option is available from the parent record's context menu.

Switching to Edit Mode
Depending on your product version you can switch to edit mode as follows:

• Select Quick Add (Item) from the header record's context menu.

• Click on  (Quick Add)

Note: Note: Your administrator can add a Refresh button to areas where entering
data causes values to be recalculated (e.g. some discounts). Use this button to
display the newly calculated values.
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Duplicating Records
You can duplicate rows in the quick add area.

Note: Note: You can only duplicate rows where data has been entered.

To duplicate a row:

1. Open the desired quick add area.

2. Select the desired row.

3. Click on .

The duplicated record is inser ted below the selected record.

Viewing Item Details in the Related Data
Information on individual item records is displayed under Related Data below the
quick add area.

In addition to displaying details on the selected item, information can also be dis-
played e. g. on when the company/person was last offered or last ordered the item
and what the conditions were.

Special Filters
You can restrict the items displayed in the quick add areas using predefined filters.
These filters are displayed in the upper search area as buttons. Click on the desired
button to apply the filter.

You can fur ther restrict the items listed by entering additional criteria in the search
mask.

Which filters are available depend on:

• The ver tical you are using

• The current info area

• The configuration defined by your administrator

The following special filters are available by default, additional filters can be available
depending on your configuration:
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All items in the item master.All

The items for which data has been entered.Overview

All items entered for the last three records in the parent info area.Last Entries

Your administrator can also define that no special filters are available.

Your administrator can define filters that are applied automatically when using the
quick add function.

Your administrator can restrict the number of records displayed when selecting Last
Entries.

Entering Data using Quick Add
The quick add function is similar for all info areas. The following describes entering
items for an order.

To enter data using the quick add function (e.g. for an order):

1. Select  (Sales) > Orders from the menu.

2. Search for the desired order.

3. Switch to edit mode, >> on page 104.

4. The item master is listed.
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5. Restrict the items that are listed:

• Enter search criteria in the search mask.

• Click on one of the buttons to apply the corresponding filter, >>  on page 105.

6. Click on an item in the results list, and enter the desired values (e.g. quantity and
end price) in the list.

Note: Note: If you enter a quantity of '0' (zero) for an existing item, you are
asked whether you want to delete it or save the item with a quantity of zero.
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The shopping car t symbol (upper right corner) displays the number of items for
which a quantity has been entered. The total quantity and net price of the order
are displayed next to the car t.

7. If you switch between items, your settings are saved automatically. You can also
click on  (Cancel) and  (Save). Rows in the list where a corresponding item
record have been added are indicated with a small shopping car t icon.

8. Additional information on the selected items is displayed beneath the list of items:

9. Once you have entered all the items, click on I'm done.

Shopping Cart
The number of items that you have entered data for in the quick add area is displayed
on the shopping car t icon:

Key values regarding the items are displayed to the right of the shopping car t.

Click on the shopping car t to display the items in the car t:
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You cannot edit data in this overview, but you can access the quick view or display
the mini details.

Deleting Data in the Quick Add Area
To delete data in the quick add area:

1. Click on Overview.

The items for which data has been entered are displayed.

2. Select the item you wish to delete and click on  (Delete).

Multilingual Texts
Your administrator can determine that you can enter texts in multiple languages.
For example, if your company has branches in multiple countries, you can define a
questionnaire in the country-specific languages.

The following example displays a field in the portfolio configuration (you can only
access this field if you have the necessary access rights):
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Your administrator is responsible for defining which languages are displayed and
which you can edit.

The  (Edit) icon is displayed next to multilingual fields. Click on this icon to open
the input mask for the available languages.

Note: Note: These texts are stored in the Text info area; not in the info area
containing the field the text is entered in. If you make changes to the multilingual
texts, the modification date of the info area referencing the text (e.g. Portfolio) is
not updated.

Notes
Notes allow you to add information that cannot otherwise be stored in the database
structure, e.g. directions for reaching a customer as text.

Depending on your configuration, notes can be available in various info areas, e.g.
Company and Person.
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CRM.launcher
CRM.launcher (included with Aurea CRM web) is required to perform certain actions
in the application. The first time you initiate an action that requires CRM.launcher,
a message that CRM.launcher needs to be installed on your computer is displayed.
You can install CRM.launcher by clicking the link in this message, >> on page 109.

CRM.launcher is required for:

• Mass mailings

• Quick campaigns

• Checking out documents

• Aurea CRM web offline

• CRM.phone (if installed)

Aurea CRM web communicates with the CRM.launcher when it has to perform these
functions that require other applications that are outside your web browser’s sandbox.

To ensure secure communication between Aurea CRM web and the CRM.launcher,
you are asked to authorize the communication between the CRM web and the
CRM.launcher. On approval, CRM web generates and stores a token specifically
for your future sessions with the CRM web server. Tokens are renewed every 30
days and consequently CRM Launcher periodically prompts you for authorization.
See the screenshot below.
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Note:  Note: If you switch to a different browser, or clear your browser’s cache you
are prompted to authorize the communication again.

Note: Note: Aurea software recommends using Google Chrome as your browser,
as problems may occur under cer tain circumstances when using Firefox.

Installing CRM.launcher
To install CRM.launcher:

1. Perform an action that requires CRM.launcher, e.g. check out a document.

The following message is displayed:

2. Download the application and executed CRM.launcher.exe.

CRM.launcher is installed automatically.

3. Confirm the installation (Finish button in the CRM.launcher - InstallShield
Wizard).

4. Once the installation is complete, a cer tificate is displayed. You need to install
this cer tificate.
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5. Return to Aurea CRM web and perform the action again.

CRM.launcher in the Windows Taskbar

Once you have star ted CRM.launcher, the  (CRM.launcher) icon is displayed in
the Windows taskbar on the right. Right-click on the icon to access the available
functions:

1. Right-click on  in the taskbar.

2. Select the desired option:

• Check for Updates, >> on page 110.

• Open offline CRM or Open online CRM, >> on page 111.

Note: Note: These options are only available if you have installed the latest
version.

• Settings, >> on page 110, on page 110 and on page 111.

• Exit
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Check for Updates
Select this option to update the application if an update is available.

Select Check for Updates:

• If an update is available, it is installed.

• Contact your administrator if CRM.launcher determines that the version on the
server is not compatible with your client version, and no update is available.

Once you have completed the installation, you can choose to work in online mode
(if you have a network connection) or in offline mode:

Switching Languages
To change the language:

1. Right-click on the CRM.launcher icon ( ) in the taskbar and select Settings from
the context menu.

2. Select the desired Language from the drop-down list on the General tab.

3. Click on OK.
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Creating Bug Reports
If problems occur while working with Aurea CRM web offline, you can create a ZIP
file and send it to your administrator for analysis.

To create an error report:

1. Right-click on the CRM.launcher icon ( ) in the taskbar and select Settings from
the context menu.

2. Switch to the Troubleshooting tab and click on (Create Bug Report).

The Bug Report - Options dialog is displayed.

3. Enter a path for the log file in the Bug report zip file field and enable the check
boxes to determine what to include in the file (CRM.designer configuration,
CRM database, Log files). By default, Log files is enabled.

Note: Note: Including the CRM database in the file may take a long time and
require significant storage space on your hard disk.

4. Click OK to save create the ZIP file.

5. You can then send the file to your administrator.

Port Settings

Note: Note: Only change these settings if requested to do so by your administrator!
Your administrator should provide you with information on which port to enter.

Your administrator can determine that you cannot change the port.

Closing and Restarting CRM.launcher
If CRM.launcher is already installed, but you are unable to perform actions requiring

CRM.launcher, verify that CRM.launcher is running (the  icon is displayed in the
system tray). If the icon is not display, star t CRM.launcher from the Windows Star t
menu.

If CRM.launcher is active, and you are notified that a new version can be installed,

you need to close CRM.launcher before installing the new version. Click on  and
select Exit from the popup menu to close CRM.launcher. CRM.launcher is automat-
ically star ted after installing the update.
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Uninstalling CRM.launcher
If necessary, you can uninstall CRM.launcher from Window’s control panel (as with
any other application).

Using CRM.launcher with Mozilla Firefox
If you are using Mozilla Firefox, you may be unable to perform actions (e.g. check
out a document) despite CRM.launcher being installed. In this case, switch to another
browser (Google Chrome or Internet Explorer). If you need to work with Mozilla
Firefox, contact your administrator.

Aurea CRM web offline
Aurea CRM web generally accesses data in the database in online mode. Depending
on your tasks (e.g. if you are often in the field) and your network connection, you
may not always have online access to the database. You can work in offline mode
instead in such cases.

Note: Note: In order to work in offline mode, you require Aurea CRM web offline.
Aurea CRM web offline is not included with Aurea CRM web by default. Contact
your Aurea representative if you wish to acquire this add-on.

Starting Aurea CRM web offline in Offline or Online
Mode
To star t Aurea CRM web in either online or offline mode:

1. Start Aurea CRM web using CRM.launcher. Two options are available:

• Click on either  (Open offline CRM) or  (Open online CRM) after
installing the latest version.

• Select on either Open offline CRM or Open online CRM from CRM.launcher’s
context menu.

2. The system then checks when data was last synchronized, and you can choose
whether you wish to synchronize data. You can only synchronize data if you can
connect to the online database.
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Note: Note: Synchronize your data as often as possible. Note that depending
on your network connection and the volume of data you are synchronizing, the
synchronization process may take some time.

3. Click Offline Synchronization to star t synchronizing.

4. Once synchronization is complete, you can choose to use Aurea CRM web in
online mode or to switch to offline mode.

Administrative Tasks
You can perform administrative tasks in Aurea CRM web. However, you require the
necessary access rights to do so, >>  on page 4. If you do not have the necessary
access rights, contact your system administrator.

For fur ther information on administrative tasks (including those not described in this
manual), >> Aurea CRM web Administrator Guide.

Note: Note: You also require the necessary access rights to define characteristics,
relationship levels, exchange rates etc. These options are therefore also accessible
from the Settings menu. These records are however described in the relevant
chapters of the User Manual.

Keyboard Shortcuts
The following default keyboard shortcuts are available in Aurea CRM web. Your
administrator can define additional shortcuts or reassign the following standard
shortcuts.

Global Keyboard Shortcuts

DescriptionShortcut

Opens the online help.F1

Moves to the next text field in the quick search.Alt+Q
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Search Area and Results Lists in Edit Mode

DescriptionShortcut

Moves to the next editable field or the next action.Tab

Moves to the previous editable field or previous action.Shift+Tab

Activates the Related Data area.Alt+0

Displays the tab at the corresponding position, e.g. Alt+3 opens the
third tab.

Note: Note: You first need to activate the Related Data area with
Alt+0.

Alt+<Num-
ber>

Star ts the search (provided the cursor is in the search area).Enter

Activates the results list (the first record in the list is selected).Alt+L

Lists in View Mode

DescriptionShortcut

Selects the previous entry.Up cursor key

Selects the next entry.Down cursor key

Selects the first entry on the current page. If the first entry is
already selected, the view switches to the previous page.

Page Up

Selects the last entry on the current page. If the last entry is
already selected, the view switches to the next page.

Page Down

Switches to the first page.Home

Switches to the last page.End
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Switches to edit mode.Space

Quits edit mode. Any changes are not saved and the previously
saved data is restored.

If a drop-down list is open, use Esc to close it.

Esc

Lists in Edit Mode

DescriptionShortcut

Quits edit mode. Any changes are not saved and the previously
saved data is restored.

If a drop-down list is open, use Esc to close it.

Esc

Moves one character to the right within a field.Right cursor key

Moves one character to the left within a field.Left cursor key

Moves to the next editable field.

If the current field is the last editable field in a row, the cursor
moves to the first editable field in the next row. Changes to the
current row are saved in the process.

Tab

Moves to the previous editable field.

If the current field is the first editable field in a row, the cursor
moves to the last editable field in the previous row. Changes to
the current row are saved in the process.

Shift+Tab

Switches to the same field in the previous row. Changes to the
current row are saved in the process.

Note: Note: If the field is a drop-down list, use Ctrl+Up instead.

Up cursor key
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Switches to the same field in the next row. Changes to the cur-
rent row are saved in the process.

Note: Note: If the field is a drop-down list, use Ctrl+Up instead.

Down cursor key

Adds a new record to the info area displayed in the list.Ctrl+Alt+N

MiniDetails

DescriptionShortcut

Displays the mini details for the selected record in a list.+

Closes the mini details for the selected record in a list.-

Tab View in Edit Mode

DescriptionShortcut

Switches to the next field and saves all data entered in the current
field.

Tab

Moves to the previous editable field or previous action.Shift+Tab

Activates the Related Data area.Alt+0

Displays the tab at the corresponding position, e.g. Alt+3 opens the
third tab.

Note: Note: You first need to activate the Related Data area with
Alt+0.

Alt+<Num-
ber>

Saves the record.Ctrl+S

215AUREA CONFIDENTIAL

Keyboard Shortcuts



Catalog Fields in Edit Mode

DescriptionShortcut

Opens a closed drop-down list and displays the available
values.

Down cursor key

Closes an opened drop-down list and resets the value to the
previous value.

Alt+  or Esc

Selects the currently highlighted value.Enter

Moves to the previous value in the drop-down list.Up cursor key

Moves to the next value in the drop-down list.Down cursor key

Moves up one page in an opened drop-down list.Page Up

Moves down one page in an opened drop-down list.Page Down

The first entry that begins with the letter is highlighted.Any letter

Check Boxes / Radio Buttons in Edit Mode

DescriptionShortcut

Toggles the status of the check box/radio button.Space

Popups

DescriptionShortcut

Closes the popup.Esc
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Calendar / Daily and Weekly Planning in Edit Mode

DescriptionShortcut

If a time period has been selected, a text field is displayed.Any letter

If you have entered text in a text field in the calendar, adds a
new activity with the text as its subject.

Enter

Moves to the next entry if an entry is selected in the calendar.Tab

Moves to the previous entry if an entry is selected in the calen-
dar.

Shift+Tab

Deletes the selected entry.Del

Resource View / Visit Planning in Edit Mode

DescriptionShortcut

Deletes the selected entry.Del
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2
Companies and Persons

Companies and Persons
Learn how to add companies and persons and manage them.

Use the Accounts menu to add new companies and persons, or to search for existing
records. This topic does not cover general functions such as searching, editing
records etc.

The Company info area is an independent info area, i.e. companies are not added
to other, parent records. Persons can be added to companies (as contact persons)
or as independent records (e.g. private persons).

Customer Data
Learn how to store customer data.

Data such as the company name, address, telephone and fax numbers of your clients
and potential clients are stored in the Company info area.

Information on persons is stored in the following info areas:

• The Person (PE) info area is used to store the actual data concerning persons,
e.g. their name, date of bir th, private address etc.

Use the Person info area to store private bank customers, or doctors that have
both a practice and are also employed at a clinic, for example.

• The Contact Person (CP) info area is used to store person data related to a
specific company, e.g. the person's department, position, telephone extension
etc.

• The Person in Company info area displays all person data in the context of a
specific company by combining information in the Person and Contact Person
info areas. If you add a person to a company who is not already present in the
database as a person (PE) record, a new person record is added automatically.

Additional Addresses

You can add additional addresses for companies (and persons, if you system is
configured accordingly), e.g. to store separate billing addresses.

You can only add a single additional address per Address Type per company/person.
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Additional Addresses
You can add additional addresses for companies (and persons, if you system is
configured accordingly), e.g. to store separate billing addresses.

You can only add a single additional address per Address Type per company/person.

Merging Companies and Persons
Learn how to merge duplicate company and person records in the database to form
a single record.

The source record, from which the process is star ted, is deleted. Conflicts can occur
if the same field contains different values in the two records. In this case, you need
to decide which data to retain. For example, you can determine which data should
be retained on a field by field basis or that all data in either the first or second record
should be retained.

The record the merge process is initiated from is referred to in the following as the
"source record"; the record the source record is being merged with is referred to as
the "target" record. The source record is removed from the database once the records
have been merged. The target record is saved and contains the merged data.

To merge companies or persons:

1. Select Merge with from the company or person’s context menu (e.g. in the search
results list or tab view). You can also mark the two entries in the results list you
wish to merge and select Start Merge Process from the context menu.

The process used to merge records is star ted and the company search is dis-
played.

2. Search for the target record that you wish to merge the source record with and
double-click on it.

An overview of both records is displayed.
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3. Click on Switch records to switch the target and source records.

4. Choose one of the available options:

• User decides conflict resolution: You can decide which of the two values to
retain for each field.

• Source record always wins: The fields in the source record are saved in the
database; the data in the target record is discarded.

• Target record always wins: The fields in the source record are saved in the
database; the data in the target record is discarded.

• In the case of conflict the newer record is used: The modification date of
the individual fields in both records are compared with one another and the
most recent value is retained.

5. Click on Continue.

6. The option selected in the previous step determines what is displayed next:

• If user decides conflict resolution was selected, you can select the field
values to be retained.
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By default, all fields in the source record are selected (highlighted in green).
To retain the value in the field in the target record, click on the contents of the
field in the Target [company] column.

221AUREA CONFIDENTIAL

Merging Companies and Persons



• If you previously selected Target record always "wins" or Source record
always "wins", an overview is displayed, but you cannot make any changes.
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No overview is displayed if you selected In the case of conflict the newer
record wins.

•

7. Click on Continue.

8. If child records have been added for both the source and target record and these
also contain identical or similar data, these also need to be merged. Click on
Continue to merge each child record. The option selected for the parent record
is also applied to the child records.

Note: Your administrator can determine whether all fields are listed, or only those
where the contents differ. If only the fields that differ are displayed, child records
may be listed without any fields - in this case, the contents of the fields in both
records are identical. However, the record's keys is different (which can cause
conflicts); you therefore need to click on Continue for each record.

9. Click on Start Merge Process.

Contact Times
Learn how to enter color coded times on a daily and weekly planner.

You can enter contact times for companies and persons, e.g. opening hours or a
person’s work hours. These times are color-coded in the daily and weekly planning
area to aid you in planning new appointments for a customer using drag&drop.

Contact times must be entered separately for each day of the week. You can enter
contact times for the morning, afternoon and other time periods. You need to define
both the star t and the end of each of these time periods. If you enter an end time
that is earlier than the star t time, a message is displayed.

You can also enter holiday periods during which a company is closed. These holidays
are taken into account when planning visits in Aurea CRM web.

To enter contact times for a company or person:

1. Select New > New Contact Time from the company or person’s context menu.

2. Select the Type and Weekday and enter the contact times in the appropriate
fields.

3. You can also enter a responsible rep.

If reps have been assigned to a customer, your administrator can determine that
the contact times entered for the current day for that rep’s customers are displayed
under Related Data.
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Relationships
Learn how to depict hierarchies and networks between companies and persons
using Relationships.

You can store relationships between companies and persons (e.g. parent and sub-
sidiary companies, sales partners, suppliers, competitors) and display the resulting
networks.

Adding Relationships

To add a new relationship:

1. Select New > New relationship from the company or person’s context menu. The
system guides you through the process of adding the new relationship.

2. Choose whether you want to add a relationship with a company or a person.

3. Select the record you want to add the relationship with. You can also choose to
add a new record; to do so, click on  (New) in the header of the search results.

4. Determine whether a reciprocal relationship should be added.

Note: When adding a new relationship, the Create reciprocal relationship check
box is enabled by default in Aurea CRM web. If the type of relationship you are
adding is between two companies and of the type "Parent", the reciprocal
relationship is "Subsidiary" (i.e. one company is the parent company and the other
is the parent’s subsidiary). The type of reciprocal relationship is displayed for
each relationship in the Reciprocal Rel. Type column. Your administrator can
change the default behavior of this check box.
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5. Select an existing relationship on the Predefined tab of switch to the Customize
tab to define a new relationship.

a. Enter the Type of relationship, the Relationship and the Business Area. The
first row defines the relationship, the second row defines the reciprocal
relationship.

b. Click on Continue to add the relationship.

Note: Note: Aurea recommends that your administrator prevent the Relationship
Type, Relationship and Department fields from being edited, as any changes made
to these fields are not applied to the reciprocal relationship, see Rights Module in
the CRM.core Administrator Guide). If you delete a relationship, the reciprocal
relationship is also removed.
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Searching for, Editing and Deleting Relationships

To search for and edit a relationship:

1. Select Go to All Related > All Relationships from a company or person’s context
menu.

The Search Relationships linked to [name] page is opened. Click on Start
Search. The results of the search are displayed.

2. Enable the Company-Related option to prevent person-related relationships from
being displayed (i.e. to only display relationship between two companies).

3. You can edit relationships as follows:

• Double-click on a record in the list or select Edit from the record’s context
menu.

• Select Delete from the context menu to delete the relationship. A message is
displayed and you can determine whether only the relationship should be
deleted, or whether the reciprocal relationship should also be deleted.

Relationship Hierarchy

The relationship hierarchy provides a graphical overview of all companies and per-
sons that are directly or indirectly linked to other companies or persons.

To display the relationship hierarchy:

1. Select Relationship Hierarchy from the desired company or person’s context
menu. A hierarchical overview of the relationships is displayed.
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The company you opened the relationship hierarchy from is displayed in bold.

2. Click on an entry to display the related record’s data below the hierarchy.

3. Click on  (Show Menu) next to an entry in the hierarchy and select Tab View
from the context menu.

Cyclical Relationships

If cyclical relationships exist (e.g. A is par tner of B; B is a par tner of C; C is a par tner
of A), one of the companies/persons needs to be displayed more than once. One
occurrence is defined as the main record and the other as duplicates. Duplicates
are indicated using an *.

No fur ther relationships are displayed for duplicates. All relationships are displayed
for the main record, except for with the company/person directly above the main
record in the tree. This includes relationships to companies that are in turn linked
to duplicates of this company/person. This allows you to display all relationships
for this company/person at a single point in the tree.

Relationship Network

The relationship network displays all a company or person’s relationships with other
companies and persons.

Multiple levels can be displayed in the relationship network. Each level represents
a degree of separation from the current record (i.e. the first level corresponds to
those companies/persons directly linked to the current record, the second level
corresponds to those companies/persons linked to the companies/persons in the
first level etc.).

To display the relationship network:

1. Switch to the desired company or person.

2. Select Relationship Network from the context menu. The relationship network
is displayed.

227AUREA CONFIDENTIAL

Relationships



• The current record (company or person) is displayed at the center (large node
with a green border). All records that are linked to the current record via a
relationship are displayed surrounding the current record. Reciprocal relationships
are not displayed.

• Move the mouse cursor over a connecting line to display the type of relationship.

• Click on  on the left to open the side bar containing a list of the relationships
stored for the current record (note that any predefined filters are also applied to
this list). Open the context menu for an entry in the list and select the person or
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company’s name to display the company or person in the quick view. Click on 
to close the side bar.

• Click on a node in the tree to select that company or person. The list of
relationships on the left is updated to display the relationships defined for the
selected company or person.

• Double-click on a node to open the corresponding record.

• Click again on a selected node to hide or display all relationships defined with
that company or person. The nodes are color-coded according to their level in
the network (i.e. how many degrees of separation lie between the node and the
current record).

• Select a node and click on New Relationship to add a new relationship for the
selected company or person. The relationship tree is refreshed once the
relationship has been added.

• Click on a node and hold down the mouse button to open the company or person
in the quick view. You can access the record’s context menu from the quick view.

• Use your mouse wheel to zoom.

• You can scroll the view and reposition nodes in the network:

• Click anywhere in the network where the  mouse cursor is displayed to scroll
in the network.

• Click on a node and then click on it again while holding down the mouse button

(the mouse cursor is displayed as ) to move the node. Any child nodes are
also moved.

• If the current record has relationships with more than 10 records (by default), the

 and  nodes are displayed. Click on these nodes to display additional
records that relationships have been defined with.

• Enable the Cross Links option to prevent the same record being displayed multiple
times in multiple nodes (when more than one company or person is related to the
same company/person). Each company/person is only displayed once and a dotted
line indicates the additional relationships with a node.
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Example: If a relationship is defined between a person and two companies in the
network, the person is displayed twice, once per relationship with each company.
If the Cross Links option is enabled, the person is only displayed once and a
dotted line links the second company to the person.

Note: Note: Your administrator can customize how the relationship network is
displayed, e.g. how many levels in the network are displayed initially (default = 1,
i.e. only the direct relationships with the current record), determine which types of
relationships are displayed, the number of child records that are displayed etc., see
CircleOfInfluence in the Aurea CRM web Administrator Guide.

Note: The relationship network can also be used to display corporate structures,
see HierarchicalCircleOfInfluence in the Aurea CRM web Administrator Guide. The
large node at the center of the chart always displays the root of the corporate
structure. If you open the chart from a company that is not the root, the current
company's node is expanded.

Defining Relationship Levels

The relationships that are available for selection are defined in the Relationship
Level info area.

Note: Note: You can only add records to the Relationship Level info area if you
have the necessary access rights.

To add a relationship level record:

1. Select  (Administration) > Relationship Levels.

2. Click on Start Search and then on  (New).
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3. Define the Relationship type, Relationship and Business Area for both the
relationship and the reciprocal relationship, and enter the appropriate Level.

4. Save the record. The defined relationship can then be selected when defining
relationships.

The Level field is used to determine the hierarchical structure formed by the rela-
tionship and which company is the root of the hierarchy:

• For all relationships that are not par t of a hierarchy (i.e. par tnerships), the field
should remain empty.

• For those relationships defined at the top of the hierarchy, the value is 1; the
value for the reciprocal relationships is 2 in this case.

For each fur ther level, the value of the upper level is always 1 lower than the level
below. i.e. for the second level (the one below the parent), the Level is 3 for the
relationship and 4 for the reciprocal relationship.

Note: Note: Because records in the Relationship level info area define pairs,
these records should not be edited once entered. If you want to redefine a
relationship, delete the existing records first.

Enable the Relationship hierarchy field if the relationship level record defines a
relationship used to define a corporate structure. The following criteria need to be
met:

• A reciprocal relationship must exist.

• The Level field in the record must contain a value that is higher or equal to the
level in the reciprocal relationship.

• The same value must be entered in the Relationship type and Reciprocal Rel.
Type fields.

Corporate Structure

The corporate structure can include hierarchical relationships and relationships on
the same level. The corporate structure can be used to define access rights and to
display corporate hierarchies, see Conditional Access to Info Areas in the CRM.core
Administrator Guide.

Companies and persons may be present in more than one corporate structure; for
example, a company may be part of a corporate group in one structure and a sup-
plier in another.

The corporate structure can be used to grant access to child records of companies
and persons (nodes in the example trees below), e.g.:

• Child records stored for records directly above the current node in the corporate
structure all the way to the root node.
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In this case, you can display all child data stored for parent companies linked to
the current company using corporate structure relationships. These are the
companies entered in the relationship records with a lower relationship level than
the current company.

• Child records stored for records directly below the current node in the hierarchy.

In this case, you can display all child data stored for child companies linked to
the current company using corporate structure relationships. These are the
companies entered in the relationship records with a higher relationship level
than the current company.

Relationship records are used to store the type of relationship between a source
company/person and a target company/person. The hierarchy itself is defined in
the relationship records using the station and serial numbers of relationship
records (not company/person records). The keys of relationships higher up in the
hierarchy and of the current relationship are automatically entered in the
PB_1_StaNo/SerNo - PB_10_StaNo/SerNo fields in one of the relationship records
(if applicable, the one with a lower level). These fields depict the path from the
current relationship record to the root relationship record; the root relationship’s
key is always entered in the PB_1_StaNo/SerNo fields. The root relationship itself
thus only contains a link to itself in the PB_1_StaNo/SerNo fields, and the Gen-
erated check box is enabled for this relationship. This relationship record is added
automatically.
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To define the corporate structure, suitable relationships first need to be defined
in the Relationship Level info area. The Relationship type and Reciprocal Rel.
Type must both be the same and the Relationship hierarchy field needs to be
enabled in the child relationship level record (i.e. the relationship with a higher
Level). In the case of relationships on the same level, the check box should only
be enabled in one of the relationship level records.

Whenever new relationships are added using the relationship defined in the rela-
tionship level record, links to the relationship records corresponding to nodes
higher up in the corporate hierarchy are entered in the PB_1_StaNo/Ser-
No-PB_10_StaNo/SerNo fields in the child relationship (i.e. the relationship cor-
responding to the relationship level record where the Relationship hierarchy
check box is enabled). The corporate hierarchy can consist of up to 10 levels.

Example: The corporate structure is defined for five companies. Company 1 is
at the root level, Company 2 is defined as a subsidiary of Company 1, Company
3 as a subsidiary of Company 2 etc. all the way down to Company 5 at the bottom
of the hierarchy. The corporate structure above the current relationship is entered
in the relationship records added for the "is a subsidiary of" relationship (Company
2 is a subsidiary of Company 1, Company 3 is a subsidiary of Company 2 etc.).

The "is a subsidiary" relationship added for Company 5 (located at the bottom of
the hierarchy) contains links to all "is a subsidiary" relationships in the hierarchy
in the PB_X_StaNo/SerNo fields. PB_5_StaNo/SerNo contain the station number
and serial number of the "is a subsidiary" relationship added for Company 5
(Company 5 is a subsidiary of Company 4); PB_4_StaNo/SerNo contain the station
number and serial number of the "is a subsidiary" relationship for Company 4
(Company 4 is a subsidiary of Company 3) etc.
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If you make changes to the records in the Relationship Level info area, including
enabling the Relationship hierarchy check box, you can update the corporate
structure automatically. If you disabled the Relationship hierarchy check box in
a relationship level record used by the corporate structure and update the corpo-
rate structure, the entries in the PB_1_StaNo/SerNo-PB_10_StaNo/SerNo fields
are deleted. If you delete a node (relationship record) in the corporate hierarchy
that has child nodes, the child nodes immediately below the deleted records be-
come the root nodes of new corporate hierarchies.

To update the corporate structure automatically:

• Aurea CRM win: Select Generate Relationship Hierarchy from the context
menu in the Relationship Level info area.

• Aurea CRM web: Use a CRM.server To-Do (type 9), see To-Do Types in the
CRM.core Administrator Guide.

Note: The PB_X_StaNo/SerNo fields are not communicated and are recalculated
when inputting the communication file. The same applies when importing records.
By default, updating the corporate structure does not initiate any triggers defined
for the Relationship info area and the records’ time stamps are not updated. The
corporate structure can be displayed graphically in a relationship network, see
HierarchicalCircleOfInfluence in the Aurea CRM web Administrator Guide.

OTC with Aurea CRM LSI

If you migrate an existing OTC installation to Aurea CRM LSI, the business logic
of the Relationship and Relationship type fields in the Relationship level and
Relationship info areas are reversed.

Corporate Structure Links
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Aurea CRM offers indirect links (via the Relationship info area) that can be used
to defined queries applied to the corporate structure, for example.

Links 950-980 and 30000-36000 are available by default and apply to all relation-
ships used to define corporate structures (irrespective of the type of relationship),
see Link IDs in the CRM.core Administrator Guide.

Indirect links (using the corporate structure) for companies and persons
(FI/KP/PE/CP) applied to their child info areas:

• 30000: Returns the entire corporate structure

• 32000: Returns all companies and persons higher up in the hierarchy

• 34000: Returns all companies and persons lower down in the hierarchy

• 36000: Returns all companies and persons both higher up and lower down in
the hierarchy

The following image outlines the difference between links 30000 and 36000. This
also applies to the 950 and 980 indirect links.

Example: The corporate structure is defined for five companies. The current rep
is entered in the Rep 1 field of Company 2 (C2). An offer exists for each company.

Define a query that returns all offers stored for companies where the current rep
is entered (in this case Company 2), as well as all offers stored for companies
that are linked to companies where the rep is entered via the corporate structure.

Link 32000 returns the offers for companies 1, 2 and 5.
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Link 34000 returns all offers for companies 2 and 5; link 30000 returns the offers
for all companies and link 36000 returns the offers for companies 1, 2 and 5.

You can define variables of the Type "Condition" to define additional links using
your own condition. You can define up to 10 different conditions for corporate
structures using the 30000-130000 links. These links are numbered in intervals
of 10,000 and are named (in Aurea CRM win) according to the relationship type
(e.g. supplier, corporate).

You can define the following 10 variables:
CORE::INDIRECT-PB-LINK-TREE-0

(this variable fur ther restricts the default links 30000-36000)
CORE::INDIRECT-PB-LINK-TREE-1

...

CORE::INDIRECT-PB-LINK-TREE-9

Example: Define the variable
CORE::INDIRECT-PB-LINK-TREE-1

in Aurea CRM win. Select the Relationship info area in the Info Area field, the
Relationship type field in the Field Name field and "Condition" in the Type field.
Add a variable value for the variable and enter the comparison field and desired
relationship type in the Var. Text field, e.g. "Corporate".
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If you define conditional access rights for the Company info area in the Right
module in Aurea CRM win and apply conditions to the Company info area, you
can select the default indirect links and the links that only apply to the relationship
type used to define the corporate structure in the Index Relationship column.

For example, this allows you to determine that a rep can access all Dutch compa-
nies as well as any subsidiaries of those Dutch companies where a corporate re-
lationship has been defined.
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Note:  For more information on variables, see Variables in the CRM.core
Administrator Guide. You can also use indirect to define conditional access to
companies and persons’ child info areas, see Conditions Applied via Indirect Links
in the CRM.core Administrator Guide.

Adding Relationships
To add a new relationship:

1. Select New > New relationship from the company or person’s context menu. The
system guides you through the process of adding the new relationship.

2. Choose whether you want to add a relationship with a company or a person.

3. Select the record you want to add the relationship with. You can also choose to
add a new record; to do so, click on  (New) in the header of the search results.

4. Determine whether a reciprocal relationship should be added.

Note: Note: When adding a new relationship, the Create reciprocal relationship
check box is enabled by default in Aurea CRM web. If the type of relationship you
are adding is between two companies and of the type "Parent", the reciprocal
relationship is "Subsidiary" (i.e. one company is the parent company and the other
is the parent’s subsidiary). The type of reciprocal relationship is displayed for
each relationship in the Reciprocal Rel. Type column.Your administrator can
change the default behavior of this check box.
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5. Select an existing relationship on the Predefined tab of switch to the Customize
tab to define a new relationship.

a. Enter the Type of relationship, the Relationship and the Business Area. The
first row defines the relationship, the second row defines the reciprocal
relationship.

b. Click on Continue to add the relationship.

Note: Note: Aurea recommends that your administrator prevent the Relationship
Type, Relationship and Department fields from being edited, as any changes made
to these fields are not applied to the reciprocal relationship (>> Rights Module in

239AUREA CONFIDENTIAL

Relationships



the CRM.core Administrator Guide).If you delete a relationship, the reciprocal
relationship is also removed.

Searching for, Editing and Deleting Relationships
To search for and edit a relationship:

1. Select Go to All Related > All Relationships from a company or person’s context
menu.

The Search Relationships linked to [name] page is opened. Click on Start
Search. The results of the search are displayed.

2. Enable the Company-Related option to prevent person-related relationships from
being displayed (i.e. to only display relationship between two companies).

3. You can edit relationships as follows:

• Double-click on a record in the list or select Edit from the record’s context
menu.

• Select Delete from the context menu to delete the relationship. A message is
displayed and you can determine whether only the relationship should be
deleted, or whether the reciprocal relationship should also be deleted.

Relationship Hierarchy
The relationship hierarchy provides a graphical overview of all companies and per-
sons that are directly or indirectly linked to other companies or persons.
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To display the relationship hierarchy:

1. Select Relationship Hierarchy from the desired company or person’s context
menu. A hierarchical overview of the relationships is displayed.

The company you opened the relationship hierarchy from is displayed in bold.

2. Click on an entry to display the related record’s data below the hierarchy.

3. Click on  (Show Menu) next to an entry in the hierarchy and select Tab View
from the context menu.

Cyclical Relationships

If cyclical relationships exist (e.g. A is par tner of B; B is a par tner of C; C is a par tner
of A), one of the companies/persons needs to be displayed more than once. One
occurrence is defined as the main record and the other as duplicates. Duplicates
are indicated using an *.

No fur ther relationships are displayed for duplicates. All relationships are displayed
for the main record, except for with the company/person directly above the main
record in the tree. This includes relationships to companies that are in turn linked
to duplicates of this company/person. This allows you to display all relationships
for this company/person at a single point in the tree.

Relationship Network
The relationship network displays all a company or person’s relationships with other
companies and persons.

Multiple levels can be displayed in the relationship network. Each level represents
a degree of separation from the current record (i.e. the first level corresponds to
those companies/persons directly linked to the current record, the second level
corresponds to those companies/persons linked to the companies/persons in the
first level etc.).

To display the relationship network:

1. Switch to the desired company or person.

2. Select Relationship Network from the context menu.

The relationship network is displayed.
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• The current record (company or person) is displayed at the center (large node
with a green border). All records that are linked to the current record via a
relationship are displayed surrounding the current record. Reciprocal relationships
are not displayed.

• Move the mouse cursor over a connecting line to display the type of relationship.

• Click on  on the left to open the side bar containing a list of the relationships
stored for the current record (note that any predefined filters are also applied to
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this list). Open the context menu for an entry in the list and select the person or

company’s name to display the company or person in the quick view. Click on 
to close the side bar.

• Click on a node in the tree to select that company or person. The list of
relationships on the left is updated to display the relationships defined for the
selected company or person.

• Double-click on a node to open the corresponding record.

• Click again on a selected node to hide or display all relationships defined with
that company or person. The nodes are color-coded according to their level in
the network (i.e. how many degrees of separation lie between the node and the
current record).

• Select a node and click on New Relationship to add a new relationship for the
selected company or person, >> on page 120.

The relationship tree is refreshed once the relationship has been added.

• Click on a node and hold down the mouse button to open the company or person
in the quick view. You can access the record’s context menu from the quick view.

• Use your mouse wheel to zoom.

• You can scroll the view and reposition nodes in the network:

• Click anywhere in the network where the  mouse cursor is displayed to scroll
in the network.

• Click on a node and then click on it again while holding down the mouse button

(the mouse cursor is displayed as ) to move the node. Any child nodes are
also moved.

• If the current record has relationships with more than 10 records (by default), the

 and  nodes are displayed. Click on these nodes to display additional
records that relationships have been defined with.

• Enable the Cross Links option to prevent the same record being displayed multiple
times in multiple nodes (when more than one company or person is related to the
same company/person). Each company/person is only displayed once and a dotted
line indicates the additional relationships with a node.

Example: If a relationship is defined between a person and two companies in the
network, the person is displayed twice, once per relationship with each company.
If the Cross Links option is enabled, the person is only displayed once and a
dotted line links the second company to the person.
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Note: Note: Your administrator can customize how the relationship network is
displayed, e.g. how many levels in the network are displayed initially (default = 1,
i.e. only the direct relationships with the current record), determine which types of
relationships are displayed, the number of child records that are displayed etc., >>
CircleOfInfluence in the Aurea CRM web Administrator Guide.

Note: The relationship network can also be used to display corporate structures,
>> HierarchicalCircleOfInfluence in the Aurea CRM web Administrator Guide. The
large node at the center of the chart always displays the root of the corporate
structure. If you open the chart from a company that is not the root, the current
company's node is expanded.

Defining Relationship Levels
The relationships that are available for selection are defined in the Relationship
Level info area.

Note: Note: You can only add records to the Relationship Level info area if you
have the necessary access rights.

To add a relationship level record:

1. Select  (Administration) > Relationship Levels.

2. Click on Start Search and then on  (New).
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3. Define the Relationship type, Relationship and Business Area for both the
relationship and the reciprocal relationship, and enter the appropriate Level.

4. Save the record.

The defined relationship can then be selected when defining relationships.

The Level field is used to determine the hierarchical structure formed by the rela-
tionship (>> on page 121) and which company is the root of the hierarchy:

• For all relationships that are not par t of a hierarchy (i.e. par tnerships), the field
should remain empty.

• For those relationships defined at the top of the hierarchy, the value is 1; the
value for the reciprocal relationships is 2 in this case.

For each fur ther level, the value of the upper level is always 1 lower than the level
below. i.e. for the second level (the one below the parent), the Level is 3 for the
relationship and 4 for the reciprocal relationship.

Note: Note: Because records in the Relationship level info area define pairs,
these records should not be edited once entered. If you want to redefine a
relationship, delete the existing records first.

Enable the Relationship hierarchy field if the relationship level record defines a
relationship used to define a corporate structure, >> on page 125. The following
criteria need to be met:

• A reciprocal relationship must exist.

• The Level field in the record must contain a value that is higher or equal to the
level in the reciprocal relationship.

• The same value must be entered in the Relationship type and Reciprocal Rel.
Type fields.

Corporate Structure
You can depict the structure of corporations using relationships in Aurea CRM.

The corporate structure can include hierarchical relationships and relationships on
the same level. The corporate structure can be used to define access rights and to
display corporate hierarchies, see Conditional Access to Info Areas in the CRM.core
Administrator Guide.

Companies and persons may be present in more than one corporate structure; for
example, a company may be part of a corporate group in one structure and a sup-
plier in another.
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The corporate structure can be used to grant access to child records of companies
and persons (nodes in the example trees below), e.g.:

• Child records stored for records directly
above the current node in the corporate
structure all the way to the root node.

In this case, you can display all child data
stored for parent companies linked to the
current company using corporate structure
relationships. These are the companies en-
tered in the relationship records with a lower
relationship level than the current company.

• Child records stored for records directly be-
low the current node in the hierarchy.

In this case, you can display all child data
stored for child companies linked to the cur-
rent company using corporate structure rela-
tionships. These are the companies entered
in the relationship records with a higher re-
lationship level than the current company.

Relationship records are used to store the type of relationship between a source
company/person and a target company/person. The hierarchy itself is defined in the
relationship records using the station and serial numbers of relationship records
(not company/person records). The keys of relationships higher up in the hierarchy
and of the current relationship are automatically entered in the PB_1_StaNo/SerNo
- PB_10_StaNo/SerNo fields in one of the relationship records (if applicable, the
one with a lower level). These fields depict the path from the current relationship
record to the root relationship record; the root relationship’s key is always entered
in the PB_1_StaNo/SerNo fields. The root relationship itself thus only contains a
link to itself in the PB_1_StaNo/SerNo fields, and the Generated check box is en-
abled for this relationship. This relationship record is added automatically.
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To define the corporate structure, suitable relationships first need to be defined in
the Relationship Level info area, >> on page 124. The Relationship type and
Reciprocal Rel. Type must both be the same and the Relationship hierarchy
field needs to be enabled in the child relationship level record (i.e. the relationship
with a higher Level). In the case of relationships on the same level, the check box
should only be enabled in one of the relationship level records.

Whenever new relationships are added using the relationship defined in the relation-
ship level record, links to the relationship records corresponding to nodes higher
up in the corporate hierarchy are entered in the PB_1_StaNo/Ser-
No-PB_10_StaNo/SerNo fields in the child relationship (i.e. the relationship corre-
sponding to the relationship level record where the Relationship hierarchy check
box is enabled). The corporate hierarchy can consist of up to 10 levels.

Example: The corporate structure is defined for five companies. Company 1 is at
the root level, Company 2 is defined as a subsidiary of Company 1, Company 3 as
a subsidiary of Company 2 etc. all the way down to Company 5 at the bottom of the
hierarchy. The corporate structure above the current relationship is entered in the
relationship records added for the "is a subsidiary of" relationship (Company 2 is a
subsidiary of Company 1, Company 3 is a subsidiary of Company 2 etc.).

The "is a subsidiary" relationship added for Company 5 (located at the bottom of
the hierarchy) contains links to all "is a subsidiary" relationships in the hierarchy in
the PB_X_StaNo/SerNo fields. PB_5_StaNo/SerNo contain the station number and
serial number of the "is a subsidiary" relationship added for Company 5 (Company
5 is a subsidiary of Company 4); PB_4_StaNo/SerNo contain the station number
and serial number of the "is a subsidiary" relationship for Company 4 (Company 4
is a subsidiary of Company 3) etc.
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If you make changes to the records in the Relationship Level info area, including
enabling the Relationship hierarchy check box, you can update the corporate
structure automatically. If you disabled the Relationship hierarchy check box in a
relationship level record used by the corporate structure and update the corporate
structure, the entries in the PB_1_StaNo/SerNo-PB_10_StaNo/SerNo fields are
deleted. If you delete a node (relationship record) in the corporate hierarchy that
has child nodes, the child nodes immediately below the deleted records become the
root nodes of new corporate hierarchies.

To update the corporate structure automatically:

• Aurea CRM win: Select Generate Relationship Hierarchy from the context menu
in the Relationship Level info area.

• Aurea CRM web: Use a CRM.server To-Do (type 9), see To-Do Types in the
CRM.core Administrator Guide.

Note: Note: The PB_X_StaNo/SerNo fields are not communicated and are
recalculated when inputting the communication file. The same applies when importing
records.By default, updating the corporate structure does not initiate any triggers
defined for the Relationship info area and the records’ time stamps are not
updated.The corporate structure can be displayed graphically in a relationship
network, see HierarchicalCircleOfInfluence in the Aurea CRM web Administrator
Guide.

OTC with Aurea CRM LSI
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If you migrate an existing OTC installation to Aurea CRM LSI, the business logic of
the Relationship and Relationship type fields in the Relationship level and Rela-
tionship info areas are reversed.

Corporate Structure Links

Aurea CRM offers indirect links (via the Relationship info area) that can be used
to defined queries applied to the corporate structure, for example.

Links 950-980 and 30000-36000 are available by default and apply to all relationships
used to define corporate structures (irrespective of the type of relationship), see
Link IDs in the CRM.core Administrator Guide.

Indirect links (using the corporate structure) for companies and persons
(FI/KP/PE/CP) applied to their child info areas:

• 30000: Returns the entire corporate structure

• 32000: Returns all companies and persons higher up in the hierarchy

• 34000: Returns all companies and persons lower down in the hierarchy

• 36000: Returns all companies and persons both higher up and lower down in the
hierarchy

The following image outlines the difference between links 30000 and 36000. This
also applies to the 950 and 980 indirect links.

Example: The corporate structure is defined for five companies. The current rep is
entered in the Rep 1 field of Company 2 (C2). An offer exists for each company.

Define a query that returns all offers stored for companies where the current rep is
entered (in this case Company 2), as well as all offers stored for companies that
are linked to companies where the rep is entered via the corporate structure.

Link 32000 returns the offers for companies 1, 2 and 5.
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Link 34000 returns all offers for companies 2 and 5; link 30000 returns the offers
for all companies and link 36000 returns the offers for companies 1, 2 and 5.

You can define variables of the Type "Condition" to define additional links using
your own condition. You can define up to 10 different conditions for corporate
structures using the 30000-130000 links. These links are numbered in intervals of
10,000 and are named (in Aurea CRM win) according to the relationship type (e.g.
supplier, corporate).

You can define the following 10 variables:
CORE::INDIRECT-PB-LINK-TREE-0

(this variable fur ther restricts the default links 30000-36000)
CORE::INDIRECT-PB-LINK-TREE-1

...

CORE::INDIRECT-PB-LINK-TREE-9

Example: Define the variable
CORE::INDIRECT-PB-LINK-TREE-1

in Aurea CRM win. Select the Relationship info area in the Info Area field, the
Relationship type field in the Field Name field and "Condition" in the Type field.
Add a variable value for the variable and enter the comparison field and desired
relationship type in the Var. Text field, e.g. "Corporate".
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If you define conditional access rights for the Company info area in the Right
module in Aurea CRM win and apply conditions to the Company info area, you can
select the default indirect links and the links that only apply to the relationship type
used to define the corporate structure in the Index Relationship column. For exam-
ple, this allows you to determine that a rep can access all Dutch companies as well
as any subsidiaries of those Dutch companies where a corporate relationship has
been defined.
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Note: Note: For more information on variables, >> Variables in the CRM.core
Administrator Guide.You can also use indirect to define conditional access to
companies and persons’ child info areas, see Conditions Applied via Indirect Links
in the CRM.core Administrator Guide.

OTC with Aurea CRM LSI
If you migrate an existing OTC installation to Aurea CRM LSI, the business logic of
the Relationship and Relationship type fields in the Relationship level and Rela-
tionship info areas are reversed.

Corporate Structure Links
Aurea CRM offers indirect links (via the Relationship info area) that can be used
to defined queries applied to the corporate structure, for example.

Links 950-980 and 30000-36000 are available by default and apply to all relationships
used to define corporate structures (irrespective of the type of relationship), >> Link
IDs in the CRM.core Administrator Guide.

Indirect links (using the corporate structure) for companies and persons
(FI/KP/PE/CP) applied to their child info areas:

• 30000: Returns the entire corporate structure

• 32000: Returns all companies and persons higher up in the hierarchy

• 34000: Returns all companies and persons lower down in the hierarchy

• 36000: Returns all companies and persons both higher up and lower down in the
hierarchy

The following image outlines the difference between links 30000 and 36000. This
also applies to the 950 and 980 indirect links.
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Example: The corporate structure is defined for five companies. The current rep is
entered in the Rep 1 field of Company 2 (C2). An offer exists for each company.

Define a query that returns all offers stored for companies where the current rep is
entered (in this case Company 2), as well as all offers stored for companies that
are linked to companies where the rep is entered via the corporate structure.

Link 32000 returns the offers for companies 1, 2 and 5.
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Link 34000 returns all offers for companies 2 and 5; link 30000 returns the offers
for all companies and link 36000 returns the offers for companies 1, 2 and 5.

You can define variables of the Type "Condition" to define additional links using
your own condition. You can define up to 10 different conditions for corporate
structures using the 30000-130000 links. These links are numbered in intervals of
10,000 and are named (in Aurea CRM win) according to the relationship type (e.g.
supplier, corporate).

You can define the following 10 variables:

CORE::INDIRECT-PB-LINK-TREE-0

(this variable fur ther restricts the default links 30000-36000)

CORE::INDIRECT-PB-LINK-TREE-1

...

CORE::INDIRECT-PB-LINK-TREE-9

Example: Define the variable
CORE::INDIRECT-PB-LINK-TREE-1

in Aurea CRM win. Select the Relationship info area in the Info Area field, the
Relationship type field in the Field Name field and "Condition" in the Type field.
Add a variable value for the variable and enter the comparison field and desired
relationship type in the Var. Text field, e.g. "Corporate".
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If you define conditional access rights for the Company info area in the Right
module in Aurea CRM win and apply conditions to the Company info area, you can
select the default indirect links and the links that only apply to the relationship type
used to define the corporate structure in the Index Relationship column. For exam-
ple, this allows you to determine that a rep can access all Dutch companies as well
as any subsidiaries of those Dutch companies where a corporate relationship has
been defined.
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Note: Note: For more information on variables, >> Variables in the CRM.core
Administrator Guide.You can also use indirect to define conditional access to
companies and persons’ child info areas, >> Conditions Applied via Indirect Links
in the CRM.core Administrator Guide.

Affiliation View
The affiliation view allows you to display data concerning other customers that are
flagged as being affiliated with the current customer.

By default, only child data added for the current customer (person, company) is
displayed. For example, you can display activities for both the current person and
all affiliated persons, or also display activities for the subsidiaries of a company.

Click on  and select Affiliation View to enable the affiliation view globally (indi-
cated by a tick in the check box). Aurea CRM web stores this setting between ses-
sions.

Note: Note: For more information on relationships and activating the affiliation
view, refer to the Aurea CRM web Administrator Guide (Affiliation View chapter)
and the CRM.core Administrator Guide. Use the Applies to the following info
areas configuration entry (Affiliations category) to determine the info areas that
can display records in the affiliation view.

Note: You can define filters to restrict which data is displayed, see Select Affiliates
(Button and Dialog) in the Aurea CRM web Administrator Guide.

Note: When defining a query, you can enable the Include Affiliations option to
include records stored for affiliates in the results. If the status of the check box is
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, records stored for affiliates are included in the results if the Affiliation View
check box is enabled in the main menu. When defining a query, pay attention to the
fact that the order of the SQL statements (queries applied to info areas) affects
the results. If company B is affiliated with company A, and you define a query applied
to the activities of company A (Include Affiliations is enabled), it makes a difference
whether the query is first applied to FI or MA records. In the first case, all activities
stored for companies A and B (affiliated companies) are returned; in the second
case, only the activities stored for company A are returned (MA is a child info area
and thus not par t of the affiliation).

Note:  If you define affiliates for a company or person, the Affiliate check box is
enabled in the relationship records where the relationship between the two entities
is defined. When applying queries to affiliates, the system checks whether this field
is enabled by applying a condition to it. You can also define that a different field
should be used, see Alternative Condition for Affiliation View in the Aurea CRM web
Administrator Guide.

Example:

Tickets displayed for a customer in the default view:

Tickets displayed for a customer in the affiliation view, including tickets added for
all affiliates.

The affiliation view is available in lists, queries, the timeline and the tree view.

Note: Note: The affiliation view only displays data stored for records that are direct
affiliates of the current record. In other words, when displaying data for companies
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in a hierarchy, only the records added for a direct subsidiary are displayed, not
records stored for any sub-subsidiaries. If you define affiliates to be displayed in
the affiliation view of a customer (Select Affiliates button), these settings are visible
to all users.

Note: Your administrator can configure that only information on parent records is
displayed in the affiliation view (e.g. when viewing activities, the company the activity
was added for), see Extended Options (showOnlyForAffiliations) in the Aurea CRM
web Administrator Guide.

To determine which customers are displayed in the affiliation view:

1. Switch to the desired customer.

2. Click on  (Select Affiliates).

All customers where a relationship with the current customer has been defined
are displayed graphically in a relationship network.

Move the mouse cursor over a connecting line to display the type of relationship.

3. Click on a node to select it and click on Add to Affiliation or Remove from
Affiliation to define whether the corresponding record is an affiliate of the current
customer.

You can select more than one node (Ctrl + Click).

Affiliates are highlighted in orange. Hover the mouse cursor over a node to display
whether that company or person is defined as an affiliate.

4. Click on Close to close the view.

Select Close & Refresh to close the view and refresh the display to include data
stored for the selected affiliates.

Relationship and Affiliation View Links
Aurea CRM includes indirect links that can be used to query data in child info areas
for companies and persons that are linked via a relationship.

For example, you can define a query that returns all activities stored for the members
of a family.

The following indirect links exist from companies/persons (FI/KP/PE/CP), and can
be used to query child info areas based on relationships (PB):

The following links are available from the Relationship (PB) info area to all info
areas that include an indexed link to the Company (FI) and/or Person (PE) info
areas:
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For a more detailed description of the available links, see Affiliations and Link IDs
in the CRM.core Administrator Guide.

Examples:

The relationship "is a parent of" is defined between a mother and her three children.
A reciprocal relationship ("is a child of") is defined for her two daughters, but not
for her son. The son and one of the daughters are defined as affiliates of the
mother. An activity has been added for each family member.

A query using link ID 24000 applied to the mother returns the activities of all family
members.

A query using link ID 28000 applied to the mother returns the activities of all family
members where a (reciprocal) relationship has been defined from the family member
to the mother.

259AUREA CONFIDENTIAL

Relationship and Affiliation View Links

https://help.aurea.com/crm/crm-core-admin-guide/crm-core-admin-guide/dita/topics/c_core_admin-4_1_2_2-Affiliations_crm.html
https://help.aurea.com/crm/crm-web-administrator-guide/crm-web-administrator-guide/dita/topics/c_crm_webAdmin-1_4_8-Link-IDs_crm.html


A query using link ID 26000 applied to the mother returns the activities of all family
members that are also defined as affiliates (Affiliate is enabled in the relationship
record).

A query applied to the relationship "is a parent of" using link ID 900 returns all ac-
tivities linked to the source record once for each relationship.
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A query applied to the relationship "is a parent of" using link ID 920 returns all ac-
tivities linked to the target record in the relationship record.

Portfolios
Portfolios allow you to classify your customers by answering a series of questions.

Customer classifications help you define your customer strategy.
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A portfolio consists of a questionnaire. The questions in the questionnaire are
weighted and the results are displayed graphically.

Portfolio Configuration

Use the Portfolio Configuration info area to determine how many rows and columns
(X and Y axes) your por tfolio contains. The sum total of all column widths and row
heights should be 100%. If the sum total is less than 100%, the columns and rows
are increased accordingly; if the value is above 100%, additional columns and rows
are not displayed.

You can assign a color to each sector. If you do not assign any colors, colors are
assigned by the system (up to 20). If your por tfolio contains more than 20 sectors,
the colors are reused.

To add a new portfolio configuration:

Click on  (Administration) > Portfolio Configuration.

1. Click on Start Search and then on  (New).

2. Enter the name of the portfolio configuration in the Text field.

3. Enter the number of columns and rows in the portfolio, which determines the total
number of sectors (columns x rows).

4. Enter the column width and row height. Enter the widths and heights as
percentages using a semicolon (;) to separate the value for each column/row.
You can use either ‘.’ or ‘,’ as the decimal separator.

5. Save the record.

Defining Portfolios

To define a por tfolio:

1. Select  (Administration) > Portfolio.

2. Start the search and click on  (New) in the search results’ header.

3. Select the type of por tfolio you want to add.

4. Click on  (Add/Find Catalog Values) next to the Portfolio field. The Find or
Add Catalog Value window opens.

5. Enter a name for the portfolio and click on New.

6. Select a Portfolio Configuration.

7. Enter a description for the X-axis in the Potential description field and a
description of the Y-axis in the Customer intimacy description field.

8. Enter an Info Area Code and Field Number to determine that the classification
determined using the portfolio is written to the corresponding field.

Note: Note: By default, the first character in the Classification field of the
portfolio sector description is transferred to the ABC field in the record from which
the portfolio was accessed. If you enter an Info Area Code and Field Number,
the value in the Classification field is entered in the selected field instead.
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Whether the entire description or only a por tion is entered in the target field
depends on the length of the target field.

Note: When transferring the result of a por tfolio to a field in the Person (PE),
Person in Company (KP) or Contact Person (CP) info areas the following applies:

Note:  If no generic link is entered in the survey (U1) and the survey is linked to
the info area the result should be entered in (Person (PE), Person in Company
(KP) or Contact Person (CP)), the result is written to the specified field.

Note: The result of the portfolio is also updated in the Person (PE) info area if
the survey is linked to a company (FI) and Person (PE).

9. Save the record.

10.Define the sector descriptions:

a. Click on Portfolio sector description and then on  (New).

b. Enter the column and row number of the sector the description applies to (e.g.
if you have 4 sectors, row 1/column 1 is the bottom left sector; row 2/column
2 is the top right sector).

c. Enter a text in the Name field that is displayed in the portfolio’s legend. Enter
a text in the Classification field that is displayed in the sector itself. Enter a
text in the Result field that is displayed to the right of the sectors.

11.Click on Questions in the tree and define the questions and answers in the
portfolio.

Assigning Portfolios and Classifying Customers

To assign a portfolio to a record:

1. Switch to the desired record (e.g. a company or opportunity).

2. Select New > New Portfolio from the context menu.

3. Search for and select the desired portfolio.

The sectors defined in the portfolio are displayed in the top area, the questions
in the portfolio are displayed in the lower area (including any sections if sections
are defined in the portfolio):
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4. Answer the questions. The white circle in the sector overview moves to the
appropriate sector depending on your answers.

If the questionnaire includes mandatory questions, click on Show mandatory
questions only to restrict the questions displayed to only the mandatory questions.
Click on Summary to display a summary of the answers to questions that have
been answered.

5. Save.

6. The result is written to the ABC field in the record the portfolio was star ted from
(or another field if defined in the portfolio).
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Portfolio Configuration
Use the Portfolio Configuration info area to determine how many rows and columns
(X and Y axes) your por tfolio contains. The sum total of all column widths and row
heights should be 100%. If the sum total is less than 100%, the columns and rows
are increased accordingly; if the value is above 100%, additional columns and rows
are not displayed.

You can assign a color to each sector. If you do not assign any colors, colors are
assigned by the system (up to 20). If your por tfolio contains more than 20 sectors,
the colors are reused.

To add a new portfolio configuration:

Click on  (Administration) > Portfolio Configuration.

1. Click on Start Search and then on  (New).

2. Enter the name of the portfolio configuration in the Text field.

3. Enter the number of columns and rows in the portfolio, which determines the total
number of sectors (columns x rows).

4. Enter the column width and row height. Enter the widths and heights as
percentages using a semicolon (;) to separate the value for each column/row.
You can use either ‘.’ or ‘,’ as the decimal separator.

5. Save the record.

Defining Portfolios
To define a por tfolio:

1. Select  (Administration) > Portfolio.

2. Start the search and click on  (New) in the search results’ header.

3. Select the type of por tfolio you want to add.

4. Click on  (Add/Find Catalog Values) next to the Portfolio field. The Find or
Add Catalog Value window opens.

5. Enter a name for the portfolio and click on New.

6. Select a Portfolio Configuration.

7. Enter a description for the X-axis in the Potential description field and a
description of the Y-axis in the Customer intimacy description field.

8. Enter an Info Area Code and Field Number to determine that the classification
determined using the portfolio is written to the corresponding field.
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Note: Note: By default, the first character in the Classification field of the
portfolio sector description is transferred to the ABC field in the record from which
the portfolio was accessed. If you enter an Info Area Code and Field Number,
the value in the Classification field is entered in the selected field instead.
Whether the entire description or only a por tion is entered in the target field
depends on the length of the target field.

Note: When transferring the result of a por tfolio to a field in the Person (PE),
Person in Company (KP) or Contact Person (CP) info areas the following applies:

Note:  If no generic link is entered in the survey (U1) and the survey is linked to
the info area the result should be entered in (Person (PE), Person in Company
(KP) or Contact Person (CP)), the result is written to the specified field.

Note: The result of the portfolio is also updated in the Person (PE) info area if
the survey is linked to a company (FI) and Person (PE).

9. Save the record.

10.Define the sector descriptions:

a. Click on Portfolio sector description and then on  (New).

b. Enter the column and row number of the sector the description applies to (e.g.
if you have 4 sectors, row 1/column 1 is the bottom left sector; row 2/column
2 is the top right sector).

c. Enter a text in the Name field that is displayed in the portfolio’s legend. Enter
a text in the Classification field that is displayed in the sector itself. Enter a
text in the Result field that is displayed to the right of the sectors.

11.Click on Questions in the tree and define the questions and answers in the
portfolio.
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Assigning Portfolios and Classifying Customers
To assign a portfolio to a record:

1. Switch to the desired record (e.g. a company or opportunity).

2. Select New > New Portfolio from the context menu.

3. Search for and select the desired portfolio.

The sectors defined in the portfolio are displayed in the top area, the questions
in the portfolio are displayed in the lower area (including any sections if sections
are defined in the portfolio):
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4. Answer the questions. The white circle in the sector overview moves to the
appropriate sector depending on your answers.

If the questionnaire includes mandatory questions, click on Show mandatory
questions only to restrict the questions displayed to only the mandatory questions.
Click on Summary to display a summary of the answers to questions that have
been answered.

5. Save.

6. The result is written to to the ABC field in the record the portfolio was star ted
from (or another field if defined in the portfolio).

Miscellaneous
Miscellaneous info areas are not accessible in the default version of Aurea CRM
web. Your administrator can however add these info areas to your Aurea CRM web
configuration.

City/Country

When adding companies or persons (PE/KP), the city and telephone codes are en-
tered automatically once you have entered a country and postal code based on the
entries in the City info area.

Records can be added to the City info area as follows:

• When adding a new company or person: if no matching entry is found in the City
info area, a new record is added to the City info area.

• By importing data

• By manually adding new records in the City info area (Service module)

Country's international dialing codes are stored in the Country table.

Lead Status

The Lead Status info area logs how long a company or person was classified with
a specific lead status, which rep classified them and why their classification was
changed. This provides you with valuable information, e.g. on the effect of advertising
campaigns.

Whenever a new company, person or sales group record is added or their lead status
is changed (Lead Status field), a new record is added to the Lead Status info area.
When adding or changing the status in a sales group record, the Product Group is
also transferred to the Lead Status info area.

Depending on the status of the Product Group field, the Lead Status info area logs
changes to the following:
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Changes to the lead status of a company or personProduct Group is empty

Changes to the status of a sales groupProduct Group contains a
value

You can also add, edit or delete records in the Lead Status info area directly.

Note: Note: Your administrator can configure that changes to the Lead Status
field in the Company, Person and Sales Group info areas are not logged in the
Lead Status info area, or that the window asking for a reason for a change is not
displayed, see CRM.core Administrator Guide.

Example:

A company’s Lead Status is set to "Interest".

After talking with a representative of the company, you assume that you can conclude
a deal. As a result, you change the lead status to "Lead". The "mood thermometer"
rises.

Enter a reason for the change or select a reason from the Reason catalog (Aurea
CRM win only).

The new lead status is entered in the Lead Status info area and the length of time
the lead status was set to the previous value is calculated.

Specialization

The Field, Occupation and Share fields in the Specialization info area are used
to store a person's fields of expertise and what share of their entire workload is
spent completing tasks related to their specialization.

Departments

You can define departments in the Department info area, and assign employees at
a company to a department using the Department field in the person in company
record. The number of employees entered in a department record is generally
higher than the number of persons in your database assigned to the department,
as not all employees is among your contact persons.

City/Country
When adding companies or persons (PE/KP), the city and telephone codes are en-
tered automatically once you have entered a country and postal code based on the
entries in the City info area.

Records can be added to the City info area as follows:

• When adding a new company or person: if no matching entry is found in the City
info area, a new record is added to the City info area.

• By importing data

• By manually adding new records in the City info area (Service module)
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Country's international dialing codes are stored in the Country table.

Lead Status
The Lead Status info area logs how long a company or person was classified with
a specific lead status, which rep classified them and why their classification was
changed. This provides you with valuable information, e.g. on the effect of advertising
campaigns.

Whenever a new company, person or sales group record is added or their lead status
is changed (Lead Status field), a new record is added to the Lead Status info area.
When adding or changing the status in a sales group record, the Product Group is
also transferred to the Lead Status info area.

Depending on the status of the Product Group field, the Lead Status info area logs
changes to the following:

Changes to the lead status of a company or personProduct Group is empty

Changes to the status of a sales groupProduct Group contains a
value

You can also add, edit or delete records in the Lead Status info area directly.

Note: Note: Your administrator can configure that changes to the Lead Status
field in the Company, Person and Sales Group info areas are not logged in the
Lead Status info area, or that the window asking for a reason for a change is not
displayed, >> CRM.core Administrator Guide.

Example:

A company’s Lead Status is set to "Interest".

After talking with a representative of the company, you assume that you will conclude
a deal. As a result, you change the lead status to "Lead". The "mood thermometer"
rises.

Enter a reason for the change or select a reason from the Reason catalog (Aurea
CRM win only).

The new lead status is entered in the Lead Status info area and the length of time
the lead status was set to the previous value is calculated.

Specialization
The Field, Occupation and Share fields in the Specialization info area are used
to store a person's fields of expertise and what share of their entire workload is
spent completing tasks related to their specialization.
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Departments
You can define departments in the Department info area, and assign employees at
a company to a department using the Department field in the person in company
record. The number of employees entered in a department record is generally
higher than the number of persons in your database assigned to the department,
as not all employees will be among your contact persons.
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3
Appointment Management

Appointment Management
Appointment management supports you in collaborating efficiently within your
company and with your customers.

Below is the list of tasks you can perfrom with appointment management:

• Display an overview of your appointments in the calendar.

• Display, edit and delete appointments.

• Use filters to determine which appointments are displayed in the calendar.

• Handle conflicting appointments.

• Send and reply to e-mails from appointments.

• Store information such as absences.

• Use tasks, reminders and To-Dos to structure your work.

• Schedule customer visits in the daily and weekly planning view.

• Display the availability of reps in the resource view.

Calendar
Use the calendar to display activities, tasks, absences and To-Dos.

To open the calendar:

1. Select  (Collaboration) > Calendar.
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• Different types of appointment are indicated using different icons (for telephone

calls, visits etc.). Click on  (Edit Settings) to determine how appointments are
color-coded (e.g. by type or rep).

• Click on  (Legend) to display an overview of the color-coding in the calendar.

• Private activities (i.e. where the Private field is enabled) are indicated with the
 icon.

• Click on the entries in the header to determine whether to display a Day, Work
Week, full Week or Month in the calendar.

• The orange cursor in the time bar indicates the current time.

• Appointments lasting all day or spanning several days are displayed in a bar at
the top of the calendar (below the date).
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• Concurrent appointments cannot be displayed in the calendar’s week view. Click
on "..." to display these appointments in a new window.

• Only a limited number of appointments can be displayed per day in the monthly
view. Click on + x more to display all the appointments in a separate window.

• If appointments have been entered that cannot be displayed in the visible area,
the following icon is displayed at the bottom edge of the visible area:

• You can display your most important appointments (e.g. your next 5 activities or

To-Dos) in the sidebar. Click on  (Settings) > User Configuration to select
which items to display in the sidebar (Activities tab). Your administrator can
determine how many records are displayed.

• You can filter the records displayed in the calendar to only display those you
require.

Note:  In order to display To-Dos in the calendar, you need to enable the Calendar
check box in the To-Do record.

• You can display or hide the sidebar
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• Holidays are color-coded. To determine which holiday calendar you wish to use,

click on  (Settings) > User Configuration.

• If the time zone used by your device is changed (automatically or manually), you
can determine that Aurea CRM takes the current time zone into account (provided
you have the necessary access rights). You need to close and restar t your web
browser to display the new time zone in the calendar.

Navigating in the Calendar

You can navigate in the calendar using the following options:

• Use the arrows to switch between pages in the calendar:

• You can use the calendar in the sidebar to:

• Click on a day to switch the view to just that day.

• Click on a calendar week to display that work week.

• Click on the month or year and select an entry from the drop-down list update
the calendar accordingly (the view type remains unchanged).

• Use the arrows to move forward or back one month

• When in the day view, hold down Ctrl and click on days in the calendar to
display multiple days at once.

• Click on Today to display the current date in the day view.

• Click on  (Daily & Weekly Planning) to open the daily and weekly planner.
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Adding Appointments

To add a new appointment:

1. Select  (Collaboration) > New Activity, New Absence or New Task from
the menu.

2. When adding an activity, select the company or person you wish to add the activity
for.

3. Enter the necessary data and save.

To add a new appointment in the calendar:

1. Double-click on a free time slot in the calendar or click on a free time slot and
click on New Calendar Entry.

2. Select whether to add a new activity, absence or task, or to add a new activity
for yourself, your company or the last company/person you viewed.

3. When adding an activity, select the company or person to add the activity for.

4. Enter the details and save.

Note:  If the system is configured to check for conflicting appointments, the
appointment planning area is displayed if an activity or absence conflicts with an
existing appointment. Your administrator can determine which types of appointments
are checked for conflicts.

You can also add an activity for yourself as follows:

1. Switch to the day, work week or week view in the calendar.

2. Click on a free time slot in the calendar. A quarter hour period is highlighted in
gray.

3. Start typing to enter a subject for the activity and confirm your entry with Enter.
The appointment is added, and you are automatically entered as the rep.

Opening Appointments

To open an appointment:

• Double-click on an appointment to open it in tabbed view.

• Click on the appointment’s icon to open it in a popup window.
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• Select Tab View from the menu in the popup window to open the record in tabbed
view.

• You can also open appointments in the sidebar by clicking on their icon.

• You can reschedule appointments by dragging the appointment to the desired
time (in all views except the month view) or to the desired date (in all views except
the day view). Drag the top or bottom edge of the appointment to change the
length of the appointment not available in the month view.

Editing Appointments

Edit an appointment by entering the desired data in the fields.

To delete an appointment:

• Select the appointment in the calendar and press the Delete key on your keyboard.
Hold down Ctrl while clicking to select multiple appointments to delete at once.

• Select Delete from the context menu.

Navigating in the Calendar
You can navigate in the calendar using the following options:

• Use the arrows to switch between pages in the calendar:

• You can use the calendar in the sidebar to:

• Click on a day to switch the view to just that day.

• Click on a calendar week to display that work week.

• Click on the month or year and select an entry from the drop-down list update
the calendar accordingly (the view type remains unchanged).
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• Use the arrows to move forward or back one month

• When in the day view, hold down Ctrl and click on days in the calendar to
display multiple days at once.

• Click on Today to display the current date in the day view.

• Click on  (Daily & Weekly Planning) to open the daily and weekly planner.

Adding Appointments
To add a new appointment:

1. Select  (Collaboration) > New Activity, New Absence or New Task from
the menu.

2. When adding an activity, select the company or person you wish to add the activity
for.

3. Enter the necessary data and save.

To add a new appointment in the calendar:

1. Double-click on a free time slot in the calendar or click on a free time slot and
click on New Calendar Entry.

2. Select whether to add a new activity, absence or task, or to add a new activity
for yourself, your company or the last company/person you viewed, >> on page
144.
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3. When adding an activity, select the company or person to add the activity for.

4. Enter the details and save.

Note: Note: If the system is configured to check for conflicting appointments, the
appointment planning area is displayed if an activity or absence conflicts with an
existing appointment, >> on page 144. Your administrator can determine which types
of appointments are checked for conflicts.

You can also add an activity for yourself as follows:

1. Switch to the day, work week or week view in the calendar.

2. Click on a free time slot in the calendar.

A quarter hour period is highlighted in gray.

3. Start typing to enter a subject for the activity and confirm your entry with Enter.

The appointment is added, and you are automatically entered as the rep.

Opening Appointments
To open an appointment:

• Double-click on an appointment to open it in tabbed view.

• Click on the appointment’s icon to open it in a popup window.

• Select Tab View from the menu in the popup window to open the record in tabbed
view.

• You can also open appointments in in the sidebar by clicking on their icon.

• You can reschedule appointments by dragging the appointment to the desired
time (in all views except the month view) or to the desired date (in all views except
the day view). Drag the top or bottom edge of the appointment to change the
length of the appointment (not available in the month view).
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Editing Appointments
Edit an appointment by entering the desired data in the fields. For more details, >>
on page 144 and the online field help.

To delete an appointment:

• Select the appointment in the calendar and press the Delete key on your keyboard.
Hold down Ctrl while clicking to select multiple appointments to delete at once.

• Select Delete from the context menu.

Filtering Appointments
Use filters to determine which appointments are displayed in the calendar.

To filter the calendar entries, select a general or rep filter from the drop-down lists
in the sidebar to restrict the display to only those appointments that meet the filter
criteria or where the selected reps are entered:

Defining General Filters

To define a filter:

1. Click on  (Define Filters and Filter Sets) in the sidebar. The Define Filters
and Filter Sets window is displayed.

2. Enable the check box next to the entries you wish to display in the calendar.

3. Select Edit Filter from the context menu next to an entry to define a condition
that needs to be met by entries of that type for them to be displayed in the
calendar.

4. To save your selection to be reused later, enter a name in the Rep Set field and
click on Save. The filter set is saved.

Note: The first value in the drop-down list has no name; however you can select
this entry and change its settings. Changes made to this entry are saved
automatically. To delete a filter set, select the desired filter from the drop-down

list, click on  (Define Filters and Filter Sets) and then click on Delete.

5. Click on OK.
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Defining Rep Filters

To define a rep filter:

1. Click on  (Reps and Rep Groups) in the sidebar. The Reps and Rep Groups
window is displayed.

2. Enable the check boxes next to the reps or groups whose appointments should
be displayed.

3. To add additional reps to the list:

a. Click on Add/Remove Reps.

The Select Rep window is displayed.

b. Select the desired rep and click on OK.

4. To save your selection to be reused later, enter a name in the Rep Set field and
click on Save.

The rep set is saved.

Note: Note: The first value in the drop-down list has no name; however you can
select this entry and change its settings. Changes made to this entry are saved
automatically. To delete a rep filter set, select the desired filter from the drop-down
list, click on  (Reps and Rep Groups) and then click on Delete.

5. Click on OK.

Defining General Filters
To define a filter:

1. Click on  (Define Filters and Filter Sets) in the sidebar.
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The Define Filters and Filter Sets window is displayed.

2. Enable the check box next to the entries you wish to display in the calendar.

3. Select Edit Filter from the context menu next to an entry to define a condition
that needs to be met by entries of that type for them to be displayed in the
calendar, >> on page 84.

4. To save your selection to be reused later, enter a name in the Rep Set field and
click on Save.

The filter set is saved.

Note: Note: The first value in the drop-down list has no name; however you can
select this entry and change its settings. Changes made to this entry are saved
automatically.To delete a filter set, select the desired filter from the drop-down

list, click on  (Define Filters and Filter Sets) and then click on Delete.

5. Click on OK.

Defining Rep Filters
To define a rep filter:

1. Click on  (Reps and Rep Groups) in the sidebar.

The Reps and Rep Groups window is displayed.

2. Enable the check boxes next to the reps or groups whose appointments should
be displayed.

3. To add additional reps to the list:

a. Click on Add/Remove Reps.
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The Select Rep window is displayed, >> on page 67.

b. Select the desired rep and click on OK.

4. To save your selection to be reused later, enter a name in the Rep Set field and
click on Save.

The rep set is saved.

Note: Note: The first value in the drop-down list has no name; however you can
select this entry and change its settings. Changes made to this entry are saved
automatically.To delete a rep filter set, select the desired filter from the drop-down

list, click on  (Reps and Rep Groups) and then click on Delete.

5. Click on OK.

Appointment Planning
Learn how to plan appointments.

The appointment planning area is opened automatically if appointments conflict. To
open it manually, open an activity, switch to edit mode and click on  (Appointment
Planning). You can move the appointment in this area while taking into account the
availability of all reps.

Enable the check for conflicting appointments in the user settings. Conflicting ap-
pointments are only checked when adding activities from outside the calendar;
conflicting appointments are displayed next to one another in the calendar.

If the blue bar indicating the current appointment is covering an existing appointment,
you cannot display tooltip information for the existing appointment. Move the new
appointment to be able to display the tooltip.

Appointment Types
Learn about the different types of appointments.

Activities are used to store details regarding contact with customers.
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Tasks allow you to store tasks, e.g. what needs to be completed within the scope
of projects (which may be customer-independent).

Absence allow you to store absence, e.g. sick leave, vacations, visits to doctors.

Activities
You can add participants to activities and determine their par ticipation type and
status.

To add a reminder for an activity, enter values in the Reminder duration and Re-
minder unit fields on the Details tab.

For example, if you enter "5 Min", the reminder is displayed for all par ticipants 5
minutes before the activity is due to star t.

Adding Participants

To add participants to an activity:

1. Add internal reps as participants in the Required, Optional and For Information
fields:

• Click on Add a value and select an entry from the drop-down list:

• Or click on Add a value and begin typing the name of the rep. Aurea CRM lists
all matching reps.

• Click on  (Select Rep), to select the desired rep in a separate window. You
can then select the desired participation type from the rep’s context menu.

The selected reps are also listed under Participants below the record.

2. You can add external par ticipants to an activity under Participants below the
record. You can choose to add a company, person in company, person, a person
linked to the current company or a record in your favorites.

284AUREA CONFIDENTIAL

Chapter 3: Appointment Management



3. Save the appointment. The selected participants are listed under Participants
below the record.

The participation type is indicated with an icon:

• In the T (Type) column:  = Required,  = Optional and  = For Information

• In the S (Status) column:  = Accepted,  = Open,  = Declined,  = Not
relevant

The person or company for which the appointment was added is displayed as a
link.

4. To change the participation type and status, select the options available under
Participation Type or Participation Status in the participant’s context menu.

5. Enable the Create To-Do check box to determine that all (internal) par ticipants
should receive a To-Do, allowing them to accept or decline the invitation to the
activity. Upon accepting or declining the invitation, their par ticipation status is
updated in the list of par ticipants.

6. Save the record.

Follow-up Activities

To add a follow-up activity for an activity:

1. Select Follow-up Activity from the activity’s context menu.

2. Enter the details of the follow-up activity.

Note: Your administrator can define which field values are automatically
transferred from the previous activity.

3. Save the record. The new activity is linked to the previous activity via the
Previous/Main Activity field.

Recurring Activities

You can add recurring activities that take place at regular intervals.

You can determine the frequency (e.g. daily, weekly, monthly or yearly) in the first
activity (the main activity), from which you can then generate the remaining appoint-
ments.

Adding Recurring Activities

To add a series of recurring activities:

1. Add the first (main) activity.

2. Click on  (Recurrence).

The Appointment Recurrence window is displayed.
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3. Determine the whether the activities should recur on a Daily, Weekly, Monthly
or Yearly basis.

4. Depending on your settings, you can determine when the activity is repeated:

• Daily: The number of days before the activity is repeated.

• Weekly: The number of weeks before the activity is repeated and the day of
the week. You can select multiple weekdays.

• Monthly: The number of months before the activity is repeated; the day of the
month; the day of the week.

• Yearly: The number of years before the activity is repeated; the day and month;
the day of the week.

When repeating activities on a monthly or yearly basis, enable Do not create
substitute activities to prevent activities that would fall on a holiday or weekend
from being moved to the next work day.

5. Enable the Weekends and Holidays options if activities should also be added
on holidays or weekends.

6. Define the Series duration:

• Ends after: The number of recurring appointments after which the series ends.

• Ends on: Date on which the series should end.

7. Save the data.

The activities are generated. Recurring activities are indicated using the  icon.

Note: The following fields are not transferred from the main activity to subsequent
activities: Response 1-5 (Marketing Act.), Updated at, Updated on, Call Result,
No. Postponements, Added on StNo., Date, Result, Created on, Created at, Ext.
Calendar, Fixed, Generated, CmCd, Costs, DelCd, Response 1-5, Status, Create
To-Do, To-Do Until Date, To-Do Until Time, Escalate To-Do, Survey on,
MA_1_SerNo, MA_1_StaNo, Follow-up on, Satisfaction.
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Editing Recurring Activities

To edit activities that are par t of a series of recurring activities:

1. Edit the first activity in the series that you want to apply changes to.

2. Save the record.

You are asked whether you wish to apply your changes to just the one activity or
to the remaining activities in the series star ting from the current activity.

Note:  Fields that are not transferred from the main activity to other activities in
the series are not transferred when applying these changes.

3. Select the desired option and confirm with OK.

Displaying the Main Activity of a Series

To display the main activity of a series:

1. Select  (Collaboration) > Activities to display activities in list view and search
for an activity in the series.

2. Select Main Record in Series from the context menu. The main activity is
displayed.

Deleting Activities in a Series

To delete one or more activities that are par t of a series of recurring activities:

1. Select Delete from the activity’s context menu.

You are asked what you wish to delete:

• Just this activity

• This activity and all subsequent activities

• The entire series

Note:  If you have chosen to delete the main activity, you can only choose to
delete the entire series.

2. Choose the desired option and confirm with OK.

Editing the Recurrence Pattern

To edit the recurrence pattern of an entire series:

1. Click on  (Recurrence) in the main activity record.

2. Edit the recurrence pattern and click on Save.

The activities in the series are deleted and new activities are generated based
on the new settings. The main activity is not deleted.
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To edit the recurrence pattern for par t of a series:

1. Open the activity in the series from which point on you wish to change the
recurrence pattern.

2. Click on  (Recurrence).

3. Edit the recurrence pattern and click on Save.

A message is displayed informing you that this activity is par t of a series of activ-
ities, and you are asked if you wish to use the activity as the main activity of a
new series.

4. Click on OK.

All activities in the series following this activity are deleted and the appointments
in the series are generated anew.

Accepting or Refusing Invitations to Recurring Activities

You can only accept or refuse the entire series of appointments. The participants’
par ticipation status is stored in the main activity and displayed in the subsequent
activities.

Activities and E-mails

Sending E-mails to Participants

To send an e-mail to all an activity’s participants:

1. Enter the subject of the e-mail in the Subject field and the e-mail’s text in the
Text field in the activity.

Note: Your administrator can determine that buttons are available to format the
HTML text.

2. If configured by your administrator, click on  (Add Signature) to inser t your
e-mail signature.

3. Click on  (Send as E-mail).

The reps and external par ticipants are transferred to the e-mail's To: and Cc:
fields based on their par ticipation status (Required, Optional, For Information).

By default, no e-mail is sent to persons with no e-mail address entered. However,
your administrator can determine that an e-mail is sent to the company's e-mail
address instead if no e-mail address is entered for a person.

If your administrator has defined that e-mails are sent locally, your e-mail client
is opened. If e-mails are sent via the server, the e-mail is sent directly.

Note: Your administrator can determine that cer tain types of files or files exceeding
a cer tain size are not sent. When sending e-mails from your e-mail client, no
attachments can be added.

Notifying Reps

288AUREA CONFIDENTIAL

Chapter 3: Appointment Management



You can send an e-mail to all an activity’s internal participants, e.g. if you need
to reschedule the appointment.

To notify the reps:

1. Select Notify Recipients from the context menu of the activity.

If your administrator has determined that e-mails are sent from your e-mail client,
your e-mail client is opened. If e-mails are sent by via the Aurea CRM server, the
following window opens:

2. Enable the check boxes next to the persons you wish to notify under Recipients.

3. You can add additional recipients to the Additional internal recipients and
Additional external recipients fields.

4. The contents of the Subject and Text fields in the activity are transferred to the
e-mail, but you can still edit them in the e-mail.

5. Use the following check boxes to carry out the corresponding action: Insert Aurea
CRM web link, Insert Aurea CRM win link, Request a delivery receipt, Request
a read receipt. Your administrator is responsible for defining which options are
available.

6. If your administrator has enabled the corresponding option, click on Insert
Signature to inser t your e-mail signature.
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7. The documents linked to the activity are added as attachments.

Note: Your administrator can determine that cer tain types of files or files
exceeding a cer tain size are not sent. When sending e-mails from your e-mail
client, no attachments can be added.

8. Click on Send to send the e-mail.

Replying to E-mails

You can reply directly to activities of the type "E-mail":

1. Click on  (Reply). A follow-up activity is added. "Re:" is added to the star t of
the Subject.

2. Enter the desired text of the e-mail in the Text field.

3. If configured by your administrator, click on  (Add Signature) to inser t your
e-mail signature.

4. If desired, you can add additional recipients to the Required, Optional and For
Information fields.

5. Click on  (Send as E-mail). The e-mail is sent to all reps and companies/persons
added as participants.
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Adding Participants
To add participants to an activity:

1. Add internal reps as participants in the Required, Optional and For Information
fields:

• Click on Add a value and select an entry from the drop-down list:

• Or click on Add a value and begin typing the name of the rep. Aurea CRM lists
all matching reps.

• Click on  (Select Rep), to select the desired rep in a separate window, >> on
page 67. You can then select the desired participation type from the rep’s
context menu.

The selected reps are also listed under Participants below the record.

2. You can add external par ticipants to an activity under Participants below the
record. You can choose to add a company, person in company, person, a person
linked to the current company or a record in your favorites.

3. Save the appointment.

The selected participants are listed under Participants below the record.

The participation type is indicated with an icon:

• In the T (Type) column:  = Required,  = Optional and  = For Information

• In the S (Status) column:  = Accepted,  = Open,  = Declined,  = Not
relevant

291AUREA CONFIDENTIAL

Appointment Types



The person or company for which the appointment was added is displayed as a
link.

4. To change the participation type and status, select the options available under
Participation Type or Participation Status in the participant’s context menu.

5. Enable the Create To-Do check box to determine that all (internal) par ticipants
should receive a To-Do, allowing them to accept or decline the invitation to the
activity. Upon accepting or declining the invitation, their par ticipation status is
updated in the list of par ticipants.

6. Save the record.

Follow-up Activities
To add a follow-up activity for an activity:

1. Select Follow-up Activity from the activity’s context menu.

2. Enter the details of the follow-up activity.

Note: Note: Your administrator can define which field values are automatically
transferred from the previous activity.

3. Save the record.

The new activity is linked to the previous activity via the Previous/Main Activity
field.

Recurring Activities
You can add recurring activities that take place at regular intervals.

You can determine the frequency (e.g. daily, weekly, monthly or yearly) in the first
activity (the main activity), from which you can then generate the remaining appoint-
ments.

Adding Recurring Activities

To add a series of recurring activities:

1. Add the first (main) activity.

2. Click on  (Recurrence).

The Appointment Recurrence window is displayed.
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3. Determine the whether the activities should recur on a Daily, Weekly, Monthly
or Yearly basis.

4. Depending on your settings, you can determine when the activity is repeated:

• Daily: The number of days before the activity is repeated.

• Weekly: The number of weeks before the activity is repeated and the day of
the week. You can select multiple weekdays.

• Monthly: The number of months before the activity is repeated; the day of the
month; the day of the week.

• Yearly: The number of years before the activity is repeated; the day and month;
the day of the week.

When repeating activities on a monthly or yearly basis, enable Do not create
substitute activities to prevent activities that would fall on a holiday or weekend
from being moved to the next work day.

5. Enable the Weekends and Holidays options if activities should also be added
on holidays or weekends.

6. Define the Series duration:

• Ends after: The number of recurring appointments after which the series ends.

• Ends on: Date on which the series should end.

7. Save the data.

The activities are generated. Recurring activities are indicated using the  icon.
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Note: Note: The following fields are not transferred from the main activity to
subsequent activities: Response 1-5 (Marketing Act.), Updated at, Updated on,
Call Result, No. Postponements, Added on StNo., Date, Result, Created on,
Created at, Ext. Calendar, Fixed, Generated, CmCd, Costs, DelCd, Response
1-5, Status, Create To-Do, To-Do Until Date, To-Do Until Time, Escalate To-Do,
Survey on, MA_1_SerNo, MA_1_StaNo, Follow-up on, Satisfaction.

Editing Recurring Activities

To edit activities that are par t of a series of recurring activities:

1. Edit the first activity in the series that you want to apply changes to.

2. Save the record.

You will be asked whether you wish to apply your changes to just the one activity
or to the remaining activities in the series star ting from the current activity.

Note: Note: Fields that are not transferred from the main activity to other activities
in the series are not transferred when applying these changes.

3. Select the desired option and confirm with OK.

Displaying the Main Activity of a Series

To display the main activity of a series:

1. Select  (Collaboration) > Activities to display activities in list view and search
for an activity in the series.

2. Select Main Record in Series from the context menu.

The main activity is displayed.

Deleting Activities in a Series

To delete one or more activities that are par t of a series of recurring activities:

1. Select Delete from the activity’s context menu.

You will be asked what you wish to delete:

• Just this activity

• This activity and all subsequent activities

• The entire series
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Note: Note: If you have chosen to delete the main activity, you can only choose
to delete the entire series.

2. Choose the desired option and confirm with OK.

Editing the Recurrence Pattern

To edit the recurrence pattern of an entire series:

1. Click on  (Recurrence) in the main activity record.

2. Edit the recurrence pattern and click on Save.

The activities in the series are deleted and new activities are generated based
on the new settings. The main activity is not deleted.

To edit the recurrence pattern for par t of a series:

1. Open the activity in the series from which point on you wish to change the
recurrence pattern.

2. Click on  (Recurrence).

3. Edit the recurrence pattern and click on Save.

A message is displayed informing you that this activity is par t of a series of activ-
ities, and you are asked if you wish to use the activity as the main activity of a
new series.

4. Click on OK.

All activities in the series following this activity are deleted and the appointments
in the series are generated anew.

Accepting or Refusing Invitations to Recurring Activities

You can only accept or refuse the entire series of appointments. The participants’
par ticipation status is stored in the main activity and displayed in the subsequent
activities.

Activities and E-mails
Sending E-mails to Participants

To send an e-mail to all an activity’s participants:

1. Enter the subject of the e-mail in the Subject field and the e-mail’s text in the
Text field in the activity.
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Note: Note: Your administrator can determine that buttons are available to format
the HTML text.

2. If configured by your administrator, click on  (Add Signature) to inser t your
e-mail signature.

3. Click on  (Send as E-mail).

The reps and external par ticipants are transferred to the e-mail's To: and Cc:
fields based on their par ticipation status (Required, Optional, For Information).

By default, no e-mail is sent to persons with no e-mail address entered. However,
your administrator can determine that an e-mail is sent to the company's e-mail
address instead if no e-mail address is entered for a person.

If your administrator has defined that e-mails are sent locally, your e-mail client
is opened. If e-mails are sent via the server, the e-mail is sent directly.

Note: Note: Your administrator can determine that cer tain types of files or files
exceeding a cer tain size are not sent.When sending e-mails from your e-mail client,
no attachments can be added.

Notifying Reps

You can send an e-mail to all an activity’s internal participants, e.g. if you need
to reschedule the appointment.

To notify the reps:

1. Select Notify Recipients from the context menu of the activity.

If your administrator has determined that e-mails are sent from your e-mail client,
your e-mail client is opened. If e-mails are sent by via the Aurea CRM server, the
following window opens:
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2. Enable the check boxes next to the persons you wish to notify under Recipients.

3. You can add additional recipients to the Additional internal recipients and
Additional external recipients fields.

4. The contents of the Subject and Text fields in the activity are transferred to the
e-mail, but you can still edit them in the e-mail.

5. Use the following check boxes to carry out the corresponding action: Insert Aurea
CRM web link, Insert Aurea CRM win link, Request a delivery receipt, Request
a read receipt. Your administrator is responsible for defining which options are
available.

6. If your administrator has enabled the corresponding option, click on Insert
Signature to inser t your e-mail signature.

7. The documents linked to the activity are added as attachments.
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Note: Note: Your administrator can determine that cer tain types of files or files
exceeding a cer tain size are not sent.When sending e-mails from your e-mail
client, no attachments can be added.

8. Click on Send to send the e-mail.

Replying to E-mails

You can reply directly to activities of the type "E-mail":

1. Click on  (Reply). A follow-up activity is added. "Re:" is added to the star t of
the Subject.

2. Enter the desired text of the e-mail in the Text field.

3. If configured by your administrator, click on  (Add Signature) to inser t your
e-mail signature.

4. If desired, you can add additional recipients to the Required, Optional and For
Information fields.

5. Click on  (Send as E-mail). The e-mail is sent to all reps and companies/persons
added as participants.
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Tasks
Learn about task appointment types.

In order to organize complex tasks, you can:

• Add tasks for yourself or for (several) other reps.

• Display tasks as projects, and divide them into sub-projects, >> on page 151.

• Select New > New Reminder from the context menu to determine that all reps
entered in the task should receive a reminder prior to the star t of the task (at the
reminder’s due date and due time).

• Enable the Create To-Do check box to determine that all reps entered in the task
should receive a To-Do, allowing them to accept or decline the task.

• Enable the Escalate To-Do check box to create escalation records if not all
required participants have accepted the task by the star t of the task.

Note: Tasks can only be escalated if you are using CRM.server.

• Reschedule tasks. The reps entered in the task receive appropriate messages.

Changing the Status of a Task

If you enable the Create To-Do field in a task, and the status of the task is "Open",
a To-Do is added for all par ticipants entered in the Required field. These participants
can change the status of the task and To-Do from the task's context menu:

• Select Complete / Missed > Completed or Missed to set the Status of your
To-Do to "Completed" or "Missed". Once all par ticipants have set the status of
their To-Do to "Completed", the Status of the task is automatically set to
"Completed".

• Select Accept / Deny > Accept or Deny to set your Participation Status in the
To-Do record to "Accepted" or "Denied".

Task Hierarchy

You can group sub-tasks together in the task hierarchy by assigning a type (sub-
project, milestone etc.) and then connecting them according to the structure of your
project.

To structure a project with sub-tasks:

1. Select  (Collaboration) > New Task to add a new task and set its Type to
"Project".

2. You can add new child tasks (e.g. of the type "Sub-project") on the Sub-Tasks
tab in the Related Data area below the task record, allowing you to define the
hierarchy.
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3. Save the record and click on  (Hierarchy Tree).

4. You can use the hierarchy tree to navigate between records in the project, add
additional records from the context menu and edit sub-tasks.

Changing the Status of a Task
If you enable the Create To-Do field in a task, and the status of the task is "Open",
a To-Do is added for all par ticipants entered in the Required field. These participants
can change the status of the task and To-Do from the task's context menu:

• Select Complete / Missed > Completed or Missed to set the Status of your
To-Do to "Completed" or "Missed". Once all par ticipants have set the status of
their To-Do to "Completed", the Status of the task is automatically set to
"Completed".

• Select Accept / Deny > Accept or Deny to set your Participation Status in the
To-Do record to "Accepted" or "Denied".

Task Hierarchy
You can group sub-tasks together in the task hierarchy by assigning a type (sub-
project, milestone etc.) and then connecting them according to the structure of your
project.

To structure a project with sub-tasks:

1. Select  (Collaboration) > New Task to add a new task and set its Type to
"Project".

2. You can add new child tasks (e.g. of the type "Sub-project") on the Sub-Tasks
tab in the Related Data area below the task record, allowing you to define the
hierarchy.

3. Save the record and click on  (Hierarchy Tree).

4. You can use the hierarchy tree to navigate between records in the project, add
additional records from the context menu and edit sub-tasks.

Absences
Learn how to enable approval for absences and add reminder for it.

To determine that an absence should be approved, enable the Create To-Do check
box on the To-Do tab. The rep entered in the Approve by ID on the Details tab
receives a To-Do informing them of the absence. If the appropriate rep then approves
the absence, the status is set to "Accepted".
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To add a reminder for an absence, enter values in the Reminder duration and Re-
minder unit fields on the Details tab. For example, if you enter "5 Min", the reminder
is displayed for the rep entered in the absence 5 minutes before the star t of the
absence.

Work Orders
Use work orders to define customer-related tasks for a specific period of time.

A work order is linked to a company/person.

For example, you can create work orders for companies and persons that are called
or visited regularly and should be given specific information or documents during
these activities.

Note: Work orders are not displayed in the calendar.

Work orders can also be generated within the scope of marketing activities.

Note: Work orders can be linked to a workflow or trigger in Aurea CRM win. The
workflow/trigger can then be executed from the work order’s context men, see Rights
in the CRM.core Administrator Guide.

Note:  Select Active from the context menu in the Work Order info area in Aurea
CRM win to display all currently active work orders for the current company/person
(i.e. where the current date is between the Starts on and Ends on dates). Select
All to view all work orders for the company. Any conditions you have applied to the
Work Order info are removed if you select All or Active.

Note: The Work Order Overview info area in Aurea CRM win provides you with
an overview of all work orders and related companies/persons. You can edit and
delete work orders here. Select Load Company or Load Marketing Activity from
the context menu to switch directly to the associated company or marketing activity.

Adding a Work Order for a Company/Person

To add a work order:

1. Switch to the desired company/person.

2. Select New > New Work Order from the context menu.

3. Enter the work order’s time period (Starts on and Ends on).

4. Enter additional details on the work order.

5. To assign a work order added manually to a marketing activity, click on  next
to the  Marketing Activity field, select the desired marketing activity and confirm
with OK.
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Generating Work Orders for Marketing Activities

Work orders can also be generated within the scope of marketing activities. When
adding work orders from marketing activities, enter dates in the Work Order Start
and Work Order End fields in the Execution (Marketing Activity) info area.

When generating work orders for a marketing activity, the work orders are linked to
the marketing activity and the following fields are transferred to the work order from
either the marketing activity or execution record:

• Marketing Activity, Level, Variant (Marketing Act.)

• The Work Order Start and Work Order End are transferred to the Starts on and
Ends on fields in the work order

• Work order for group

• Priority

• Questionnaire

• Survey on

• The following fields are only relevant to Aurea CRM win:

• Work order type (empty, Workflow, Trigger),

• Work order Format (the workflow or trigger format),

• Work order document; these values are transferred to the Type,

• Format and Document 1 fields in the work order.

Adding a Work Order for a Company/Person
To add a work order:

1. Switch to the desired company/person.

2. Select New > New Work Order from the context menu.

3. Enter the work order’s time period (Starts on and Ends on).

4. Enter additional details on the work order.

5. To assign a work order added manually to a marketing activity, click on  next
to the -> Marketing Activity) field, select the desired marketing activity and
confirm with OK.

Generating Work Orders for Marketing Activities
Work orders can also be generated within the scope of marketing activities, >>  on
page 273. When adding work orders from marketing activities, enter dates in the
Work Order Start and Work Order End fields in the Execution (Marketing Activity)
info area.
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When generating work orders for a marketing activity, the work orders are linked to
the marketing activity and the following fields are transferred to the work order from
either the marketing activity or execution record:

• Marketing Activity, Level, Variant (Marketing Act.)

• The Work Order Start and Work Order End are transferred to the Starts on and
Ends on fields in the work order

• Work order for group

• Priority

• Questionnaire

• Survey on

• The following fields are only relevant to Aurea CRM win:Work order type (empty,
Workflow, Trigger), Work order Format (the workflow or trigger format), Work
order document; these values are transferred to the Type, Format and Document
1 fields in the work order.

Daily and Weekly Planning
You can use the daily and weekly planning area to plan your customer visits and
add activities.

To add an activity in the daily & weekly planning area:

1. Select  (Collaboration) > Daily & Weekly Planning, or click on  (Daily &
Weekly Planning) in the calendar. The search and calendar are displayed.

2. You can define default values for cer tain values under Activity Defaults. These
values are automatically transferred to activities you add in the daily & weekly
planning area.

These default values are only valid as long as you are in the daily & weekly
planning area. If you switch to another info area and then reopen the daily &
weekly planning area, the default values are reset.

3. To search for companies instead of persons, select Company from the drop-down
list in the header.

Note:  By default, you can search for companies or persons and account managers.
Your administrator can define additional search options, see DayWeekPlanning
in the Aurea CRM web Administrator Guide.
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4. Enter your search criteria and click on Start Search.

The search results are displayed in the results list between the search mask and
calendar.
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5. Drag the desired company or person to the desired time slot in the calendar to
add an activity. Note that you there is no visual feedback until you drag the
person/company over the calendar.

If contact times have been defined for the company or person, these times are
colored white in the calendar.

The activity is added with the activity default values your have defined. (Default
duration is one hour).

You can select multiple entries in the search results (by holding Ctrl while clicking)
and drag these to the calendar. The appointments are added one after another
(in the order in which you clicked on the records).

6. The other functions in the daily & weekly planning area (e.g. filters, switching
views) function the same as in the calendar.

7. Click on  (Calendar) to switch to the calendar.

Resources
The resource view allows you to view the workload of reps.

This makes planning activities (especially internal meetings) much easier. Reps’
absences (holidays and sick leave) are also displayed here.

To open the resource view, select  (Collaboration) > Resources.

305AUREA CONFIDENTIAL

Resources



The current date and time is indicated by a ver tical line. Holidays are color-coded.

If a rep’s working hours have been defined, this time is color-coded. The time when
no work hours have been defined including weekends is colored gray. You can
customize the resource view. You can edit the displayed activities and absences
and add new ones.

Customizing the Resource View

You can customize the resource view as follows:

• Display the sidebar if it is currently hidden by clicking on the arrow:

• To configure the time period that is displayed:

• Click on the desired day or star t of the time period in the small calendar in the
sidebar.

• Select the time period that is displayed using the slider in the header or by
clicking on the + and minus icons:

• Click on the header and drag it left or right to scroll:

• Select filters from the drop-down lists in the sidebar to determine which
reps/appointments are displayed. You can define your own filters.

Note:  At most 50 reps and 5,000 activities can be displayed. If your filters return
more reps or activities, a message is displayed informing you that not all records
can be displayed. Either refine your filter criteria or display a shorter time period.

• Select one or more reps displayed in the view (hold down Ctrl) and select Remove
Rep from the context menu to remove the rep(s) from the view.

• You can select additional criteria used to group reps from the Group reps by
drop-down list, e.g. Department (Org. Group ID field in the rep record), Country
or Skill or No grouping.

Note:  Reps of the type "Resource" are displayed within a group at the end of the
group's entries.
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• Click in the Reps column in the header to sor t the reps displayed in the resource
view.

• Click on  (Edit Settings):

• Select the Color Coding criteria used to color activities. Click on  (Legend)
to display an overview of the color-coding in the calendar.

• Determine whether you wish to Show working hours only.

• Enable the Show group column option to display reps’ groups in a separate
column.

• Enable the Show hidden items option to include those appointments whose
duration is less than the minimum duration for the selected view. These
appointments are only displayed for reference and cannot be edited in the
resource view.

Note: The time period, reps and grouping options are stored and applied again the
next time you open the resource view (including if you log off in the meantime).

Editing Activities and Absences

You can edit the activities and absences displayed as follows:

• Use the mouse to move activities or absences to a different time.

• Drag the left or right borders of an appointment to change its duration.

• Activities are displayed with a solid frame in the row of the organizer (rep):
You can drag these activities to another rep using the mouse.

Note: You cannot assign an absence to another rep.

• To delete an appointment, click on the appointment to select it and press Delete
on your keyboard.

• Double-click on an appointment to open and edit it.
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• Click on New Activity to add an activity for yourself, another rep at your company
or any participants you wish.

Private activities (i.e. where the Private field is enabled) are indicated with the
 icon.

• Use the context menu next to a rep in the list to remove a rep from the list
(Remove Rep), or to add a New Activity or New Absence for the rep.

• Hold down Ctrl while clicking to select multiple reps - you can then use the context
menu to select an option that is applied to all reps. You cannot however add
absences for multiple reps.

Customizing the Resource View
You can customize the resource view as follows:

• Display the sidebar if it is currently hidden by clicking on the arrow:

• To configure the time period that is displayed:

• Click on the desired day or star t of the time period in the small calendar in the
sidebar.

• Select the time period that is displayed using the slider in the header or by
clicking on the + and minus icons:

• Click on the header and drag it left or right to scroll:

• Select filters from the drop-down lists in the sidebar to determine which
reps/appointments are displayed. You can define your own filters.

Note: Note: At most 50 reps and 5,000 activities can be displayed. If your filters
return more reps or activities, a message is displayed informing you that not all
records can be displayed. Either refine your filter criteria or display a shorter time
period.

• Select one or more reps displayed in the view (hold down Ctrl) and select Remove
Rep from the context menu to remove the rep(s) from the view.
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• You can select additional criteria used to group reps from the Group reps by
drop-down list, e.g. Department (Org. Group ID field in the rep record), Country
or Skill or No grouping.

Note: Note: Reps of the type "Resource" are displayed within a group at the end
of the group's entries.

• Click in the Reps column in the header to sor t the reps displayed in the resource
view.

• Click on  (Edit Settings):

• Select the Color Coding criteria used to color activities. Click on  (Legend)
to display an overview of the color-coding in the calendar.

• Determine whether you wish to Show working hours only.

• Enable the Show group column option to display reps’ groups in a separate
column.

• Enable the Show hidden items option to include those appointments whose
duration is less than the minimum duration for the selected view. These
appointments are only displayed for reference and cannot be edited in the
resource view.

Note: Note: The time period, reps and grouping options are stored and applied
again the next time you open the resource view (including if you log off in the
meantime).
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Editing Activities and Absences
You can edit the activities and absences displayed as follows:

• Use the mouse to move activities or absences to a different time.

• Drag the left or right borders of an appointment to change its duration.

• Activities are displayed with a solid frame in the row of the organizer (rep):
You can drag these activities to another rep using the mouse.

Note: Note: You cannot assign an absence to another rep.

• To delete an appointment, click on the appointment to select it and press Delete
on your keyboard.

• Double-click on an appointment to open and edit it.

• Click on New Activity to add an activity for yourself, another rep at your company
or any participants you wish.

Private activities (i.e. where the Private field is enabled) are indicated with the
 icon.

• Use the context menu next to a rep in the list to remove a rep from the list
(Remove Rep), or to add a New Activity or New Absence for the rep.

• Hold down Ctrl while clicking to select multiple reps - you can then use the context
menu to select an option that is applied to all reps. You cannot however add
absences for multiple reps.

Visit Planning
You can schedule customer visits for yourself or other reps in Aurea CRM web,
helping you optimize your working week.

You can generate automatic suggestions for routes, edit the suggested route and
then automatically generate activities for the stops on your route. When generating
a route, the system takes into account your work hours and the location (geo-coor-
dinates) and contact times of your customers. Existing appointments, absences,
public holidays (defined in the calendar), visit durations (Default: 60 minutes),
breaks between visits (Default: 15 minutes) are all taken into account. You can also
take other criteria such as open work orders, the customer’s ABC classification, the
ratio of actual visits to target visits etc. into account when planning routes.

You can also plan routes manually without suggestions by adding customers to a
route. Routes you have planned manually can be optimized by Aurea CRM web.
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Routes can be planned for a single day or over several days. Only the stops on the
route on the day selected in the calendar are displayed. If you edit a route (e.g. add
customers or activities), the route is recalculated automatically.

Note: Your administrator needs to define geo-coordinates for reps, customers etc.
and reps’ work hours and customers’ contact times are only taken into account if
they are stored in Aurea CRM web. If no contact times have been entered for a
customer, activities are generated during the rep’s work hours. Saturdays and
Sundays are ignored when planning routes unless work hours have been defined
on these days for the specific rep. If no individual work hours have been entered
for the rep, the work hours are determined by the Calendar.DayStar tsAt and Calen-
dar.DayEndsAt web configuration parameters. Your administrator needs to define
two queries (Candidates and Planned) in CRM.designer. Your administrator can use
variables (Z5) to define values used to suggest visits, e.g. the duration of visits
(default: 60 minutes), the length of the break between visits (default: 15 minutes)
etc., see VisitPlanning in the Aurea CRM web Administrator Guide.Your administrator
can also define which activities (status, type) are displayed on the timeline.

Select  (Collaboration) > Visit Planning or select Visit Planning from a
company or person’s context menu to open the visit planning area.

Note:  If you open the visit planning area from a company/person, only that
customer’s activities are displayed on suggestions are only made for that
customer.When opening the visit planning area, only those activities and suggestions
are displayed for the date selected in the calendar. If more than one activity and/or
suggestion exists, the corresponding route is displayed when opening the area.

The visit planning area is divided into several areas:

311AUREA CONFIDENTIAL

Visit Planning

https://help.aurea.com/crm/crm-web-administrator-guide/crm-web-administrator-guide/dita/topics/c_crm_webAdmin-5_6_4_5-CalendarDayStartsAt_crm.html
https://help.aurea.com/crm/crm-web-administrator-guide/crm-web-administrator-guide/dita/topics/c_crm_webAdmin-5_6_4_4-CalendarDayEndsAt_crm.html
https://help.aurea.com/crm/crm-web-administrator-guide/crm-web-administrator-guide/dita/topics/c_crm_webAdmin-5_6_4_4-CalendarDayEndsAt_crm.html
https://help.aurea.com/crm/crm-web-administrator-guide/crm-web-administrator-guide/dita/topics/c_crm_webAdmin-9_35-VisitPlanning_crm.html


Map

• The location of your customers on the map are color-coded:

• Orange: The location of your customers (  companies and  persons).

• Orange circle with number ( ): Indicates several companies are display at a
single location as there is not enough room to display them all on the map. The
number indicates the number of companies at the location. Zoom in to display
the customers’ individual locations.

Click on the orange circle to display a list of all customers at that location.

• Blue ( , , ): Visits that are par t of the route (either existing
appointments in your calendar or suggestions). The number indicates the order
in which customers are visited. The house icon indicates the star t of the route
and the flag the end.

Activities and suggestions are only displayed for the date selected in the calen-
dar.

• Violet ( ): Customers originally suggested in the route, but that you have
manually removed from the route.

• Gray ( ): Customers that are either par t of a route or suggested as part of
a route on another day.

• The currently selected location is indicated by a circle below the pin ( ).

• Click on a pin or a customer in the list if multiple customers are grouped at the
same location. Information on the customer and the activity/suggestion is displayed
below the mini calendar. The activity/suggestion is highlighted in the timeline (if
it exists).

• Click on a location on the map or click on  (Show Menu) in the list of customers
at a location to open the context menu. Select Add to Route or Remove from
Route to add the customer to the route or remove them from it. Select Edit to
edit the corresponding visit suggestion.

Note:  If you add a customer to a route or remove a customer, the star t and end
time of existing suggestions are not updated. Click on Optimize to recalculate
the route.

• Messages, e.g. concerning long idle times, exceeded travel times, conflicting
appointments and appointments outside of work hours or on holidays are displayed
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and highlighted with an icon according to severity (  (information),  (warning),

 (error)). These messages are either displayed on the route between two
locations, or at the star ting location if the message applies to the star ting location.
Click on an icon to display the message. The record the message applies to is
highlighted in the timeline.

Sidebar

• Use  to display or hide the sidebar.

• Select a date in the mini calendar to display the route on the selected date or to
plan a route on that date.

• To generate visit suggestions:

1. Click on  (New Suggestions) below the calendar.

A window is opened where you can define the settings used to generate the
suggested route.

2. Choose where to star t the route from (Home, Office, Last Visit) and the star t
and end date (by default, the star t and end date are the same). If the route
spans several days, determine where the route should star t from on the
subsequent days (Last Visit star ts the next day from the location of the last
visit on the previous day).

3. Click on Create Suggested Route. The route is created (any existing visit
suggestions are deleted) and is displayed on the map. You can now edit the
route (e.g. add customers).

Note:  Calculating the route may take a while. By default, the route is created
for you. To generate a route for another rep, click on  (Select Rep) in the
header and select the desired rep. The selected rep is remembered and reused
the next time you access the visit planning area. When planning a route for
another rep, variable values defined in the corresponding info areas (Z5/Z6)
are applied to the current rep, not the rep the route is planned for.If you apply
a filter (  (Settings) in the header), the filter is taken into account when
generating visit suggestions. If you add or reschedule an activity outside of the
rep’s work hours, the rep’s work hours for that day are extended accordingly.
Routes can span 31 days at most.
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• Click on Optimize to optimize the route if you have edited it or added the route
manually. The route is recalculated. The order of visits in the route may change.
Existing activities and the star ting location are not changed.

Note:  Calculating the route may take a while. A message is displayed if the route
is already optimized or cannot be optimized fur ther.

• Once you are satisfied with the route, click on Save as Visits. Activities are
automatically generated (type = "Visit") based on the suggestions in the route.

If you are planning a route over several days, you can choose whether to generate
activities for all the suggestions or only for a specific day.

• Click on  (Discard all Suggestions) in the sidebar next to the number of
suggested visits. All visit suggestions are deleted (not just those on the current
day).

• Click on a location on the map or on an activity/suggestion in the timeline to
display information on the record in the sidebar.

Move your mouse cursor over the record’s header (e.g. the name of the customer)
to display the icons used to access the menu ( ) and quick view ( ). Select
Remove from Route from the menu to remove the customer from the route.

Timeline

• A timeline is displayed above the map containing suggestions that are currently
part of the route (blue) or not par t of the route (violet). Existing activities and
absences are colored the same as they are in the calendar.

• Visit suggestions are indicated by the  icon in both the timeline and sidebar.
Existing activities and absences are indicated using the same icon as in the
calendar (e.g.  for a visit).

• Click on an activity or visit suggestion to highlight the customer on the map with

a circle beneath the pin ( ).

• You can reschedule activities and suggestions by dragging them to the desired
time in the timeline. Drag the left or right borders to change the star t and end
time (and the duration).

• Double-click on an activity or visit suggestion to open a popup where you can
edit its details.
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Header

• The rep the route is being planned for is displayed in the header. By default,
routes are created for you.

Click on  (Select Rep) to select a different rep. The selected user is stored and
selected by default the next time you open the visit planning area.

• Click on  (Map) and  (Calendar) to switch between the map and calendar
view of activities and suggestions. You can edit activities in the calendar view,
e.g. move an appointment to reschedule it.

• Click on  (Legend) to display the legend.

• Select  (Settings) >  (Filter) to determine which customers are displayed on
the map (e.g. companies, persons) and define filters. The system remembers
which filters are active and applies them again the next time you open the visit
planning area. Filters are applied when generating visit suggestions.
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4
Surveys

Surveys
Learn about creating survey questionnaires and evaluating them.

You can define questionnaires, e.g. for telephone marketing campaigns. You can:

• Define the questions in the questionnaire and possible answers

• Define branches in the questionnaire that are carried out based on the answers
given to specific questions

• Define mandatory questions and default answers

• Use values in the database as answers

• Update records based on the answers received

Surveys can be carried out from an activity record. Within the scope of campaigns,
you can automatically assign a questionnaire to the activities generated for the
campaign.

Defining Questionnaires

To define a questionnaire:

1. Select  (Collaboration) > Questionnaire.

2. Click on Start Search and then on New.

3. Click on  (Add/Find Catalog Values) next to the Questionnaire field. The Find
or Add Catalog Value window opens.

4. Enter a name for the questionnaire.

5. Click on New.

6. Save.

7. Define the questions and answers used by the questionnaire.

Defining Questions

You need to define the individual questions in the questionnaire and what answers
can be given.

a. Click on Questions in the questionnaire’s tree view and click on New.

b. Enter the Question.
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c. Enter the Question No.. This number determines the order in which the
questions are displayed in the questionnaire.

Note:  If you do not enter a number, the questions are displayed in the order
they were added when filling out the questionnaire. update recommends always
assigning a question number. Do not number the questions sequentially (i.e.
1, 2, 3) but leave gaps (e.g. 10, 20, 30 etc.) so that you can insert additional
questions later.

d. The following options are available for questions:

• Do not display: The question is not displayed when carrying out the survey.

• New section: The question is not handled as a question but as the title of
a section.

Sections allow you to structure the questionnaire. All questions in the same
section are displayed at once, and you can switch between sections while
carrying out the survey.

You need to enter a Question No. for section titles to ensure they are dis-
played in the right order. Enter the title of the section in the Question field.

• Weighting: A percentage value that determines how the points awarded for
answers to this question are weighted in the overall points total.

For example, if you define that an answer is worth 50 points, and weight the
question with 200%, 100 points are awarded for the answer when carrying
out the survey.

• Mandatory Answer: Enable this option to determine that answering this
question is mandatory.

Note:  Although you can save and navigate within the questionnaire without
answering a mandatory question, all mandatory questions need to be
answered to finalize the survey. If a question leads to a branch in the
questionnaire, the question is automatically set as a mandatory question.

e. The following options are available for the answers to a question:

• Choose one answer from a number of predefined answers (radio buttons):
The Multiple Answers and Edit Answer options must be disabled.

• Select several answers from the list of available options (check boxes):
Enable the Multiple Answers option.

You need to define answers for these two types of questions.

• Enter the answer manually: Enable the Edit Answer check box.

• Select a catalog value as the answer: Enable the Edit Answer check box
and select the Info Area Code and Field Number of the corresponding
catalog field.

Note:  Child catalog fields cannot be used in questionnaires.

317AUREA CONFIDENTIAL

Surveys



• The default answer is the current value entered in a field of the current
company or person, which can either be accepted or updated: Select the
applicable Info Area Code and Field. Enable the Edit Answer and Read
answer check boxes. If you enable the Save answer check box, any changes
you make to the suggested answer are updated in the corresponding record.

Note: Values in the database are only updated if a question is actually
answered. Default answers or empty answers in questions that are not
answered do not overwrite the value in the database.

• You can add a new record based on the answers received. The data required
by the new record can be collected over multiple questions.

Enable the Edit Answer check box and select the Info Area Code and Field
Number that the answer should be written to for each question. Switch to
the Add new tab and enable the Add Record check box.

You can add two separate records to the same info area from a questionnaire
(e.g. two activity records).  Enable the Add Further Record check box (in-
stead of Add Record) for all questions whose answers should be stored in
the second record.

Use the Default Values field to select the default values that should be en-
tered in the new record.

Note:  If you fill in the questionnaire multiple times, a new record is added
each time.

• You can enter a trigger in the Trigger field. This trigger is star ted once the
question has been answered.

• Default answer: You can select the default answer that is automatically
suggested when carrying out the survey.

Defining Answers

To define an answer:

1. Click on Answer in the questionnaire’s tree view and click on New.

2. Enter the Answer No. and Answer.

3. You can define Points that are awarded for this answer.

4. To define that this answer should be followed by a specific question, enter the
question’s number in the Follow-up question field.

Follow-up questions allow you to define branches in the questionnaire, i.e. to ask
different questions based on the answers you have received.

Note: The follow-up question’s number must be higher than the current question’s
number. Follow-up questions are not available for questions where the Multiple
Answers option is enabled (if a follow-up question is defined, it is ignored).
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Note:  If a questionnaire contains branches, ensure that a follow-up question is
defined for each question or answer, and that the Last Question check box is
enabled for the last question. If no follow-up question is defined and the Last
Question check box is not enabled, the question with the next highest number is
automatically used as the next question.

Carrying Out a Survey

To carry out a survey within the context of an activity:

1. Enter the questionnaire in the Questionnaire field of the activity (on the Survey
tab).

2. Save.

3. Select Start Survey from the activity’s context menu.

319AUREA CONFIDENTIAL

Surveys



• Click on the Previous Section and Next Section buttons to switch between
sections in the questionnaire.

• Follow-up questions are displayed once the answer that leads to the follow-up
question has been selected.

• Click on Show mandatory questions only to restrict the display to only the
mandatory questions. Mandatory questions are displayed in orange and indicated
with an asterisk (*).
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4. You can answer questions by:

• Typing the answer

• Selecting one or more answers from the list of predefined answers (radio buttons
or check boxes).

• Selecting answers from an Aurea CRM catalog (catalog fields).

• Select dates from the mini calendar (date fields).

5. Click on Summary to display an overview of the questions that have been
answered. You can return to previous sections and correct the answers you have
entered.

6. Save the questionnaire.

Depending the questionnaire’s configuration, records may be added to the Aurea
CRM database or existing records may be updated automatically based on the
answers you entered.

You can still edit the answers in a questionnaire that has been saved. Once you
have clicked on Finalize survey, the questionnaire can only be edited by your
administrator.

Evaluating Questionnaires

To display the evaluation of a questionnaire:

1. Select Questionnaire Analysis from the questionnaire’s context menu.

2. Click on a question to display the analysis graphically.
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• The answers given to individual questions are displayed on the right (selected
answers graphically, answers entered as text in a list).

• By default, answers that none of the participants gave are also displayed.

Displaying the Questionnaires Answered by a Person

To display the questionnaires that a person has answered:

1. Select Go to All Related > All Surveys from the person’s context menu. All
surveys carried out for this person are displayed.
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The Result (%), Max. Points and Points Attained columns are calculated from
the answers given by the person (taking into account the weighting).

2. Click on a survey in the list of results to display the answers the person gave.
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Defining Questionnaires
Leanr to define question and answers for Questionnaires.

To define a questionnaire:

1. Select  (Collaboration) > Questionnaire.

2. Click on Start Search and then on New.

3. Click on  (Add/Find Catalog Values) next to the Questionnaire field. The Find
or Add Catalog Value window opens.

4. Enter a name for the questionnaire.

5. Click on New.

6. Save.

7. Define the questions and answers used by the questionnaire.

Defining Questions
You need to define the individual questions in the questionnaire and what answers
can be given.

1. Click on Questions in the questionnaire’s tree view and click on New.

2. Enter the Question.

3. Enter the Question No.. This number determines the order in which the questions
are displayed in the questionnaire.

Note: Note: If you do not enter a number, the questions are displayed in the
order they were added when filling out the questionnaire. update recommends
always assigning a question number.Do not number the questions sequentially
(i.e. 1, 2, 3) but leave gaps (e.g. 10, 20, 30 etc.) so that you can insert additional
questions later.

4. The following options are available for questions:

• Do not display: The question is not displayed when carrying out the survey.

• New section: The question is not handled as a question but as the title of a
section.

Sections allow you to structure the questionnaire. All questions in the same
section are displayed at once, and you can switch between sections while car-
rying out the survey.
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You need to enter a Question No. for section titles to ensure they are displayed
in the right order. Enter the title of the section in the Question field.

• Weighting: A percentage value that determines how the points awarded for
answers to this question are weighted in the overall points total.

For example, if you define that an answer is worth 50 points, and weight the
question with 200%, 100 points are awarded for the answer when carrying out
the survey.

• Mandatory Answer: Enable this option to determine that answering this question
is mandatory.

Note: Note: Although you can save and navigate within the questionnaire
without answering a mandatory question, all mandatory questions need to be
answered to finalize the survey. If a question leads to a branch in the
questionnaire (>> on page 162), the question is automatically set as a mandatory
question.

5. The following options are available for the answers to a question:

• Choose one answer from a number of predefined answers (radio buttons): The
Multiple Answers and Edit Answer options must be disabled.

• Select several answers from the list of available options (check boxes): Enable
the Multiple Answers option.

You need to define answers for these two types of questions, >> on page 162.

• Enter the answer manually: Enable the Edit Answer check box.

• Select a catalog value as the answer: Enable the Edit Answer check box and
select the Info Area Code and Field Number of the corresponding catalog
field.

Note: Note: Child catalog fields cannot be used in questionnaires.

• The default answer is the current value entered in a field of the current company
or person, which can either be accepted or updated: Select the applicable Info
Area Code and Field. Enable the Edit Answer and Read answer check boxes.
If you enable the Save answer check box, any changes you make to the
suggested answer are updated in the corresponding record.

Note: Note: Values in the database are only updated if a question is actually
answered. Default answers or empty answers in questions that are not answered
do not overwrite the value in the database.
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• You can add a new record based on the answers received. The data required
by the new record can be collected over multiple questions.

Enable the Edit Answer check box and select the Info Area Code and Field
Number that the answer should be written to for each question. Switch to the
Add new tab and enable the Add Record check box.

You can add two separate records to the same info area from a questionnaire
(e.g. two activity records).  Enable the Add Further Record check box (instead
of Add Record) for all questions whose answers should be stored in the second
record.

Use the Default Values field to select the default values that should be entered
in the new record.

Note: Note: If you fill in the questionnaire multiple times, a new record is
added each time.

• You can enter a trigger in the Trigger field. This trigger is star ted once the
question has been answered.

• Default answer: You can select the default answer that is automatically
suggested when carrying out the survey.

Defining Answers
To define an answer:

1. Click on Answer in the questionnaire’s tree view and click on New.

2. Enter the Answer No. and Answer.

3. You can define Points that are awarded for this answer.

4. To define that this answer should be followed by a specific question, enter the
question’s number in the Follow-up question field.

Follow-up questions allow you to define branches in the questionnaire, i.e. to ask
different questions based on the answers you have received.

Note: Note: The follow-up question’s number must be higher than the current
question’s number.Follow-up questions are not available for questions where the
Multiple Answers option is enabled (if a follow-up question is defined, it is
ignored).

Note: Note: If a questionnaire contains branches, ensure that a follow-up question
is defined for each question or answer, and that the Last Question check box is
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enabled for the last question. If no follow-up question is defined and the Last
Question check box is not enabled, the question with the next highest number is
automatically used as the next question.

Carrying Out a Survey
To carry out a survey within the context of an activity:

1. Enter the questionnaire in the Questionnaire field of the activity (on the Survey
tab).

2. Save.

3. Select Start Survey from the activity’s context menu.
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• Click on the Previous Section and Next Section buttons to switch between
sections in the questionnaire.

• Follow-up questions are displayed once the answer that leads to the follow-up
question has been selected.

• Click on Show mandatory questions only to restrict the display to only the
mandatory questions. Mandatory questions are displayed in orange and indicated
with an asterisk (*).
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4. You can answer questions by:

• Typing the answer

• Selecting one or more answers from the list of predefined answers (radio buttons
or check boxes).

• Selecting answers from an Aurea CRM catalog (catalog fields).

• Select dates from the mini calendar (date fields).

5. Click on Summary to display an overview of the questions that have been
answered. You can return to previous sections and correct the answers you have
entered.

6. Save the questionnaire.

Depending the questionnaire’s configuration, records may be added to the Aurea
CRM database or existing records may be updated automatically based on the
answers you entered.

You can still edit the answers in a questionnaire that has been saved. Once you
have clicked on Finalize survey, the questionnaire can only be edited by your
administrator.

Evaluating Questionnaires
To display the evaluation of a questionnaire:

1. Select Questionnaire Analysis from the questionnaire’s context menu.

2. Click on a question to display the analysis graphically.

329AUREA CONFIDENTIAL

Evaluating Questionnaires



• The answers given to individual questions are displayed on the right (selected
answers graphically, answers entered as text in a list).

• By default, answers that none of the participants gave are also displayed.
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Displaying the Questionnaires Answered by a
Person
To display the questionnaires that a person has answered:

1. Select Go to All Related > All Surveys from the person’s context menu. All
surveys carried out for this person are displayed.
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The Result (%), Max. Points and Points Attained columns are calculated from
the answers given by the person (taking into account the weighting).

2. Click on a survey in the list of results to display the answers the person gave.
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5
Document Management
You can store existing documents in Aurea CRM Web database.

For example, a letter that you received from a customer. You can create single letters
to your customer using templates defined by your administrator. The template doc-
uments are defined to automatically populate the letter with data from the CRM
database. You can also generate mass mailings within the scope of marketing activ-
ities and automatically populate the e-mail with data related to the target group
created for the marketing activity. All the documents created are stored in the
database.

Note: To send an e-mail in a language other than the default languages, you should
use UTF-16 encoding for the template document. For example, to send an e-mail
in Cyrillic, encode the template document in UTF-16. You can use any text editor
that supports UTF-16, to encode the template document.

Documents

Opening and Editing Documents

You can open documents in read-only mode or edit them.

To open a document:

1. Search for the document using one of the following options:

• Select  (Collaboration) > Documents and star t the search.

• Open a record (e.g. an offer) and switch to the Document Links tab.

2. Click on the document to open it.

The document is opened in the associated application (based on the document
type).
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Note: The document is read-only and any changes you make to the document
are not stored in the Aurea CRM database.

To edit a document:

1. Search for the document (see above).

2. Select Check Out & Edit from the document’s context menu.

Note:  CRM.launcher is required to check out documents.

The document is opened in the associated application (based on the document
type). The document is locked for other users.

3. Edit the document.

4. Many types of documents (e.g. Microsoft Office documents) can be saved and
uploaded automatically. To save the document in the Aurea CRM database, save
or close the document in the associated application.

You are asked whether you wish to upload the document. The document is auto-
matically checked in once it has been uploaded, and is thus again available to
other users.

If the document type cannot be saved automatically, a message is displayed. To
upload the document:

a. Save the document in the associated application.

b. Click on  (Checked Out Documents) in Aurea CRM web. This icon is visible
whenever a document has been checked out.

c. Select the desired document.

d. Click on Upload.

Displaying Checked Out Documents

To display the documents you have checked out:

1. Select  (Collaboration) > Checked Out Documents. The documents that
you have checked out are listed.

2. The following entries are available from the document’s context menu:

• View Document Record displays the document record.

• Select Undo Check Out.

3. To check in the document, select  (Collaboration) > Checked Out
Documents, select View Document Record from the document’s context menu
and click on  (Select / Upload Document) next to the Document Key field and
upload the document.
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If you log out of Aurea CRM web and you have checked out documents, you are
asked whether you want to:

• Cancel logging out in order to upload the document

• Upload the document the next time you use the system. The document remains
checked out.

• Undo the check out before logging off.

Saving Documents in the Database

The following options are available for uploading documents to the database:

• Uploading a (Local) Document to the Aurea CRM database

1. You can choose to upload a general document, or upload the document to a
specific record:

• Select  (Collaboration) > Documents, star t the search and click on 
(New).

• Open the record (e.g. an offer) and switch to the Document Links tab under
Related Data. Click on  (New) and select Upload new document.

2. Click on Select File in the Upload Document window and select the desired
document(s).

You can also drag the document(s) to the window using your mouse.

3. Save. The record is displayed in tab view or in the list.

• Linking an Aurea CRM Document with a Record

1. Open the record (e.g. an offer) and switch to the Document Links tab under
Related Data. Click on  (New) and select Existing update.CRM Document.

2. Select one or more documents.

3. Choose Select from the context menu.

Replacing Documents in the Database

To replace an existing document in the database:

1. Select  (Collaboration) > Documents or switch to the Document Links tab
under Related Data in the corresponding record.

2. Search for the document you wish to replace.
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3. Select Tab View from the context menu.

4. Click on  (Select / Upload Document) next to the Document Key field.

5. Select Upload Document.

6. Click on Browse and select the desired document.

7. Save the record.

Deleting Documents

To delete a document:

1. Search  (Collaboration) > Documents or switch to the Document Links tab
under Related Data in the corresponding record.

2. Search for the document you want to delete.

3. Select Delete from the document’s context menu.

A message is displayed with information on the number of links that exist to the
document and the info areas that the document is linked to.

4. Choose whether to delete the record.

You can also choose to delete a document from a record to which the document is
linked:

1. Switch to the parent record (e.g. a company) and switch to the Document Links
tab.

2. Select Delete from the document’s context menu.

3. Choose whether to delete the link between the document and the record or to
delete the document and all existing links.

Document Fields

Certain info areas allow you to enter documents in document fields.

Document fields offer the following options:

1. Click on  (Select / Upload Document).

2. Choose one of the following options:

• Open document: Opens the document entered in the field.

• Existing Document: Allows you to enter a document stored in the Aurea CRM
database in the field.

• Existing Customer Document: Allows you to enter a customer document stored
in the Aurea CRM database in the field.

• Upload Document: Allows you to upload a document (e.g. from your local hard
drive) and store it in the document field.

Note: Your administrator can determine that uploaded images are displayed in
the record’s mask.

3. Click on  (Delete) to remove the current document from the field.
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Note:  If your administrator has defined that a document field is displayed in a list,
the document key is displayed instead of the document name.

Letters

You can create letters based on document templates as Word documents from certain
records in Aurea CRM web. Data entered in the record is transferred to your word
processor and merged with the document.

Document templates for letters including the desired transfer fields and label formats
are created in Aurea CRM win and can then be accessed in Aurea CRM web, see
Word Processor in the Aurea CRM win User Guide.

Your administrator can define the following options in the transfer format used to
create the letter:

• Whether the letter is read-only. In this case you cannot edit the letter; it can only
be viewed.

• Whether the letter is generated in the background, stored in the database and
linked to the customer record using a document link.

• How the document is named. Your administrator can use the available variables
to generate the name of the letter.

Creating Letters

Your administrator can determine how you can create letters and which templates
are available from which info areas.

To create a letter for a company, for example:

1. Select the desired template from the company’s context menu or using a predefined
button.

The current record is transferred to your word processor and merged with the
document. The document is automatically linked to the record.

2. The document is displayed in Microsoft Word. You can edit the document.

3. Close or save the Word document. The document is uploaded to the Aurea CRM
database.

Mail Merges

Quick campaigns allow you to generate a letter for several persons, without needing
to first add a campaign and associated marketing activities etc.

You can also create mail merges within the scope of marketing activities. You cannot
however create mass mailings in Aurea CRM web itself, but only the control file
containing the customer data that is then merged with your text in Microsoft Word.

Note: To send than the default languages, you should use UTF-16 encoding for
the template document. For example, to send a mail in Cyrillic, encode the HTML
template document in UTF-16.
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Your administrator can define that you can store the customer data merged with the
document template for each recipient. When you open the document, the customer-
specific data is merged with the document template and the letter received by the
customer is displayed. Document templates are stored as read-only documents in
the database and cannot subsequently be edited.

To access a previously sent mailing:

1. Switch to a company or person.

Switch to the Document Links tab. The documents available in Aurea CRM are
listed.

You can identify mass mailings as documents that were created by a Marketing
Activity. The Serial Letter and Read only check boxes are automatically enabled.

2. Click on the title of the document or select Check Out & Edit from the context
menu. The document opens in Microsoft word.

Document Management
You can store existing documents in Aurea CRM web’s database, e.g. a letter that
you received from a customer. You can create single letters defined by your admin-
istrator, which can include data from the database, in order to send a letter to a
customer. You can also generate mass mailings within the scope of marketing activ-
ities which include data relating to the target group created for the marketing activ-
ity. These documents are also stored in the database.

Documents

Opening and Editing Documents
You can open documents in read-only mode or edit them.

To open a document:

1. Search for the document using one of the following options:

• Select  (Collaboration) > Documents and star t the search.

• Open a record (e.g. an offer) and switch to the Document Links tab.
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2. Click on the document to open it.

The document is opened in the associated application (based on the document
type).

Note: Note: The document is read-only and any changes you make to the
document are not stored in the Aurea CRM database.

To edit a document:

1. Search for the document (see above).

2. Select Check Out & Edit from the document’s context menu.

Note: Note: CRM.launcher is required to check out documents, >> on page 109.

The document is opened in the associated application (based on the document
type). The document is locked for other users.

3. Edit the document.

4. Many types of documents (e.g. Microsoft Office documents) can be saved and
uploaded automatically. To save the document in the Aurea CRM database, save
or close the document in the associated application.

You will be asked whether you wish to upload the document. The document is
automatically checked in once it has been uploaded, and is thus again available
to other users.

If the document type cannot be saved automatically, a message is displayed. To
upload the document:

a. Save the document in the associated application.

b. Click on  (Checked Out Documents) in Aurea CRM web. This icon is visible
whenever a document has been checked out.

c. Select the desired document.

d. Click on Upload.
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Displaying Checked Out Documents
To display the documents you have checked out:

1. Select  (Collaboration) > Checked Out Documents. The documents that
you have checked out are listed.

2. The following entries are available from the document’s context menu:

• View Document Record displays the document record.

• Select Undo Check Out.

3. To check in the document, select  (Collaboration) > Checked Out
Documents, select View Document Record from the document’s context menu
and click on  (Select / Upload Document) next to the Document Key field and
upload the document.

If you log out of Aurea CRM web and you have checked out documents, you will be
asked whether you want to:

• Cancel logging out in order to upload the document

• Upload the document the next time you use the system. The document remains
checked out.

• Undo the check out before logging off.

Saving Documents in the Database

Note: Note: If your administrator has determined that you can upload multiple
documents at once (>> Configuration Settings > Documents in the CRM.core
Administrator Guide), you can select multiple documents of various types or drag
them from your local file system to Aurea CRM.

The following options are available for uploading documents to the database:
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Uploading a (Local) Document to the Aurea CRM database

1. You can choose to upload a general document, or upload the document to a
specific record:

• Select  (Collaboration) > Documents, star t the search and click on 
(New).

• Open the record (e.g. an offer) and switch to the Document Links tab under
Related Data. Click on  (New) and select Upload new document.

2. Click on Select File in the Upload Document window and select the desired
document(s).

You can also drag the document(s) to the window using your mouse.

3. Save. The record is displayed in tab view or in the list.

Linking an Aurea CRM Document with a Record

1. Open the record (e.g. an offer) and switch to the Document Links tab under
Related Data. Click on  (New) and select Existing update.CRM Document.

2. Select one or more documents.

3. Choose Select from the context menu.

Replacing Documents in the Database
To replace an existing document in the database:

1. Select  (Collaboration) > Documents or switch to the Document Links tab
under Related Data in the corresponding record.

2. Search for the document you wish to replace.

3. Select Tab View from the context menu.

4. Click on  (Select / Upload Document) next to the Document Key field.

5. Select Upload Document.
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6. Click on Browse and select the desired document.

7. Save the record.

Deleting Documents
To delete a document:

1. Search  (Collaboration) > Documents or switch to the Document Links tab
under Related Data in the corresponding record.

2. Search for the document you want to delete.

3. Select Delete from the document’s context menu.

A message is displayed with information on the number of links that exist to the
document and the info areas that the document is linked to.

4. Choose whether to delete the record.

You can also choose to delete a document from a record to which the document is
linked:

1. Switch to the parent record (e.g. a company) and switch to the Document Links
tab.

2. Select Delete from the document’s context menu.

3. Choose whether to delete the link between the document and the record or to
delete the document and all existing links.

Document Fields
Certain info areas allow you to enter documents in document fields.

Document fields offer the following options:

1. Click on  (Select / Upload Document).

2. Choose one of the following options:

• Open document: Opens the document entered in the field.

• Existing Document: Allows you to enter a document stored in the Aurea CRM
database in the field.

• Existing Customer Document: Allows you to enter a customer document stored
in the Aurea CRM database in the field.

• Upload Document: Allows you to upload a document (e.g. from your local hard
drive) and store it in the document field.
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Note: Note: Your administrator can determine that uploaded images are displayed
in the record’s mask.

3. Click on  (Delete) to remove the current document from the field.

Note: Note: If your administrator has defined that a document field is displayed in
a list, the document key is displayed instead of the document name.

Letters
You can create letters based on document templates as Word documents from certain
records in Aurea CRM web. Data entered in the record is transferred to your word
processor and merged with the document.

Document templates for letters including the desired transfer fields and
label formats are created in Aurea CRM win and can then be accessed in
Aurea CRM web, see Word Processor in the Aurea CRM win User Guide.

Your administrator can define the following options in the transfer format
used to create the letter:

• Whether the letter is read-only. In this case you cannot edit the letter; it
can only be viewed.

• Whether the letter is generated in the background, stored in the database
and linked to the customer record using a document link.

• How the document is named. Your administrator can use the available
variables to generate the name of the letter.

Creating Letters
Your administrator can determine how you can create letters and which templates
are available from which info areas.

To create a letter for a company, for example:

1. Select the desired template from the company’s context menu or using a predefined
button.
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The current record is transferred to your word processor and merged with the
document. The document is automatically linked to the record.

2. The document is displayed in Microsoft Word. You can edit the document.

3. Close or save the Word document. The document is uploaded to the Aurea CRM
database.

Mail Merges
Quick campaigns allow you to generate a letter for several persons, without needing
to first add a campaign and associated marketing activities etc.

You can also create mail merges within the scope of marketing activities. You cannot
however create mass mailings in Aurea CRM web itself, but only the control file
containing the customer data that is then merged with your text in Microsoft Word,
>> on page 271.

Note:  Note: To send than the default languages, you should use UTF-16 encoding
for the template document. For example, to send a mail in Cyrillic, encode the HTML
template document in UTF-16.

Your administrator can define that you can store the customer data merged with the
document template for each recipient. When you open the document, the customer-
specific data is merged with the document template and the letter received by the
customer is displayed. Document templates are stored as read-only documents in
the database and cannot subsequently be edited.

To access a previously sent mailing:

1. Switch to a company or person.

Switch to the Document Links tab. The documents available in Aurea CRM are
listed.

You can identify mass mailings as documents that were created by a Marketing
Activity. The Serial Letter and Read only check boxes are automatically enabled.

2. Click on the title of the document or select Check Out & Edit from the context
menu. The document opens in Microsoft word.
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Document Templates
Learn about the Aurea CRM Add-in for MS Word and how to create and manage
document template.

Using Aurea CRM Addin for Microsoft Word

Aurea CRM Add-in for Microsoft Word allows CRM users to create documents based
on templates that meet the corporate customer interaction (CI) guidelines and enrich
the documents with content from the CRM.

CRM administrator and users can create template documents that can be used for
various recurring tasks. Some of the tasks for different user roles include the follow-
ing:

• A Sales representative could create and maintain template documents for offer
letters, order sheets, e-mail etc. Use the different information in the CRM system
to enrich the document.

• Marketing personnel could create new templates to meet the latest customer
interaction guidelines. Create templates for marketing campaigns sent by letters
or flyers using information from the CRM.

• Service representatives can create solution documents or other documents for
different services and use the CRM information in those documents.

• Field service representatives can create service report documents at the customer
site along with the current ticket.

• All users can ensure that customers receive information in their preferred language.

Note: To send email in a language other than the default languages, you should
use UTF-16 encoding for the template documents. For example, to send a mail in
Cyrillic, encode the HTML template document in UTF-16.

• The Aurea CRM word Add-in supports the following features:

• Allows you to use the same set of methods used by Aurea CRM web.

• Template documents can use fields that are used to store information in Aurea
CRM.

• You can generate the documents on CRM.pad using the same templates from
Aurea CRM.

• Serial and single letter fields can be easily integrated into the templates using
drag and drop features.

• You can create template documents in multiple languages.

• You can create formatted text, when merging documents and mail merge.

• Allows you to embed additional information in the documents like images and
pictograms.
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Installing Aurea CRM Add-in for Microsoft Word

The recommended way to install Aurea CRM Word Add-in is to use a network shared
location containing the latest installation package. Ask your CRM administrator for
the central shared location for the CRM Add-in for Word installation package. Using
this process ensures that the latest version of the CRM Add-in for Word is automat-
ically upgraded to the latest version. You only have to install it once using the shared
central location.

If your organization does not provide a shared location, the Aurea CRM add-in for
Word installation package can be found on the Aurea CRM customer support site.

To install the Aurea CRM add-in for Word:

1. Browse to the network shared central location provided by your CRM administrator.

Or

Unzip the package
OfficeAddins_<versionNo>_full.zip

. The
<versionNo>

is the latest version available on the customer support site.

2. Double click
aurea.office.word.vsto

file in the shared location or the unzipped folder. The Microsoft Office
Customization Installer window opens.

The installer verifies the publisher, in this case Aurea CRM, and then displays
the following window.
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3. Click Install. The Installing Office Customization message displays.

4. The window automatically closes on successful installation.

5. Start Microsoft Word and open a blank document, the Aurea CRM menu item
should be visible.

6. Click the Aurea CRM menu.
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7. To work with the plugin you have to be connected to Aurea CRM. Click Settings
to open the connection dialog.

8. Enter the following details in the connection dialog:

a. Enter the URL of the Aurea CRM server.

b. If Aurea CRM web is deployed on a RAS server, perform the following steps:

Select the Use RAS authentication checkbox.

Click Open RAS Advanced Settings. The following RAS settings dialog displays:
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Enter the URL for the RAS server and the Application ID of Aurea CRM web instance
on the RAS server.

Click Close RAS advanced settings.

1. Click Log In.

2. Now you can use the CRM Word Add-in to create templates for your documents.

Upgrading the Aurea CRM Add-in for Microsoft Word

Aurea CRM Add-in for MS Word is developed as a VSTO Add-in. Visual Studio Tools
for Office (VSTO) Add-ins use the ClickOnce deployment solution which automati-
cally updates your installation of CRM Add-in for Word. This requires your adminis-
trator to publish Aurea CRM Add-in to a network shared central location. You can
install the latest version from this location once, all subsequent upgrades then
happens automatically. Publishing a new version to this location automatically up-
dates the CRM Add-in for Word installed from this location. ClickOnce checks this
location once in every seven days for new updates.

Note:  If there are multiple users on your machine, then you have to install your
own version of CRM Word Add-in. This is a limitation of the ClickOnce solution.

Note: You may have to login to the shared network location to ensure that it is
accessible to the ClickOnce installer to check for a new version of the CRM Add-in
and perform the upgrade.

If you have used a network shared central location to install CRM Add-in for word,
your upgrade should star t automatically. If a new version is published to the shared
location, on star ting MS Word, ClickOnce installer checks the shared folder for a
newer version and if a new version is available, it automatically star ts the update
process.
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If you have installed the word plugin using the installer package from the support
site, then you have to uninstall the existing Aurea CRM Word Add-in from Control
Panel > Programs > Programs and Features.

Unzip the package. This is the latest version available on the customer support site.
Follow the installation instructions in Installing Aurea CRM Add-in for Microsoft
Word.
OfficeAddins_<version no>_release.zip

<version no>

Creating and Saving new Document Template

You can create document templates for documents that you regularly use for recurring
tasks.

Note: To send an e-mail in a language other than the default languages, you should
use UTF-16 encoding for the template document. For example, to send an e-mail
in Cyrillic, encode the template document in UTF-16.

To create a new document template:

1. Open a Microsoft Word document containing basic text.

2. Edit the content of the document.

3. Click on the Aurea CRM menu item.
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4. Click Settings to open the connection dialog.
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5. Enter the following details in the connection dialog:

a. Enter the URL of the update CRM server.

b. Enter your Username and Password.

c. Select the language you prefer to work on Aurea CRM.

d. Click Log In.

Note:  None of the other Aurea CRM sub-menu items are activated until you login.

6. Click Save As to open the dialog.

a. Give a File Name for the template document.

b. Select the Document Class of the template, from the following options:

• MailMerge Template

• Template (BASE)
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In this case, we save the template document as a MailMerge Template class.

Note: The document class is drawn from the CRM, therefore the drop-down
values can be different based on your installation.

7. Click Save. The template document is saved to the D1 infoarea of the Aurea CRM
server.

Note:  After a template is saved to Aurea CRM, the Insert Mail Merge Fields
menu item is activated.

8. Login to the Aurea CRM server with the same username and password and search
for the document. The saved document should be visible in the search list as
shown in the screenshot below:

9. Click Insert Mail Merge Fields, to update the document with information from
the records on Aurea CRM server. The Mail Merge Fields column displays.
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10.Click Queries ( ) to list existing queries.
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11.You can create a new query by selecting an existing query then modifying, and
saving it.

To create a new query, perform the following:

a. Select any query or record and click . In the following screenshot, typing com
in the filters text box shows companies 01.

b. Right click on the root record node and select Remove.

c. Click Add Info Area to open the Select info Area dialog.

d. Select the infoarea of interest and select the required fields from that info area.
For this example, type KP and select the Contact Person info area. The Select
Field(s) in Info Area: Contact Person dialog box opens.
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e. Select the required fields in the Available Fields pane and click  to move
it to the Selected Fields pane. Click OK. The selected infoarea and fields are
displayed in the Mail Merge Fields.

f. To add more info areas, right click on an infoarea and select Add Info area.
Selecting the infoarea opens a Relationships dialog. You can define the type
of relationship between the existing infoarea and the new one you add.

g. Select the required fields from for the new infoarea. The following screenshot
shows the Mail Merge Fields with the selected info areas and parameters.

h. Click  to save the modified query.

Note: This overwrites the before selected query and the changes is done in
the CRM solution. Please ensure that the query can be modified to your
requirements to avoid conflicts with queries set up by other users.

12.To populate the template document with the fields from infoarea records, drag
and drop the fields in the required places. The following screenshot shows the
template document enriched with fields.
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13.Click Save. The template document is saved to the D1 infoarea on Aurea CRM
server.

Opening and Editing document templates

You can open an existing template and edit and save it. You can also rename it and
save it with a different template name.
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To open an existing template:

1. In the Microsoft Word, click on the Aurea CRM menu item.

2. Click Settings, and login to the Aurea CRM server.

3. Click Open. The Documents dialog is displayed.

You can type in the text box to filter for a specific document. You can also select
the name of the template document. In the screenshot above, Template (BASE)
was the document class selected and invi was typed in the filter text box, to find
the Template Invitation.docx template.

4. The selected template document is retrieved from the Server and loaded into
Microsoft Word. For example, the screenshot below shows the Template
Invitation.docx.
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5. You can edit the template document and make modifications. For example, in the
Invitation template.docx, you might want to add the country name, after the City
name.

6. Click Insert Mail Merge Fields. The Mail Merge Fields column displaying the fields
from the selected infoarea is displayed to the right of the editing pane. See the
screenshot below.
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7. To add a field from the infoarea to the template document, select the field and
drag and drop it in the document at the appropriate position. For example, the
Country field was selected and added to the document. See the screenshot below.
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8. Click Save. The template document is saved to the D1 area of Aurea CRM.

Mail Merge Using Document Templates

To generate a document for several persons using the document template:

1. From the Aurea CRM menu, login to the CRM server and open the Mail Merge
template document. Edit the template document if necessary. For more information,
see Opening and Editing document templates.

2. Click Get Data From CRM. The Select Records dialog displays single record or
a list of records, showing the data fields you selected. You can then select the
data you want use with the document template.
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3. Click Start Mail Merge. The document is opened is in a new Window.
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4. To see the individual documents populated with the field values, select the required
recipient from the Preview Results menu. The document is populated with the
required information. The following screenshot shows the merged fields with their
values populated and highlighted.
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5. You can work with the documents created from the Aurea CRM server. The
following screenshot shows the Invitation template.docx template document on
the CRM server.
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Deleting a Template Document

You can delete a template document from the CRM server. This deletes the template
document along with all linked information in Aurea CRM and the D1 infoarea.

To delete a template document:

1. Search for your documents in Aurea CRM using Colloborate > Documents menu
option.

2. Open the required document from the search results.

3. Select the Delete option from the context menu for the document.
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Working with Images in the Template Document

You can add images and then modify them in the template document. The following
steps show a sample of adding an image to the template document and then making
some modifications to the image. You should be using the standard functions
available in Microsoft Word to process an image, like resizing and adding borders.

Perform the following steps:

1. Create a new blank template document. Perform steps 1 to 11 in the topic, creating
and saving new Document Template on page 200. In step eleven you have to
create a query that retrieves the fields from the infoarea that has the images you
require. For this example steps, we have created a simple query to retrieve the
Company infoarea records that has the Logo field containing images of company
logos (F1Image), the name of the company (F1Company), and the country
(F1Country) it is located in.

2. Add the three fields the company name, country, and logo fields to the template
document. The Word add-in automatically detects that the added field is an image
field and adds the appropriate code, see the screenshot below.

3. Format the fields to the desired fonts, bold it and other changes you desire, as
you would a normal a normal word document.

4. Click  to execute the mail merge and fetch the data and populate the record
field and create the pages for each record set in the CRM database. The
screenshot below shows one of the pages generated.
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5. To resize the displayed image switch to the template document and click on the
logo record, a sample image is displayed, resize it as you would resize an image
in a word document.

6. To add a border, right click on the image in the template document and select
Borders and Shadings as shown in the screenshot below.

7. Add a border using the standard Borders dialog in MS Word.

8. Click  to execute Mail Merge again. The resulting document is shown in the
screenshot below.
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Adding Tables to a Template Document

Aurea CRM add-in for Microsoft Word provides an Insert Table feature that allows
you to create a hierarchical grouping of records.

For example, if you want to group all the employees of a company into separate
documents, you have to use the Insert Table feature. If you have two companies
and three employees in each company then a simple mail merge would create six
pages containing the company name and one employee name. If you use the Insert
Table feature then the result document contains two pages for the two companies
and all the employees of a company grouped in a single page.

The sample table created in the procedure described below uses a query to retrieve
a company along with the employees of the company.

Perform the following steps:

1. Create a new blank template document. Perform steps 1 to 11 in the topic, Creating
and Saving new Document Template. In step eleven you have to create a query
that retrieves the fields from the infoarea that has the information that you want
to tabulate. For this example steps, we have created a complex query to retrieve
the Company infoarea records along with its employee information.

2. From the Mail Merge Fields add the Company name and the Country fields to the
template document.

3. Click Insert Table.

The Table Builder Wizard (Step1/2) dialog displays. See the screenshot below.
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4. You can add tables to the template document based on a grouping field or without
a grouping field. A grouping field groups the sub-records of a selected parent
record. To add a table based on a grouping field, go to step 5.

To add a table without grouping fields, perform the following steps:

a. Click Next. The Table Builder Wizard (Step2/2) dialog displays.

b. The Available Fields pane in the dialog displays the records that you can add
to your table.

c. Select the records that you want to add to your table and click  to select the
required records. The selected records are added to the Table Column Fields
pane.
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d. Click Add auto numbering column to add the numbering column for all the
employees that get populated for each company in the result documents.

Note: The numbering re-star ts for each separate table (hierarchical group)
created in the result document.

e. Click OK.

f. The required code is generated and populated in the template document.

g. Click  to execute the mail merge. The Select Records dialog is displayed.
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h. Click Start Mail Merge.

i. The results documents are created. Sample pages containing the tables for
companies are shown below.

Another page:
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j. You can add formatting to the table by selecting the table format in the template
document and add the required formatting.

k. To format the table, go to the template document, right click the table and select
Table Properties.

l. In this example, we set the borders to the table. See the screenshot below for
the Table properties   Borders and Shading dialog.
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m. In this example, we apply a simple formatting to the table. All borders to the
table grid. See the screenshot below.

n. You can resize the image. Click the image record in the table and resize the
image visible in the table cell. See the screenshot below.
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o. To see the result of resizing, click  to star t the mail merge. A result page
is shown in the screenshot below. The images are displayed in the size specified
in the template document.

This completes the steps required to generate documents without using a
grouping field.

5. To create a template document using a grouping field, perform the following steps:

a. Select a grouping field. The following screenshot shows the Country (Person
in Company) field selected.
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b. Click Next. The Table Builder Wizard (Step2/2) dialog displays.

Note: This grouping fields does not show Company record in the available
fields as it is not a sub-record of the selected grouping field, Country (Person
in Company) field.

c. Select the records you want to add to the table columns and click  to add the
records to the Table Column Fields. Click OK.

The table wizard generated the required code in the template document.

d. Add the Company name and the Company Country records to the template
document. See the screenshot below.
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e. Click  to execute the mail merge. The Select Record dialog displays. See
the screenshot below.
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f. Click Star t Mail Merge to generate the result document.

The result document contains three tables for each company, based on the
country of the employee (grouping field), which are three countries.

The following screenshot shows the result document showing the employee
tables for the company “Contoso” in two tables for the grouping in terms of
countries: Deutschland and Italien.
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6. Click Save As to save the template document. The Save As dialog displays.

A default name in the following format is automatically displayed,
<documentName_<date>_<user name>. In the screenshot above the default name is
<Demo>_<2016-12-21>_<SU>.

7. Click Save. The template document is saved to the D1 infoarea of the Aurea CRM
server.

Using Aurea CRM Addin for Microsoft Word
Aurea CRM Add-in for Microsoft Word allows CRM users to create documents based
on templates that meet the corporate customer interaction (CI) guidelines and enrich
the documents with content from the CRM.

CRM administrator and users can create template documents that can be used for
various recurring tasks. Some of the tasks for different user roles include the follow-
ing:

• A Sales representative could create and maintain template documents for offer
letters, order sheets, e-mail etc. Use the different information in the CRM system
to enrich the document.

• Marketing personnel could create new templates to meet the latest customer
interaction guidelines. Create templates for marketing campaigns sent by letters
or flyers using information from the CRM.

• Service representatives can create solution documents or other documents for
different services and use the CRM information in those documents.

• Field service representatives can create service report documents at the customer
site along with the current ticket.

• All users can ensure that customers receive information in their preferred language.

Note:  Note: To send email in a language other than the default languages, you
should use UTF-16 encoding for the template documents. For example, to send a
mail in Cyrillic, encode the HTML template document in UTF-16.

• The Aurea CRM word Add-in supports the following features:

• Allows you to use the same set of methods used by Aurea CRM web.
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• Template documents can use fields that are used to store information in Aurea
CRM.

• You can generate the documents on CRM.pad using the same templates from
Aurea CRM.

• Serial and single letter fields can be easily integrated into the templates using
drag and drop features.

• You can create template documents in multiple languages.

• You can create formatted text, when merging documents and mail merge.

• Allows you to embed additional information in the documents like images and
pictograms.

Installing Aurea CRM Add-in for Microsoft Word
The recommended way to install Aurea CRM Word Add-in is to use a network shared
location containing the latest installation package. Ask your CRM administrator for
the central shared location for the CRM Add-in for Word installation package. Using
this process will ensure that the latest version of the CRM Add-in for Word is auto-
matically upgraded to the latest version. You only have to install it once using the
shared central location.

If your organization does not provide a shared location, the Aurea CRM add-in for
Word installation package can be found on the Aurea CRM customer support site.

To install the Aurea CRM add-in for Word:

1. Browse to the network shared central location provided by your CRM administrator.

Or

Unzip the package
OfficeAddins_<versionNo>_full.zip

. The
<versionNo>

will be the latest version available on the customer support site.

2. Double click
aurea.office.word.vsto

file in the shared location or the unzipped folder. The Microsoft Office
Customization Installer window opens.
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The installer verifies the publisher, in this case Aurea CRM, and then displays
the following window.

3. Click Install. The Installing Office Customization message displays.
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4. The window automatically closes on successful installation.

5. Start Microsoft Word and open a blank document, the Aurea CRM menu item
should be visible.

6. Click the Aurea CRM menu.
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7. To work with the plugin you have to be connected to Aurea CRM. Click Settings
to open the connection dialog.

8. Enter the following details in the connection dialog:

a. Enter the URL of the Aurea CRM server.

b. If Aurea CRM web is deployed on a RAS server, perform the following steps:

Select the Use RAS authentication checkbox.

Click Open RAS Advanced Settings. The following RAS settings dialog displays:

Enter the URL for the RAS server and the Application ID of Aurea CRM web instance
on the RAS server.

Click Close RAS advanced settings.

1. Click Log In.

2. Now you can use the CRM Word Add-in to create templates for your documents.
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Upgrading the Aurea CRM Add-in for Microsoft Word
Aurea CRM Add-in for MS Word is developed as a VSTO Add-in. Visual Studio Tools
for Office (VSTO) Add-ins use the ClickOnce deployment solution which automati-
cally updates your installation of CRM Add-in for Word. This requires your adminis-
trator to publish Aurea CRM Add-in to a network shared central location. You can
install the latest version from this location once, all subsequent upgrades will then
happen automatically. Publishing a new version to this location will automatically
update the CRM Add-in for Word installed from this location. ClickOnce will check
this location once in every seven days for new updates.

Note:  Note: If there are multiple users on your machine, then you have to install
your own version of CRM Word Add-in. This is a limitation of the ClickOnce solution.

Note:  Note: You may have to login to the shared network location to ensure that it
is accessible to the ClickOnce installer to check for a new version of the CRM Add-in
and perform the upgrade.

If you have used a network shared central location to install CRM Add-in for word,
your upgrade should star t automatically. If a new version is published to the shared
location, on star ting MS Word, ClickOnce installer will check the shared folder for
a newer version and if a new version is available, it automatically star ts the update
process.
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If you have installed the word plugin using the installer package from the support
site, then you have to uninstall the existing Aurea CRM Word Add-in from Control
Panel > Programs > Programs and Features.

Unzip the package
OfficeAddins_<version no>_release.zip

. The
<version no>

will be the latest version available on the customer support site. Follow the installa-
tion instructions in Installing Aurea CRM Add-in for Microsoft Word on page 195.

Creating and Saving new Document Template
You can create document templates for documents that you regularly use for recurring
tasks.

Note: To send an e-mail in a language other than the default languages, you should
use UTF-16 encoding for the template document. For example, to send an e-mail
in Cyrillic, encode the template document in UTF-16.
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To create a new document template:

1. Open a Microsoft Word document containing basic text.

2. Edit the content of the document.

3. Click on the Aurea CRM menu item.

4. Click Settings to open the connection dialog.
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5. Enter the following details in the connection dialog:

a. Enter the URL of the update CRM server.

b. Enter your Username and Password.

c. Select the language you prefer to work on Aurea CRM.

d. Click Log In.

Note:  Note: None of the other Aurea CRM sub-menu items are activated until
you login.
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6. Click Save As to open the dialog.

a. Give a File Name for the template document.

b. Select the Document Class of the template, from the following options:

• MailMerge Template

• Template (BASE)

In this case, we save the template document as a MailMerge Template class.

Note:  Note: The document class is drawn from the CRM, therefore the
drop-down values can be different based on your installation.

7. Click Save. The template document is saved to the D1 infoarea of the Aurea CRM
server.

Note:  Note: After a template is saved to Aurea CRM, the Insert Mail Merge
Fields menu item is activated.

8. Login to the Aurea CRM server with the same username and password and search
for the document. The saved document should be visible in the search list as
shown in the screenshot below:
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9. Click Insert Mail Merge Fields, to update the document with information from
the records on Aurea CRM server. The Mail Merge Fields column displays.
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10.Click Queries ( ) to list existing queries.
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11.You can create a new query by selecting an existing query then modifying, and
saving it.

To create a new query, perform the following:

a. Select any query or record and click . In the following screenshot, typing com
in the filters text box shows companies 01.

b. Right click on the root record node and select Remove.

c. Click Add Info Area to open the Select info Area dialog.
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d. Select the infoarea of interest and select the required fields from that info area.
For this example, type KP and select the Contact Person info area. The Select
Field(s) in Info Area: Contact Person dialog box opens.

e. Select the required fields in the Available Fields pane and click  to move
it to the Selected Fields pane. Click OK. The selected infoarea and fields are
displayed in the Mail Merge Fields.

f. To add more info areas, right click on an infoarea and select Add Info area.
Selecting the infoarea opens a Relationships dialog. You can define the type
of relationship between the existing infoarea and the new one you add.

g. Select the required fields from for the new infoarea. The following screenshot
shows the Mail Merge Fields with the selected info areas and parameters.

h. Click  to save the modified query.

Note:  Note: This will overwrite the before selected query and the changes will
be done in the CRM solution. Please ensure that the query can be modified to
your requirements to avoid conflicts with queries set up by other users.

12.To populate the template document with the fields from infoarea records, drag
and drop the fields in the required places. The following screenshot shows the
template document enriched with fields.
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13.Click Save. The template document will be saved to the D1 infoarea on Aurea
CRM server.

Opening and Editing document templates
You can open an existing template and edit and save it. You can also rename it and
save it with a different template name.

394AUREA CONFIDENTIAL

Chapter 5: Document Management



To open an existing template:

1. In the Microsoft Word, click on the Aurea CRM menu item.

2. Click Settings, and login to the Aurea CRM server.

3. Click Open. The Documents dialog is displayed.

You can type in the text box to filter for a specific document. You can also select
the name of the template document. In the screenshot above, Template (BASE)
was the document class selected and invi was typed in the filter text box, to find
the Template Invitation.docx template.

4. The selected template document is retrieved from the Server and loaded into
Microsoft Word. For example, the screenshot below shows the Template
Invitation.docx.
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5. You can edit the template document and make modifications. For example, in the
Invitation template.docx, you might want to add the country name, after the City
name.

6. Click Insert Mail Merge Fields. The Mail Merge Fields column displaying the fields
from the selected infoarea is displayed to the right of the editing pane. See the
screenshot below.
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7. To add a field from the infoarea to the template document, select the field and
drag and drop it in the document at the appropriate position. For example, the
Country field was selected and added to the document. See the screenshot below.
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8. Click Save. The template document is saved to the D1 area of Aurea CRM.

Mail Merge Using Document Templates
To generate a document for several persons using the document template:

1. From the Aurea CRM menu, login to the CRM server and open the Mail Merge
template document. Edit the template document if necessary. For more information,
see >> Opening and Editing document templates.

2. Click Get Data From CRM. The Select Records dialog displays single record or
a list of records, showing the data fields you selected. You can then select the
data you want use with the document template.
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3. Click Start Mail Merge. The document is opened is in a new Window.
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4. To see the individual documents populated with the field values, select the required
recipient from the Preview Results menu. The document is populated with the
required information. The following screenshot shows the merged fields with their
values populated and highlighted.
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5. You can work with the documents created from the Aurea CRM server. The
following screenshot shows the Invitation template.docx template document on
the CRM server.

401AUREA CONFIDENTIAL

Document Templates



Deleting a Template Document
You can delete a template document from the CRM server. This will delete the
template document along with all linked information in Aurea CRM and the D1 in-
foarea.

To delete a template document:

1. Search for your documents in Aurea CRM using Colloborate > Documents menu
option.

2. Open the required document from the search results.

3. Select the Delete option from the context menu for the document.
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Working with Images in the Template Document
You can add images and then modify them in the template document. The following
steps show a sample of adding an image to the template document and modifying
then making some modifications to the image. You will be using the standard func-
tions available in Microsoft Word to process an image, like resizing and adding
borders.

Perform the following steps:

1. Create a new blank template document. Perform steps 1 to 11 in the topic, creating
and saving new Document Template on page 200. In step eleven you have to
create a query that will retrieve the fields from the infoarea that has the images
you require. For this example steps, we have created a simple query to retrieve
the Company infoarea records that has the Logo field containing images of
company logos (F1Image), the name of the company (F1Company), and the
country (F1Country) it is located in.

2. Add the three fields the company name, country, and logo fields to the template
document. The Word add-in automatically detects that the added field is an image
field and adds the appropriate code, see the screenshot below.
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3. Format the fields to the desired fonts, bold it and other changes you desire, as
you would a normal a normal word document.

4. Click  to execute the mail merge and fetch the data and populate the record
field and create the pages for each record set in the CRM database.

The screenshot below shows one of the pages generated.
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5. To resize the displayed image switch to the template document and click on the
logo record, a sample image is displayed, resize it as you would resize an image
in a word document.

6. To add a border, right click on the image in the template document and select
Borders and Shadings as shown in the screenshot below.

7. Add a border using the standard Borders dialog in MS Word.

8. Click  to execute Mail Merge again.

The resulting document is shown in the screenshot below.
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Adding Tables to a Template Document
Aurea CRM add-in for Microsoft Word provides an Insert Table feature that allows
you to create a hierarchical grouping of records.

For example, if you want to group all the employees of a company into separate
documents, you have to use the Insert Table feature. If you have two companies
and three employees in each company then a simple mail merge would create six
pages containing the company name and one employee name. If you use the Insert
Table feature then the result document will contain two pages for the two companies
and all the employees of a company grouped in a single page.

The sample table created in the procedure described below uses a query to retrieve
a company along with the employees of the company.

Perform the following steps:

1. Create a new blank template document. Perform steps 1 to 11 in the topic, Creating
and Saving new Document Template on page 386. In step eleven you have to
create a query that will retrieve the fields from the infoarea that has the information
that you want to tabulate. For this example steps, we have created a complex
query to retrieve the Company infoarea records along with its employee
information.

2. From the Mail Merge Fields add the Company name and the Country fields to the
template document.

3. Click Insert Table.

The Table Builder Wizard (Step1/2) dialog displays. See the screenshot below.
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4. You can add tables to the template document based on a grouping field or without
a grouping field. A grouping field groups the sub-records of a selected parent
record.

To add a table based on a grouping field, go to step 5.

To add a table without grouping fields, perform the following steps:

a. Click Next. The Table Builder Wizard (Step2/2) dialog displays.

b. The Available Fields pane in the dialog displays the records that you can add
to your table.

c. Select the records that you want to add to your table and click  to select the
required records. The selected records are added to the Table Column Fields
pane.

d. Click Add auto numbering column to add the numbering column for all the
employees that get populated for each company in the result documents.

Note:  Note: The numbering re-star ts for each separate table (hierarchical
group) created in the result document.

e. Click OK.

f. The required code is generated and populated in the template document.
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g. Click  to execute the mail merge. The Select Records dialog is displayed.

h. Click Start Mail Merge.

i. The results documents are created. Sample pages containing the tables for
companies are shown below.
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Another page:

j. You can add formatting to the table by selecting the table format in the template
document and add the required formatting.

k. To format the table, go to the template document, right click the table and select
Table Properties.
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l. In this example, we will set the borders to the table. See the screenshot below
for the Table properties   Borders and Shading dialog.

m. In this example, we apply a simple formatting to the table. All borders to the
table grid. See the screenshot below.
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n. You can resize the image. Click the image record in the table and resize the
image visible in the table cell. See the screenshot below.

o. To see the result of resizing, click  to star t the mail merge. A result page
is shown in the screenshot below. The images are displayed in the size specified
in the template document.
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This completes the steps required to generate documents without using a
grouping field.

5. To create a template document using a grouping field, perform the following steps:

a. Select a grouping field. The following screenshot shows the Country (Person
in Company) field selected.

b. Click Next. The Table Builder Wizard (Step2/2) dialog displays.

Note:  Note: This grouping fields does not show Company record in the available
fields as it is not a sub-record of the selected grouping field, Country (Person
in Company) field.

c. Select the records you want to add to the table columns and click  to add the
records to the Table Column Fields. Click OK.

The table wizard generated the required code in the template document.
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d. Add the Company name and the Company Country records to the template
document. See the screenshot below.

e. Click  to execute the mail merge. The Select Record dialog displays. See
the screenshot below.
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f. Click Star t Mail Merge to generate the result document.

The result document contains three tables for each company, based on the
country of the employee (grouping field), which are three countries.

The following screenshot shows the result document showing the employee
tables for the company “Contoso” in two tables for the grouping in terms of
countries: Deutschland and Italien.
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6. Click Save As to save the template document. The Save As dialog displays.

A default name in the following format is automatically displayed,
<documentName_<date>_<user name>. In the screenshot above the default name is
<Demo>_<2016-12-21>_<SU>.

7. Click Save. The template document is saved to the D1 infoarea of the Aurea CRM
server.
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6
Currencies

Currencies
Aurea CRM allows you to use multiple currencies in parallel. Exchange rates are
used to convert values between currencies.

In addition, you can display amounts in a second currency in various info areas.
This allows you to display values in two currencies, e.g. euro and US dollars.

Exchange Rate

Select  (Administration) > Exchange Rate to define exchange rates.

Currencies are converted using base currencies.

Example: The base currency is euro. Using the exchange rate defined above, you
can convert yen to euro. You can also use this record to convert from euro to yen,
or from yen to any other currency that has an exchange rate entered for euro.

Currency Conversions
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The exchange rate is always added for the base currency. Currencies can be con-
ver ted to and from the base currency. By defining exchange rates between all cur-
rencies and the base currencies, any currency can be converted to any other cur-
rency via the base currency.

If you define an exchange rate record that does not contain a currency in the Cur-
rency field, you can use this record to convert values without a currency to other
currencies. The first record in the example above allows values without a currency
to be converted to euro, and by extension to all currencies for which an exchange
rate is defined where euro is the base currency.

Note: You can work with more than one base currency. However, Aurea recommends
only working with a single base currency. However, if you wish to work with several
base currencies, contact your Aurea representative.

Changing the Currency in a Record

You subsequently change the currency in all info areas except for the Offer and
Offer Item info areas. Amounts are converted automatically.

Note:  For currencies to be converted, appropriate exchange rates between the
currencies need to be defined.

Displaying Amounts in a Second Currency

To determine your second currency:

1. Select  (Settings) > User Configuration.

2. Switch to the Handling tab.

3. Select a Base Currency and save.

4. Select  (Settings) > Invalidate Cache.

Amounts entered in records are automatically displayed in this second currency
next to the value in the original currency. Sum totals in lists are also displayed in
this currency.

Note: The name of the second currency field is the same as the field containing
the original currency with the suffix "2C" (2nd Currency). These fields are not visible
by default in Aurea CRM web.

Note:  For currencies to be converted, appropriate exchange rates between the
currencies need to be defined.
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Corporate Currency

You can define a corporate currency in Aurea CRM. This corporate currency can
then be used to carry out analyses and evaluate data. When adding records that
contain fields used to store values in the corporate currency, the currently valid
exchange rate between the record's currency and the corporate currency is entered
in the record. This provides you with a snapshot of the value at the time the record
was added, and the exchange rate is not updated automatically if it changes in the
meantime.

For example, you can convert all prices and other currency amounts entered in the
local currency in opportunities and orders to the corporate currency, e.g. to analyze
and compare results for various regional subsidiaries.

The corporate currency is defined using the update_CorporateCurrency variable.
Select the desired currency in the Catalog Text field of the variable value, see
Variables in the CRM.core Administrator Guide. If you subsequently change the
corporate currency, the new currency is not updated in existing records.

To store values in the corporate currency in records, you need to add a new reference
field to the corresponding info area in the data model. The field type must be "cor-
porate currency". You then need to select the field (e.g. Total Product Value in the
Opportunity info area) whose value is converted to the corporate currency and
written to this field, see Adding New Fields in the CRM.core Administrator Guide.
Three additional fields are automatically added:

• Exchange rate (numeric field): Used to convert values between the two currencies.
The current exchange rate is transferred from the Exchange Rate info area when
adding a new record. If the exchange rate is changed manually, all corporate
currency fields in the record are recalculated using the new exchange rate. If the
exchange rate is deleted, the current exchange rate in the Exchange Rate info
area is entered automatically.

• Date (date field): The date on which the exchange rate was transferred from the
Exchange Rate info area or the date it was edited manually. This date is entered
automatically.

• Corporate currency (variable catalog): Cannot be edited.

In order to convert amounts between currencies in a record, the corresponding
currencies need to be entered in the Exchange Rate info area and the currency
used by amounts needs to be entered in the record itself.

Values in the corporate currency (i.e. in corporate currency fields) are updated in
the following cases:

• Whenever the value in the referenced field (i.e. the value in the record’s currency)
is edited

• Whenever the exchange rate entered in the record is updated

• The currency entered in the record is changed

Note:  Changes to the exchange rate in the Exchange Rate info area are not
automatically applied to existing records.
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Exchange Rate

Select  (Administration) > Exchange Rate to define exchange rates.

Currencies are converted using so-called base currencies.

Example: The base currency is euro. Using the exchange rate defined above, you
can convert yen to euro. You can also use this record to convert from euro to yen,
or from yen to any other currency that has an exchange rate entered for euro.

Currency Conversions

The exchange rate is always added for the base currency. Currencies can be con-
ver ted to and from the base currency. By defining exchange rates between all cur-
rencies and the base currencies, any currency can be converted to any other cur-
rency via the base currency.

If you define an exchange rate record that does not contain a currency in the Cur-
rency field, you can use this record to convert values without a currency to other
currencies. The first record in the example above allows values without a currency
to be converted to euro, and by extension to all currencies for which an exchange
rate is defined where euro is the base currency.
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Note: Note: You can work with more than one base currency. However, Aurea
recommends only working with a single base currency. If you nonetheless wish to
work with several base currencies, contact your Aurea representative.

Changing the Currency in a Record
You subsequently change the currency in all info areas except for the Offer and
Offer Item info areas. Amounts are converted automatically.

Note: Note: For currencies to be converted, appropriate exchange rates between
the currencies need to be defined, >> on page 171.

Displaying Amounts in a Second Currency
To determine your second currency:

1. Select  (Settings) > User Configuration.

2. Switch to the Handling tab.

3. Select a Base Currency and save.

4. Select  (Settings) > Invalidate Cache.

Amounts entered in records are automatically displayed in this second currency
next to the value in the original currency. Sum totals in lists are also displayed in
this currency.

Note: Note: The name of the second currency field is the same as the field
containing the original currency with the suffix "2C" (2nd Currency). These fields
are not visible by default in Aurea CRM web.

Note:  For currencies to be converted, appropriate exchange rates between the
currencies need to be defined, >> on page 171.
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Corporate Currency
You can define a corporate currency in Aurea CRM. This corporate currency can
then be used to carry out analyses and evaluate data. When adding records that
contain fields used to store values in the corporate currency, the currently valid
exchange rate between the record's currency and the corporate currency is entered
in the record. This provides you with a snapshot of the value at the time the record
was added, and the exchange rate is not updated automatically if it changes in the
meantime.

For example, you can convert all prices and other currency amounts entered in the
local currency in opportunities and orders to the corporate currency, e.g. to analyze
and compare results for various regional subsidiaries.

The corporate currency is defined using the update_CorporateCurrency variable.
Select the desired currency in the Catalog Text field of the variable value, >>
Variables in the CRM.core Administrator Guide. If you subsequently change the
corporate currency, the new currency is not updated in existing records.

To store values in the corporate currency in records, you need to add a new reference
field to the corresponding info area in the data model. The field type must be "cor-
porate currency". You then need to select the field (e.g. Total Product Value in the
Opportunity info area) whose value is converted to the corporate currency and
written to this field, >> Adding New Fields in the CRM.core Administrator Guide.
Three additional fields are automatically added:

• Exchange rate (numeric field): Used to convert values between the two currencies.
The current exchange rate is transferred from the Exchange Rate info area when
adding a new record. If the exchange rate is changed manually, all corporate
currency fields in the record are recalculated using the new exchange rate. If the
exchange rate is deleted, the current exchange rate in the Exchange Rate info
area is entered automatically.

• Date (date field): The date on which the exchange rate was transferred from the
Exchange Rate info area or the date it was edited manually. This date is entered
automatically.

• Corporate currency (variable catalog): Cannot be edited.

In order to convert amounts between currencies in a record, the corresponding
currencies need to be entered in the Exchange Rate info area and the currency
used by amounts needs to be entered in the record itself.
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Values in the corporate currency (i.e. in corporate currency fields) are updated in
the following cases:

• Whenever the value in the referenced field (i.e. the value in the record’s currency)
is edited

• Whenever the exchange rate entered in the record is updated

• The currency entered in the record is changed

Note: Note: Changes to the exchange rate in the Exchange Rate info area are not
automatically applied to existing records.
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7
Rep Information

Rep Information
Learn to store users in Aurea CRM and add additional information about them.

Users in Aurea CRM are stored in the Rep info area (  (Administration) > Reps).
You can enter additional information concerning the rep in the Rep Additional Info
info area.

Assign the rep to a business area (e.g. "OTC") in the Business Area field in the
Rep Additional Info info area. If you define product details for the "OTC" business
area, these records only apply to reps assigned to the "OTC" business area. The
same applies to the entry of sample codes, weightings and conditions.

Reps can only view those entries assigned to their business area.
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8
Items

Items
You can manage the items offered by your company in the item master in Aurea
CRM. The item master stores all items.

You can:

• Search for and add items.

• Automatically transfer item details to other info areas (e.g. offer items, installed
base items etc.).

• Group items by product group, sector, brand and grade.

• Define various price lists in various currencies that are used to automatically price
items when adding offers, orders and refunds.

• Enter sample codes for each business area to determine the introduction period
for an item and the amount of samples that may be distributed during this phase.

• Define complex conditions with staggered discounts (at the offer/order and item
levels), fixed prices and discounts in kind for companies, customer groups, items
and item groups.

• Define hierarchical item structures.

Note: You can also search for items in Aurea CRM win using the item search ( ),
see Aurea win Business Logic BTB manual.

424AUREA CONFIDENTIAL

Chapter 8: Items



Item Master

The Item Master info area stores basic information about individual items. For more
information on the individual fields, refer to the online field help.

Item data plays an important role in other info areas:

• For example, you can define discounts for sectors or product groups, which then
apply to all items belonging to that sector or product group.

• You can define any number of price lists for each item.

The following info areas access the item master:

• Special Offer Item

• Offer Item

• Order Item

• Stock

• Stock Control Item

• Installed Base Item

• Conditions

• Competition Item
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• Listing

• POS Monitoring Item

• Product Discussion Definition Item

• Refunding Item

• Slotting Fees

• Promotional Material

Click on  (Select) next to the Item No. field in these info areas to select the desired
item. Data from the item master is transferred to the record (e.g. Item No., Item
name etc.).

Note: Note: If a record is deleted in the Item Master info area, all sales sector
items relating to this item are also deleted. Do not subsequently change the Item
No. and Item name, as these changes are not applied to any linked records (e.g.
stock control items), in order to retain the history using the original Item No.. Any
calculations carried out for records containing the old item number is no longer be
correct.

Adding Items

To add a new item:

1. The following options are available:

• Select  (Products & Service) > New Item.

• Select  (Products & Service) > Item Master, star t the search and click
on  (New).

2. Enter data such as the Item No., Item name, Sector, Product Group etc.

3. Enter additional data on the various tabs. For example, you can define the time
period over which the item may be sold using the Saleable From and Saleable
To fields.

4. Save the record.

Price Lists

Any number of price lists can be defined per item in the Price List info area. The
prices of items in offers, orders and refunds are automatically calculated based on
the price lists.
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There are three types of price lists:

• Individual price lists (Indiv. Price List field): A price list that can be selected
explicitly in an offer/order.

• Customer group price lists (Customer Group field): A price list for a group of
companies.

• Country-specific price lists (Country field): Price list for a country.

In each price list, only one of these three fields may contain data. When pricing
items, individual price lists take precedence. If no suitable individual price list is
available, a customer group price list is used, and finally the price list for a country
is used if no other list is found.

Note: Note: Price lists are only valid for offers, orders and refunds added in the
same currency as the price list. Currencies cannot be converted.When viewing an
item, price lists defined for an item are listed under Related Data.

Time Limitations for Price Lists

Define the time period the price list is valid for in the Valid from and Valid to fields.
For example, you can add new price lists for an item for various countries each
year, without needing to delete the old price lists. These time periods may not
overlap one another for the same item, country and currency (i.e. only one price list
can be valid for at any time).

If you add a new price list, whose time period overlaps the time period entered for
an existing price list, a message is displayed including existing price list's time pe-
riod. You can change the time period as necessary.

Defining the Structure of a Price List

Aurea recommends creating a price list in the local currency for every country and
item. This price list is then used for offers and orders if no individual or customer
group price lists apply.
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Individual and customer group price lists only need to be added if prices for individ-
ual companies or company groups differ from the standard prices (i.e. the country
prices).

Customer group price lists are recommended if you want to define a price list for a
group of customers, especially if you want define conditions (discounts) for this
group, >> on page 233.

Individual price lists can used to define specific price lists for companies that are
part of a customer group, but to which prices that differ from the group’s prices apply.

Individual price lists must be entered in offers or orders, i.e. you can choose whether
an individual price list should be used when adding an offer or order.

Weightings

Use the Weighting info area (not available by default in Aurea CRM web) to define
weightings for a specific time period that apply to an item and business area: The
time periods defined for the weightings per business area may not overlap.

Enter weightings for an item in the Item Master info area.

The following prerequisites must be met to use weightings when adding offers and
orders:

• The weighting must apply to the same business area as the offer or order. The
business area is transferred from the data stored in the Rep Additional Info info
area for the rep who added the offer or order.

• A weighting record must exist for the item entered in the offer or order items.

• The weighting must be valid at the time of the offer or order (Date in the offer/order
is between the dates entered in the Valid from and Valid to fields in the
weighting).

If no suitable weighting has been entered, the Weighting is set to 0 (zero).

The weighted total quantity of an offer/order items and the total weighted quantity
of the offer/order are calculated automatically is based on the weightings; these
values are used to apply discounts at the offer/order level.

The corresponding fields in the offer or order items are calculated as follows:

CalculationField

Factor (from the Weighting info area)Weighting

Quantity * WeightingWtd. Qty

Inventory quantity * WeightingWtd. Qty. Or-
dered

The Wtd. Qty Ordered and Inventory quantity fields are only present in the Order
Item info area.

The values in the Wtd. Qty. fields in the item records are totaled in the Weighted
total quantity field in the order record.
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Time Periods

You can enter time periods in the Item Master info area for each item and business
area, which determine when an item can be sold, ordered or returned:

• If you have a continuous time period during which orders, sales and returns
can take place, you can enter the time period directly in the item master record
(Saleable from/to, In Stock From/To, Repurchase From/To fields).

• Time periods that are not continuous can be defined for orders, sales and
returns in the Period info area (not available by default in Aurea CRM web). Enter
the Business Area, Type (Can be sold, Can be Ordered, Return) and the valid
time period (Valid from/to fields).

Note: Note: Your administrator can use these time periods to define conditions
that apply to access rights. For example, your administrator can determine that
items are only displayed if the current date in within one of the time periods entered
in the Item Master or Period info areas, see CRM.core Administrator Guide.

Item Structure

You can define item structures in Aurea CRM in order to depict products in your
product catalog, components in a product consisting of multiple items or a basic
product and its additional components (e.g. a bicycle composed of a frame, breaks,
tires, saddle etc. or a games console package including two controllers and a game).

Defining item structures provides you with quick access to items and related items
in the item structure, and allows you to restrict and group items, e.g. in the quick
add area.

Items are defined in the Item Master info area and are linked to form a structure in
the Item Structure info area. Whenever you add an item structure record, Aurea
CRM automatically updates the item structure.

Item structures are defined by adding item structure records and entering the
Structure type and the parent item in the field. A single item structure consists of
all items linked to one another (directly or indirectly) using the same structure type.
The top level of the hierarchy (the root) has no parent node. The item structure is
thus defined from bottom to top. Any number of items can have the same parent
item. Only items without children (leaves) may be present in the item structure more
than once to ensure that the item structure is unique. Ensure you do not define any
cyclical structures.

To add an item structure:

1. Switch to the desired item in the Item Master info area.

2. Switch to the Item Structure tab and click on  (New).

3. Select the parent item.

4. Select the Structure type.

5. Save. The item structure is added or updated automatically.
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The item structure itself is formed based on the station and serial numbers of item
structure records. The keys (station number and serial number) of item structure
records higher up in the hierarchy and of the current item structure record are auto-
matically entered in the PB_1_StaNo/SerNo - PB_10_StaNo/SerNo fields. These
fields depict the path from the current item structure record to the root item structure
record. The root item structure’s key is always entered in the PB_1_StaNo/SerNo
fields and the Generated check box is enabled automatically in the root item
structure record (this record is generated automatically). The item structure can
consist of up to 10 levels.

Example:

Six item, A1-A6 are present in the system. The Structure type "Structure 1" is used
to depict the item structure. The following image illustrates the item structure.

Item 6 (A6) is represented by the following item structure record, which stores the
full path to item 1 (A1, the root item). IS_4_StaNo/SerNo contain the station number
and serial number of the current record (A6), IS_3_StaNo/SerNo contain the the
key of the item structure record added for item 3 (A3) etc.
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Whenever you delete an item structure record or an item, Aurea CRM automatically
updates the item structure. If you delete a node (item or item structure record) that
has child nodes, the child nodes immediately below the deleted records become the
root nodes of new item structures.

If you make changes to the item structure records themselves, you can update the
item structure.

To update the item structure automatically:

• Aurea CRM win: Select Item Structure from the context menu in the Item Master
info area. Select Generate Relationship Hierarchy from the context menu in the
Item Structure info area.

• Aurea CRM web: Use a CRM.server To-Do (type 20), see To-Do Types in the
CRM.core Administrator Guide.

Note: Note: The IS_X_StaNo/SerNo fields are not communicated and are
recalculated when inputting the communication file.When importing an item structure,
the Item No. and Parent Item No. are used to create the hierarchy automatically.
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Item Master

The Item Master info area stores basic information about individual items. For more
information on the individual fields, refer to the online field help.

Item data plays an important role in other info areas:

• For example, you can define discounts for sectors or product groups, which then
apply to all items belonging to that sector or product group.

• You can define any number of price lists for each item, >> on page 177.

The following info areas access the item master:

• Special Offer Item

• Offer Item

• Order Item

• Stock
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• Stock Control Item

• Installed Base Item

• Conditions

• Competition Item

• Listing

• POS Monitoring Item

• Product Discussion Definition Item

• Refunding Item

• Slotting Fees

• Promotional Material

Click on  (Select) next to the Item No. field in these info areas to select the desired
item. Data from the item master is transferred to the record (e.g. Item No., Item
name etc.).

Note: Note: If a record is deleted in the Item Master info area, all sales sector
items relating to this item are also deleted.Do not subsequently change the Item
No. and Item name, as these changes are not applied to any linked records (e.g.
stock control items), in order to retain the history using the original Item No.. Any
calculations carried out for records containing the old item number will no longer
be correct.

Adding Items
To add a new item:

1. The following options are available:

• Select  (Products & Service) > New Item.

• Select  (Products & Service) > Item Master, star t the search and click
on  (New).

2. Enter data such as the Item No., Item name, Sector, Product Group etc.

3. Enter additional data on the various tabs. For example, you can define the time
period over which the item may be sold using the Saleable From and Saleable
To fields.

4. Save the record.
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Price Lists
Any number of price lists can be defined per item in the Price List info area. The
prices of items in offers, orders and refunds are automatically calculated based on
the price lists.

There are three types of price lists:

• Individual price lists (Indiv. Price List field): A price list that can be selected
explicitly in an offer/order.

• Customer group price lists (Customer Group field): A price list for a group of
companies.

• Country-specific price lists (Country field): Price list for a country.

In each price list, only one of these three fields may contain data. When pricing
items, individual price lists take precedence. If no suitable individual price list is
available, a customer group price list is used, and finally the price list for a country
is used if no other list is found, >> on page 199.

Note: Note: Price lists are only valid for offers, orders and refunds added in the
same currency as the price list. Currencies cannot be converted.When viewing an
item, price lists defined for an item are listed under Related Data.
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Time Limitations for Price Lists
Define the time period the price list is valid for in the Valid from and Valid to fields.
For example, you can add new price lists for an item for various countries each
year, without needing to delete the old price lists. These time periods may not
overlap one another for the same item, country and currency (i.e. only one price list
can be valid for at any time).

If you add a new price list, whose time period overlaps the time period entered for
an existing price list, a message is displayed including existing price list's time pe-
riod. You can change the time period as necessary.

Defining the Structure of a Price List
Aurea recommends creating a price list in the local currency for every country and
item. This price list is then used for offers and orders if no individual or customer
group price lists apply.

Individual and customer group price lists only need to be added if prices for individ-
ual companies or company groups differ from the standard prices (i.e. the country
prices).

Customer group price lists are recommended if you want to define a price list for a
group of customers, especially if you want define conditions (discounts) for this
group, >> on page 233.

Individual price lists can used to define specific price lists for companies that are
part of a customer group, but to which prices that differ from the group’s prices apply.

Individual price lists must be entered in offers or orders, i.e. you can choose whether
an individual price list should be used when adding an offer or order.

Weightings
Use the Weighting info area (not available by default in Aurea CRM web) to define
weightings for a specific time period that apply to an item and business area: The
time periods defined for the weightings per business area may not overlap.

Enter weightings for an item in the Item Master info area.

435AUREA CONFIDENTIAL

Weightings



The following prerequisites must be met to use weightings when adding offers and
orders:

• The weighting must apply to the same business area as the offer or order. The
business area is transferred from the data stored in the Rep Additional Info info
area for the rep who added the offer or order.

• A weighting record must exist for the item entered in the offer or order items.

• The weighting must be valid at the time of the offer or order (Date in the offer/order
is between the dates entered in the Valid from and Valid to fields in the
weighting).

If no suitable weighting has been entered, the Weighting is set to 0 (zero).

The weighted total quantity of an offer/order items and the total weighted quantity
of the offer/order are calculated automatically is based on the weightings; these
values are used to apply discounts at the offer/order level, >> on page 235.

The corresponding fields in the offer or order items are calculated as follows:

CalculationField

Factor (from the Weighting info area)Weighting

Quantity * WeightingWtd. Qty

Inventory quantity * WeightingWtd. Qty. Or-
dered

The Wtd. Qty Ordered and Inventory quantity fields are only present in the Order
Item info area.

The values in the Wtd. Qty. fields in the item records are totaled in the Weighted
total quantity field in the order record.

Time Periods
You can enter time periods in the Item Master info area for each item and business
area, which determine when an item can be sold, ordered or returned:

• If you have a continuous time period during which orders, sales and returns
can take place, you can enter the time period directly in the item master record
(Saleable from/to, In Stock From/To, Repurchase From/To fields).

• Time periods that are not continuous can be defined for orders, sales and
returns in the Period info area (not available by default in Aurea CRM web). Enter
the Business Area, Type (Can be sold, Can be Ordered, Return) and the valid
time period (Valid from/to fields).
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Note: Note: Your administrator can use these time periods to define conditions
that apply to access rights. For example, your administrator can determine that
items are only displayed if the current date in within one of the time periods entered
in the Item Master or Period info areas, >> CRM.core Administrator Guide.

Item Structure
You can define item structures in Aurea CRM in order to depict products in your
product catalog, components in a product consisting of multiple items or a basic
product and its additional components (e.g. a bicycle composed of a frame, breaks,
tires, saddle etc. or a games console package including two controllers and a game).

Defining item structures provides you with quick access to items and related items
in the item structure, and allows you to restrict and group items, e.g. in the quick
add area, >> on page 183.

Items are defined in the Item Master info area and are linked to form a structure in
the Item Structure info area. Whenever you add an item structure record, Aurea
CRM automatically updates the item structure.

Item structures are defined by adding item structure records and entering the
Structure type and the parent item in the field. A single item structure consists of
all items linked to one another (directly or indirectly) using the same structure type.
The top level of the hierarchy (the root) has no parent node. The item structure is
thus defined from bottom to top. Any number of items can have the same parent
item. Only items without children (leaves) may be present in the item structure more
than once to ensure that the item structure is unique. Ensure you do not define any
cyclical structures.

To add an item structure:

1. Switch to the desired item in the Item Master info area.

2. Switch to the Item Structure tab and click on  (New).

3. Select the parent item.

4. Select the Structure type.

5. Save.

The item structure is added or updated automatically.
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The item structure itself is formed based on the station and serial numbers of item
structure records. The keys (station number and serial number) of item structure
records higher up in the hierarchy and of the current item structure record are auto-
matically entered in the PB_1_StaNo/SerNo - PB_10_StaNo/SerNo fields. These
fields depict the path from the current item structure record to the root item structure
record. The root item structure’s key is always entered in the PB_1_StaNo/SerNo
fields and the Generated check box is enabled automatically in the root item
structure record (this record is generated automatically). The item structure can
consist of up to 10 levels.

Example:

Six item, A1-A6 are present in the system. The Structure type "Structure 1" is used
to depict the item structure. The following image illustrates the item structure.

Item 6 (A6) is represented by the following item structure record, which stores the
full path to item 1 (A1, the root item). IS_4_StaNo/SerNo contain the station number
and serial number of the current record (A6), IS_3_StaNo/SerNo contain the the
key of the item structure record added for item 3 (A3) etc.
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Whenever you delete an item structure record or an item, Aurea CRM automatically
updates the item structure. If you delete a node (item or item structure record) that
has child nodes, the child nodes immediately below the deleted records become the
root nodes of new item structures.

If you make changes to the item structure records themselves, you can update the
item structure.

To update the item structure automatically:

• Aurea CRM win: Select Item Structure from the context menu in the Item Master
info area. Select Generate Relationship Hierarchy from the context menu in the
Item Structure info area.

• Aurea CRM web: Use a CRM.server To-Do (type 20), >> To-Do Types in the
CRM.core Administrator Guide.

Note: Note: The IS_X_StaNo/SerNo fields are not communicated and are
recalculated when inputting the communication file.When importing an item structure,
the Item No. and Parent Item No. are used to create the hierarchy automatically.
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Item Structure Links
Aurea CRM offers indirect links between items in the Item Master info area (via the
Item Structure info area) that can be used to defined queries applied to the item
structure, for example.

Links 950-980 and 30000-36000 are available by default and apply to all item
structure records (irrespective of the structure type), >> Link IDs in the CRM.core
Administrator Guide.

• 30000: Returns the entire item structure

• 32000: Returns all parent items

• 34000: Returns all child items

• 36000: Returns all parent and child items both higher up and lower down in the
hierarchy

The following image outlines the difference between links 30000 and 36000.

Example:

Six item, A1-A6 are present in the system. The Structure type "Structure 1" is used
to depict the item structure. "Sport" is entered as item 2’s Business Area. The fol-
lowing image illustrates the item structure.
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Define a query that returns all items whose business area is "Sport" as well as all
items linked to these items via the item structure (Structure type "Structure 1").

Link 34000 returns items 2, 3, 4 and 6.

Link 32000 returns items 1 and 2; link 30000 returns all items and link 36000 returns
items 1,2, 3, 4 and 6.

You can define variables of the Type "Condition" to define additional links using
your own condition. You can define up to 10 different conditions for item structures
using the 30000-130000 links. These links are numbered in intervals of 10,000 and
are named according to the structure type (e.g. "Structure 1").
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You can define the following 10 variables:

CORE::INDIRECT-IS-LINK-TREE-0

(this variable fur ther restricts the default links 30000-36000).

CORE::INDIRECT-IS-LINK-TREE-1

...

CORE::INDIRECT-IS-LINK-TREE-9

Example:

Define the variable
CORE::INDIRECT-IS-LINK-TREE-1

in the Rights module in Aurea CRM win. Select the Item Structure info area in the
Info Area field, the Structure type field in the Field Name field and "Condition" in
the Type field. Add a variable value for the variable and enter the comparison field
and desired structure type in the Var. Text field, e.g. "F6=’Structure 1’".

If you define conditional access rights for items in the Rights module in Aurea CRM
win and apply conditions to the Item Master info area, you can select the default
indirect links and the links that only apply to the structure type used to define the
item structure in the Index Relationship column. This allows you to define that a
rep can access items assigned to a specific business area, as well as all related
items in the item structure, for example.
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Note: Note: For more information on variables, >> Variables and Conditions Applied
via Indirect Links in the CRM.core Administrator Guide.

Item Structure in the Quick Add Area
Your administrator can integrate a tree displaying the hierarchical item structure in
the generic quick add area for items (e.g. for offer items). You can then select items
directly from within the tree. All child items in the item structure are displayed in
the quick add area. The selected item can also be displayed, if configured accord-
ingly.

For information on the configuration, refer to HierarchicalSerialEntry in the Aurea
CRM web Administrator Guide.

If you open the quick add area, the tree view is displayed on the left, and the quick
add area on the right displays all items, including those not in the item structure,
>> on page 104. All items continue to be listed in the quick add area until an item
is selected from the tree.
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• Click on  or  in the tree to show/hide items (nodes).

• Click on an item in the tree to display only those items below the selected item
in the tree in the quick add area.

Note: Note: By default, the selected item is not displayed in the quick add area
on the right. Your administrator can however determine that the selected item
(node) is displayed (as in the mountain bike example).By default, the tree only
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displays structure nodes (e.g. "Gearshift (MB)") and not individual items (e.g.
"Gearshift LX"). Your administrator can however determine that items are also
displayed in the tree, as in the example.Your administrator can define the order
in which items are sor ted in the tree (e.g. in ascending or descending alphabetical
order).

• Search criteria and filters (e.g. All) are applied to the selected item and child
items displayed in the list.

For example, enter all or a por tion of an item’s number in the Item field to restrict
the display to only those items with a matching number. For example, if you select
the Mountain Bike node in the tree and enter "*04*", only items c204-1, c204-11,
c204-12 and c204-13 are displayed in the list.

Note: Note: Click on the Overview filter button to remove the current selection
from the tree and display those items in your shopping car t. Clicking on the Last
Entries filter button also removes the current selection from the tree. If the
Overview or Last Entries filters are enabled and you click on an item in the tree,
the All filter is automatically applied.

• Click on Deselect to clear the selection in the item tree. Filters and search criteria
apply to the display of all items in the quick add area, irrespective of whether
they are in the item structure or not.

• Drag the separator between the tree and quick add area to change the width of
the tree.
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9
Opportunities

Opportunities
You can add opportunities in Aurea CRM once you come to know of a possible sales
opportunity.

Throughout the sales process, you can collect more and more information relating
to the opportunity. Enter this information in Aurea CRM so that your colleagues can
access the current status of an opportunity at any time.

Opportunity management in Aurea CRM allows you to:

• Add opportunities and manage them.

• Add opportunity products including details (estimated price etc.).

• Enter the persons involved in an opportunity as participants with specific roles
(decision maker, par tner etc.) including details on the participants’ attitude and
influence.

• Add an installed base for an opportunity par ticipant.

• Add Opportunity Competitors.

• Add relevant documents.

• Document all activities that take place within the scope of the opportunity.

• Once you have begun negotiations, you can create an initial offer and
automatically transfer information from the opportunity to the offer.

• Opportunities can be rated (ABC classification), allowing you to concentrate on
those opportunities with the highest expected impact/revenue.

• Analyze opportunities, for example to create revenue forecasts or to optimize
your sales processes.

Adding Opportunities

Fundamental information on sales opportunities is stored in the Opportunity info
area.
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To add an opportunity:

1. The following options are available:

• Select  (Sales) > New Opportunity. Select a company.

• Switch to the company you wish to add the opportunity for, and select New >
New Opportunity from the context menu.

2. Enter the following details:

• Name of the Opportunity.

• Currency

• Estimated product value (Total product value)

You can also add opportunity products, in which case the product value is au-
tomatically calculated.

• The opportunity’s investment and realization probability.

• The estimated Completion Date.

3. Save the record.

4. Add the following additional information regarding the opportunity:

• Opportunity par ticipants

• Opportunity products and offers
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• Opportunity competitors

• Activities

• Document links

• Installed base

• Opportunity rating

Adding Opportunity Participants

Opportunity par ticipants are those companies and persons involved in the decision-
making process of an opportunity, e.g. contact persons, planners, local authorities,
par tners etc. Opportunity offers are always created for opportunity par ticipants.

Adding Activities for Opportunity Participants

If you have an appointment with an opportunity par ticipant, you can add a corre-
sponding activity.

To add activity for an opportunity par ticipant:

1. Switch to the desired opportunity.

2. The following options are available:

• Select New > New Activity from the opportunity’s context menu. Select the
opportunity par ticipant.

• Select New > New Activity from the opportunity par ticipant’s context menu.

The input mask for activities is displayed.

3. Enter the data.

4. Save the record.

Adding Installed Bases for Opportunity Participants

The Installed Base info area allows you to store the products currently used by a
customer.

Opportunity Products and Offers

There are several ways to calculate the value of an opportunity based on the values
entered in opportunity products and offers.

Entering the Value of an Opportunity Directly

If you only have estimates available when first dealing with an opportunity, and have
no specific details on products, enter the values directly in the opportunity. Once
you add products or an offer with items for the opportunity, these values are over-
written.

• Total product value: Estimated total value of the opportunity

• Wtd. total product value: The estimated value weighted by the probability of the
opportunity

• Realization probability (%): The probability of the customer placing an order
corresponding to this opportunity with anyone.

• Investment Probability (%): Probability of the customer placing an order with
your company (and not with a competitor).
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A fur ther weighted value is calculated automatically.

Adding Opportunity Products

If you know which of your products have attracted the interest of a potential customer,
you can add the products as opportunity products.

To add opportunity products:

1. Switch to the desired opportunity.

2. Switch to the Opportunity Product tab and click on  (New).

3. Enter the following details:

• Prod.Cat. and Brand

• Product value (the absolute product value)

• Wtd. product value (the product value weighted by the probability)

Note: Note: If you change the Product value, the Wtd. product value is not
updated automatically. Enter 0 (zero) in the Wtd. product value field to recalculate
the value.

4. Save the record.

A second weighted value is calculated automatically by the system using the prob-
abilities entered in the opportunity as follows:

Wtd. product value (Opportunity) = Product value * Investment Probability
(%)[opportunity] * Realization Probability (%)[opportunity]

The product values of all opportunity products are totaled and written to the Total
product value, Wtd. total product value and Wtd. total product value (Opportu-
nity) fields in the opportunity. Manual values entered previously are overwritten in
the process.

Note: Note: If you add an item to an opportunity offer that corresponds to an
opportunity product, the Product value, Wtd. product value  and Wtd product
value (Opportunity( are overwritten with the values in the offer. Opportunity products
are only added or updated automatically if the Status of the offer is "Offered".Wtd.
product value = Product value * Investment Probability (%)[offer] * Realization
Probability (%)[offer]

449AUREA CONFIDENTIAL

Opportunities



Adding Opportunity Offers

If you add an offer for an opportunity, the value of the items in the offer are totaled
and the weighted value is entered in the opportunity. In many cases, offers are
subject to negotiations. Enter any changes to the offer in the opportunity and add
any follow-up offers. If the negotiations are successful, you can copy the offer to
an order.

To add an offer for an opportunity:

1. Switch to the desired opportunity.

2. Switch to the Opportunity Participants tab and select New > New Offer from
the desired participant’s context menu.

The new offer is automatically linked to the opportunity. If the participant is a
person, they are entered in the Contact Person field.

3. Enter the Currency. Once the offer has been saved, you can no longer edit the
Currency field. The currency is transferred to the offer’s items.

4. Enter fur ther data concerning the offer, e.g. the Offer No., Realization Probability
(%) etc.

Note: Note: Set the Status to Offered to transfer the values entered in the offer
items to the opportunity products.

5. Save the record.

6. Select New > New Offer Item from the opportunity par ticipant’s context menu to
add items to the offer.
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The Offer value field in the offer is calculated from the sum total of the value of
all items (after any discounts have been applied to the items and offer). Offer
items where the Optional item check box is enabled are ignored.

An opportunity product record is automatically added for each product entered in
the offer item records using the following values:

• Product value: The value of the item

• Wtd. product value: Item value weighted according to the probability of the offer

• Wtd. product value (Opportunity): Item value weighted according to the
probabilities entered in the opportunity

Note: Note: If you add an item to an opportunity offer that corresponds to an
opportunity product (the values in the Product Group and Brand field are the same,
the Sector and Grade fields are empty), the Product value, Wtd. product value
and Wtd. product value (Opportunity( are overwritten with the values in the offer.
Opportunity products are only added or updated automatically if the Status of the
offer is "Offered".

If the currency entered in the offer differs from that in the opportunity, the values
are converted automatically using the exchange rate table, >> on page 171.

For fur ther information on offers and orders, >> on page 193.

Adding Opportunity Competitors

Aurea CRM web allows you to store competitors also competing for an opportunity.

To add a competitor:

1. Switch to the desired opportunity.

2. The following options are available:

• Select New > New Competitor from the opportunity’s context menu.

• Switch to the Opportunity Competitor tab and click on  (New).

3. Select a competitor from the drop-down list or enter a new name.

Note: Note: Competitors are not stored as companies or persons, but as catalog
values.

4. Enter fur ther information, such as the Strengths and Weaknesses of the
competitor and the Price of the competitor’s products.

Rating Opportunities

You can evaluate opportunities in Aurea CRM web. To do so, your administrator
needs to define a por tfolio. The portfolio format contains questions used to classify
opportunities.
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To evaluate an opportunity:

1. Switch to the desired opportunity.

2. Select New > New Portfolio from the context menu.

3. Answer the predefined questions.

By default, the rating determined for the opportunity is entered in the ABC field in
the opportunity record.

Sales Funnel

Use the sales funnel to analyze your opportunities, for example to:

• Forecast future business development

• Localize possible problems and implement corrective measures

To access the sales funnel:

1. Select  (Sales) > Sales Funnel.
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2. You can change which data is displayed, for example by choosing a different
category or defining a filter and clicking on Start.

Note: Note: Only opportunities where a completion date has been entered are
included in the sales funnel.

Buying Center Wall

The buying center wall display all opportunity par ticipants and provides suggestions
for additional par ticipants. You can display information on participants’ roles (e.g.
decision maker, contact person) and attitude (e.g. neutral, positive), manage partic-
ipants and add notes. This allows you to keep track of individual par ticipant’s attitude
and ensures that important par ticipants are not forgotten.
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Note: Note: Your administrator can configure the appearance of the buying center
wall (e.g. column sort order, font color), see BuyingCenter in the Aurea CRM web
Administrator Guide.

To open the buying center wall, switch to the desired opportunity and select Buying
Center from the context menu.

The buying center wall is opened.

• The opportunity’s par ticipants are displayed in the main area on the right in various
columns (grouped by attitude by default). If no attitude has been entered for a
participant, the participant is displayed in the no value column. This column is
only displayed if par ticipants exist where no attitude is entered.

• Opportunity par ticipants are color-coded according to their role.

• Information on the opportunity is displayed in the header, e.g. the level.

• If a par ticipant’s attitude has changed, drag the participant to the corresponding
column to update their attitude.

• Click on a participant to display the context menu and edit icons.

• Click on  (Edit) to change the participant’s role or enter a comment etc.

Click on the circle ( ) to set the person’s Influence (low, medium, high).
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Note: Note: When in edit mode, you can save your changes ( ) or cancel
them ( ). You can also click on another par ticipant to save, or press the Esc
key to cancel your edit. You cannot drag and drop records while in edit mode.

• Open the context menu ( ) and select Delete to remove the opportunity
participant.

• Click on New Participant in the sidebar to add a new participant to the opportunity.
Choose the participant and then set their attitude by dragging the participant to
the appropriate column.

Note: Note: The same participant can be added to the opportunity with multiple
roles, but can only be added once per role.

• Open the Suggested Participants drop-down list and select an entry to display
suggested participants:

• from other opportunities: Those companies and persons are listed that are
involved in other opportunities with at least one of the current opportunity’s
participants.

• from activities: Those companies and persons are displayed that are entered
as participants in activities linked to the current opportunity.

• from corporate structure:This options suggests companies and persons in
companies within the same corporate structure as the company the current
opportunity was added for. Only companies/persons that are par ticipants in
other opportunities of the same Type as the current opportunity are suggested.

• from company: All persons in the company (KP) the opportunity was added
for are suggested (excluding those that are already participants).

Drag the desired company/person from the list of suggestions below the Suggest
Participants field to the appropriate column (e.g. indifferent) to add them to the
opportunity as a par ticipant. A corresponding opportunity par ticipant record is
added automatically and the participant’s attitude is entered.

• If configured by your administrator, information is displayed in the sidebar on the
Missing required roles and Missing optional roles. For example, you may need
to add 3 consultants, but have only added one.

• Click on  or  to hide/show the sidebar and Related Data.

• Data related to the current opportunity is displayed under Related Data.

• Click on  (Context Menu) on the right of the header to access the context menu,
e.g. select Tab View to open the opportunity in tab view.
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Adding Opportunities
Fundamental information on sales opportunities is stored in the Opportunity info
area.

To add an opportunity:

1. The following options are available:

• Select  (Sales) > New Opportunity. Select a company.

• Switch to the company you wish to add the opportunity for, and select New >
New Opportunity from the context menu.

2. Enter the following details:

• Name of the Opportunity.

• Currency

• Estimated product value (Total product value)
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You can also add opportunity products, in which case the product value is au-
tomatically calculated, >> on page 187.

• The opportunity’s investment and realization probability, >> on page 187.

• The estimated Completion Date, >> on page 190.

3. Save the record.

4. Add the following additional information regarding the opportunity:

• Opportunity par ticipants >> on page 186

• Opportunity products and offers, >> on page 187 and on page 188

• Opportunity competitors, >> on page 189

• Activities, >> on page 187

• Document links, >> on page 167

• Installed base, >> on page 187

• Opportunity rating, >> on page 190

Adding Opportunity Participants
Opportunity par ticipants are those companies and persons involved in the decision-
making process of an opportunity, e.g. contact persons, planners, local authorities,
par tners etc. Opportunity offers are always created for opportunity par ticipants, >>
on page 188 and on page 69.

Adding Activities for Opportunity Participants
If you have an appointment with an opportunity par ticipant, you can add a corre-
sponding activity.

To add activity for an opportunity par ticipant:

1. Switch to the desired opportunity.

2. The following options are available:

• Select New > New Activity from the opportunity’s context menu. Select the
opportunity par ticipant.

• Select New > New Activity from the opportunity par ticipant’s context menu.

The input mask for activities is displayed, >> on page 144.

3. Enter the data.

4. Save the record.
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Adding Installed Bases for Opportunity Participants
The Installed Base info area allows you to store the products currently used by a
customer, >> on page 292.

Opportunity Products and Offers
There are several ways to calculate the value of an opportunity based on the values
entered in opportunity products and offers.

Entering the Value of an Opportunity Directly
If you only have estimates available when first dealing with an opportunity, and have
no specific details on products, enter the values directly in the opportunity. Once
you add products or an offer with items for the opportunity, these values are over-
written.

• Total product value: Estimated total value of the opportunity

• Wtd. total product value: The estimated value weighted by the probability of the
opportunity

• Realization probability (%): The probability of the customer placing an order
corresponding to this opportunity with anyone.

• Investment Probability (%): Probability of the customer placing an oder with
your company (and not with a competitor).

A fur ther weighted value is calculated automatically:

Adding Opportunity Products
If you know which of your products have attracted the interest of a potential customer,
you can add the products as opportunity products.

To add opportunity products:

1. Switch to the desired opportunity.

2. Switch to the Opportunity Product tab and click on  (New).
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3. Enter the following details:

• Prod.Cat. and Brand

• Product value (the absolute product value)

• Wtd. product value (the product value weighted by the probability)

Note: Note: If you change the Product value, the Wtd. product value is not
updated automatically. Enter 0 (zero) in the Wtd. product value field to recalculate
the value.

4. Save the record.

A second weighted value is calculated automatically by the system using the prob-
abilities entered in the opportunity as follows:

Wtd. product value (Opportunity) = Product value * Investment Probability
(%)[opportunity] * Realization Probability (%)[opportunity]

The product values of all opportunity products are totaled and written to the Total
product value, Wtd. total product value and Wtd. total product value (Opportu-
nity) fields in the opportunity. Manual values entered previously are overwritten in
the process.

Note: Note: If you add an item to an opportunity offer that corresponds to an
opportunity product, the Product value, Wtd. product value  and Wtd product
value (Opportunity( are overwritten with the values in the offer. Opportunity products
are only added or updated automatically if the Status of the offer is "Offered".Wtd.
product value = Product value * Investment Probability (%)[offer] * Realization
Probability (%)[offer]
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Adding Opportunity Offers
If you add an offer for an opportunity, the value of the items in the offer are totaled
and the weighted value is entered in the opportunity. In many cases, offers are
subject to negotiations. Enter any changes to the offer in the opportunity and add
any follow-up offers. If the negotiations are successful, you can copy the offer to
an order, >> on page 195.

To add an offer for an opportunity:

1. Switch to the desired opportunity.

2. Switch to the Opportunity Participants tab and select New > New Offer from
the desired participant’s context menu.

The new offer is automatically linked to the opportunity. If the participant is a
person, they are entered in the Contact Person field.

3. Enter the Currency. Once the offer has been saved, you can no longer edit the
Currency field. The currency is transferred to the offer’s items.

4. Enter fur ther data concerning the offer, e.g. the Offer No., Realization Probability
(%) etc.

Note: Note: Set the Status to Offered to transfer the values entered in the offer
items to the opportunity products.
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5. Save the record.

6. Select New > New Offer Item from the opportunity par ticipant’s context menu to
add items to the offer, >> on page 194.

The Offer value field in the offer is calculated from the sum total of the value of
all items (after any discounts have been applied to the items and offer). Offer
items where the Optional item check box is enabled are ignored.

An opportunity product record is automatically added for each product entered in
the offer item records using the following values:

• Product value: The value of the item

• Wtd. product value: Item value weighted according to the probability of the offer

• Wtd. product value (Opportunity): Item value weighted according to the
probabilities entered in the opportunity

Note: Note: If you add an item to an opportunity offer that corresponds to an
opportunity product (the values in the Product Group and Brand field are the same,
the Sector and Grade fields are empty), the Product value, Wtd. product value
and Wtd. product value (Opportunity( are overwritten with the values in the
offer.Opportunity products are only added or updated automatically if the Status of
the offer is "Offered".

If the currency entered in the offer differs from that in the opportunity, the values
are converted automatically using the exchange rate table, >> on page 171.

For fur ther information on offers and orders, >> on page 193.

Adding Opportunity Competitors
Aurea CRM web allows you to store competitors also competing for an opportunity.

To add a competitor:

1. Switch to the desired opportunity.

2. The following options are available:

• Select New > New Competitor from the opportunity’s context menu.

• Switch to the Opportunity Competitor tab and click on  (New).

3. Select a competitor from the drop-down list or enter a new name.
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Note: Note: Competitors are not stored as companies or persons, but as catalog
values.

4. Enter fur ther information, such as the Strengths and Weaknesses of the
competitor and the Price of the competitor’s products.

Rating Opportunities
You can evaluate opportunities in Aurea CRM web. To do so, your administrator
needs to define a por tfolio, >> on page 134. The portfolio format contains questions
used to classify opportunities.

To evaluate an opportunity:

1. Switch to the desired opportunity.

2. Select New > New Portfolio from the context menu.

3. Answer the predefined questions.

By default, the rating determined for the opportunity is entered in the ABC field in
the opportunity record.

Sales Funnel
Use the sales funnel to analyze your opportunities, for example to:

• Forecast future business development

• Localize possible problems and implement corrective measures

To access the sales funnel:

1. Select  (Sales) > Sales Funnel.
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2. You can change which data is displayed, for example by choosing a different
category or defining a filter and clicking on Start.

Note: Note: Only opportunities where a completion date has been entered are
included in the sales funnel.
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Buying Center Wall
The buying center wall display all opportunity par ticipants and provides suggestions
for additional par ticipants. You can display information on participants’ roles (e.g.
decision maker, contact person) and attitude (e.g. neutral, positive), manage partic-
ipants and add notes. This allows you to keep track of individual par ticipant’s attitude
and ensures that important par ticipants are not forgotten.

Note: Note: Your administrator can configure the appearance of the buying center
wall (e.g. column sort order, font color), >> BuyingCenter in the Aurea CRM web
Administrator Guide.

To open the buying center wall, switch to the desired opportunity and select Buying
Center from the context menu.

The buying center wall is opened.

• The opportunity’s par ticipants are displayed in the main area on the right in various
columns (grouped by attitude by default). If no attitude has been entered for a
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participant, the participant is displayed in the no value column. This column is
only displayed if par ticipants exist where no attitude is entered.

• Opportunity par ticipants are color-coded according to their role.

• Information on the opportunity is displayed in the header, e.g. the level.

• If a par ticipant’s attitude has changed, drag the participant to the corresponding
column to update their attitude.

• Click on a participant to display the context menu and edit icons.

• Click on  (Edit) to change the participant’s role or enter a comment etc.

Click on the circle ( ) to set the person’s Influence (low, medium, high).

Note: Note: When in edit mode, you can save your changes ( ) or cancel
them ( ). You can also click on another par ticipant to save, or press the Esc
key to cancel your edit. You cannot drag and drop records while in edit mode.

• Open the context menu ( ) and select Delete to remove the opportunity
participant.

• Click on New Participant in the sidebar to add a new participant to the opportunity.
Choose the participant and then set their attitude by dragging the participant to
the appropriate column.

Note: Note: The same participant can be added to the opportunity with multiple
roles, but can only be added once per role.

• Open the Suggested Participants drop-down list and select an entry to display
suggested participants:

• from other opportunities: Those companies and persons are listed that are
involved in other opportunities with at least one of the current opportunity’s
participants.

• from activities: Those companies and persons are displayed that are entered
as participants in activities linked to the current opportunity.

• from corporate structure:This options suggests companies and persons in
companies within the same corporate structure as the company the current
opportunity was added for. Only companies/persons that are par ticipants in
other opportunities of the same Type as the current opportunity are suggested.

• from company: All persons in the company (KP) the opportunity was added
for are suggested (excluding those that are already participants).
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Drag the desired company/person from the list of suggestions below the Suggest
Participants field to the appropriate column (e.g. indifferent) to add them to the
opportunity as a par ticipant. A corresponding opportunity par ticipant record is
added automatically and the participant’s attitude is entered.

• If configured by your administrator, information is displayed in the sidebar on the
Missing required roles and Missing optional roles. For example, you may need
to add 3 consultants, but have only added one.

• Click on  or  to hide/show the sidebar and Related Data.

• Data related to the current opportunity is displayed under Related Data.

• Click on  (Context Menu) on the right of the header to access the context menu,
e.g. select Tab View to open the opportunity in tab view.
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10
Offers and Orders

Offers and Orders
If you submit an offer to a customer, you can save the offer in Aurea CRM web.

Offers (and orders) consist of a "header record" that contains data relating to the
entire offer (e.g. offer number, currency etc.), and item records that contain data
concerning the individual items in the offer.

If a customer places an order, you can copy the offer’s data to an order.

Aurea CRM web allows you to:

• Add offers from a company or opportunity par ticipants.

• Copy data from offers to orders, or add orders directly.

• Access the item master when adding items to offers and orders.

• Add offer items using the quick add function.

• Manage the companies and persons involved.

• Automatically calculate the value of offers/orders based on the items entered.

• Automatic pricing based on price lists and conditions.

• Enter special offers with special conditions for various quantities.

• Use listings in conjunction with the quick add function.

• Enter information on how items in offers affect stocks and automatically update
stocks when adding orders.

• Choose the delivery address (Aurea CRM win only).

The following additional function is available when adding orders:

• Analyze orders per item and rep.

• Enter the delivery date for orders.

Note: You can import order statistics in Aurea CRM win (Order Statistics info
area) and use this data when adding orders.
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Offers
Learn how to add offers and offer items.

Any number of offers may be added for a company or opportunity par ticipant.

Note the following when adding offers:

• If you commonly add offers in various currencies, decide on the currency to be
used by the offer. Once the offer has been saved, you can no longer edit the
Currency field. The currency is transferred to the offer’s (and order’s) items.

• Prices are calculated for the individual offer items (and order items). If price
lists for the items have been defined in the same currency as the offer, these
price lists are used to price the items.

Conditions, bulk discounts and special prices must be defined before adding an
order.

Adding Offers

To add an offer:

1. Switch to the desired company or opportunity par ticipant and select New > New
Offer from the context menu.

Note:  If you add an offer from an opportunity par ticipant, the Opportunity field
in the offer is entered automatically and the offer is linked to the opportunity.
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Note:  If Payment Conditions and Delivery Conditions have been entered for
the company, these are transferred to the offer (and the offer items).

2. Enter data that affect the value of the offer, such as the Currency, Offer No.,
Status, Receipt Type, Realization Probability (%) and any discount.

Note: Note: If you commonly add offers in various currencies, decide on the
currency to be used by the offer. Once the offer has been saved, you can  no
longer edit the Currency field.

Investment and Realization Probability

Aurea CRM uses two probabilities to calculated the weighted value of an offer:

• Realization probability: The probability of the customer placing an order
corresponding to this offer with anyone.

• Investment probability: Probability of the customer placing an order with your
company (and not with a competitor).

For example, if the realization probability is 80% and the investment probability is
50%, the overall probability of closing the deal is 40% (50% of 80%).

Adding Offer Items

Use the Offer Item info area to enter the items that make up an offer. Prices are
calculated for the individual offer items.
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You can either add items to offers individually or use the quick add function (select
Quick Add (Items) from the offer's context menu). If a special offer has been entered
in the offer, only the Overview and Special Offer filters are available in the Quick
Add area. Select Special Offer to display the special offer items defined for the
special offer.

To add an offer item:

1. Switch to the desired offer.

2. Select New > New Offer Item from the context menu.

3. Click on  (Select) next to the Item No. field to select an item. The Item No.,
Item name, Sector, Product Group, Brand, Grade and Packaging Unit are
entered automatically.

The Currency is transferred from the offer and cannot be edited. Individual cur-
rency values in fields can be displayed in a second currency. For this to occur
an exchange rate needs to be entered.

4. Enter data such as the Quantity and any discount. The Value is automatically
calculated by multiplying the Quantity, End Price, value factor and Price Factor.
If a Packaging Unit and Quantity factor of "+- Qty" (in the order) have been
entered, the value factor is 1 / packaging unit; otherwise the value factor is 1.
The Price Factor is transferred from the item master and is set to 1 by default.
If suitable price lists exist, the End Price and Value are calculated automatically.
You can manually change the End Price.

5. Save the record. The Offer Item No. is entered automatically.

The value Discount abs. (absolute discount) is calculated as End Price * Dis-
count / 100 (i.e. the discount is a percentage).
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The item value after the discount is applied is entered in the Disc.Value1 field
(Value - Discount abs.).

Data such as the Rev.cr.M (the revenue for the current month) and the Qty. Curr.
Q (the quantity in the current quarter) are displayed on the Revenue & Quantity
tab.

The total offer value is calculated automatically: Offer value = Total Items Value
* (1 - Discount Cond. (Fixed)/100) * (1 - Cash Cond. (Special Offer)/100)

Adding Offers
To add an offer:

1. Switch to the desired company or opportunity par ticipant and select New > New
Offer from the context menu.

Note: Note: If you add an offer from an opportunity par ticipant, the Opportunity
field in the offer is entered automatically and the offer is linked to the opportunity,
>> on page 188.

Note: Note: If Payment Conditions and Delivery Conditions have been entered
for the company, these are transferred to the offer (and the offer items).

2. Enter data that affect the value of the offer, such as the Currency, Offer No.,
Status, Receipt Type, Realization Probability (%) and any discount.
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Note: Note: If you commonly add offers in various currencies, decide on the
currency to be used by the offer. Once the offer has been saved, you can  no
longer edit the Currency field.

Calculating the Weighted Offer Value
The weighted value of the offer is calculated as follows in Aurea CRM web:

The default value for both probabilities is 100%.

Investment and Realization Probability
Aurea CRM uses two probabilities to calculated the weighted value of an offer:

• Realization probability: The probability of the customer placing an order
corresponding to this offer with anyone.

• Investment probability: Probability of the customer placing an oder with your
company (and not with a competitor).

For example, if the realization probability is 80% and the investment probability is
50%, the overall probability of closing the deal is 40% (50% of 80%).

Adding Offer Items
Use the Offer Item info area to enter the items that make up an offer. Prices are
calculated for the individual offer items, >> on page 199.

You can either add items to offers individually or use the quick add function (select
Quick Add (Items) from the offer's context menu), >> on page 104. If a special offer
has been entered in the offer, only the Overview and Special Offer filters are
available in the Quick Add area. Select Special Offer to display the special offer
items defined for the special offer.

To add an offer item:

1. Switch to the desired offer.

2. Select New > New Offer Item from the context menu.
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3. Click on  (Select) next to the Item No. field to select an item. The Item No.,
Item name, Sector, Product Group, Brand, Grade and Packaging Unit are
entered automatically.

The Currency is transferred from the offer and cannot be edited. Individual cur-
rency values in fields can be displayed in a second currency. For this to occur
an exchange rate needs to be entered, >> on page 172.

4. Enter data such as the Quantity and any discount. The Value is automatically
calculated by multiplying the Quantity, End Price, value factor and Price Factor.
If a Packaging Unit and Quantity factor of "+- Qty" (in the order) have been
entered, the value factor is 1 / packaging unit; otherwise the value factor is 1.
The Price Factor is transferred from the item master and is set to 1 by default.
If suitable price lists exist, the End Price and Value are calculated automatically,
>> on page 199 and on page 177. You can manually change the End Price.

5. Save the record.

The Offer Item No. is entered automatically.

The value Discount abs. (absolute discount) is calculated as End Price * Dis-
count / 100 (i.e. the discount is a percentage).

The item value after the discount is applied is entered in the Disc.Value1 field
(Value - Discount abs.).

Data such as the Rev.cr.M (the revenue for the current month) and the Qty. Curr.
Q (the quantity in the current quarter) are displayed on the Revenue & Quantity
tab.
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The total offer value is calculated automatically: Offer value = Total Items Value
* (1 - Discount Cond. (Fixed)/100) * (1 - Cash Cond. (Special Offer)/100)

Copying Offers to Orders
If you receive an order from a customer after submitting an offer, you can copy the
data entered in the original offer to the new order.

To copy an offer’s data to an order:

1. Switch to the desired offer.

2. Select Copy to Order from the context menu.

A new record is added and the relevant data (e.g. currency, items) is transferred
to the new record.

Note: Note: Participants are not copied.

The Status of the offer is automatically set to "Order".

For more details on which fields are copied from offers to orders, refer to the
online field help. Your administrator can configure which additional fields are
copied from offers to orders in the Configuration info area, >> CRM.core Admin-
istrator Guide.

Note: Note: Offer items where the Optional item field is enabled are not copied
to the order.You can only generate an order from an offer once; if an offer has
already been copied to an order, you cannot copy it to another order.

Orders
Orders are added for companies and consist of several order items. It is not added
for persons.

When adding an order, you need to take the same aspects into account as with
adding an offer. Calculating the order value, discounts etc. is the same as for offers.

Adding Orders

Orders are always added for companies.
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To add an order:

1. The following options are available:

• Select  (Sales) > New Order. Select a company.

• Switch to the desired company. Switch to the Orders tab and click on  (New).

Note:  If Payment Conditions and Delivery Conditions have been entered for
the company, these are transferred to the order (and the order items).

2. Enter data such as the Currency, Quantity and any discount.

Note:  Once the order has been saved, you can no longer edit the Currency
field.The Receipt Type determines how stocks are affected by the order.

3. Save the record. The AU-SerNo field (the serial number of the order record) is
entered automatically.

Adding Items to Orders

Individual items are added to orders using order item records.

You can either add items to orders individually or use the quick add function (select
Quick Add (Order Items) from the order's context menu). If a special offer has
been entered in the order, only the Overview and Special Offer filters are available
in the Quick Add area. Select Special Offer to display the special offer items defined
for the special offer

Note: The End Price entered in the price list (if present) is only displayed in the
quick add area once the item has been saved. If you select the Listing filter, you
can select a relationship type in the field beneath the filters. The Lot No. column
displays the lot numbers and current quantity. You can choose to only display the
lot numbers using the Lots without quantities configuration entry (Stock category),
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see CRM.core Administrator Guide. If you have entered more than one delivery
date, the Quantity field displays all delivery dates and you can enter the quantity
for each delivery date. You can configure the behavior of the special input fields
(Quantity, Scale of discount, Lot No.) in the Quick Add area, see CRM.core Ad-
ministrator Guide.

To add an order item directly:

1. Switch to the desired order.

2. Select New > New Order Item from the context menu.

3. Click on  (Select) next to the Item No. field in the upper por tion of the mask to
select an item. The Item name, Item No., Sector, Product Group, Brand and
Grade are entered automatically.

The Currency is transferred from the order and cannot be edited. Individual cur-
rency values in fields can be displayed in a second currency. For this to occur
an exchange rate needs to be entered.

4. Enter data such as the Quantity and any discount. The Value is automatically
calculated by multiplying the Quantity, End Price, value factor and Price Factor.
If a Packaging Unit and Quantity factor of "+- Qty" (in the offer) have been
entered, the value factor is 1 / packaging unit; otherwise the value factor is 1.
The Price Factor is transferred from the item master and is set to 1 by default.
If suitable price lists exist, the End Price and Value are calculated automatically.

You can manually change the End Price.

5. Save. The AU_SerNo and UP-SerNo (serial number of the order and order item)
are entered automatically.

The sum total of the item values (Total Item Values field) is calculated automat-
ically. Other fields are calculated as for offer items,.
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Note:  If you have already entered items in an order, you can no longer edit the
Rep ID, Rep and Stock fields in the order record.

Deliveries

Items in an order may be delivered on different dates. When adding an order item
in the quick add area, information on the delivery is displayed in the Quantity field.
Quantities can be entered for each delivery date. After saving the record, the total
quantity (for all deliveries) is displayed in the Quantity field.

To enter a delivery date:

1. Switch to the desired order.

2. Click on  (New) on the Order Delivery tab.

3. Enter a Delivery No. and Delivery Date.

Note: Your administrator can determine that delivery data is also displayed for the
Discount vol. in kind field, see SerialEntry in the Aurea CRM web Administrator
Guide.

Copying Offers to Orders

If you receive an order from a customer after submitting an offer, you can copy the
data entered in the original offer to the new order.

To copy an offer’s data to an order:

1. Switch to the desired offer.

2. Select Copy to Order from the context menu. A new record is added and the
relevant data (e.g. currency, items) is transferred to the new record.

Note:  Participants are not copied.

The Status of the offer is automatically set to "Order".

For more details on which fields are copied from offers to orders, refer to the
online field help. Your administrator can configure which additional fields are
copied from offers to orders in the Configuration info area, see CRM.core Admin-
istrator Guide.

Note:  Offer items where the Optional item field is enabled are not copied to the
order. You can only generate an order from an offer once; if an offer has already
been copied to an order, you cannot copy it to another order.

Adding Orders
Orders are always added for companies.
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To add an order:

1. The following options are available:

• Select  (Sales) > New Order. Select a company.

• Switch to the desired company. Switch to the Orders tab and click on  (New).

Note: Note: If Payment Conditions and Delivery Conditions have been entered
for the company, these are transferred to the order (and the order items).

2. Enter data such as the Currency, Quantity and any discount.

Note: Note: Once the order has been saved, you can no longer edit the Currency
field.The Receipt Type determines how stocks are affected by the order, >> on
page 249.

3. Save the record.

The AU-SerNo field (the serial number of the order record) is entered automati-
cally.

Adding Items to Orders
Individual items are added to orders using order item records.
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You can either add items to orders individually or use the quick add function (select
Quick Add (Order Items) from the order's context menu), >> on page 104. If a
special offer has been entered in the order, only the Overview and Special Offer
filters are available in the Quick Add area. Select Special Offer to display the special
offer items defined for the special offer

Note: Note: The End Price entered in the price list (if present) is only displayed
in the quick add area once the item has been saved.If you select the Listing filter,
you can select a relationship type in the field beneath the filters, >> on page 212.The
Lot No. column displays the lot numbers and current quantity. You can choose to
only display the lot numbers using the Lots without quantities configuration entry
(Stock category), >> CRM.core Administrator Guide.If you have entered more than
one delivery date, the Quantity field displays all delivery dates and you can enter
the quantity for each delivery date, >> on page 227.You can configure the behavior
of the special input fields (Quantity, Scale of discount, Lot No.) in the Quick Add
area, >> CRM.core Administrator Guide.

To add an order item directly:

1. Switch to the desired order.

2. Select New > New Order Item from the context menu.

3. Click on  (Select) next to the Item No. field in the upper por tion of the mask to
select an item. The Item name, Item No., Sector, Product Group, Brand and
Grade are entered automatically.

The Currency is transferred from the order and cannot be edited. Individual cur-
rency values in fields can be displayed in a second currency. For this to occur
an exchange rate needs to be entered, >> on page 172.
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4. Enter data such as the Quantity and any discount. The Value is automatically
calculated by multiplying the Quantity, End Price, value factor and Price Factor.
If a Packaging Unit and Quantity factor of "+- Qty" (in the offer) have been
entered, the value factor is 1 / packaging unit; otherwise the value factor is 1.
The Price Factor is transferred from the item master and is set to 1 by default.
If suitable price lists exist, the End Price and Value are calculated automatically,
>> on page 199 and on page 177.

You can manually change the End Price.

5. Save.

The AU_SerNo and UP-SerNo (serial number of the order and order item) are
entered automatically.

The sum total of the item values (Total Item Values field) is calculated automat-
ically. Other fields are calculated as for offer items, >> on page 194.

Note: Note: If you have already entered items in an order, you can no longer edit
the Rep ID, Rep and Stock fields in the order record.

Deliveries
Items in an order may be delivered on different dates. When adding an order item
in the quick add area, information on the delivery is displayed in the Quantity field.
Quantities can be entered for each delivery date. After saving the record, the total
quantity (for all deliveries) is displayed in the Quantity field.

To enter a delivery date:

1. Switch to the desired order.

2. Click on  (New) on the Order Delivery tab.

3. Enter a Delivery No. and Delivery Date.

Note: Note: Your administrator can determine that delivery data is also displayed
for the Discount vol. in kind field, see SerialEntry in the Aurea CRM web
Administrator Guide.
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Sales Areas
Learn how to define sales areas and assign items and offers to them.

The Sales Area (  (Sales) > Sales Area) info area defines sales areas that
consist of a combination of Sales Organization, Sales Channel and Branch. Sales
areas can be assigned to items. The combination of the Sales Organization, Sales
Channel and Branch catalogs can be imported, meaning that this info area is rele-
vant to integrating SAP.

You can add any number of records with a unique combination of Sales Organiza-
tion, Sales Channel and Branch.

Benefits:

• Manage sales areas centrally

• Define sales areas that correspond to your sales structure

• Assign multiple sales areas to companies

• Assign offers and orders to a company’s sales sector (Aurea CRM win only)

• Add information about par tner companies and persons and assign them to company
sales areas (not available in Aurea CRM web by default)

• Assign items to sales areas

Note: The Sales Area (Item) info area does not include the branch. If an item
recorded is deleted from the item master, all records in the Sales Area (Item) info
area added for that item are also deleted.

Sales Area (Company)

The Sales Area (Company) info area is a child info area of the Company info area,
and is used to assign customers to specific sales areas. This is relevant to SAP in-
tegration.

You can assign companies to any number of sales areas you have defined in the
Sales Area info area. When adding offers, customer-specific sales areas are then
suggested.

Sales Area (Item)

The Sales Area (Item) info area is used to assign items to sales areas (Sales Or-
ganization, Sales Channel) and the item (Item No., Item name, Product Category,
Product).

An item’s sale areas are displayed on the Sales Area (Item) tab in the Item Master
info area in Aurea CRM web.
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As in SAP, this info area does not include the branch (unlike the Sales Area info
area). This means that sales sectors which only differ in the Branch field is assigned
to the same items.

An item can be assigned to any number of sales areas in the Sales Area (Item) info
area, and any number of items can be assigned to the same sales area.

If the last record in the Sales Area info area that combines a specific combination
of sales organization and sales channel is deleted, all sales area (item) records
defined for that combination are also deleted.

If an item recorded is deleted from the item master, all records in the Sales Area
(Item) info area added for that item are also deleted.

Assigning Offers/Orders to a Sales Area

You can assign offers and orders to sales areas (Sales Organization and Sales
Channel fields).

When adding offer items using the quick add area, you can use the Sales Organi-
zation filter to restrict the display to those items assigned to the same sales area
in the Sales Area (Item) info area.

Note:  If a sales are is entered in an offer or order, you can only select items as-
signed to the same sales area in Aurea CRM win when adding items manually. The
Sales Area filter is available in the quick add area.

Note: Your administrator can deny access to the Sales Organization, Sales
Channel and Branch fields in the Offer and Order info areas, preventing you from
adding new sales areas from there.

Sales Area (Partner)

You can store partners in the Sales Area (Partner) info areas that are assigned to
company sales areas (Sales Area (Company) info area; not available in Aurea CRM
web by default) You can enter the partner’s Role, e.g. supplier or wholesaler.

Note: These partner roles are not displayed in the Partner Role info area.

Sales areas and related information (e.g. whether par tial deliveries are permitted)
are relevant to SAP integration.

Sales Area (Company)
The Sales Area (Company) info area is a child info area of the Company info area,
and is used to assign customers to specific sales areas. This is relevant to SAP in-
tegration.

You can assign companies to any number of sales areas you have defined in the
Sales Area info area. When adding offers, customer-specific sales areas are then
suggested.
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Sales Area (Item)
The Sales Area (Item) info area is used to assign items to sales areas (Sales Or-
ganization, Sales Channel) and the item (Item No., Item name, Product Category,
Product).

An item’s sale areas are displayed on the Sales Area (Item) tab in the Item Master
info area in Aurea CRM web.

As in SAP, this info area does not include the branch (unlike the Sales Area info
area). This means that sales sectors which only differ in the Branch field is assigned
to the same items.

An item can be assigned to any number of sales areas in the Sales Area (Item) info
area, and any number of items can be assigned to the same sales area.

If the last record in the Sales Area info area that combines a specific combination
of sales organization and sales channel is deleted, all sales area (item) records
defined for that combination are also deleted.

If an item recorded is deleted from the item master, all records in the Sales Area
(Item) info area added for that item are also deleted.

Assigning Offers/Orders to a Sales Area
You can assign offers and orders to sales areas (Sales Organization and Sales
Channel fields).

When adding offer items using the quick add area, you can use the Sales Organi-
zation filter to restrict the display to those items assigned to the same sales area
in the Sales Area (Item) info area.

Note: If a sales are is entered in an offer or order, you can only select
items assigned to the same sales area in Aurea CRM win when adding
items manually. The Sales Area filter is available in the quick add area.

Note: Note: Your administrator can deny access to the Sales Organization, Sales
Channel and Branch fields in the Offer and Order info areas, preventing you from
adding new sales areas from there.

Sales Area (Partner)
You can store partners in the Sales Area (Partner) info areas that are assigned to
company sales areas (Sales Area (Company) info area; not available in Aurea CRM
web by default) You can enter the partner’s Role, e.g. supplier or wholesaler.
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Note: Note: These partner roles are not displayed in the Partner Role info area.

Sales areas and related information (e.g. whether par tial deliveries are permitted)
are relevant to SAP integration.

Pricing and Discounts
Learn to apply pricing and discounts and item and order levels.

Pricing and discounts are applied at the offer and order level.

Note: The functions described here for orders also apply to offers.

When adding an order, the value of the individual items and the total value of the
order are determined as follows:

• If a special offer is entered in the order, the volume scale and discounts defined
for the special offer are applied to the order.

• If no special offer is entered, the item and order values are determined as follows:

1. Pricing for the individual items (using prices in price lists and fixed conditions).

2. Discount at the item level, i.e. percentage discounts and discounts in kind
defined in company and general conditions.

3. Discount at the order level, i.e. percentage discounts defined in company
and general conditions that are applied to the weighted total quantity of the
order.

Pricing

When adding order items, Aurea CRM calculates the price (End Price field).

The following diagram illustrates how prices are determined:
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When adding an order item:

1. No price field:The system checks whether the No price field is enabled in the
order item ( Default=disabled).

• Enabled: You can enter a price manually in the End Price field, and conditions
may be applied to this price.

• Disabled: The system searches for fixed price conditions. Continue to step 2.

2. Searching for fixed price conditions:The system searches for fixed price
conditions in the following order:

a. A record in the Company Conditions info area that meets the following criteria:

• The company the order was added for is entered in the company conditions
record

• The item in the order item record is the item in the company conditions record

• The business area in the order is entered in the company conditions record

• The Currency in the order is entered in the company conditions record

• A fixed price is entered in the company conditions record

• The company conditions record is currently valid (i.e. the date of the order
lies in the time period that the conditions are valid for)

b. A record in the Conditions info area that meets the following criteria :

• The customer group entered in the conditions matches the customer group
assigned to the customer the order was added for

• The item in the order item record is the item in the conditions record

• The currency in the order is entered in the conditions record
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• A fixed price is entered in the conditions record

• The conditions record is currently valid (i.e. the date of the order lies in the
time period that the conditions are valid for)

• If a fixed price is found: If a fixed price is found in a suitable company
conditions or conditions record, the system searches for a matching fixed price
volume (Volume Type = "Fixed price scale" and Comp. value = "Order Item").

• Searching for fixed price volumes:

• If no fixed price is found: The system searches for a price entered in a price
list. Continue to step 3.

3. Searching in price lists: The system searches for a price in price lists in the
following order:

a. An individual price list if the Indiv. Price List field in the order contains a
price list,

b. A customer group price list if a customer group has been entered in the
company record,

c. A country price list defined for the country the company is located in.

The price list must meet the following conditions:

• The item in the order item record is the item in the price list

• The currency in the order is entered in the price list

• the price list is currently valid (i.e. the date of the order lies in the time period
that the price list is valid for)

The first price list found is used. If no suitable price list is found, no price is en-
tered. In this case you need to enter the price manually in the End Price field.

Note:  If an end price was determined by the system, you can edit it.

4. Once you have entered a Quantity in the order item, the value of the
corresponding items is entered in the Value field (calculated as Quantity * End
Price * value factor * Price Factor). The items’ values are totaled in the Total
Items Value field in the order each time an order item record is saved.

If applicable, discounts are applied to the order items, i.e. percentage discounts
and discounts in kind defined in company and general conditions.

After saving an order item record, the discount on the order level (if applicable) is
recalculated.

Discounts at the Item Level

Once the End Price and Quantity have been entered in an order item record, Aurea
CRM searches for valid conditions, company conditions and volume scales in order
to determine which discounts and discounts in kind apply.

Note:  If you enable the No discount field when adding a new order item, the system
does not search for valid conditions for the item and the item is ignored when
calculating the discount applied to the weighted total quantity of the order, >> on
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page 203. This field is disabled by default. If a Discount is entered in the conditions
record, this discount is transferred to the Discount % (Condition) field in the order.
The bulk discounts entered in the conditions record (Bulk discount (%) field) and
in volumes (Discount field) are not applied.

The following diagram illustrates how discounts are determined:

The system searches for valid conditions in the following order:

1. A record in the Company Conditions info area that meets the following criteria:

• The company the order was added for is entered in the company conditions
record

• The business area in the order is entered in the company conditions record

• The item (Item No. and Item Name), sector, product group, brand or grade
entered in the company conditions match those entered in the order item

Note: These fields cannot be combined in company conditions.

• The currency in the order is entered in the company conditions record
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• A Bulk discount (%) and/or Discount vol. in kind have been entered in the
company conditions record

• The company conditions record is currently valid (i.e. the date of the order lies
in the time period that the conditions are valid for)

2. A record in the Conditions info area that meets the following criteria:

• The customer group entered in the conditions matches the customer group
assigned to the customer the order was added for

• The item (Item No. and Item Name), Sector, Product Group, Brand or Grade
entered in the conditions match those entered in the order item

Note: These fields cannot be combined in conditions.

• The currency in the order is entered in the conditions record

• A Bulk discount (%) and/or Discount vol. in kind have been entered in the
conditions record

• The conditions record is currently valid (i.e. the date of the order lies in the
time period that the conditions are valid for)

3. If suitable company conditions or generally conditions are found, the system
searches for a suitable scale of discount (Volume Type = "Scale of discount"
and Comp. value = "Order Item").

4. The discount determined is entered in the order item:

• Discount in kind are entered in the Discount vol. in kind field

• Percentage discounts are entered in the Discount % (Condition) field.
Depending on the settings selected in the Conditions apply to field (in the
company or general conditions), this discount is applied in addition to the item
discount (Discount field); or only if no discount is entered in the Discount
field; or the discount entered in the conditions overwrites the discount in the
Discount field.

5. The value of the items is calculated based on the discount in the order item and
conditions record as follows:

• Value = Quantity * End price * value factor * Price factor

• Discount abs. = Value * Discount / 100

• Disc.Value1 = Value - Discount abs.

• Disc.Value2 = Disc.Value1 - Discount % (Conditions) - Item Group Discount

After saving each order item, the discounts at the order level are recalculated (if
present).

Note:  Discounts entered in conditions at the order level overwrite discounts in
conditions at the item level.
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Discounts at the Order Level

After saving each order item, the discounts at the order level are recalculated.

The following diagram illustrates the order in which discounts are applied and how
discounts are determined at the order level:

Discounts are determine in the following order:

1. To determine the discount applied to the weighted total quantity in the order,
Aurea CRM searches for valid conditions in the following order:

Note:  A valid weighting must be entered in the order item, >> on page 178.If
the No discount field in the order is enabled, the system does not search for
applicable conditions. In order for bulk discounts to be applied, the Bulk discount
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(%) field must be empty. If discounts in kind have been defined in conditions or
bulk volumes (Discount vol. in kind field), they are transferred to the order item.

a. A record in the Company Conditions info area that meets the following criteria
(>> on page 234):

• The Company the order was added for is entered in the company conditions
record

• The Business Area in the order is entered in the company conditions record

• The item (Item No. and Item name), Sector, Product Group, Brand or
Grade entered in the company conditions match those entered in the order
item

Note: These fields cannot be combined in company conditions.

• The Currency in the order is entered in the company conditions record

• A Discount is entered in the company conditions record

The company conditions record is currently valid (i.e. the date of the order lies
in the time period that the conditions are valid for)

b. A record in the Conditions info area that meets the following criteria (>> on
page 233):

• The Customer Group entered in the conditions matches the customer group
assigned to the customer the order was added for

• The item (Item No. and Item name), Sector, Product Group, Brand or
Grade entered in the conditions match those entered in the order item

Note: These fields cannot be combined in conditions.

• The Currency in the order is entered in the conditions record

• A Discount is entered in the conditions record

• The conditions record is currently valid (i.e. the date of the order lies in the
time period that the conditions are valid for)

c. If suitable company conditions or generally conditions are found, the system
searches for a suitable Scale of discount (Volume Type = "Scale of discount
(weighted total quantity)" and Comp. value = "Total Order"), >> on page 235.

Note:  If more than one order item has been entered containing the same item,
the total quantity entered in all order items is used to determine the volume
and any discount.

d. The discount determined is entered in the Discount % (Condition) field in item
records, whereby discounts at the order level overwrite discounts at the item
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level. The discount is also used to calculate the Disc. Order % in the order
and the.

e. The Disc.Value2 field in the item records is updated accordingly.

2. After applying discounts from conditions (if present), the discount entered for the
company is deducted (Discount Cond. (Fixed) field in the order).

3. If present, any order discount (Discount field) granted manually is then deducted.

Fields in Order Value Calculations

CalculationField

Sum total of the item values (Value field) where Discount in k. is
disabled

Total Items
Value

Sum total of the item values (Value field) where Discount in k. is
enabled

Value in Kind

Total Items Value - Discount Cond. (Fixed) - Cash Cond. (Special
Offer)

Discount Cond. (Fixed) is transferred from the company

Cash Cond. (Special Offer) is transferred from the special offer

Order Value

Total Items Value - Discount Cond. (Fixed) - Discount

You can define an additional discount applied at the order level in
the Discount field.

Disc. Order
Val.

Sum total of the Disc.Value2 fields in those items where Discount
in k. is disabled (discount from the conditions applied at the order
level).

Disc. Order
Val. 1

Disc. Order Val. 1 - Discount Cond. (Fixed) - DiscountDisc. Order
Val. 2

Total discount as a percentage, calculated from Disc. Order Val.
2 / Total Items Value -1.

Disc. Order %

Pricing for Special Offers

If a special offer is entered in the order, the volume scale and discounts defined for
the special offer are applied to the order. Special offers are managed in the Special
Offer info area.

Special offer volume scales and discounts applied to item groups are taken into
account prior to conditions when pricing items and applying discounts.

Enter the special offer in Special Offer Name field in the order. You can only access
special offers that are currently valid; i.e. the current date needs to be between the
star t and end date of the special offer.
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Note:  If you add order items manually (i.e. not using the quick add function), prices
defined for special offers are not calculated automatically, even if the item is currently
on special offer. Company conditions and general conditions are however applied.
If you enter a special offer in the order, no links to work orders are available. You
can use the same business logic as used in Aurea CRM win in Aurea CRM web. In
this case, only those special offers where no customer group or the same customer
group is entered as the company the order was added for. To do so, add the
Customer Group (FI,147) field to the order's tab view and use it as a fixed filter
applied to the search (in the record selector, e.g. for the Special Offer Name field).

You can use the Additional items field special offers in Aurea CRM win to determine
how the quick add area for order items behaves.

• Enabled: All items are displayed. All radio buttons are active and you can use
the Special Offer option to display all special offer item as a list of suggestions.

• Disabled: Only special offer items are listed. Only the Overview and Special
Offer options are active. Select Overview to display all items where quantities
have been entered; select Special Offer to display all special offer items.

Special Offer Volume Scales

If you have defined bulk discounts and/or discounts in kind in a special offer item
record, these can be displayed in the quick add area (Scale of discount field), see
Aurea CRM win Administrator Guide.

If you select a different scale in the Scale of discount field, the lower limit of the
scale’s volume is entered in the Quantity field and the corresponding discounts are
entered in the Discount % (Condition) and Discount vol. in kind fields. Your ad-
ministrator can disable this behavior using the Do not apply scale of discount
configuration entry (General Settings category), see CRM.core Administrator Guide.

Corresponding order items can be created automatically using triggers (see CRM.core
Administrator Guide) for the units granted as a discount in kind.

Item Group Discounts

You can group special offer items and define volumes that apply to these groups.

Whenever a new offer/order item is added, the system searches for a suitable volume
by totaling the Quantity and Value fields in all items. If a new volume has been
reached, all affected items are updated (Item Group Discount, Item Group Discount
in Kind, Total discount in kind, Disc.Value2.

Note: The quick add areas in Aurea CRM web are not automatically refreshed by
default. To use the functions described here in Aurea CRM web, the "Refresh" button
needs to be integrated in the quick add areas (e.g. in the 'SerialEntry.List' header
for the 'AU’ header group for orders).

When granting discounts in kind on item groups, new offer/order items are not auto-
matically added; the existing item records are only updated (Item Group Discount
in Kind and Total discount in kind fields). A new item record is not added for
special offer items in orders/offers where the Discount in kind share is positive.

Discount scales at the item group level are not displayed in the Scale of discount
field.
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Note:  Special offer bulk volumes and volumes defined for item groups can overlap.

Transferring Individual Fields from Special Offers

The following fields are transferred from special offer items to the following fields
in order items:

Target Order Item FieldSpecial Offer Item
Field

Special Offer Item PricePrice

Special Offer Item QtyQuantity

Special Offer NameSpecial Offer Name

The Special Offer Item Price is converted to the currency in the order item. An
appropriate exchange rate needs to have been defined, otherwise the field remains
empty.

Pricing
When adding order items, Aurea CRM calculates the price (End Price field).

The following diagram illustrates how prices are determined:
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When adding an order item:

1. No price field:The system checks whether the No price field is enabled in the
order item (disabled by default).

• Enabled: You can enter a price manually in the End Price field, and conditions
may be applied to this price, >> on page 201.

• Disabled: The system searches for fixed price conditions. Continue to step 2.

2. Searching for fixed price conditions:The system searches for fixed price
conditions in the following order:

a. A record in the Company Conditions info area that meets the following criteria
(>> on page 234):

• The company the order was added for is entered in the company conditions
record

• The item in the order item record is the item in the company conditions record

• The business area in the order is entered in the company conditions record

• The Currency in the order is entered in the company conditions record

• A fixed price is entered in the company conditions record

• The company conditions record is currently valid (i.e. the date of the order
lies in the time period that the conditions are valid for)

b. A record in the Conditions info area that meets the following criteria (>> on
page 233):

• The customer group entered in the conditions matches the customer group
assigned to the customer the order was added for

• The item in the order item record is the item in the conditions record

• The currency in the order is entered in the conditions record

• A fixed price is entered in the conditions record

• The conditions record is currently valid (i.e. the date of the order lies in the
time period that the conditions are valid for)

• If a fixed price is found: If a fixed price is found in a suitable company
conditions or conditions record, the system searches for a matching fixed price
volume (Volume Type = "Fixed price scale" and Comp. value = "Order Item"),
>> on page 235.

• Searching for fixed price volumes:

• If no fixed price is found: The system searches for a price entered in a price
list, >> on page 177. Continue to step 3.
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3. Searching in price lists: The system searches for a price in price lists in the
following order:

a. An individual price list if the Indiv. Price List field in the order contains a
price list,

b. A customer group price list if a customer group has been entered in the
company record,

c. A country price list defined for the country the company is located in.

The price list must meet the following conditions:

• The item in the order item record is the item in the price list

• The currency in the order is entered in the price list

• the price list is currently valid (i.e. the date of the order lies in the time period
that the price list is valid for)

The first price list found is used. If no suitable price list is found, no price is en-
tered. In this case you need to enter the price manually in the End Price field.

Note: Note: If an end price was determined by the system, you can edit it.

4. Once you have entered a Quantity in the order item, the value of the
corresponding items is entered in the Value field (calculated as Quantity * End
Price * value factor * Price Factor). (The items’ values are totaled in the Total
Items Value field in the order each time an order item record is saved.)

If applicable, discounts are applied to the order items, i.e. percentage discounts
and discounts in kind defined in company and general conditions, >> on page
201.

After saving an order item record, the discount on the order level (if applicable) is
recalculated, >> on page 203.

Discounts at the Item Level
Once the End Price and Quantity have been entered in an order item record, Aurea
CRM searches for valid conditions, company conditions and volume scales in order
to determine which discounts and discounts in kind apply.

Note: Note: If you enable the No discount field when adding a new order item,
the system does not search for valid conditions for the item and the item is ignored
when calculating the discount applied to the weighted total quantity of the order,
>> on page 203. This field is disabled by default.If a Discount is entered in the
conditions record, this discount is transferred to the Discount % (Condition) field
in the order. The bulk discounts entered in the conditions record (Bulk discount
(%) field) and in volumes (Discount field) are not applied.
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The following diagram illustrates how discounts are determined:

The system searches for valid conditions in the following order:

1. A record in the Company Conditions info area that meets the following criteria
(>> on page 234):

• The company the order was added for is entered in the company conditions
record

• The business area in the order is entered in the company conditions record

• The item (Item No. and Item Name), sector, product group, brand or grade
entered in the company conditions match those entered in the order item

Note: Note: These fields cannot be combined in company conditions.

• The currency in the order is entered in the company conditions record
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• A Bulk discount (%) and/or Discount vol. in kind have been entered in the
company conditions record

• The company conditions record is currently valid (i.e. the date of the order lies
in the time period that the conditions are valid for)

2. A record in the Conditions info area that meets the following criteria (>> on page
233):

• The customer group entered in the conditions matches the customer group
assigned to the customer the order was added for

• The item (Item No. and Item Name), Sector, Product Group, Brand or Grade
entered in the conditions match those entered in the order item

Note: Note: These fields cannot be combined in conditions.

• The currency in the order is entered in the conditions record

• A Bulk discount (%) and/or Discount vol. in kind have been entered in the
conditions record

• The conditions record is currently valid (i.e. the date of the order lies in the
time period that the conditions are valid for)

3. If suitable company conditions or generally conditions are found, the system
searches for a suitable scale of discount (Volume Type = "Scale of discount"
and Comp. value = "Order Item"), >> on page 235.

4. The discount determined is entered in the order item:

• Discount in kind are entered in the Discount vol. in kind field

• Percentage discounts are entered in the Discount % (Condition) field.
Depending on the settings selected in the Conditions apply to field (in the
company or general conditions), this discount is applied in addition to the item
discount (Discount field); or only if no discount is entered in the Discount
field; or the discount entered in the conditions overwrites the discount in the
Discount field, >> on page 233.

5. The value of the items is calculated based on the discount in the order item and
conditions record as follows:

• Value = Quantity * End price * value factor * Price factor

• Discount abs. = Value * Discount / 100

• Disc.Value1 = Value - Discount abs.

• Disc.Value2 = Disc.Value1 - Discount % (Conditions) - Item Group Discount

After saving each order item, the discounts at the order level are recalculated (if
present), >> on page 203.
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Note: Note: Discounts entered in conditions at the order level overwrite discounts
in conditions at the item level.

Discounts at the Order Level
After saving each order item, the discounts at the order level are recalculated.

The following diagram illustrates the order in which discounts are applied and how
discounts are determined at the order level:

Discounts are determine in the following order:

1. To determine the discount applied to the weighted total quantity in the order,
Aurea CRM searches for valid conditions in the following order:
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Note: Note: A valid weighting must be entered in the order item, >> on page
178.If the No discount field in the order is enabled, the system does not search
for applicable conditions.In order for bulk discounts to be applied, the Bulk
discount (%) field must be empty.If discounts in kind have been defined in
conditions or bulk volumes (Discount vol. in kind field), they are transferred to
the order item.

a. A record in the Company Conditions info area that meets the following criteria
(>> on page 234):

• The Company the order was added for is entered in the company conditions
record

• The Business Area in the order is entered in the company conditions record

• The item (Item No. and Item name), Sector, Product Group, Brand or
Grade entered in the company conditions match those entered in the order
item

Note: Note: These fields cannot be combined in company conditions.

• The Currency in the order is entered in the company conditions record

• A Discount is entered in the company conditions record

The company conditions record is currently valid (i.e. the date of the order lies
in the time period that the conditions are valid for)

b. A record in the Conditions info area that meets the following criteria (>> on
page 233):

• The Customer Group entered in the conditions matches the customer group
assigned to the customer the order was added for

• The item (Item No. and Item name), Sector, Product Group, Brand or
Grade entered in the conditions match those entered in the order item

Note: Note: These fields cannot be combined in conditions.

• The Currency in the order is entered in the conditions record

• A Discount is entered in the conditions record

• The conditions record is currently valid (i.e. the date of the order lies in the
time period that the conditions are valid for)

c. If suitable company conditions or generally conditions are found, the system
searches for a suitable Scale of discount (Volume Type = "Scale of discount
(weighted total quantity)" and Comp. value = "Total Order"), >> on page 235.
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Note: Note: If more than one order item has been entered containing the same
item, the total quantity entered in all order items is used to determine the volume
and any discount.

d. The discount determined is entered in the Discount % (Condition) field in item
records, whereby discounts at the order level overwrite discounts at the item
level. The discount is also used to calculate the Disc. Order % in the order
and the.

e. The Disc.Value2 field in the item records is updated accordingly.

2. After applying discounts from conditions (if present), the discount entered for the
company is deducted (Discount Cond. (Fixed) field in the order).

3. If present, any order discount (Discount field) granted manually is then deducted.

Fields in Order Value Calculations

CalculationField

Sum total of the item values (Value field) where Discount in k. is
disabled

Total Items
Value

Sum total of the item values (Value field) where Discount in k. is
enabled

Value in Kind

Total Items Value - Discount Cond. (Fixed) - Cash Cond. (Special
Offer)

Discount Cond. (Fixed) is transferred from the company

Cash Cond. (Special Offer) is transferred from the special offer

Order Value

Total Items Value - Discount Cond. (Fixed) - Discount

You can define an additional discount applied at the order level in
the Discount field.

Disc. Order
Val.

Sum total of the Disc.Value2 fields in those items where Discount
in k. is disabled (discount from the conditions applied at the order
level).

Disc. Order
Val. 1

Disc. Order Val. 1 - Discount Cond. (Fixed) - DiscountDisc. Order
Val. 2

Total discount as a percentage, calculated from Disc. Order Val.
2 / Total Items Value -1.

Disc. Order %
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Pricing for Special Offers
If a special offer is entered in the order, the volume scale and discounts defined for
the special offer are applied to the order. Special offers are managed in the Special
Offer info area.

Special offer volume scales and discounts applied to item groups are taken into
account prior to conditions when pricing items and applying discounts.

Enter the special offer in Special Offer Name field in the order. You can only access
special offers that are currently valid; i.e. the current date needs to be between the
star t and end date of the special offer.

Note: Note: If you add order items manually (i.e. not using the quick add function),
prices defined for special offers are not calculated automatically, even if the item
is currently on special offer. Company conditions and general conditions are however
applied.If you enter a special offer in the order, no links to work orders are available,
>> on page 229.You can use the same business logic as used in Aurea CRM win
in Aurea CRM web. In this case, only those special offers where no customer group
or the same customer group is entered as the company the order was added for.
To do so, add the Customer Group (FI,147) field to the order's tab view and use
it as a fixed filter applied to the search (in the record selector, e.g. for the Special
Offer Name field).

You can use the Additional items field special offers in Aurea CRM win to determine
how the quick add area for order items behaves.

• Enabled: All items are displayed. All radio buttons are active and you can use
the Special Offer option to display all special offer item as a list of suggestions.

• Disabled: Only special offer items are listed. Only the Overview and Special
Offer options are active. Select Overview to display all items where quantities
have been entered; select Special Offer to display all special offer items.

Special Offer Volume Scales

If you have defined bulk discounts and/or discounts in kind in a special offer item
record (>> on page 228), these can be displayed in the quick add area (Scale of
discount field), >> Aurea CRM win Administrator Guide.

If you select a different scale in the Scale of discount field, the lower limit of the
scale’s volume is entered in the Quantity field and the corresponding discounts are
entered in the Discount % (Condition) and Discount vol. in kind fields. Your ad-
ministrator can disable this behavior using the Do not apply scale of discount
configuration entry (General Settings category), >> CRM.core Administrator Guide.

Corresponding order items can be created automatically using triggers (>> CRM.core
Administrator Guide) for the units granted as a discount in kind.

Item Group Discounts
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You can group special offer items and define volumes that apply to these groups,
>> on page 228.

Whenever a new offer/order item is added, the system searches for a suitable volume
by totaling the Quantity and Value fields in all items. If a new volume has been
reached, all affected items are updated (Item Group Discount, Item Group Discount
in Kind, Total discount in kind, Disc.Value2.

Note: Note: The quick add areas in Aurea CRM web are not automatically refreshed
by default. To use the functions described here in Aurea CRM web, the "Refresh"
button needs to be integrated in the quick add areas (e.g. in the 'SerialEntry.List'
header for the 'AU’ header group for orders).

When granting discounts in kind on item groups, new offer/order items are not auto-
matically added; the existing item records are only updated (Item Group Discount
in Kind and Total discount in kind fields). A new item record is not added for
special offer items in orders/offers where the Discount in kind share is positive.

Discount scales at the item group level are not displayed in the Scale of discount
field.

Note: Note: Special offer bulk volumes and volumes defined for item groups can
overlap.

Transferring Individual Fields from Special Offers

The following fields are transferred from special offer items to the following fields
in order items:

Target Order Item FieldSpecial Offer Item
Field

Special Offer Item PricePrice

Special Offer Item QtyQuantity

Special Offer NameSpecial Offer Name

The Special Offer Item Price is converted to the currency in the order item. An
appropriate exchange rate needs to have been defined, otherwise the field remains
empty.

Transferring Individual Fields from Special Offers
The following fields are transferred from special offer items to the following fields
in order items:
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Target Order Item FieldSpecial Offer Item
Field

Special Offer Item PricePrice

Special Offer Item QtyQuantity

Special Offer NameSpecial Offer Name

The Special Offer Item Price is converted to the currency in the order item. An
appropriate exchange rate needs to have been defined (>> on page 171), otherwise
the field remains empty.

Addresses
You can enter the company’s address or an additional address in offers/orders.

In addition, you can specify up to 5 wholesalers including branch offices responsible
for supplying the company. Wholesalers themselves are companies in the database.
Enter the wholesaler by entering the keys in the Wholes. Grp 1-5 and Wholes.No.
1-5 fields.

When a new offer/order is added, the first wholesaler is automatically entered (Addr.
FI_StaNo. and Addr. FI_SerNo; and FI-StaNo (wholesaler) and FI-SerNo (whole-
saler) fields. The wholesalers address data is also transferred.

To enter another wholesaler or company address, select Address from the context
menu in the Offer/Order info area. A list of the available wholesalers is displayed.

If you select another wholesaler, the company’s data is transferred to the order or
offer.

The Type column displays the type of address. Possible values:

• FI – company address

• Wholesaler - wholesaler entered in the company record

• OA – additional address added for the company

If you select an address, the address type is entered in the Address Type field in
the offer/order.

Note:  Only those additional addresses that are company-related are available when
adding orders; you do not have access to person-related addresses.
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11
Refunding

Refunding
Use the Refunding info area to store refunds - influence stocks without an invoice.

For example - You can use refunding info area to store refunds for exchanged goods.

The Refunding info area only differs marginally from the Order info area in its
functionality and is mainly used to exchange goods or for cash refunds should you
wish to manage these separately from the order. The corresponding revenue infor-
mation can be made available here as well. As such information is often maintained
in external systems, you can also transfer refund information from other systems to
Aurea CRM.

You can display individual fields in the Refunding and Refunding Item info areas
in a second currency. For this to occur an exchange rate needs to be entered.
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To add a new refunding record:

1. Switch to the desired company and select New > Refunding from the context
menu.

2. Enter data such as the Currency, Stock, Receipt Type etc.

3. Enter additional data such as cash refunds on the various tabs and enter a
Reason.

4. Save. The VG-SerNo is entered automatically.

You can either add refunding items directly or select Quick Add (Items) from the
refunding’s context menu to use the quick add function.

To add refunding items individually:

1. Switch to the refunding record you wish to add the item to, and select Refunding
Items from the context menu.

2. Click on  (New).

Select an item from the Item No. field. The Item name, Sector, Product Group,
Brand and Grade are entered automatically.

3. Enter additional data such as the Quantity and End Price on the various tabs.
The value is automatically calculated (Value = Quantity * End Price).

Note: Note: If a price list exists for the item, the End Price is transferred from
the price list. You can manually change the End Price.
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The Value in the refunding record is calculated from the sum total of all refunding
items.
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12
Product Detailing

Product Detailing
Learn how to use the Product Detailing info area to define products and various
items that is the subject of your focus for the defined time period.

You can select cer tain products in your item master that should receive special at-
tention for a specific time period. Reps can link these items to activity records using
the quick add features and enter the customer responses.

Adding a Product Discussion Definition

In order to define which products is focused and transferred to activities when dis-
cussing them:

1. Select  (Products & Service) > New Product Detailing Definition.

2. Enter a Name.

3. Enter a Type. The items displayed in the quick add area can be filtered based
on this type.
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4. Enter the time period that this product should be focused on in the Start Date
and End Date  fields. Only those items are displayed in the Quick Add (Product
Detailing) area where the current date is in the defined time period.

5. Enter the Business Area and/or Specialization. The items that are displayed in
the quick add area for product detailing records are determined based on this
data as follows:

• Items where the business area entered in the product detailing definition
matches the rep assigned to the activity are displayed.

• Items where no specialization is entered are displayed.

• Items where the specialization matches the one of the specializations entered
in the person record (Spec. 1-5 fields) the activity was added for are displayed.

Note:  Only one record may exist for the same combination of Type, Business
Area and Specialization for a cer tain time period.

To add product detailing definition items:

1. Switch to the desired product detailing definition and select New Product Detailing
Definition Item from the context menu.

2. Select an item from the Item No. field. The Item name, Product Group, Sector,
Brand and Grade fields are transferred automatically from the item master.

3. Save. The Item No. and SP-SerNo fields are entered automatically.

Discussing Products

Products are discussed with customers with the scope of activities (e.g. visits). You
can store the customer’s response the various items.

To add a product detailing record:

1. Switch to the desired activity or add a new one.

2. Select Quick Add (Product Detailing) from the context menu.

3. Select a filter to display the items defined for the selected type (Focus Product
or Standard Focus Product). Select All to display all items in the currently valid
product detailing definitions (of all types) where the business area is the same
as your own and where the specialization (if available) matches that of the person
the activity is linked to. Click on Overview to display an overview of the entered
items.
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4. Enter the desired data.

5. Save. A product detailing record and product detailing item record is added for
each of the items you have entered.

Editing Product Detailing Records

To display and edit product detailing and product detailing item records:

1. Switch to the desired activity.

2. Select Go to All Related > All Product Detailings from the context menu. The
product detailing records added for the activity are displayed.

3. Switch to the desired record. The product detailing item records are displayed
and can be edited.

Adding a Product Discussion Definition
In order to define which products is focused and transferred to activities when dis-
cussing them:

1. Select  (Products & Service) > New Product Detailing Definition.

2. Enter a Name.

3. Enter a Type. The items displayed in the quick add area can be filtered based
on this type, >> on page 210.
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4. Enter the time period that this product should be focused on in the Start Date
and End Date  fields. Only those items are displayed in the Quick Add (Product
Detailing) area where the current date is in the defined time period.

5. Enter the Business Area and/or Specialization. The items that are displayed in
the quick add area for product detailing records are determined based on this
data as follows:

• Items where the business area entered in the product detailing definition
matches the rep assigned to the activity are displayed.

• Items where no specialization is entered are displayed.

• Items where the specialization matches the one of the specializations entered
in the person record (Spec. 1-5 fields) the activity was added for are displayed.

Note: Note: Only one record may exist for the same combination of Type,
Business Area and Specialization for a cer tain time period.

To add product detailing definition items:

1. Switch to the desired product detailing definition and select New Product Detailing
Definition Item from the context menu.

2. Select an item from the Item No. field. The Item name, Product Group, Sector,
Brand and Grade fields are transferred automatically from the item master.

3. Save. The Item No. and SP-SerNo fields are entered automatically.

Discussing Products
Products are discussed with customers with the scope of activities (e.g. visits). You
can store the customer’s response the various items.

To add a product detailing record:

1. Switch to the desired activity or add a new one, >> on page 141.

2. Select Quick Add (Product Detailing) from the context menu, >> on page 104.
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3. Select a filter to display the items defined for the selected type (Focus Product
or Standard Focus Product). Select All to display all items in the currently valid
product detailing definitions (of all types) where the business area is the same
as your own and where the specialization (if available) matches that of the person
the activity is linked to. Click on Overview to display an overview of the entered
items.

4. Enter the desired data.

5. Save.

A product detailing record and product detailing item record is added for each of
the items you have entered, >> on page 210.

Editing Product Detailing Records
To display and edit product detailing and product detailing item records:

1. Switch to the desired activity.

2. Select Go to All Related > All Product Detailings from the context menu.

The product detailing records added for the activity are displayed.

3. Switch to the desired record.

The product detailing item records are displayed and can be edited.
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13
Listing

Listing
Learn how to use the Listing info area to store the items listed for a company.

You can also include information that shelf space has been alloted at a specific spot
and has been paid for.

The listing is a kind of "contract" at the item level: If a company is paid e. g. for
placing an ar ticle at a specific spot in a supermarket shelf for a specific period, add
a listing to document this information.

The following functions are available:

• Listings can be used in the quick add area for POS monitoring items (you can
display facings, prices and placements).

• Listings need not be entered for each outlet, but can be inherited from a parent
company or wholesaler.

• You can define a time period that the listing is valid for.

• You can list the same item more than once (e.g. lasagne in the noodles and the
Italian specialties sections of a store).

Adding Listings

You can add any number of listing for an item/item group and company, e.g. if the
same item is placed on various shelves. The validity periods can overlap.

To add a listing:

1. Switch to the company you want to add the listing for.

2. Select Go to All Related > All Listings from the context menu.

3. Click on  (New).

4. Select the item from the Item name field. If you want to add a listing for an product
group, enter the Sector, Product Group, Brand and Grade.

5. To display the item/product group in the quick add area, enter dates in the Valid
from and Valid to fields. If you do not enter a date in the Valid from field, the
listing is valid without a star t date (i.e. it also applies to the past).

6. Enter the Branch type to determine that a listing applies to a specific type of
branch (small outlet, flagship store etc.). If you do not enter a Branch type, the
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listing applies to the current company and all companies that inherit the listing
from the current company.

7. Enter information on the items placement in the Facings, Placing and Price
fields.

Listings for Product Groups

If you want to list all items in a product group for a company, enter the Product
Group and leave the remaining fields empty.

A combination of criteria (e.g. all items in the "noodles" product group in the sector
"own products") is not possible in listing records. However, you can add multiple
listings per company, each with different criteria (e.g. one listing for "noodles" an-
other listing for "own products").

When inheriting listings, the first listing found in the following order is used:

1. A listing containing the Item No.

2. A listing containing the Grade

3. A listing containing the Brand

4. A listing containing the Product Group

5. A listing containing the Sector

Inheriting Listings

Listings can be entered at all levels of a company hierarchy and can then be inher-
ited by individual outlets. Listings added for several companies can be inherited,
e.g. branches can inherit listings from the parent company.

There are two types of inheritance:

• Using external keys

• Using the relationship hierarchy

The various types of inheritance are defined by your administrator in the Configura-
tion info area, see CRM.core Administrator Guide.

Inheriting Listings via External Keys

Listings can be inherited by companies using external keys.

In this example, the company "RanComp 3" should inherit the listing defined for
"RanComp 2".

1. Enter an external key in the "RanComp2" company: external key = "234" and
external system = "RA".
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Note: Note: Your administrator needs to define the contents of the Ext. System
field (in this example "RA") that is used to inherit the listing in the Configuration
info area (Listing category, External System option.

2. Enter the external key ("234") of "RanComp 2" in the Listing Reference
(Company) field of "RanComp 3".

If a listing is available for "RanComp 3", that listing is used. If no listing is avail-
able, the system searches for a company with the corresponding external company
key (the Ext. System defined in the Configuration info area and the Ext. Key
entered in the Listing Reference (Company) field of "RanComp 3"). If a listing
is defined for "RanComp 2" that listing is used.

Note: Note: As the external company key is unique across the whole system, a
company can only inherit listings from one other company.The company from which
the listing is inherited can however itself inherit a listing from another company. The
system continues to search for a listing in the hierarchy until one is found. In our
example, RanComp 2 inherits the listings of RanComp 1. If no listing is entered for
either RanComp 3 or RanComp 2, but a listing is entered for RanComp 1, RanComp
3 also inherits the listing from RanComp 1.

Inheriting Listings via Relationship Hierarchy

Listings are generally not added for individual outlets, but for the headquarters or
a wholesaler or similar. The link between an outlet and the headquarters is estab-
lished by means of relationships.

Listings can be inherited by outlets as follows:

• When adding item records manually:

When adding items manually, only listings defined for POS monitoring items are
relevant.

If a valid listing is found for an item added for a company, the POS monitoring
item record is linked to the listing. The first listing that matches the item is used;
the system searches for a matching listing record in the following order: matching
item, grade, brand, product group or sector.

If no listing is found for a company, the system searches for a listing at the next
highest level of the hierarchy defined in the Configuration info area (Listing
category, Inheritance option; one or more relationship types must to be entered
in the Value field of the configuration entry). The first matching listing that is
found is used. For example, if the company has several wholesalers, the first
listing found for a wholesaler is used. The other wholesalers are ignored.

• In the quick add area:

If your administrator has configured the quick add area for inheriting listings
(Configuration info area, Listing category, Inheritance - Quick Add option; one
or more relationship types need to be entered in the Value field), the Inheritance
drop-down list is available in the quick add areas (Offer (Aurea CRM win only),
Order, POS Monitoring, Refunding (Aurea CRM win only)).

You can select the desired relationship type in the field below the filters in the
quick add areas.
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If multiple listings are present for an item for a company, the item is displayed
multiple times in the quick add area for the POS; only the first listing is displayed
in the quick add area for orders (in the following order: item, grade, brand, product
group, sector).

Note: Note: As reciprocal relationships are also taken into account, the reciprocal
relationships must be defined using a different relationship type in order to define
a hierarchic structure used to inherit listings.

You can restrict the inheritance of listings using the Branch type field in the Listing
info area. Only those listings where no branch type is entered or where the same
branch type as the company is entered are inherited. If a suitable listing with the
branch type entered and a listing with an empty branch type are found, the listing
with the branch type entered is used.

Adding Listings
You can add any number of listing for an item/item group and company, e.g. if the
same item is placed on various shelves. The validity periods can overlap.

To add a listing:

1. Switch to the company you want to add the listing for.

2. Select Go to All Related > All Listings from the context menu.

3. Click on  (New).

4. Select the item from the Item name field.

If you want to add a listing for an product group, enter the Sector, Product Group,
Brand and Grade, >> on page 211.

5. To display the item/product group in the quick add area (>> on page 104):

• Enter dates in the Valid from and Valid to fields. If you do not enter a date in
the Valid from field, the listing is valid without a star t date (i.e. it also applies
to the past).

6. Enter the Branch type to determine that a listing applies to a specific type of
branch (small outlet, flagship store etc.). If you do not enter a Branch type, the
listing applies to the current company and all companies that inherit the listing
from the current company, >> on page 212.

7. Enter information on the items placement in the Facings, Placing and Price
fields.
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Listings for Product Groups
If you want to list all items in a product group for a company, enter the Product
Group and leave the remaining fields empty.

A combination of criteria (e.g. all items in the "noodles" product group in the sector
"own products") is not possible in listing records. However, you can add multiple
listings per company, each with different criteria (e.g. one listing for "noodles" an-
other listing for "own products").

When inheriting listings, the first listing found in the following order is used:

1. A listing containing the Item No.

2. A listing containing the Grade

3. A listing containing the Brand

4. A listing containing the Product Group

5. A listing containing the Sector

Inheriting Listings
Listings can be entered at all levels of a company hierarchy and can then be inher-
ited by individual outlets. Listings added for several companies can be inherited,
e.g. branches can inherit listings from the parent company.

There are two types of inheritance:

• Using external keys

• Using the relationship hierarchy

The various types of inheritance are defined by your administrator in the Configu-
ration info area, >> CRM.core Administrator Guide.

Inheriting Listings via External Keys

Listings can be inherited by companies using external keys.

In this example, the company "RanComp 3" should inherit the listing defined for
"RanComp 2".

1. Enter an external key in the "RanComp2" company: external key = "234" and
external system = "RA".
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Note: Note: Your administrator needs to define the contents of the Ext. System
field (in this example "RA") that is used to inherit the listing in the Configuration
info area (Listing category, External System option.

2. Enter the external key ("234") of "RanComp 2" in the Listing Reference
(Company) field of "RanComp 3".

If a listing is available for "RanComp 3", that listing is used. If no listing is avail-
able, the system searches for a company with the corresponding external company
key (the Ext. System defined in the Configuration info area and the Ext. Key
entered in the Listing Reference (Company) field of "RanComp 3"). If a listing
is defined for "RanComp 2" that listing is used.

Note: Note: As the external company key is unique across the whole system, a
company can only inherit listings from one other company.The company from which
the listing is inherited can however itself inherit a listing from another company. The
system continues to search for a listing in the hierarchy until one is found. In our
example, RanComp 2 inherits the listings of RanComp 1. If no listing is entered for
either RanComp 3 or RanComp 2, but a listing is entered for RanComp 1, RanComp
3 also inherits the listing from RanComp 1.

Inheriting Listings via Relationship Hierarchy

Listings are generally not added for individual outlets, but for the headquarters or
a wholesaler or similar. The link between an outlet and the headquarters is estab-
lished by means of relationships.

Listings can be inherited by outlets as follows:

• When adding item records manually:

When adding items manually, only listings defined for POS monitoring items are
relevant.

If a valid listing is found for an item added for a company, the POS monitoring
item record is linked to the listing. The first listing that matches the item is used;
the system searches for a matching listing record in the following order: matching
item, grade, brand, product group or sector.
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If no listing is found for a company, the system searches for a listing at the next
highest level of the hierarchy defined in the Configuration info area (Listing
category, Inheritance option; one or more relationship types must to be entered
in the Value field of the configuration entry). The first matching listing that is
found is used. For example, if the company has several wholesalers, the first
listing found for a wholesaler is used. The other wholesalers are ignored.

• In the quick add area:

If your administrator has configured the quick add area for inheriting listings
(Configuration info area, Listing category, Inheritance - Quick Add option; one
or more relationship types need to be entered in the Value field), the Inheritance
drop-down list is available in the quick add areas (Offer (Aurea CRM win only),
Order, POS Monitoring, Refunding (Aurea CRM win only)).

You can select the desired relationship type in the field below the filters in the
quick add areas.

If multiple listings are present for an item for a company, the item is displayed
multiple times in the quick add area for the POS; only the first listing is displayed
in the quick add area for orders (in the following order: item, grade, brand, product
group, sector).

Note: Note: As reciprocal relationships are also taken into account, the reciprocal
relationships must be defined using a different relationship type in order to define
a hierarchic structure used to inherit listings.

You can restrict the inheritance of listings using the Branch type field in the Listing
info area. Only those listings where no branch type is entered or where the same
branch type as the company is entered are inherited. If a suitable listing with the
branch type entered and a listing with an empty branch type are found, the listing
with the branch type entered is used.

Inheriting Listings via External Keys
Listings can be inherited by companies using external keys.

In this example, the company "RanComp 3" should inherit the listing defined for
"RanComp 2".

1. Enter an external key in the "RanComp2" company: external key = "234" and
external system = "RA".
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Note: Note: Your administrator needs to define the contents of the Ext. System
field (in this example "RA") that is used to inherit the listing in the Configuration
info area (Listing category, External System option.

2. Enter the external key ("234") of "RanComp 2" in the Listing Reference
(Company) field of "RanComp 3".

If a listing is available for "RanComp 3", that listing is used. If no listing is avail-
able, the system searches for a company with the corresponding external company
key (the Ext. System defined in the Configuration info area and the Ext. Key
entered in the Listing Reference (Company) field of "RanComp 3"). If a listing
is defined for "RanComp 2" that listing is used.

Note: Note: As the external company key is unique across the whole system, a
company can only inherit listings from one other company.The company from which
the listing is inherited can however itself inherit a listing from another company. The
system continues to search for a listing in the hierarchy until one is found. In our
example, RanComp 2 inherits the listings of RanComp 1. If no listing is entered for
either RanComp 3 or RanComp 2, but a listing is entered for RanComp 1, RanComp
3 also inherits the listing from RanComp 1.

Inheriting Listings via Relationship Hierarchy
Listings are generally not added for individual outlets, but for the headquarters or
a wholesaler or similar. The link between an outlet and the headquarters is estab-
lished by means of relationships, >> on page 120.

Listings can be inherited by outlets as follows:

• When adding item records manually:

When adding items manually, only listings defined for POS monitoring items are
relevant.

If a valid listing is found for an item added for a company, the POS monitoring
item record is linked to the listing. The first listing that matches the item is used;
the system searches for a matching listing record in the following order: matching
item, grade, brand, product group or sector, >> on page 211.
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If no listing is found for a company, the system searches for a listing at the next
highest level of the hierarchy defined in the Configuration info area (Listing
category, Inheritance option; one or more relationship types must to be entered
in the Value field of the configuration entry). The first matching listing that is
found is used. For example, if the company has several wholesalers, the first
listing found for a wholesaler is used. The other wholesalers are ignored.

• In the quick add area:

If your administrator has configured the quick add area for inheriting listings
(Configuration info area, Listing category, Inheritance - Quick Add option; one
or more relationship types need to be entered in the Value field), the Inheritance
drop-down list is available in the quick add areas (Offer (Aurea CRM win only),
Order, POS Monitoring, Refunding (Aurea CRM win only)).

You can select the desired relationship type in the field below the filters in the
quick add areas.

If multiple listings are present for an item for a company, the item is displayed
multiple times in the quick add area for the POS; only the first listing is displayed
in the quick add area for orders (in the following order: item, grade, brand, product
group, sector).

Note: Note: As reciprocal relationships are also taken into account, the reciprocal
relationships must be defined using a different relationship type in order to define
a hierarchic structure used to inherit listings.

You can restrict the inheritance of listings using the Branch type field in the Listing
info area. Only those listings where no branch type is entered or where the same
branch type as the company is entered are inherited. If a suitable listing with the
branch type entered and a listing with an empty branch type are found, the listing
with the branch type entered is used.
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14
Point of Sale

Point of Sale
Learn about POS info area.

Aurea CRM allows you to store the facings of your own products (POS Monitoring
info area) and those of your competitors (Competition info area) at your customers,
as well as analyze the points of sale per rep and item.

POS Monitoring

The POS Monitoring info area (POS = point of sale) is used to store facings for
your own products at the point of sale on a specific date. You can store various in-
formation on your business partners. Points of sale monitoring records are always
added for a company. You can add one POS monitoring record per company per
day.
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To add a POS monitoring record:

1. The following options are available:

• Switch to the desired company and select New > New POS Monitoring from
the context menu.

• Select  (Products & Service) > POS Monitoring. Star t the search. Click
on  (New) and select the desired company.

2. Enter the following:

• Currency: The currency cannot be edited once the record has been saved.
POS monitoring items use the currency entered in the POS monitoring record.
The currency cannot be changed in the items.

• Date of the POS monitoring.

POS Monitoring Items

You can add multiple POS monitoring items to a POS monitoring record in order to
store the facings at a customer at the item level. You can store stock situations,
facing situations and the distribution status, so as to identify weak points and to
take necessary measures.

You can either add POS monitoring items directly or select Quick Add (Items) from
the POS monitoring record’s context menu to use the quick add function.
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To add items to a POS monitoring record:

1. The following options are available:

• Switch to the desired POS monitoring record and select POS Monitoring Items
from the context menu. Star t the search and click on  (New).

• Switch to the desired company. Select Go to All Related > All POS Monitorings
from the context menu. Switch to the desired POS monitoring record and select
POS Monitoring Items from the context menu. Star t the search and click on

 (New).

2. Select an item from the Item No. field. The Item name, Sector, Product Group,
Brand and Grade are entered automatically.

3. Enter date on the various tabs, such as the Stock, Facings, Price etc. The
Currency is transferred from the POS monitoring record and cannot be changed.

Switch to the desired POS monitoring record and select Quick Add (Items) from
the context menu to use the quick add function.

Note: Note:The Last POS Monitoring button displays the items in the last three
POS monitoring records added for the selected company. The filter accessed by
this button can be configured using the
recentFilterOptions

parameter, see CRM.core Administrator Guide. If you select the Listing filter, you
can select a relationship type in the field directly beneath the filters. If an item is
defined in a listing multiple times, it is listed multiple times. If you select the Special
Offer filter, the items defined for the valid special offer are displayed.

Transferring Individual Fields from Listings

You can transfer information stored in listings when adding POS monitoring data in
the quick add area.

The following fields are transferred from the Listing info area to the following fields
in the POS Monitoring Item info area:

POS Monitoring Item FieldListing Field

LS_StaNoLS-StaNo

LS_SerNoLS-SerNo

Agreed Facings and LS-FacingsFacings

Agreed Facings (%) and LS-Facing %Facing %

Agreed Placement 1 and LS-Placing 1Placing

Agreed Placement 2 and LS-Placing 2Placing 2
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POS Monitoring Item FieldListing Field

Agreed Price and LS-PricePrice

LS-Plac.TextPlac.Text

The value in the Price field in the Listing info area is transferred to the LS-Price
and Agreed Price fields in the POS Monitoring Item info area. The amount is
converted to the currency entered in the POS Monitoring info area. An exchange
rate needs to be defined for the currency to be converted.

POS Monitoring

The POS Monitoring info area (POS = point of sale) is used to store facings for
your own products at the point of sale on a specific date. You can store various in-
formation on your business partners. Points of sale monitoring records are always
added for a company. You can add one POS monitoring record per company per
day.
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To add a POS monitoring record:

1. The following options are available:

• Switch to the desired company and select New > New POS Monitoring from
the context menu.

• Select  (Products & Service) > POS Monitoring. Star t the search. Click
on  (New) and select the desired company.

2. Enter the following:

• Currency: The currency cannot be edited once the record has been saved.
POS monitoring items use the currency entered in the POS monitoring record.
The currency cannot be changed in the items.

• Date of the POS monitoring.

POS Monitoring Items
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You can add multiple POS monitoring items to a POS monitoring record in order to
store the facings at a customer at the item level. You can store stock situations,
facing situations and the distribution status, so as to identify weak points and to
take necessary measures.

You can either add POS monitoring items directly or select Quick Add (Items) from
the POS monitoring record’s context menu to use the quick add function, >> on
page 104.

To add items to a POS monitoring record:

1. The following options are available:

• Switch to the desired POS monitoring record and select POS Monitoring Items
from the context menu. Star t the search and click on  (New).

• Switch to the desired company. Select Go to All Related > All POS Monitorings
from the context menu. Switch to the desired POS monitoring record and select
POS Monitoring Items from the context menu. Star t the search and click on

 (New).

2. Select an item from the Item No. field. The Item name, Sector, Product Group,
Brand and Grade are entered automatically.

3. Enter date on the various tabs, such as the Stock, Facings, Price etc. The
Currency is transferred from the POS monitoring record and cannot be changed.

Switch to the desired POS monitoring record and select Quick Add (Items) from
the context menu to use the quick add function.

Note: Note:The Last POS Monitoring button displays the items in the last three
POS monitoring records added for the selected company. The filter accessed by
this button can be configured using the
recentFilterOptions

parameter, >> CRM.core Administrator Guide.If you select the Listing filter, you
can select a relationship type in the field directly beneath the filters, >> on page
212. If an item is defined in a listing multiple times, it is listed multiple times, >> on
page 211.If you select the Special Offer filter, the items defined for the valid special
offer are displayed, >> on page 227 and on page 229.

Transferring Individual Fields from Listings
You can transfer information stored in listings when adding POS monitoring data in
the quick add area, >> on page 211.

The following fields are transferred from the Listing info area to the following fields
in the POS Monitoring Item info area:
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POS Monitoring Item FieldListing Field

LS_StaNoLS-StaNo

LS_SerNoLS-SerNo

Agreed Facings and LS-FacingsFacings

Agreed Facings (%) and LS-Facing %Facing %

Agreed Placement 1 and LS-Placing 1Placing

Agreed Placement 2 and LS-Placing 2Placing 2

Agreed Price and LS-PricePrice

LS-Plac.TextPlac.Text

The value in the Price field in the Listing info area is transferred to the LS-Price
and Agreed Price fields in the POS Monitoring Item info area. The amount is
converted to the currency entered in the POS Monitoring info area. An exchange
rate needs to be defined for the currency to be converted, >> on page 171.
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15
Promotional Material

Promotional Material
Learn how to store information on promotional material for a company.

You can define how much the customer needs to be paid in order for the promotional
material to be displayed.

In contrast to offers, orders and refunds, promotional material records are only
stored as items; there is no parent "header" record. Always enter the number of
individual units in the Quantity field, not the number of packages. There is no
quantity factor. Enable the Entered in Inventory field to prevent the quantity entered
from being deducted from the Stock.The field is disabled by default, i.e. stocks are
decreased.

You can enter promotional material directly or using the quick add function (Quick
Add (Promotional Material)).

528AUREA CONFIDENTIAL

Chapter 15: Promotional Material



To add promotional material individually:

1. Switch to the desired company and select New > Promotional Material from the
context menu.

2. Enter data such as the Item No., Quantity, Currency, Placing etc.

3. Save.

To display all promotional material entered for a company, switch to the desired
company and select Go to All Related > All Promotional Materials from the context
menu.

Note: Your can determine that promotional material can also be distributed to
persons (PE_StaNo, PE_SerNo and Person).
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16
Samples

Samples
Learn how to manage the distribution of samples by your field staff.

Sample management is important for pharmaceutical products and encompasses
the following features:

• You can define that cer tain persons are not subject to quotas, i.e they may
receive any number of samples of any item.

• You can define the launch phase per item and business area and determine how
many samples (i.e. the quota) may be distributed during and after the launch
phase. The end of the launch phase is the latest end date in all an item’s sample
codes.

• Use the Sample info area to store how many samples of an item have been issued
to a person and how many still need to be sent. The quick add function is available
for entering samples.

Note: You can access the quick add area for samples from the Activity info area.
The samples entered there are linked to the activity record.

• When entering samples, Aurea CRM automatically verifies whether the available
quota is exceeded.

• Use the Stock field (in the Sample info area) to determine which stocks the
samples should be deducted from. When reps issue samples, the corresponding
rep’s stock is decreased by the quantity entered in the Quantity issued field.

• You can display an overview of all samples you have issued to a person over the
course of a year in the Samples/Year info area. You can display a list of all
samples issued and still to be sent in the Sample info area.

Note: (European Federation of Pharmaceutical Industries and
Associations/Healthcare Professionals): You can configure the distribution of
samples such that it corresponds to Article 16 of the EFPIA HCP Code. Use the
Quota after initial distribution configuration entry (Sample category) to do so.
Enter
2;2
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as the Value to determine that two samples per year may be distributed to a person
(doctor) over the two years from the date that the first samples were issued. If this
quota is exceeded, a message is displayed. The setting defined in the Quota
exceeded configuration entry (Sample category) determine whether the record can
be saved in this case. If a sample is added after the two year period has ended, a
message is displayed and the record cannot be saved. If the sample is not subject
to a quota, the sample can be issued without a message being displayed, and fur ther
samples can be issued and stored in the system after the two year period has
ended.If you use the Quota after initial distribution configuration entry, the
Date-based quota configuration entry is ignored and the default sample-related
business logic is not applied (sample codes).If you change the value in the
configuration entry, remaining quotas based on previously issued samples are not
recalculated.In order to be able to check how many samples a person has already
received, the access rights defined for the Sample/Year info area are ignored by
the business logic.

Persons not Subject to Quotas

You can define categories of persons that are not subject to quotas. These persons
can receive any number of samples during and after the launch phase, irrespective
of whether a sample code is entered in the item.

Follow the below steps to define categories of persons that are not subject to quotas:

1. Define the categories for persons not subject to quotas in the Category info area
in Aurea CRM win, and enable the No sample limit check box. Alternatively, you
can enable the No sample limit field for individual persons.

2. Enter the desired Category in the appropriate person records in Aurea CRM web
(on the Classification tab).

The No sample limit field in the Person info area only affects the corresponding
person, irrespective of their category. The No sample limit field in the Category
info area affects all persons assigned to the category.
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Entering Sample Quotas for Items

Use the Sample Code info area to define the following per item and business area:

• Whether samples of this item are subject to a quota

• The duration of the launch phase: The end of the launch phase is the latest end
date in all an item’s sample codes.

• The number of samples that may be distributed per person before and during the
launch phase

Sample Codes

Use the Sample Code info area to define the launch phase and the amount of
samples that can be distributed per person during and after this phase, and whether
the item is subject to a quota.

The settings apply to all reps assigned to the corresponding business area.

To define an item as a sample:

1. Switch to the desired item in the Item Master info area.

2. Select New > New Sample Code from the context menu.

3. Enter the desired Business Area.

4. Enter the following details:

• If the Allocated field is disabled, there are no restrictions imposed on the
number of items that can be distributed to persons as samples. (‘*’ is displayed
for these items in the Available Quota column in the quick add area.)

• Enable the Allocated field to determine that the item is subject to a quota. Use
the remaining fields in the info area to determine the quota and duration of the
launch phase.

• Launch start: Star t of the launch phase

• Launch end: End of the launch phase

• Units during launch:  Quota that can be issued per person and year during
the launch phase.
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• Units after launch: Quota that can be issued per person and year after the
launch phase.

• The quotas defined here (Units during launch and Units after launch) are
compared to the sum total in the Samples/Year info area when issuing
samples.

Note: Note: Define a configuration entry in Aurea CRM win using the
Date-based quota option (Sample category) to determine that quotas are
calculated from the end of the launch phase rather than using the calendar
year, see CRM.core Administrator Guide.

5. Save. You can define different introductory phases and quotas for each business
area.

When entering samples, the system checks the number of items currently available
(based on the current date) to be distributed as samples based on the information
in the Sample Code and Samples/Year info areas.

Note: Note: If the No sample limit field is enabled for a person (or the person is
assigned to an appropriate category), the person can receive an unlimited number
of samples of each item, irrespective of whether a quota is defined for the item.

Issuing and Sending Samples

You can enter the samples you have issued or still need to send either directly or
using the quick add function, see Quick Add on page 199.

To add a sample directly:

1. Switch to the desired person and select New > New Sample from the context
menu.

2. Enter Date and Business Area and click on Next.

3. Select the item.
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In order to be able to enter an item as a sample, the following conditions need to
be met:

• The current date must be either during or after the launch phase (except for
items that are not subject to quotas).

4. Enter the number of units issued as samples in the Quantity issued field and the
amount that you still need to send in the Order quantity field.

5. Enter additional data such as the Lot No., Status etc. You are automatically
entered in the Rep ID field.

6. Save.

Note: Note: You can access the quick add function for samples from an activity.
In this case, information is automatically transferred from the activity to the sample
record (Date, Rep ID, Business Area, MA_StaNo, MA_SerNo). When using the
quick add function, a sample code needs to be defined for the rep’s Business
Area.You can define which items should be displayed in the quick add area, see
Serial Entry Configurations (OTC) in the Aurea CRM web Administrator Guide. The
Lot No. and current quantity are displayed in the quick add area. Use the Lots
without quantity configuration entry (Inventory category) to only display the lot
number, see CRM.core Administrator Guide and Aurea CRM web Administrator
Guide.Click on the Special Offer button in the quick add area to only display samples
for currently valid special offers; the key fields entered in the special offer are
transferred to any items added in the quick add area.

Issued Samples and Samples to be Sent

You can enter the following for each sample:
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ExplanationField

Determines the stock that the samples are deducted from. The quantity
in the Stock info area is automatically decreased by the amount entered
in the Quantity issued field.

Stock

Enter the number of samples that have been issued to the person
here.Enter negative numbers to determine that the quantity entered in
this field is added to the stock (if samples are returned).

Quantity
issued

Enter the number of samples that still need to be sent to this person
here.Quantities entered in the Order quantity field are ignored in stock
calculations, as these samples are generally sent out directly from
central stores and therefore have no influence on a rep’s stocks.

Order
quantity

If you have entered data in the Order quantity field, this field is set
to "Ordered".

Status

The available quota is calculated based on the values in the Quantity issued and
Order quantity fields.

Available Quota

Aurea CRM allows you to monitor the amount of samples (of an item) a person has
received and the amount they can still receive.

The currently available quota (i.e. the number of units of an item that a person can
still receive) is determined per item and customer based on information stored in
various info areas:

ExplanationFieldInfo Area

If this field is enabled for a person (or the person is
assigned to an appropriate category where No sample
limit is enabled), the person can receive an unlimited
number of samples of each item.

No sample limitPerson

If this field is disabled all persons can receive an
unlimited quantity of this item as samples.

AllocatedSample
Code

Star t and end date of the launch phase for the item.
By default, the available quota for an item is calculated
for a calendar year. For information on date-based
quotas.

Launch star t

Launch end

Sample
Code

Maximum number of units of this item that a person
can receive during and after the introductory phase.

Units during
launch

Units after
launch

Sample
Code
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When entering samples, the system checks the date entered in the Sample info
area to determine whether the launch phase has star ted or ended. The maximum
available quote is calculated based on the data in the Sample Code info area. The
currently available quota is calculated from this upper limit and the number of
samples already issued to the person this current year.

The available quota is updated in the Available Quota field in the quick add area
or when adding or editing a sample record once a new entry is made in the Quantity
issued and Order quantity fields. If a person or sample item is not subject to a
quota, ‘*’ is displayed in the Available Quota field.

Note:  If the available quota is exceeded, the record cannot be added. Your
administrator can define that records can still be added if the available quota is
exceeded using the Quota exceeded option (Sample category) in the Configuration
info area, see CRM.core Administrator Guide. In this case, a warning message is
displayed if the quota is exceeded.

Date-based Quotas

By default, the available quota for an item is calculated for a calendar year. The
quota defined in the Units after launch field applies to the end of the calendar year
following the launch phase.

Your administrator can use the Date-based quota configuration entry (Sample
category) to define that the quota applies for a full year after the last launch end
date defined for the item, instead of until the end of the calendar year, see CRM.core
Administrator Guide.

If you are using date-based quotas, the quota is calculated per item based on the
End of Period entered in the sample code record. This is the latest Launch end
date + 1 year.

The available quota is calculated based on the currently valid record in the Sam-
ples/Year info area (i.e. End of Period > date the sample was issued). If no such
record exists, it is added automatically. The number of samples issued is calculated
when adding the new record.

Overview

Aurea CRM allows you to display an overview of the samples issued to a customer
during and after the launch phase, as well as an overview of any samples that still
need to be sent.

Samples/Year

The Samples/Year info area provides you with an overview of the samples issued
to a customer during and after the launch phase.

• Select  (Sales) > Search Samples/Year.

The current number of samples issued per person, item and sample period is dis-
played:

When issuing samples, Aurea CRM calculates the available quota based on the
number of samples that have been issued or still need to be sent.

Samples
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Select  (Sales) > Samples and click on search to list all samples that have
been issued or that still need to be sent. Use the context menu to switch to the
company, person or activity that a sample belongs to.

Persons not Subject to Quotas
Aurea CRM allows you to define categories of persons that are not subject to quotas.
These persons can receive any number of samples during and after the launch
phase, irrespective of whether a sample code is entered in the item.

Define the categories for persons not subject to quotas in the Category
info area in Aurea CRM win, and enable the No sample limit check box.

Alternatively, you can enable the No sample limit field for individual per-
sons.
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Enter the desired Category in the appropriate person records in Aurea CRM web
(on the Classification tab).

The No sample limit field in the Person info area only affects the corresponding
person, irrespective of their category. The No sample limit field in the Category
info area affects all persons assigned to the category.

Entering Sample Quotas for Items
Use the Sample Code info area to define the following per item and business area:

• Whether samples of this item are subject to a quota

• The duration of the launch phase: The end of the launch phase is the latest end
date in all an item’s sample codes.

• The number of samples that may be distributed per person before and during the
launch phase

Sample Codes
Use the Sample Code info area to define the launch phase and the amount of
samples that can be distributed per person during and after this phase, and whether
the item is subject to a quota.

The settings apply to all reps assigned to the corresponding business area.

To define an item as a sample:

1. Switch to the desired item in the Item Master info area, >> on page 175.

2. Select New > New Sample Code from the context menu.

3. Enter the desired Business Area.

538AUREA CONFIDENTIAL

Chapter 16: Samples



4. Enter the following details:

• If the Allocated field is disabled, there are no restrictions imposed on the
number of items that can be distributed to persons as samples. (‘*’ is displayed
for these items in the Available Quota column in the quick add area.)

• Enable the Allocated field to determine that the item is subject to a quota. Use
the remaining fields in the info area to determine the quota and duration of the
launch phase.

• Launch start: Star t of the launch phase

• Launch end: End of the launch phase

• Units during launch:  Quota that can be issued per person and year during
the launch phase.

• Units after launch: Quota that can be issued per person and year after the
launch phase.

• The quotas defined here (Units during launch and Units after launch) are
compared to the sum total in the Samples/Year info area when issuing
samples, >> on page 225.

Note: Note: Define a configuration entry in Aurea CRM win using the
Date-based quota option (Sample category) to determine that quotas are
calculated from the end of the launch phase rather than using the calendar
year, >> CRM.core Administrator Guide and on page 225.

5. Save.

You can define different introductory phases and quotas for each business area.

When entering samples, the system checks the number of items currently available
(based on the current date) to be distributed as samples based on the information
in the Sample Code and Samples/Year info areas, >> on page 224.

Note: Note: If the No sample limit field is enabled for a person (or the person is
assigned to an appropriate category), the person can receive an unlimited number
of samples of each item, irrespective of whether a quota is defined for the item, >>
on page 222.
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Issuing and Sending Samples
You can enter the samples you have issued or still need to send either directly or
using the quick add function, >> on page 104.

To add a sample directly:

1. Switch to the desired person and select New > New Sample from the context
menu.

2. Enter Date and Business Area and click on Next.

3. Select the item.

In order to be able to enter an item as a sample, the following conditions need to
be met:

• The current date must be either during or after the launch phase (except for
items that are not subject to quotas).

4. Enter the number of units issued as samples in the Quantity issued field and the
amount that you still need to send in the Order quantity field, >> on page 224.

5. Enter additional data such as the Lot No., Status etc.

You are automatically entered in the Rep ID field.

6. Save.

Note: Note: You can access the quick add function for samples from an activity.
In this case, information is automatically transferred from the activity to the sample
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record (Date, Rep ID, Business Area, MA_StaNo, MA_SerNo). When using the
quick add function, a sample code needs to be defined for the rep’s Business Area,
>> on page 222.You can define which items should be displayed in the quick add
area, >> Special Serial Entry Configurations (OTC) in the Aurea CRM web
Administrator Guide.The Lot No. and current quantity are displayed in the quick
add area. Use the Lots without quantity configuration entry (Inventory category)
to only display the lot number, >> CRM.core Administrator Guide and Aurea CRM
web Administrator Guide.Click on the Special Offer button in the quick add area to
only display samples for currently valid special offers; the key fields entered in the
special offer are transferred to any items added in the quick add area, >> on page
227.

Issued Samples and Samples to be Sent
You can enter the following for each sample:

ExplanationField

Determines the stock that the samples are deducted from. The quantity
in the Stock info area is automatically decreased by the amount entered
in the Quantity issued field, >> on page 256.

Stock

Enter the number of samples that have been issued to the person
here.Enter negative numbers to determine that the quantity entered in
this field is added to the stock (if samples are returned).

Quantity
issued

Enter the number of samples that still need to be sent to this person
here.Quantities entered in the Order quantity field are ignored in stock
calculations, as these samples are generally sent out directly from
central stores and therefore have no influence on a rep’s stocks.

Order
quantity

If you have entered data in the Order quantity field, this field is set
to "Ordered".

Status

The available quota is calculated based on the values in the Quantity issued and
Order quantity fields, >> on page 224.

Available Quota
Aurea CRM allows you to monitor the amount of samples (of an item) a person has
received and the amount they can still receive.
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The currently available quota (i.e. the number of units of an item that a person can
still receive) is determined per item and customer based on information stored in
various info areas:

ExplanationFieldInfo Area

If this field is enabled for a person (or the person is
assigned to an appropriate category where No sample
limit is enabled), the person can receive an unlimited
number of samples of each item, >> on page 222.

No sample limitPerson

If this field is disabled all persons can receive an
unlimited quantity of this item as samples.

AllocatedSample
Code

Star t and end date of the launch phase for the item.By
default, the available quota for an item is calculated
for a calendar year. For information on date-based
quotas, >> on page 225.

Launch star t

Launch end

Sample
Code

Maximum number of units of this item that a person
can receive during and after the introductory phase.

Units during
launch

Units after
launch

Sample
Code

When entering samples, the system checks the date entered in the Sample info
area to determine whether the launch phase has star ted or ended. The maximum
available quote is calculated based on the data in the Sample Code info area. The
currently available quota is calculated from this upper limit and the number of
samples already issued to the person this current year, >> on page 225.

The available quota is updated in the Available Quota field in the quick add area
or when adding or editing a sample record once a new entry is made in the Quantity
issued and Order quantity fields. If a person or sample item is not subject to a
quota, ‘*’ is displayed in the Available Quota field.

Note: Note: If the available quota is exceeded, the record cannot be added. Your
administrator can define that records can still be added if the available quota is
exceeded using the Quota exceeded option (Sample category) in the Configuration
info area, >> CRM.core Administrator Guide. In this case, a warning message is
displayed if the quota is exceeded.
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Date-based Quotas
By default, the available quota for an item is calculated for a calendar year. The
quota defined in the Units after launch field applies to the end of the calendar year
following the launch phase.

Your administrator can use the Date-based quota configuration entry
(Sample category) to define that the quota applies for a full year after the
last launch end date defined for the item, instead of until the end of the
calendar year, >> CRM.core Administrator Guide.

If you are using date-based quotas, the quota is calculated per item based on the
End of Period entered in the sample code record. This is the latest Launch end
date + 1 year.

The available quota is calculated based on the currently valid record in the Sam-
ples/Year info area (i.e. End of Period > date the sample was issued). If no such
record exists, it is added automatically. The number of samples issued is calculated
when adding the new record.

Overview
Aurea CRM allows you to display an overview of the samples issued to a customer
during and after the launch phase, as well as an overview of any samples that still
need to be sent.

Samples/Year
The Samples/Year info area provides you with an overview of the samples issued
to a customer during and after the launch phase.

• Select  (Sales) > Search Samples/Year.

The current number of samples issued per person, item and sample period is dis-
played:

When issuing samples, Aurea CRM calculates the available quota based on the
number of samples that have been issued or still need to be sent, >> on page 224.
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Samples

Select  (Sales) > Samples and click on search to list all samples that have
been issued or that still need to be sent. Use the context menu to switch to the
company, person or activity that a sample belongs to.
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17
Special Offers

Special Offers
Learn how to add offers and discounts and manage them.

Use special offers to:

• Define volume scales and discounts for customer groups or customers that are
applied when adding offers or orders.

• Add special offer items, which can be displayed exclusively in the quick add area.

• Define fixed prices and discounts for various volumes for special offer items (for
items, sectors, product groups, brands, grades).

• Define discount scales for freely definable item groups.

• Link special offers to activities and associated work orders.

Adding Special Offers

Special offers are not company-specific.

To ad a special offer:

1. Select  (Marketing) > New Special Offer.
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2. Enter the Special Offer No., Special Offer Name, and the time period the special
offer is valid (Starts on and Ends on fields).

3. Enter data such as the Currency, Customer Group etc.

4. Enter additional data on the various tabs, such as the volume scales (Order Value
1-5) and the discount applied to orders based on the value of the order (Cash
cond. 1-5) fields. You can also enter details on the related marketing activity.

Discount Scale

Special offers include condition fields (Cash cond. 1-5 fields) that are linked to a
value entered in an offer/order (Cash Cond. field). These fields allow you to deter-
mine the maximum discount based on the value of the order. These fields are only
taken into account if the Additional items field is disabled.

If the special offer number is entered in an order or offer, the appropriate discounts
are applied; in the case of the example above:

Maximum Value in the Cash Cond. (Special Offer) fieldOffer/Order Val-
ue

5.00%1 – 250 euro

6.00%251 – 400 euro

12.00%401 – 500 euro

The last volume bracket is also used if the value in the order exceeds the maximum
value entered. If you only define three values, as in this example, the last discount
also applies to orders over 500 euro.

A message is displayed in Aurea CRM win if you enter a value in the Cash. Cond
(Special Offer) field that exceeds the maximum discount. This message is for infor-
mation only and the order/offer can still be saved.
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Special Offer Items

You can add special offer items to special offers. These items are then available in
the quick add area.

To add a special offer item:

1. The following options are available:

• Switch to the desired special offer and select New > New Special Offer Item
from the context menu.

• Switch to the special offer you want to add the special offer item to, switch to
the Special Offer Items tab and click on  (New).

2. Select an item from the Item No. field.

The Item Name, Sector, Product Group, Brand and Grade and entered automat-
ically.

3. Enter additional data such as the Quantity, Price etc.

Note: Note: The Order, POS Monitoring, Refunding, Promotional Material
and Sample fields determine whether a link to the corresponding info area should
be established when linking the special offer with an activity.

Note: Note: If you want to add a special offer item for all items in the "Nutrition"
sector, only enter the Sector and leave the other fields empty. A combination of
criteria (e.g. all items in the "noodles" product group in the sector "own products")
is not possible.All items in this sector are displayed in the quick add area (Special
Offer filter).You can also group special offer items in the Item Group info area.

Special Offer Bulk Volumes

Select Special Offer Bulk Volumes from a special offer item's context menu to
define bulk volumes for individual special offer items in order to determine fixed
prices, bulk discounts and discounts in kind depending on the quantity of an item
entered in an offer or order item record.

You can also define discount scales applied at the offer or order level for special
offer items added for a product group or sector.

These volume scales are defined in the same way as conditions.

Special offer bulk volumes are taken into account prior to all conditions and price
lists when pricing items and applying discounts.

Item Group Discounts

You can define groups for special offer items in the Item Group info area (not
available in the default version of Aurea CRM web).

The child Volume info area allows you to define quantity scales for these item groups
in order to define price discounts or discounts in kind.
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Enter the quantity the discount applies to in the Quantity from/to fields for bulk
discounts or a value range in the Value from/to fields for discounts based on the
value. Enter the Discount and/or Discount vol. in kind.

Enter a Currency for the values (the values are automatically converted to the
currency entered in the offer/order when adding an offer/order).

Once you have added the item group, assign an item to it. To do so, switch to the
Special Offer Item info area and enter the desired group in the Item Group field
of those items you wish to group. If you are using discounts in kind, you also need
to enter the percentage of the (group’s) discount in kind to apply to the item in the
Discount in kind share field.

Discounts are applied when entering offers/orders once the quantity or value of all
items surpasses the threshold defined in the volume record. This means that, irre-
spective of which items in the group are actually added to the offer/order, the discount
is applied to all items (in the group). Each time items are added, the item discounts
are recalculated.

Special Offer Management

Use Aurea CRM’s special offer management features to assign special offers to
target groups and access special offer items automatically in the quick add area.

Associating Special Offers with Marketing Activities

Special offers can be associated with existing marketing activities and to the related
work orders generated within the scope of the marketing activity. The following fields
are transferred from the marketing activity to the special offer:

• AK_StaNo and AK_SerNo (station number and serial number of the marketing
activity)

• Marketing Activity, Level and Variant (Marketing Act.)

• VR_StaNo and VR_SerNo (station and serial number of the sales cycle).

A link to the special offer is established via a work order record and is only estab-
lished when adding items using the quick add function, >> on page 104. The following
diagram depicts this link:
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This association with the marketing activity and work order allows multiple special
offers and consequently specific products to be assigned to a company or person.
The rep assigned to a company/person receives an overview of the planned marketing
activity steps, carries out these steps and then enters the feedback in the Work
Order info area (Response 1 (Marketing Act.) - Response 5 (Marketing Act.)
fields). For example, if the marketing activity involved entering details on a POS,
the rep can access the items for which a special offer exists in the quick add area
(Special Offer filter). The time period entered in the work order and special offer
are taken into account.

Note: Note: The Special Offer filter is not available by default for promotional
material and refunding records in Aurea CRM web, see SerialEntry in the Aurea
CRM web Administrator Guide.

Special Offer Management: Workflow

To use the special offer management features:

1. Add a marketing activity.

2. Add work orders for companies/persons, either:

• for target groups by executing a marketing activity.

• manually by selecting Go to All Related > All Work Orders from the menu
and clicking on  (New)

Note: Note: If you add a work order manually, enter the marketing activity (in
the Marketing Activity and -> Marketing Activity fields).
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3. The following fields are transferred to the Work Order info area from the
Execution (Marketing Activity) info area: Work Order Start, Word Order End,
Work orders for group, Work order type, Work order format, Mandatory work
order.

4. Add a special offer and assign a marketing activity to it (-> Marketing Activity
field). The AK_StaNo and AK_SerNo (station number and serial number of the
marketing activity), Marketing Activity, Level and Variant (Marketing Act.) are
entered automatically. The station number and serial number of the sales cycle
(VR_StaNo and VR_SerNo are also transferred.

Note: Note: The Additional items check box must be enabled in the special
offer.

5. Enter the time period the special offer is valid (Starts on and Ends on) in the
special offer.

6. Add the special offer items. Determine in which info areas the item should be
available using the quick add function.

7. For example, if you add a new order for a company that a work order has been
added for, the items currently on special offer are listed in the quick add area
(Special Offer filter).

Special Offer Management: Usage

If you access the quick add function for a company or person, the system searches
for a applicable special offer items as follows:

• The system checks for valid work orders for the following date:

• Offer info area: Date in the offer record

• Order info area: Date in the order record

• Refunding info area: Date in the refunding record

• Promotional Material info area: current date

• POS Monitoring info area: Date in the POS monitoring record

• Sample info area: Date entered in the quick add area

• The marketing activities entered in the work orders are determined.

• All special offers linked to the marketing activities are searched for, and the period
for which the special offer is valid is compared to the date determined previously.

• The items for which a special offer is currently valid are listed in the quick add
area (Special Offer filter).

• The same item may be listed more than once if it is entered in more than one
special offer.

• The key fields in the special offer are copied to the special offer items. The Price
and Quantity fields in the special offer item used to create the offer/order item
can thus be displayed.

Example
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An field rep has an activity with a person entered in his calendar. The person is par t
of the target group for a defined marketing activity that is currently ongoing. The
work order added for the rep informs the rep that samples should be issued; the rep
opens the quick add area for samples. The rep clicks on the Special Offer button
in the quick add area to display an overview of the samples that are currently on
special offer and are relevant to this customer.

Adding Special Offers
Special offers are not company-specific.

To ad a special offer:

1. Select  (Marketing) > New Special Offer.

2. Enter the Special Offer No., Special Offer Name, and the time period the special
offer is valid (Starts on and Ends on fields), >> on page 229.

3. Enter data such as the Currency, Customer Group etc.

4. Enter additional data on the various tabs, such as the volume scales (Order Value
1-5) and the discount applied to orders based on the value of the order (Cash
cond. 1-5) fields, >> on page 228. You can also enter details on the related
marketing activity, >> on page 266.
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Discount Scale
Special offers include condition fields (Cash cond. 1-5 fields) that are linked to a
value entered in an offer/order (Cash Cond. field). These fields allow you to deter-
mine the maximum discount based on the value of the order. These fields are only
taken into account if the Additional items field is disabled.

If the special offer number is entered in an order or offer, the appropriate discounts
are applied; in the case of the example above (>> on page 227):

Maximum Value in the Cash Cond. (Special Offer) fieldOffer/Order Val-
ue

5.00%1 – 250 euro

6.00%251 – 400 euro

12.00%401 – 500 euro

The last volume bracket is also used if the value in the order exceeds the maximum
value entered. If you only define three values, as in this example, the last discount
also applies to orders over 500 euro.

A message is displayed in Aurea CRM win if you enter a value in the Cash. Cond
(Special Offer) field that exceeds the maximum discount. This message is for infor-
mation only and the order/offer can still be saved.

Special Offer Items
You can add special offer items to special offers. These items are then available in
the quick add area, >> on page 104.

To add a special offer item:

1. The following options are available:

• Switch to the desired special offer and select New > New Special Offer Item
from the context menu.

• Switch to the special offer you want to add the special offer item to, switch to
the Special Offer Items tab and click on  (New).

2. Select an item from the Item No. field.
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The Item Name, Sector, Product Group, Brand and Grade and entered automat-
ically.

3. Enter additional data such as the Quantity, Price etc.

Note: Note: The Order, POS Monitoring, Refunding, Promotional Material
and Sample fields determine whether a link to the corresponding info area should
be established when linking the special offer with an activity, >> on page 229.

Note: Note: If you want to add a special offer item for all items in the "Nutrition"
sector, only enter the Sector and leave the other fields empty. A combination of
criteria (e.g. all items in the "noodles" product group in the sector "own products")
is not possible.All items in this sector are displayed in the quick add area (Special
Offer filter).You can also group special offer items in the Item Group info area, >>
on page 229.

Special Offer Bulk Volumes
Select Special Offer Bulk Volumes from a special offer item's context menu to
define bulk volumes for individual special offer items in order to determine fixed
prices, bulk discounts and discounts in kind depending on the quantity of an item
entered in an offer or order item record.

You can also define discount scales applied at the offer or order level for special
offer items added for a product group or sector.

These volume scales are defined in the same way as conditions, >> on page 235.

Special offer bulk volumes are taken into account prior to all conditions and price
lists when pricing items and applying discounts.

Item Group Discounts
You can define groups for special offer items in the Item Group info area (not
available in the default version of Aurea CRM web).

The child Volume info area allows you to define quantity scales for these item groups
in order to define price discounts or discounts in kind.

Enter the quantity the discount applies to in the Quantity from/to fields for bulk
discounts or a value range in the Value from/to fields for discounts based on the
value. Enter the Discount and/or Discount vol. in kind.
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Enter a Currency for the values (the values are automatically converted to the
currency entered in the offer/order when adding an offer/order).

Once you have added the item group, assign an item to it. To do so, switch to the
Special Offer Item info area and enter the desired group in the Item Group field
of those items you wish to group. If you are using discounts in kind, you also need
to enter the percentage of the (group’s) discount in kind to apply to the item in the
Discount in kind share field.

Discounts are applied when entering offers/orders once the quantity or value of all
items surpasses the threshold defined in the volume record. This means that, irre-
spective of which items in the group are actually added to the offer/order, the discount
is applied to all items (in the group). Each time items are added, the item discounts
are recalculated, >> on page 199.

Special Offer Management
Use Aurea CRM’s special offer management features to assign special offers to
target groups and access special offer items automatically in the quick add area.

Associating Special Offers with Marketing Activities

Special offers can be associated with existing marketing activities and to the related
work orders generated within the scope of the marketing activity. The following fields
are transferred from the marketing activity to the special offer:

• AK_StaNo and AK_SerNo (station number and serial number of the marketing
activity)

• Marketing Activity, Level and Variant (Marketing Act.)

• VR_StaNo and VR_SerNo (station and serial number of the sales cycle), >> on
page 239.

A link to the special offer is established via a work order record and is only estab-
lished when adding items using the quick add function, >> on page 104. The following
diagram depicts this link:
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This association with the marketing activity and work order allows multiple special
offers and consequently specific products to be assigned to a company or person.
The rep assigned to a company/person receives an overview of the planned marketing
activity steps, carries out these steps and then enters the feedback in the Work
Order info area (Response 1 (Marketing Act.) - Response 5 (Marketing Act.)
fields). For example, if the marketing activity involved entering details on a POS,
the rep can access the items for which a special offer exists in the quick add area
(Special Offer filter). The time period entered in the work order and special offer
are taken into account.

Note: Note: The Special Offer filter is not available by default for promotional
material and refunding records in Aurea CRM web, >> SerialEntry in the Aurea CRM
web Administrator Guide.

Special Offer Management: Workflow
To use the special offer management features:

1. Add a marketing activity, >> on page 266.

2. Add work orders for companies/persons, either:

• for target groups by executing a marketing activity, >> on page 277.

• manually by selecting Go to All Related > All Work Orders from the menu
and clicking on  (New)
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Note: Note: If you add a work order manually, enter the marketing activity (in
the Marketing Activity and -> Marketing Activity fields).

3. The following fields are transferred to the Work Order info area from the
Execution (Marketing Activity) info area: Work Order Start, Word Order End,
Work orders for group, Work order type, Work order format, Mandatory work
order.

4. Add a special offer and assign a marketing activity to it (-> Marketing Activity
field). The AK_StaNo and AK_SerNo (station number and serial number of the
marketing activity), Marketing Activity, Level and Variant (Marketing Act.) are
entered automatically. The station number and serial number of the sales cycle
(VR_StaNo and VR_SerNo are also transferred.

Note: Note: The Additional items check box must be enabled in the special
offer.

5. Enter the time period the special offer is valid (Starts on and Ends on) in the
special offer, >> on page 227.

6. Add the special offer items. Determine in which info areas the item should be
available using the quick add function, >> on page 228.

7. For example, if you add a new order for a company that a work order has been
added for, the items currently on special offer are listed in the quick add area
(Special Offer filter), >> on page 231.

Special Offer Management: Usage
If you access the quick add function for a company or person, the system searches
for a applicable special offer items as follows:

• The system checks for valid work orders for the following date:

• Offer info area: Date in the offer record

• Order info area: Date in the order record

• Refunding info area: Date in the refunding record

• Promotional Material info area: current date

• POS Monitoring info area: Date in the POS monitoring record

• Sample info area: Date entered in the quick add area

• The marketing activities entered in the work orders are determined.

• All special offers linked to the marketing activities are searched for, and the period
for which the special offer is valid is compared to the date determined previously.
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• The items for which a special offer is currently valid are listed in the quick add
area (Special Offer filter).

• The same item may be listed more than once if it is entered in more than one
special offer.

• The key fields in the special offer are copied to the special offer items. The Price
and Quantity fields in the special offer item used to create the offer/order item
can thus be displayed.

Example
An field rep has an activity with a person entered in his calendar. The person is par t
of the target group for a defined marketing activity that is currently ongoing. The
work order added for the rep informs the rep that samples should be issued; the rep
opens the quick add area for samples. The rep clicks on the Special Offer button
in the quick add area to display an overview of the samples that are currently on
special offer and are relevant to this customer.
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18
Conditions

Conditions
Learn how to enter conditions for individual companies or company groups, which
are automatically used to price items in offers and orders.

Different price lists allow you to define a flexible price structure:

• You can define conditions with fixed prices for individual items, bulk discounts at
the offer/order level and bulk discounts an/or discounts in kind at the item level.

• Conditions can either apply to an individual item, all items or the items in a product
group, sector, brand or grade.

• For each discount entered in a condition, you can define whether an additional
discount can be granted or whether the discount in the condition only applies if
no manual discount has been defined.

• You can define volumes for conditions.

• You can determine the maximum extent of conditions for special offers.

In order for conditions to be automatically applied to the pricing of items, the following
must apply:

• Reps need to be assigned to business areas.

• Valid weightings need to be defined per item and business area.

• Valid prices must be available for the items.

Conditions for individual companies are defined in the Company Conditions info
area; all other conditions are defined in the Conditions info area.

For information on the order in which conditions are applied when adding offers and
orders, see Offers and Orders on page 467.

Defining Conditions

To define conditions:

1. Select  (Sales) > Conditions.

2. Start the search.

3. Click on  (New).
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4. Enter the desired Currency.

5. Define the time period the conditions are valid for in the Valid from and Valid to
fields.

6. Select a Customer Group if you want the conditions to only apply to offers/orders
added for companies assigned to a par ticular customer group.

7. Enter details on the items the conditions should apply to on the Product tab.

• Item No./Item name: Enter an item to apply the conditions to a par ticular item.

Note: Note: Fixed price conditions can only be defined for individual items. If
you select an item from the Item No. field, leave the Sector, Product Group,
Brand and Grade fields empty in order for the conditions to be applied.

• Sector/Product Group/Brand/Grade: Select a sector, product group, brand
or grade to define conditions for all items where these values are entered. For
example, if you want to define conditions that apply to all items in a product
group, enter a Product Group and leave the Sector, Brand, Grade and Item
No. fields empty.

8. Enter the conditions:

• Enter a Fixed price to define a fixed price for an item.

• Enter a Discount (percentage) to define a discount at the offer/order level.
This discount is applied to the weighted quantity of all offer and order items
that the conditions apply to.

• Enter a Bulk discount (%) to define a discount at the offer/order item level.
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Note: Note: Discounts at the offer/order level overwrite discounts at the item
level.

• Enter a Discount vol. in kind to define the quantity of items granted as a
discount in kind.

9. Select what the conditions apply to in the Conditions apply to field:

• Item: Additional: The discount is applied in addition to the other discounts.
The discount entered manually in offer or order items is applied first, and then
the additional discount from the conditions is calculated.

• Item: if nothing entered: The discount is only applied if no other discount is
entered in the offer/order item.

• Item: Not Included: This discount takes precedence over a discount entered
manually in an offer or order item; if a discount has been entered there, it is
ignored.

Note: Note: This setting has no effect on fixed price conditions.

When determining the value of items, the fixed price is first taken into account fol-
lowed by bulk discounts or discounts in kind, see Pricing and Discounts on page
484.

Defining Company Conditions

To define conditions for a specific company:

1. Switch to the desired company.

2. Select Go to All Related > All Comp. Conditions from the context menu.

3. Click on  (New).

560AUREA CONFIDENTIAL

Chapter 18: Conditions



4. Company conditions must be defined for individual business areas: Select the
desired business area in the Business Area field.

5. Enter the additional data as for general conditions.

Company conditions are applied before general conditions.

Volume Scales

You can define bulk volumes in conditions.

• To define fixed prices, quantities and discounts in kind based on the quantity of
an item entered in an offer or order.

• To apply discounts based on the weighted volume of the entire offer/order.

Bulk volumes (not available by default in Aurea CRM web) are defined for conditions
(or special offers, see Special Offers on page 545); i.e. these volumes also apply to
a business area, all or some items for a company or a company group.

Fixed Price Volumes

You can define fixed prices for a cer tain conditions or company conditions record
in the Condition Scale and Company Condition Scale info areas (these info areas
are not available in the default version of Aurea CRM web).

To define volume-based fixed prices for individual items:

1. Select "Fixed price scale" in the Volume Type field.

2. Enter the Volume From and Volume Up To to define the quantity range.

3. Select "Order Item" in the Comp. value field.

Note: Note:These volumes also apply to offer items.

4. Enter a Fixed price.

5. Define additional volumes.

When adding offers and orders, the fixed price defined for the appropriate volume
(based on the quantity entered) is used.

Discount Scales at the Order/Offer Level

You can define fixed prices for a cer tain conditions or company conditions record
in the Condition Scale and Company Condition Scale info areas.

To define discounts for the weighted total quantity of all items added to an offer/order:

1. Select "Scale of discount (weighted total quantity)" in the Volume Type field.

2. Enter the Volume From and Volume Up To to define the quantity range.

3. Select "Total Order" in the Comp. value field.

Note: Note: The scale also applied to offers.

4. Enter a Discount (a percentage).

5. Define additional volumes.
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When adding offers and orders, the corresponding discount defined for the appro-
priate volume (based on the weighted total quantity entered in the Weighted total
quantity in the order or offer) is used.

Note: Note: In order for the discount defined in the condition scale record to be
applied, the Bulk discount (%) field in the conditions record must be empty.

Discount Scales at the Item Level

You can define fixed prices for a cer tain conditions or company conditions record
in the Condition Scale and Company Condition Scale info areas.

To define bulk discounts and/or discounts in kind at the item level:

1. Select "Scale of discount" in the Volume Type field.

2. Enter the Volume From and Volume Up To to define the quantity range.

3. Select "Order Item" in the Comp. value field.

Note: These volumes also apply to offer items.

4. Enter the discount in kind in the Discount vol. in kind field and/or a bulk discount
in the Discount field.

Note: You can combined bulk discounts and discounts in kind. However the
volume ranges must be the same.

5. Define additional volumes.

When adding offers and orders, the discount defined for the appropriate volume
(based on the quantity entered) is used.

Note:  In order for the discount defined in the condition scale record to be applied,
the Discount field in the conditions record must be empty.

The condition scale applied to the offer or order item is entered in the Scale of
discount field. Your administrator can also add this field to the quick add area, see
Serial Input Tab (OTC) in the CRM.core Administrator Guide.

If you select a different discount scale in the Scale of discount field, the lower
threshold of the scale is entered in the Quantity field and the corresponding dis-
counts are entered in the Discount % (Condition) and Discount vol. in kind fields.
Your administrator can disable this behavior using the Do not apply scale of dis-
count configuration entry (General Settings category), >> CRM.core Administrator
Guide.

Volume scales in company conditions are not taken into consideration when Bulk
Discount (%)  or Discount vol. in kind are empty. To change this behavior, the
administrator can enable the Disable check for mandatory fields in company condi-
tions in CRM.core Administrator Guide.

Corresponding offer and order items can be created automatically using triggers
(see CRM.core Administrator Guide) for the units granted as a discount in kind.
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Defining Conditions
To define conditions:

1. Select  (Sales) > Conditions.

2. Start the search.

3. Click on  (New).

4. Enter the desired Currency.

5. Define the time period the conditions are valid for in the Valid from and Valid to
fields.

6. Select a Customer Group if you want the conditions to only apply to offers/orders
added for companies assigned to a par ticular customer group.

7. Enter details on the items the conditions should apply to on the Product tab.

• Item No./Item name: Enter an item to apply the conditions to a par ticular item.

Note: Note: Fixed price conditions can only be defined for individual items.If
you select an item from the Item No. field, leave the Sector, Product Group,
Brand and Grade fields empty in order for the conditions to be applied.

• Sector/Product Group/Brand/Grade: Select a sector, product group, brand
or grade to define conditions for all items where these values are entered. For
example, if you want to define conditions that apply to all items in a product
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group, enter a Product Group and leave the Sector, Brand, Grade and Item
No. fields empty.

8. Enter the conditions:

• Enter a Fixed price to define a fixed price for an item.

• Enter a Discount (percentage) to define a discount at the offer/order level.
This discount is applied to the weighted quantity of all offer and order items
that the conditions apply to.

• Enter a Bulk discount (%) to define a discount at the offer/order item level.

Note: Note: Discounts at the offer/order level overwrite discounts at the item
level.

• Enter a Discount vol. in kind to define the quantity of items granted as a
discount in kind.

9. Select what the conditions apply to in the Conditions apply to field:

• Item: Additional: The discount is applied in addition to the other discounts.
The discount entered manually in offer or order items is applied first, and then
the additional discount from the conditions is calculated.

• Item: if nothing entered: The discount is only applied if no other discount is
entered in the offer/order item.

• Item: Not Included: This discount takes precedence over a discount entered
manually in an offer or order item; if a discount has been entered there, it is
ignored.

Note: Note: This setting has no effect on fixed price conditions.

When determining the value of items, the fixed price is first taken into account fol-
lowed by bulk discounts or discounts in kind, >> on page 199.

Defining Company Conditions
To define conditions for a specific company:

1. Switch to the desired company.

2. Select Go to All Related > All Comp. Conditions from the context menu.

3. Click on  (New).
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4. Company conditions must be defined for individual business areas: Select the
desired business area in the Business Area field.

5. Enter the additional data as for general conditions, >> on page 233.

Company conditions are applied before general conditions, >> on page 199.

Volume Scales
You can define bulk volumes in conditions.

• To define fixed prices, quantities and discounts in kind based on the quantity of
an item entered in an offer or order, >> on page 235 and on page 235.

• To apply discounts based on the weighted volume of the entire offer/order, >> on
page 235.

Bulk volumes (not available by default in Aurea CRM web) are defined for conditions
(or special offers, >> on page 228 and on page 229); i.e. these volumes also apply
to a business area, all or some items for a company or a company group.

Fixed Price Volumes
You can define fixed prices for a cer tain conditions or company conditions record
in the Condition Scale and Company Condition Scale info areas (these info areas
are not available in the default version of Aurea CRM web).

To define volume-based fixed prices for individual items:

1. Select "Fixed price scale" in the Volume Type field.

2. Enter the Volume From and Volume Up To to define the quantity range.

565AUREA CONFIDENTIAL

Volume Scales



3. Select "Order Item" in the Comp. value field.

Note: Note:These volumes also apply to offer items.

4. Enter a Fixed price.

5. Define additional volumes.

When adding offers and orders, the fixed price defined for the appropriate volume
(based on the quantity entered) is used, >> on page 193 and on page 200.

Discount Scales at the Order/Offer Level
You can define fixed prices for a cer tain conditions or company conditions record
in the Condition Scale and Company Condition Scale info areas.

To define discounts for the weighted total quantity of all items added to an offer/order
(>> on page 178):

1. Select "Scale of discount (weighted total quantity)" in the Volume Type field.

2. Enter the Volume From and Volume Up To to define the quantity range.

3. Select "Total Order" in the Comp. value field.

Note: Note: The scale also applied to offers.

4. Enter a Discount (a percentage).

5. Define additional volumes.

When adding offers and orders, the corresponding discount defined for the appro-
priate volume (based on the weighted total quantity entered in the Weighted total
quantity in the order or offer) is used, >> on page 193 and on page 203.

Note: Note: In order for the discount defined in the condition scale record to be
applied, the Bulk discount (%) field in the conditions record must be empty.

Discount Scales at the Item Level
You can define fixed prices for a cer tain conditions or company conditions record
in the Condition Scale and Company Condition Scale info areas.

To define bulk discounts and/or discounts in kind at the item level:

1. Select "Scale of discount" in the Volume Type field.

2. Enter the Volume From and Volume Up To to define the quantity range.

3. Select "Order Item" in the Comp. value field.
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Note: These volumes also apply to offer items.

4. Enter the discount in kind in the Discount vol. in kind field and/or a bulk discount
in the Discount field.

Note: You can combined bulk discounts and discounts in kind. However the
volume ranges must be the same.

5. Define additional volumes.

When adding offers and orders, the discount defined for the appropriate volume
(based on the quantity entered) is used, >> on page 193 and on page 201.

Note:  In order for the discount defined in the condition scale record to be applied,
the Discount field in the conditions record must be empty.

The condition scale applied to the offer or order item is entered in the Scale of
discount field. Your administrator can also add this field to the quick add area, >>
Serial Input Tab (OTC) in the CRM.core Administrator Guide.

If you select a different discount scale in the Scale of discount field, the lower
threshold of the scale is entered in the Quantity field and the corresponding dis-
counts are entered in the Discount % (Condition) and Discount vol. in kind fields.
Your administrator can disable this behavior using the Do not apply scale of dis-
count configuration entry (General Settings category), >> CRM.core Administrator
Guide.

Volume scales in company conditions are not taken into consideration when Bulk
Discount (%)  or Discount vol. in kind are empty. To change this behavior, the
administrator can enable the Disable check for mandatory fields in company
conditions under Right module -> Configuration. >> CRM.core Administrator
Guide.

Corresponding offer and order items can be created automatically using triggers
(>> CRM.core Administrator Guide) for the units granted as a discount in kind.
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Sales Management

Sales Management
Learn how to manage sales and support.

You can display an overview of support data for each company and person; i.e. the
number of phone calls, visits and meetings as well as associated costs.

Note:  Aurea CRM win includes the Sales Volume Statistics and Revenue
Statistics info areas, which can be used to import external sales figures.

Support

The Support  info area (not available in Aurea CRM web by default) provides an
overview of the support provided for a person or can automatically be calculated
for the entire company.

Note:  Calculating support data is handled using a CRM.server To-Do, see CRM.core
Administrator Guide.

The following are taken into account:

• Completed visits (activities of the type "Visit" with the status "Completed")

• Completed telephone calls (activities of the type "Telephone" with the status
"Completed")

• Mailings

• The number and cost of orders (only available for orders, as orders are always
company-related)

The support data for a person only takes into account those records added for that
person. The support data for companies applies to the whole company, i.e. all
records that are related to the company and any persons in the company are taken
into account.

The calculation takes place for each year that includes at least one mailing, telephone
call or visit, and corresponding support records are updated or created.
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Support
The Support  info area (not available in Aurea CRM web by default) provides an
overview of the support provided for a person or can automatically be calculated
for the entire company.

Note: Note: Calculating support data is handled using a CRM.server To-Do, >>
CRM.core Administrator Guide.

The following are taken into account:

• Completed visits (activities of the type "Visit" with the status "Completed")

• Completed telephone calls (activities of the type "Telephone" with the status
"Completed")

• Mailings

• The number and cost of orders (only available for orders, as orders are always
company-related)

The support data for a person only takes into account those records added for that
person. The support data for companies applies to the whole company, i.e. all
records that are related to the company and any persons in the company are taken
into account.

The calculation takes place for each year that includes at least one mailing, telephone
call or visit, and corresponding support records are updated or created.
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Sales Cycles

Sales Cycles
Learn about sales cycle and its phases.

A sales cycle defines a time period during which a specific item (e.g. asparagus in
spring, products relating to seasonal holidays) is sold or during which specific targets
should be achieved. A sales cycle can consist of several phases. For example, a
rep may first prepare outlets for the sale of an item, then the item is promoted during
the marketing phase before the item is put on display and made available for sale
in the final phase.

When adding a sales cycle, you can define work orders assigned to reps, special
offers that apply to items, promotional material to be used etc. Sales cycles can
overlap.

Select (Marketing) > Sales Cycle to add a sales cycle.

Marketing activities can be assigned to a sales cycle. Each marketing activity includes
the target group for a specific activity in the sales cycle (e.g. sending promotional
material). Special offers including items (and possible conditions) that are relevant
to the sales cycle can be linked to each marketing activity. Items are defined in the
item master info area, and can then be added as special offer items. The quick add
flags (e.g. Order, Refunding) need to be enabled in the item master.

A campaign can consist of several marketing activities, and thus may include multiple
sales cycles. Individual marketing activities in a campaign can target different audi-
ences at different times, but still be related to the same sales cycle. Work orders
generated within the scope of a sales cycle are assigned to marketing activities.

Sales cycles can be linked to other records (activities, refunding etc.) via marketing
activities, special offers or when adding new records based on the date and business
area entered.

• If a marketing activity is assigned to a sales cycle, and linked to a special offer,
activity or work order, the sales cycle entered in the marketing activity is entered
in the linked record.
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Note: The sales cycle’s duration is transferred to special offers, but can be
edited. If a special offer is added to a sales cycle and linked to a marketing activity,
the sales cycle entered in the marketing activity is entered in the special offer.

• If promotional material, a sample, refunding item, listing, POS monitoring item or
order/offer item is linked to a special offer, the sales cycle entered in the special
offer is transferred to the linked record.

Note:  If the link to the marketing activity or special offer is changed, the sales cycle
entered in the linked records is overwritten (or deleted if the newly linked marketing
activity or special offer is not linked to a sales cycle). If the sales cycle in the
marketing activity or special offer is changed, this change is not applied to linked
records.

• POS monitoring items, offer/order items, refunding items, promotional material,
samples, activities and work orders are assigned to a sales cycles based on their
date and business area. The business area is determined based on the business
area assigned to the rep entered in the record (and defined in the Rep Additional
Info info area).

The following table lists the date and rep fields that are used to determine the
applicable sales cycle:

RepDate

Rep ID (PS:5)Date (PS:4)

Rep ID (AU:8)Date (AU:6)

Rep ID (PR:9)Date (PR:7)

Rep ID (VG:8)Date (VG:6)

Rep ID (4)Contract Star t (20)

Rep ID (5)Date (4)

Rep ID (15)Star ts on (0)

Processed by ID (13)Star ts on (8)

571AUREA CONFIDENTIAL

Sales Cycles



21
Expenses and Receipts

Expenses and Receipts
Learn how to add expenses and receipts for reps.

You can use the Expenses info area to store the duration and costs of business
trips. You can add any number of receipts to an expense record. The sum total of
the costs entered in the receipts is calculated and entered in the Total Amount
field in the Expenses info area.

Expenses

To add a new expense record:

1. Select  (Collaboration) > New Expenses.

2. Enter the Currency.

3. Enter additional data such as:

• The Dep. Date (departure date) and Arrival Date: The total duration (in days)
is automatically calculated and entered in the Travel duration field.

• Information on travel by car: The costs (Mileage Allowance field) are calculated
automatically.

• Daily rates and accommodation rates: The sum total of the rates is automatically
calculated (Total Flat Rates field).

Note:  Enter total amounts for flat rates, not the flat rate per day.

Receipts

To add a receipt to an expense record:

1. Switch to the desired expense record.

2. Select New Receipt from the context menu.

3. Enter the data.

4. Save the record.
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Expenses
To add a new expense record:

1. Select  (Collaboration) > New Expenses.

2. Enter the Currency.

3. Enter additional data such as:

• The Dep. Date (departure date) and Arrival Date: The total duration (in days)
is automatically calculated and entered in the Travel duration field.

• Information on travel by car: The costs (Mileage Allowance field) are calculated
automatically.

• Daily rates and accommodation rates: The sum total of the rates is automatically
calculated (Total Flat Rates field).

Note: Note: Enter total amounts for flat rates, not the flat rate per day.

4. Save.

You can add receipts to expense records, >> on page 241.

The sum total of the costs entered in the receipts is calculated and entered in the
Total Amount field in the Expenses info area. The mileage costs are added to this
amount and entered in the Receipts Total field.

Receipts
To add a receipt to an expense record:

1. Switch to the desired expense record.

2. Select New Receipt from the context menu.

3. Enter the data.

4. Save the record.
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Account Managers

Accounts Managers - OTC only
Learn how to assign field reps and account managers to companies.

Note: This topic is relevant only for Business Logic - OTC

You can:

• Assign reps based on a company’s address or a person's private address.

• Partition your sales activities for companies according to sectors and product
groups.

• Enter reps in various roles.

• Automatically assign account managers to companies and persons.

Adding Account Managers

You manually or automatically add account managers in the Account Manager info
area.

To add an account manager manually, switch to the desired company and select
Go to All Related > All Account Managers from the context menu. Star t the search
and click on  (New).

The Manual field is automatically enabled for records that are added manually. If
an account manager record is added automatically, the Manual field is enabled
automatically if the record is subsequently edited. The route and support fields are
an exception; these fields can be edited without the Manual field being enabled.

Allocating Account Managers

As a rule, account managers are allocated based on a customer’s address. Reps
are assigned to geographical areas in the City info area and for postal code ranges.

You can also use the From Block No. and To Block No. fields in the Allocation info
area. Several records can be added and different account managers allocated for
identical postcodes but different block numbers. The Block No. entered in the
company or person record is compared to the block range entered here. If a block
number is entered, the postal code is ignored, even if no matching allocation record
is found for the block number.

When entering a postal code, access is required to the City info area in order to
access the data there. For fur ther details, see City info area in CRM.core Adminis-
trator Guide.
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When adding (or editing) company records, the system checks whether reps have
been entered in the appropriate record in the City and Allocation info areas. If a
Rep and/or Office Rep are entered in the City info area, they are entered in the
Rep ID and Office Rep ID fields in the company. If matching entries are found in
both the City and Allocation info areas, the data in the Allocation info area is used.

Your administrator can prevent reps from being transferred from the City info areas
by using the Disconnect Fields from City Table (City Table category) and Disconnect
Fields from Country Table (Country Table category) in the Configuration info area
in CRM.core Administrator Guide.

If account managers should not be allocated automatically, access can be denied
to the Allocation and Business Line info areas using the Deny Access option in the
Rights module in CRM.core Administrator Guide.

If you manually add a company of account manager record, account managers are
transferred from the Allocation info area as follows:

• Transferred to company records:

If the Product Group, Sector and Business Area fields are empty.

If you add a new company, the system searches for an account manager in the
Allocation info area allocated to the company's address. The account manager
is automatically entered in the Rep field in the company record.

• Transferred to account manager records (of a FI/KP):

If at least one of the Product Group, Sector and Business Area fields contains
data (when adding account managers manually).

If you manually add an account manager for a company and enter a Product
Group, Sector and/or Business Area in the account manager record, the corre-
sponding account manager (in the appropriate Country) is transferred automati-
cally from the Allocation info area and entered in the Account Manager field.

Note: Note: Reps are re-allocated to customers each time one of these fields is
edited in the Account Manager info area. If conflicting records are present, the
allocation that was first valid based on the fields entered is used.

Account managers can be assigned and updated automatically. To do so, assign
companies and persons to a business area, and assign the business area to an
account manager.

Business Lines

Use the Business Line info area (not available by default in Aurea CRM web) to
allocate companies and persons to a business area. Use the Specialization field
to fur ther limit the business line for persons (e.g. "Practice" company type and
specialization "Sports doctor").

When automatically assigning account managers, Aurea CRM checks for matching
records in the Business Line info area based on the Allocation Code field in the
Person info area. The Allocation code can be entered using a trigger in the Person
info area.

Account managers are assigned to companies instead of persons if only the Business
Area and Co. Type are entered. If you also enter data in the Specialty or Allocation
Code fields, the account manager is allocated to persons (PE/KP).
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Enter a Person type and leave the Co. Type empty to add account managers for
persons (PE).

The following table lists available fields:

Data required to write
to Person in Company

(KP)

Data required to
write to Person (PE)

Data required to
write to Company

(FI)

Business
Line fields

entered or emptyemptyentered or emptyCo. Type

emptyenteredemptyPerson type

optionalentered or emptyemptySpecializa-
tion

optionalemptyemptyAllocation
Code

enteredenteredenteredBusiness
Area

An account managers is
added or updated (pro-
vided the Manual check
box is disabled) for all
persons in company
(KP) where a matching
Co. Type (including
empty), Specialization
or Allocation Code
(one of the fields must
contain data) is entered.
The Business Area is
entered in the account
manager record.

An account managers
is added or updated
(provided the Manual
check box is disabled)
for all persons (PE)
where a matching
Person type and
Specialization are
entered. The Busi-
ness Area is entered
in the account manag-
er record.

An account man-
agers is added or
updated (provided
the Manual check
box is disabled) for
all companies where
a matching Co. Type
is entered (including
empty). The Busi-
ness Area is en-
tered in the account
manager record.

If the Co. Type field is empty, only companies where the Co. Type field is empty
are taken into account.

If you add a person (PE) as a contact person (CP) at a company, account managers
are added as for a person in company (KP) record.

If you change a person in company (KP) record’s specialization, all contact persons
(CP) and person in company (KP) records linked to the corresponding person (PE)
record are updated.

Allocation

Use the Allocation info area (not available in the default version of Aurea CRM
web) to determine which account managers are responsible for a country, business
area, postal code range and block number range.

You can fur ther subdivide block number or postal code ranges. In this case, the
smallest range is used.
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Example: Sam Shine is responsible for the post codes from "75001-75020", but
Warren Teed is responsible for "75010-75013". Consequently, a company with the
post code "75012" is assigned to Warren Teed.

The geographic block number allocations take precedence over postal codes, and
postal codes are ignored if block numbers have been entered for a company/person.

If you enter account managers manually, and want to assign an account manager
in the Allocation info area, you do not need to enter data in all three of the Product
Group, Sector and Business Area fields. Only values that have been entered are
compared.

You can allocate up to 11 reps:

Company/PersonAccount ManagerAllocation

RepAccount ManagerRep 1

District ManagerRep 2

Head of SalesRep 3

Sales ManagerRep 4

Key Account Int.Rep 5

Key Account Nat.Rep 6

Key Account Reg.Rep 7

Key Account TrackRep 8

Office RepOffice RepRep 9

Sales PromoterRep 10

RepRep 11

Allocating Reps

Account managers can be allocated automatically using the settings defined in the
Account Manager info area in several ways:

• By selecting Allocate from the context menu in the Business Line info area in
Aurea CRM win.All companies and persons are then tested.

• By adding new companies and persons

• Whenever a company or person is added or edited (the Co.Type, address and
block fields in a company record, the Spec. 1 to Spec. 5 and Allocation Code
fields in a person record (KP/CP)).
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Note: Note: You can enter multiple company types for a company, and multiple
specializations for a person. As a result, multiple account manager records are
added.

The system checks the following:

• Whether a record exists in the Business Line info area where the Co.Type and/or
Specialization and Allocation Code fields are the same as in the person or
company record.

• Whether a record exists in the Allocation info area for the same country and
where the block number or postal code ranges match the data entered for the
company or person.

• Whether the business area in the allocation record matches the business area in
the business line record.

If all three of the above conditions are met, an account manager record is auto-
matically added using the rep entered in the allocation record for the business area.

If you restructure your sales team, you only need to update the entries in the Allo-
cation and Business Line info areas, and select the Allocate from the context
menu in the Business Line info area in Aurea CRM win to apply the changes to the
account managers allocated to all the affected companies and persons.

You can also add or delete records to change the allocation criteria or add territories.

Note:  Account managers added or edited manually (i.e. the Manual field is enabled)
are not updated. Reps can also be allocated using a To-Do ( type 5), see To-Do
Types in the CRM.core Administrator Guide.

Several account manager records may be added for a company or person, for exam-
ple if several specializations are entered for a person, meaning that reps from various
business areas may be required. If multiple reps are entered in a record in the Allo-
cation info area, they are transferred to the account manager record.

Route Planning

In addition to the support activities, there are two ways to plan routes for activities:

• Using the Ranking field (which determine the order in which activities are
generated automatically).

• Using the Route-No. and RO_INo. fields and the Route info area.

Ranking and route fields are present in the Person, Account Manager and Activity
info areas. When generating activities, you can specify whether you wish to use the
data in the Person or Account Manager info areas.

The following differences exist between the two:
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Persons Assigned to RoutesRep Taken
From

Sort Or-
der

Using selections in Aurea CRM winPerson or Ac-
count Manager

RankingRank-
ing

Choosing the route, or using selection (Aurea
CRM win)

Person or Ac-
count Manager

RO_INo.Routes

Adding Routes

To add a route:

1. Add a new record in the Route info area (  (Collaboration) > Routes).

Routes are uniquely identified by the rep (Rep ID) and the route number (RO_INo.).

2. Enter the Route-No, RO_INo. (route record serial number) and the rep in the
person records. The route serial number determines the order within a route. A
person is assigned to a route using the rep (Rep ID, assuming no account manager
exists) and the route number.

Adding a Person to Multiple Routes

You can only enter a single route in the Person info area. If you want to add a
person to several routes, use the Account Manager info area. You can enter various
routes in separate account manager records for the same person or select the desired
route by double-clicking on the Route-No. field.

Adding Account Managers
You manually or automatically add account managers in the Account Manager info
area.

To add an account manager manually, switch to the desired company and select
Go to All Related > All Account Managers from the context menu. Star t the search
and click on  (New).

The Manual field is automatically enabled for records that are added manually. If
an account manager record is added automatically, the Manual field is enabled
automatically if the record is subsequently edited. The route and support fields are
an exception; these fields can be edited without the Manual field being enabled.

Allocating Account Managers
As a rule, account managers are allocated based on a customer’s address. Reps
are assigned to geographical areas in the City info area and for postal code ranges.
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You can also use the From Block No. and To Block No. fields in the Allocation
info area. Several records can be added and different account managers allocated
for identical postcodes but different block numbers. The Block No. entered in the
company or person record is compared to the block range entered here. If a block
number is entered, the postal code is ignored, even if no matching allocation record
is found for the block number.

When entering a postal code, access is required to the City info area in order to
access the data there. For fur ther details, see City info area in CRM.core Adminis-
trator Guide.

When adding (or editing) company records, the system checks whether reps have
been entered in the appropriate record in the City and Allocation info areas. If a
Rep and/or Office Rep are entered in the City info area, they are entered in the
Rep ID and Office Rep ID fields in the company.If matching entries are found in
both the City and Allocation info areas, the data in the Allocation info area is
used.

Your administrator can prevent reps from being transferred from the City info areas
by using the Disconnect Fields from City Table (City Table category) and Disconnect
Fields from Country Table (Country Table category) in the Configuration info area
in CRM.core Administrator Guide.

If account managers should not be allocated automatically, access can be denied
to the Allocation and Business Line info areas using the Deny Access option in the
Rights module in CRM.core Administrator Guide.

If you manually add a company of account manager record, account managers are
transferred from the Allocation info area as follows:

• Transferred to company records:

If the Product Group, Sector and Business Area fields are empty.

If you add a new company, the system searches for an account manager in the
Allocation info area allocated to the company's address. The account manager
is automatically entered in the Rep field in the company record.

• Transferred to account manager records (of a FI/KP):

If at least one of the Product Group, Sector and Business Area fields contains
data (when adding account managers manually).

If you manually add an account manager for a company and enter a Product
Group, Sector and/or Business Area in the account manager record, the corre-
sponding account manager (in the appropriate Country) is transferred automati-
cally from the Allocation info area and entered in the Account Manager field.

Note: Note: Reps are re-allocated to customers each time one of these fields is
edited in the Account Manager info area. If conflicting records are present, the
allocation that was first valid based on the fields entered is used.
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Account managers can be assigned and updated automatically. To do so, assign
companies and persons to a business area, and assign the business area to an
account manager.

Business Lines

Use the Business Line info area (not available by default in Aurea CRM web) to
allocate companies and persons to a business area. Use the Specialization field
to fur ther limit the business line for persons (e.g. "Practice" company type and
specialization "Sports doctor").

When automatically assigning account managers, Aurea CRM checks for matching
records in the Business Line info area based on the Allocation Code field in the
Person info area. The Allocation code can be entered using a trigger in the Person
info area.

Account managers are assigned to companies instead of persons if only the Business
Area and Co. Type are entered. If you also enter data in the Specialty or Allocation
Code fields, the account manager is allocated to persons (PE/KP).

Enter a Person type and leave the Co. Type empty to add account managers for
persons (PE).

The following table lists available fields:

Data required to write
to Person in Company

(KP)

Data required to
write to Person (PE)

Data required to
write to Company

(FI)

Business
Line fields

entered or emptyemptyentered or emptyCo. Type

emptyenteredemptyPerson type

optionalentered or emptyemptySpecializa-
tion

optionalemptyemptyAllocation
Code
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Data required to write
to Person in Company

(KP)

Data required to
write to Person (PE)

Data required to
write to Company

(FI)

Business
Line fields

enteredenteredenteredBusiness
Area

An account managers is
added or updated (pro-
vided the Manual check
box is disabled) for all
persons in company
(KP) where a matching
Co. Type (including
empty), Specialization
or Allocation Code
(one of the fields must
contain data) is entered.
The Business Area is
entered in the account
manager record.

An account managers
is added or updated
(provided the Manual
check box is disabled)
for all persons (PE)
where a matching
Person type and
Specialization are
entered. The Busi-
ness Area is entered
in the account manag-
er record.

An account man-
agers is added or
updated (provided
the Manual check
box is disabled) for
all companies where
a matching Co. Type
is entered (including
empty). The Busi-
ness Area is en-
tered in the account
manager record.

If the Co. Type field is empty, only companies where the Co. Type field is empty
are taken into account.

If you add a person (PE) as a contact person (CP) at a company, account managers
are added as for a person in company (KP) record.

If you change a person in company (KP) record’s specialization, all contact persons
(CP) and person in company (KP) records linked to the corresponding person (PE)
record are updated.

Allocation

Use the Allocation info area (not available in the default version of Aurea CRM
web) to determine which account managers are responsible for a country, business
area, postal code range and block number range.

You can fur ther subdivide block number or postal code ranges. In this case, the
smallest range is used.

Example: Sam Shine is responsible for the post codes from "75001-75020", but
Warren Teed is responsible for "75010-75013". Consequently, a company with the
post code "75012" is assigned to Warren Teed.

The geographic block number allocations take precedence over postal codes, and
postal codes are ignored if block numbers have been entered for a company/person.
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If you enter account managers manually, and want to assign an account manager
in the Allocation info area, you do not need to enter data in all three of the Product
Group, Sector and Business Area fields. Only values that have been entered are
compared.

You can allocate up to 11 reps:

Company/PersonAccount ManagerAllocation

RepAccount ManagerRep 1

District ManagerRep 2

Head of SalesRep 3

Sales ManagerRep 4

Key Account Int.Rep 5

Key Account Nat.Rep 6

Key Account Reg.Rep 7

Key Account TrackRep 8

Office RepOffice RepRep 9

Sales PromoterRep 10

RepRep 11

Allocating Reps

Account managers can be allocated automatically using the settings defined in the
Account Manager info area in several ways:

• By selecting Allocate from the context menu in the Business Line info area in
Aurea CRM win.All companies and persons are then tested.

• By adding new companies and persons

• Whenever a company or person is added or edited (the Co.Type, address and
block fields in a company record, the Spec. 1 to Spec. 5 and Allocation Code
fields in a person record (KP/CP)).
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Note: Note: You can enter multiple company types for a company, and multiple
specializations for a person. As a result, multiple account manager records are
added.

The system checks the following:

• Whether a record exists in the Business Line info area where the Co.Type and/or
Specialization and Allocation Code fields are the same as in the person or
company record.

• Whether a record exists in the Allocation info area for the same country and
where the block number or postal code ranges match the data entered for the
company or person.

• Whether the business area in the allocation record matches the business area in
the business line record.

If all three of the above conditions are met, an account manager record is auto-
matically added using the rep entered in the allocation record for the business area.

If you restructure your sales team, you only need to update the entries in the Allo-
cation and Business Line info areas, and select the Allocate from the context
menu in the Business Line info area in Aurea CRM win to apply the changes to the
account managers allocated to all the affected companies and persons.

You can also add or delete records to change the allocation criteria or add territories.

Note:  Account managers added or edited manually (i.e. the Manual field is enabled)
are not updated. Reps can also be allocated using a To-Do ( type 5), see To-Do
Types in the CRM.core Administrator Guide.

Several account manager records may be added for a company or person, for exam-
ple if several specializations are entered for a person, meaning that reps from various
business areas may be required. If multiple reps are entered in a record in the Allo-
cation info area, they are transferred to the account manager record.

Note: You can enter visit and telephone frequencies in Aurea CRM win that can
be used to automatically generated activities relating to support tasks over a specific
time period.

Business Lines
Use the Business Line info area (not available by default in Aurea CRM web) to
allocate companies and persons to a business area. Use the Specialization field
to fur ther limit the business line for persons (e.g. "Practice" company type and
specialization "Sports doctor").
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When automatically assigning account managers, Aurea CRM checks for matching
records in the Business Line info area based on the Allocation Code field in the
Person info area. The Allocation code can be entered using a trigger in the Person
info area.

Account managers are assigned to companies instead of persons if only the Business
Area and Co. Type are entered. If you also enter data in the Specialty or Allocation
Code fields, the account manager is allocated to persons (PE/KP).

Enter a Person type and leave the Co. Type empty to add account managers for
persons (PE).

The following table lists available fields:

Data required to write
to Person in Company
(KP)

Data required to
write to Person (PE)

Data required to
write to Company
(FI)

Business
Line fields

entered or emptyemptyentered or emptyCo. Type

emptyenteredemptyPerson type

optionalentered or emptyemptySpecializa-
tion

optionalemptyemptyAllocation
Code

enteredenteredenteredBusiness
Area

An account managers is
added or updated (pro-
vided the Manual check
box is disabled) for all
persons in company
(KP) where a matching
Co. Type (including
empty), Specialization
or Allocation Code
(one of the fields must
contain data) is entered.
The Business Area is
entered in the account
manager record.

An account managers
is added or updated
(provided the Manual
check box is disabled)
for all persons (PE)
where a matching
Person type and
Specialization are
entered. The Busi-
ness Area is entered
in the account manag-
er record.

An account man-
agers is added or
updated (provided
the Manual check
box is disabled) for
all companies where
a matching Co. Type
is entered (including
empty). The Busi-
ness Area is en-
tered in the account
manager record.
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If the Co. Type field is empty, only companies where the Co. Type field is empty
are taken into account.

If you add a person (PE) as a contact person (CP) at a company, account managers
are added as for a person in company (KP) record.

If you change a person in company (KP) record’s specialization, all contact persons
(CP) and person in company (KP) records linked to the corresponding person (PE)
record are updated.

Allocation
Use the Allocation info area (not available in the default version of Aurea CRM
web) to determine which account managers are responsible for a country, business
area, postal code range and block number range.

You can fur ther subdivide block number or postal code ranges. In this case, the
smallest range is used.

Example: Sam Shine is responsible for the post codes from "75001-75020", but
Warren Teed is responsible for "75010-75013". Consequently, a company with the
post code "75012" is assigned to Warren Teed.

The geographic block number allocations take precedence over postal codes, and
postal codes are ignored if block numbers have been entered for a company/person.

If you enter account managers manually, and want to assign an account manager
in the Allocation info area, you do not need to enter data in all three of the Product
Group, Sector and Business Area fields. Only values that have been entered are
compared.

You can allocate up to 11 reps:

Company/PersonAccount ManagerAllocation

RepAccount ManagerRep 1

District ManagerRep 2

Head of SalesRep 3

Sales ManagerRep 4

Key Account Int.Rep 5

Key Account Nat.Rep 6

Key Account Reg.Rep 7
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Key Account TrackRep 8

Office RepOffice RepRep 9

Sales PromoterRep 10

RepRep 11

Allocating Reps
Account managers can be allocated automatically using the settings defined in the
Account Manager info area in several ways:

• By selecting Allocate from the context menu in the Business Line info area in
Aurea CRM win.All companies and persons are then tested.

• By adding new companies and persons

• Whenever a company or person is added or edited (the Co.Type, address and
block fields in a company record, the Spec. 1 to Spec. 5 and Allocation Code
fields in a person record (KP/CP)).

Note: Note: You can enter multiple company types for a company, and multiple
specializations for a person. As a result, multiple account manager records are
added.

The system checks the following:

• Whether a record exists in the Business Line info area where the Co.Type and/or
Specialization and Allocation Code fields are the same as in the person or
company record.

• Whether a record exists in the Allocation info area for the same country and
where the block number or postal code ranges match the data entered for the
company or person.

• Whether the business area in the allocation record matches the business area in
the business line record.

If all three of the above conditions are met, an account manager record is auto-
matically added using the rep entered in the allocation record for the business area.

If you restructure your sales team, you only need to update the entries in the Allo-
cation and Business Line info areas, and select the Allocate from the context
menu in the Business Line info area in Aurea CRM win to apply the changes to the
account managers allocated to all the affected companies and persons.

You can also add or delete records to change the allocation criteria or add territories.
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Note: Note: Account managers added or edited manually (i.e. the Manual field is
enabled) are not updated, >> on page 243.Reps can also be allocated using a To-Do
( type 5), >> To-Do Types in the CRM.core Administrator Guide.

Several account manager records may be added for a company or person, for exam-
ple if several specializations are entered for a person, meaning that reps from various
business areas may be required. If multiple reps are entered in a record in the Allo-
cation info area, they are transferred to the account manager record.

Note: You can enter visit and telephone frequencies in Aurea CRM win
that can be used to automatically generated activities relating to support
tasks over a specific time period, >> Generating Contacts in the update.sev-
en win Business Logic OTC Manual.

Route Planning
In addition to the support activities, there are two ways to plan routes for activities:

• Using the Ranking field (which determine the order in which activities are
generated automatically).

• Using the Route-No. and RO_INo. fields and the Route info area.

Ranking and route fields are present in the Person, Account Manager and Activity
info areas. When generating activities, you can specify whether you wish to use the
data in the Person or Account Manager info areas.

The following differences exist between the two:

Persons Assigned to RoutesRep Taken
From

Sort Or-
der

Using selections in Aurea CRM winPerson or Ac-
count Manager

RankingRank-
ing

Choosing the route, or using selection (Aurea
CRM win)

Person or Ac-
count Manager

RO_INo.Routes

Adding Routes

To add a route:

1. Add a new record in the Route info area (  (Collaboration) > Routes).
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Routes are uniquely identified by the rep (Rep ID) and the route number (RO_INo.).

2. Enter the Route-No, RO_INo. (route record serial number) and the rep in the
person records. The route serial number determines the order within a route. A
person is assigned to a route using the rep (Rep ID, assuming no account manager
exists) and the route number.

Adding a Person to Multiple Routes

You can only enter a single route in the Person info area. If you want to add a
person to several routes, use the Account Manager info area. You can enter various
routes in separate account manager records for the same person or select the desired
route by double-clicking on the Route-No. field.

Adding Routes
To add a route:

1. Add a new record in the Route info area (  (Collaboration) > Routes).

Routes are uniquely identified by the rep (Rep ID) and the route number (RO_INo.).

2. Enter the Route-No, RO_INo. (route record serial number) and the rep in the
person records. The route serial number determines the order within a route. A
person is assigned to a route using the rep (Rep ID, assuming no account manager
exists) and the route number.

Adding a Person to Multiple Routes
You can only enter a single route in the Person info area. If you want to add a
person to several routes, use the Account Manager info area. You can enter various
routes in separate account manager records for the same person or select the desired
route by double-clicking on the Route-No. field.
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23
Inventory Management

Inventory Management Overview
Learn how to manage your items and products using Inventory management. Here
the info areas and functions involved are described without dictating a fixed approach
to inventory management.

Outgoing items can be deducted from stocks in the "central warehouse" (an external
ERP system).

Inventory management in Aurea CRM provides the following functions:

• Each rep can manage company-independent stocks for each item and lot.

• Stock movements are stored in the Stock Control info area (e.g. receiving goods,
returns, losses etc.).

• When adding orders, offers, samples, refunds and promotional material, you
can enter details on how items affect stocks.

• The number of items in reps’ stocks are automatically calculated in the Stock
info area based on the information entered in stock control, order, sample,
refunding and promotional material records, such as which lot an item is taken
from and what quantity.

• You can define various transaction types (e.g. order, return, delivery, loss etc.)
for orders, refunds and stocks control records, which determine how stocks are
affected: For each type, you can determine whether items are added to or removed
from stocks, and whether quantities are specified in units or packaging units.

• You can assign stocks to SAP company codes in the SAP Company Code info
area for use with SAP.

When stocktaking, data that affects stocks (in order, sample, refunding, promo-
tional material or stock control records) is aggregated for reps, stocks, lots and
items. The results are written to the Stock Control info area.

During stock-taking, stock-relevant data in existing orders is taken into account.
If you edit or delete these orders after completing stock-keeping, your changes
no longer affect current stocks.

Note: Your administrator can determine (in Aurea CRM win) how Aurea CRM
behaves if a transaction exceeds current stock levels, e.g. display a warning
message, or permit negative stocks.
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Administrator Information

Your administrator can configure Aurea CRM’s inventory management to meet your
company’s specific needs: Stocks can be added or updated automatically or manu-
ally, transactions can be represented using either positive or negative numbers,
calculations can be carried out using single units or packaging units etc.

Depending on how the inventory management features are used in your company,
your administrator must configure the following options:

• Automatic stocktaking and stock calculations are enabled by default. If you do
not wish to use Aurea CRM’s inventory management features, your administrator
can deactivate the "Stock Calculation" process in the Process configuration info
area.

• To use Aurea CRM’s stock management features in a distributed system, all info
areas containing stock-relevant data (Stock Control, Order etc.) must be
communicated .

• The Stock Control info area requires all stock-related data to be present on
branch offices in order to correctly track stocks. For this reason, records (e.g.
companies) for which stock-relevant data exists for reps assigned to the station
(Stat.No. field in the Rep info area) are not deleted by the synchronization
process.

Use the No Inventory configuration entry (Communication category) to disable
this behavior. Alternatively, you can disable Aurea CRM’s stock management
features across the entire system by locking the "Stock Calculation" process
(recommended method).

• By default, stocktaking (Stocktaking and Reset options) can only be carried out
on the main office. Use the Take inventory configuration entry (Inventory
category) to allow stocktaking on other stations (possibly restricted to cer tain
reps or groups).

Stock

Use the Stock info area (not available in the default version of Aurea CRM web) to
manage various stocks for each rep and item. When a rep removes goods from
storage, their personal stock increases; when a rep distributes goods, their personal
stock is decreased. This allows reps to sell items or hand out samples from their
personal stock.

Based on stock-effective stock control item, order item, refunding item and promo-
tional material records, Aurea CRM automatically adds stock records for each rep,
stock, lot and item. Each time stocks are affected by a transaction, the corresponding
number of units are added or subtracted.

Items can also be distributed without affecting stocks, in which case the rep’s stock
remains unchanged.
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Stocks are always counted in units (Quantity Unit field). The available packages
and remaining units are calculated as follows:

• Quantity Unit: Quantities entered in stock-effective records are added/subtracted
in units.

• Target number of packs: Number of packages available (Quantity Unit / Pack.
Unit)

• Target remainder units: Number of remainder units available according to the
database (Quantity Unit - (Packaging Unit * Target number of packs))

Use the No Restrics. (no restrictions) and Negative stock allowed (negative stocks
allowed) fields to determine how the system behaves if stocks are exceeded.

To use the automatic stock calculation functions, for example when adding orders,
enter the following data in the order:

• Rep or Rep ID: The rep whose stocks are affected. By default, you are
automatically entered.

• Stock: The stock from which items are deducted.

• Receipt Type or Quantity factor.

• The Currency.

The items and quantities are entered in the Order Item info area. Enter the following
details:

• Item No.: The Item name, Sector, Product Group, Brand, Grade and Packaging
Unit are entered automatically.

• Quantity: You can also enter a lot number in the Lot No. field. The stock-effective
quantity is calculated automatically based on the Quantity factor (in the order)
and Pack. Unit and entered in the Inventory quantity field.

The corresponding stock is automatically updated in the Stock info area.

Note:  Offers do not affect stocks. However, you can enter information on how items
impact stocks when adding an offer (Stock, Receipt Type, Quantity factor, SAP
Company Code in offers; Pack. Unit  in offer items). This information is then
transferred to the order and order items when creating an order from an offer by
selecting Copy to Order from the context menu , and is consequently taken into
account when calculating stocks.

Assigning Stocks to an SAP Company Code

You can assign each stock to an SAP company code in the SAP Company Code
info area when integrating Aurea CRM with SAP. You can assign multiple stocks to
the same company code.

If you then select a stock, the corresponding SAP Company Code is entered. The
SAP company code is entered automatically in the following info areas:

• Offer

• Order

• Stock

• Stock Control
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• Promotional Material

• Refunding

Records with no Effect on Stocks

You can flag order items, stock control items, refunding items, samples and promo-
tional material as having no effect on stocks (Entered in Inventory enabled).
Records where this option is enabled are ignored when calculating stocks and when
stocktaking.

• You can enable or disable the check box as required in order item, stock control
item, refunding items sample and promotional material records.

• Once stock-taking has been performed for order item, stock control item, refunding
items sample and promotional material records (Stocktaking and Reset options),
the Entered in Inventory field is automatically enabled.

• Stock control items added during stocktaking (Count and Calculate options) are
also flagged as having no effect on stocks.

Exceeding Stocks

For each stock, you can use the No Restrics. and Negative stock allowed allowed
fields to determine how Aurea CRM handles cases where stocks are exceeded.

No Restrics. and Neg.stock allowed enabled: Aurea CRM ignores cases where
stocks are exceeded, and stocks may be negative.

No Restrics. disabled and Negative stock allowed enabled: Aurea CRM does not
output a message when saving the record if stocks are exceeded. The order item
record can be saved.

Both No Restrics. and Negative stock allowed disabled: Aurea CRM displays a
corresponding message and the record cannot be saved.

Overview
Inventory management in Aurea CRM provides the following functions:

• Each rep can manage company-independent stocks for each item and lot.

• Stock movements are stored in the Stock Control info area (e.g. receiving goods,
returns, losses etc.).

• When adding orders, offers, samples, refunds and promotional material, you
can enter details on how items affect stocks.

• The number of items in reps’ stocks are automatically calculated in the Stock
info area based on the information entered in stock control, order, sample,
refunding and promotional material records, such as which lot an item is taken
from and what quantity.

• You can define various transaction types (e.g. order, return, delivery, loss etc.)
for orders, refunds and stocks control records, which determine how stocks are
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affected: For each type, you can determine whether items are added to or removed
from stocks, and whether quantities are specified in units or packaging units.

• You can assign stocks to SAP company codes in the SAP Company Code info
area for use with SAP.

When stocktaking, data that affects stocks (in order, sample, refunding, promo-
tional material or stock control records) is aggregated for reps, stocks, lots and
items. The results are written to the Stock Control info area.

During stock-taking, stock-relevant data in existing orders is taken into account.
If you edit or delete these orders after completing stock-keeping, your changes
no longer affect current stocks.

Note: Your administrator can determine (in Aurea CRM win) how Aurea CRM
behaves if a transaction exceeds current stock levels, e.g. display a warning
message, or permit negative stocks.
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Administrator Information:

Depending on how the inventory management features are used in your
company, your administrator must configure the following options:

• Automatic stocktaking and stock calculations are enabled by default. If
you do not wish to use Aurea CRM’s inventory management features,
your administrator can deactivate the "Stock Calculation" process in the
Process configuration info area, >> Process Configuration in the Ad-
ministrator Guide.

• To use Aurea CRM’s stock management features in a distributed system,
all info areas containing stock-relevant data (Stock Control, Order etc.)
must be communicated, >> CRM.core Administrator Guide.

• The Stock Control info area requires all stock-related data to be present
on branch offices in order to correctly track stocks. For this reason,
records (e.g. companies) for which stock-relevant data exists for reps
assigned to the station (Stat.No. field in the Rep info area) are not
deleted by the synchronization process.

Use the No Inventory configuration entry (Communication category)
to disable this behavior, >> CRM.core Administrator Guide. Alternatively,
you can disable Aurea CRM’s stock management features across the
entire system by locking the "Stock Calculation" process (recommended
method).

• By default, stocktaking (Stocktaking and Reset options) can only be
carried out on the main office. Use the Take inventory configuration
entry (Inventory category) to allow stocktaking on other stations (possibly
restricted to cer tain reps or groups), >> CRM.core Administrator Guide.

Stock
Use the Stock info area (not available in the default version of Aurea CRM web) to
manage various stocks for each rep and item. When a rep removes goods from
storage, their personal stock increases; when a rep distributes goods, their personal
stock is decreased. This allows reps to sell items or hand out samples from their
personal stock.

Based on stock-effective stock control item, order item, refunding item and promo-
tional material records, Aurea CRM automatically adds stock records for each rep,
stock, lot and item. Each time stocks are affected by a transaction, the corresponding
number of units are added or subtracted.
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Items can also be distributed without affecting stocks, in which case the rep’s stock
remains unchanged, >> on page 256.

Stocks are always counted in units (Quantity Unit field). The available packages
and remaining units are calculated as follows:

• Quantity Unit: Quantities entered in stock-effective records are added/subtracted
in units.

• Target number of packs: Number of packages available (Quantity Unit / Pack.
Unit)

• Target remainder units: Number of remainder units available according to the
database (Quantity Unit - (Packaging Unit * Target number of packs))

Use the No Restrics. (no restrictions) and Negative stock allowed (negative stocks
allowed) fields to determine how the system behaves if stocks are exceeded, >> on
page 256.

To use the automatic stock calculation functions, for example when adding orders,
enter the following data in the order:

• Rep or Rep ID: The rep whose stocks are affected. By default, you are
automatically entered.

• Stock: The stock from which items are deducted.

• Receipt Type or Quantity factor, >> on page 255.

• The Currency.

The items and quantities are entered in the Order Item info area. Enter the following
details:

• Item No.: The Item name, Sector, Product Group, Brand, Grade and Packaging
Unit are entered automatically.

• Quantity: You can also enter a lot number in the Lot No. field. The stock-effective
quantity is calculated automatically based on the Quantity factor (in the order)
and Pack. Unit and entered in the Inventory quantity field.

The corresponding stock is automatically updated in the Stock info area.

Note: Note: Offers do not affect stocks. However, you can enter information on
how items impact stocks when adding an offer (Stock, Receipt Type, Quantity
factor, SAP Company Code in offers; Pack. Unit  in offer items). This information
is then transferred to the order and order items when creating an order from an offer
by selecting Copy to Order from the context menu (>> on page 193), and is
consequently taken into account when calculating stocks.
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Inventory Management
Learn how to manage goods storage using Stock Control.

The Stock Control info area allows you to enter goods removed from or returned
to storage for each rep (warehouse management). The individual items removed or
returned and their lot number are stored in stock control item records.

Switch to the Stock Control info area and add a new record.

1. Enter the rep (Rep ID) that the record applies to. By default, you are automatically
entered.

2. Select the Stock that the record applies to.

3. Select the type of transaction in the Stock Receipt Type field, e.g. withdrawal,
return, defective, loss etc.

4. Choose the desired quantity factor in the Quantity factor field. The quantity factor
determines how the stock control items affect stocks, i.e. whether stocks are
increased or decreased, and whether quantities are specified in individual units
(+ Qty, - Qty) or packaging units (+ Pack.Unit, - Pack.Unit).

Note: You can assign a fixed quantity factor to the transaction types in the Stock
Transaction Type info area. If you enter a transaction type in the Stock Control
info area, the quantity factor is then entered automatically.
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Note:  Based on the information in the Stock Control and Stock Control Item info
areas, Aurea CRM automatically adds records for each rep, stock, lot and item to
the Stock info area, with the corresponding number of units being subtracted or
added each time a change is made.

Stock Control Items

If you remove items from the stock or return them, you need to add a stock control
item to the stock control record. You can also enter quantities per lot (Lot No. field).

You can either add stock control items directly or select Quick Add (Items) from
the context menu to use the quick add function.

To add a stock control item record:

1. Switch to the desired record in the Stock Control info area.

2. Select Stock Control Items from the context menu.

3. Start the search.

4. Click on  (New).

5. Enter the Item No. or click on  (Select) to select an item. The Item Name,
Sector, Product Group, Brand, Grade and Packaging Unit are entered
automatically.

6. Enter the item’s quantity in the Quantity field to determine the amount to be
added or removed from the stock.
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If either +Pack. Unit or -Pack.Unit is entered as the quantity factor in the parent
stock control record, the quantity by which stocks are affected (Inventory quan-
tity) is calculated based on the size of a packaging unit. The Packaging Unit is
transferred from the Item Master info area or can be entered manually.

7. Save.

Aurea CRM automatically adds a stock record to the Stock info area for this item
and lot (if not already present) and calculates the current items in stock (or updates
the existing record accordingly).

Stock Control Items
If you remove items from the stock or return them, you need to add a stock control
item to the stock control record. You can also enter quantities per lot (Lot No. field).

You can either add stock control items directly or select Quick Add (Items) from
the context menu to use the quick add function, >> on page 104.

To add a stock control item record:

1. Switch to the desired record in the Stock Control info area.

2. Select Stock Control Items from the context menu.

3. Start the search.

4. Click on  (New).

5. Enter the Item No. or click on  (Select) to select an item.
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The Item Name, Sector, Product Group, Brand, Grade and Packaging Unit are
entered automatically.

6. Enter the item’s quantity in the Quantity field to determine the amount to be
added or removed from the stock.

If either +Pack. Unit or -Pack.Unit is entered as the quantity factor in the parent
stock control record, the quantity by which stocks are affected (Inventory quan-
tity) is calculated based on the size of a packaging unit. The Packaging Unit is
transferred from the Item Master info area or can be entered manually.

7. Save.

Aurea CRM automatically adds a stock record to the Stock info area for this item
and lot (if not already present) and calculates the current items in stock (or updates
the existing record accordingly).

Quantity Factors
The quantity factor determines how stock control items, refunding items and order
items affect stocks.

You can assign specific quantity factors to records in the Stock Transaction Type
and Receipt Transaction Type info areas.

The following quantity factors are available:

• + Pack.Unit: Quantities entered are multiplied by the packaging unit and added
to stocks.

• - Pack.Unit:Quantities entered are multiplied by the packaging unit and subtracted
from stocks.

• + Qty:Quantities entered are added to stocks as individual units.

• - Qty:Quantities entered are subtracted from stocks as individual units.

• 0:The quantity entered has no effect on stocks.

Note:  Packaging units can be defined in the item master. They are automatically
entered in stock control items records once an item has been selected. The - Qty:
quantity factor is always used for samples and promotional material. Enter negative
numbers in samples to determine that the quantity entered in this field is added to
the stock (if samples are returned).Quantities are always entered as units.
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Quantity Factor 0

The quantity factor ‘0’ can be used to enter delivered goods into the system that
should subsequently be verified. Stock control and item records can be added using
a receipt type that does not affect stocks (e.g. "Goods order" with the quantity factor
‘0’). The rep responsible for the stock can then compare the quantities entered in
the system with the actual quantities received, and then change the receipt type,
e.g. to "Goods delivered" with the quantity factor "+ Qty". Only at this point are the
stocks updated in Aurea CRM.

If you then select a Stock Receipt Type or Receipt Type in the Stock Control,
Refunding or Order info areas, the corresponding Quantity factor is entered.

The stock control records added automatically for the current rep within the scope
of stock-taking use the quantity factor ‘0’.

Assigning Quantity Factors to Transaction Types

You can assign a fixed quantity factor to the transaction types in the Stock Trans-
action Type info area. The quantity factor determines how stock control items affect
stocks:

If you select a transaction type in the Stock Receipt Type field in the Stock Control
info area, the corresponding quantity factor is entered automatically.

Assigning Quantity Factors to Receipt Transaction Types

You can assign a quantity factor to the default transaction types in the Receipt
Type Calculation info area. This info area is otherwise identical in function to the
Stock Receipt Type info area.

You can define receipt types per Sales Channel (C) in the Receipt Transaction
Type info area. This field is only relevant to SAP integration.

The Quantity factor and Sales Channel (C) are automatically entered in orders
and refunds if a Receipt Type is selected. Packaging units are entered in the item
master and transferred to item records once an item is selected.

Note: The - Qty: quantity factor is always used for samples and promotional
material. Quantities are always entered as units.

Assigning Quantity Factors to Transaction Types
You can assign a fixed quantity factor to the transaction types in the Stock Trans-
action Type info area. The quantity factor determines how stock control items affect
stocks:

If you select a transaction type in the Stock Receipt Type field in the Stock Control
info area, the corresponding quantity factor is entered automatically.
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Assigning Quantity Factors to Receipt Transaction
Types
You can assign a quantity factor to the default transaction types in the Receipt
Type Calculation info area. This info area is otherwise identical in function to the
Stock Receipt Type info area, >> on page 255.

You can define receipt types per Sales Channel (C) in the Receipt Transaction
Type info area. This field is only relevant to SAP integration.

The Quantity factor and Sales Channel (C) are automatically entered in orders
and refunds if a Receipt Type is selected. Packaging units are entered in the item
master and transferred to item records once an item is selected.

Note: Note: The - Qty: quantity factor is always used for samples and promotional
material. Quantities are always entered as units.

Assigning Stocks to an SAP Company Code
You can assign each stock to an SAP company code in the SAP Company Code
info area when integrating Aurea CRM with SAP. You can assign multiple stocks to
the same company code.

If you then select a stock, the corresponding SAP Company Code is entered. The
SAP company code is entered automatically in the following info areas:

• Offer

• Order

• Stock

• Stock Control

• Promotional Material

• Refunding
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Records with no Effect on Stocks
You can flag order items, stock control items, refunding items, samples and promo-
tional material as having no effect on stocks (Entered in Inventory enabled).
Records where this option is enabled are ignored when calculating stocks and when
stocktaking, >> on page 250 and on page 257.

• You can enable or disable the check box as required in order item, stock control
item, refunding items sample and promotional material records.

• Once stock-taking has been performed for order item, stock control item, refunding
items sample and promotional material records (Stocktaking and Reset options),
the Entered in Inventory field is automatically enabled.

• Stock control items added during stocktaking (Count and Calculate options) are
also flagged as having no effect on stocks, >> on page 257.

Exceeding Stocks
For each stock, you can use the No Restrics. and Negative stock allowed allowed
fields to determine how Aurea CRM handles cases where stocks are exceeded.

No Restrics. and Neg.stock allowed enabled: Aurea CRM ignores cases where
stocks are exceeded, and stocks may be negative.

No Restrics. disabled and Negative stock allowed enabled: Aurea CRM does not
output a message when saving the record if stocks are exceeded. The order item
record can be saved.

Both No Restrics. and Negative stock allowed disabled: Aurea CRM displays a
corresponding message and the record cannot be saved.

Stocktaking
Aurea CRM’s inventory management includes a stock-taking function. Quantities
entered in order item, stock control item, refunding items sample and promotional
material records records that affect stocks can be totaled over a specific time period
or for archiving purposes, and current stocks can be recalculated or reset.

Stocktaking can be performed for cer tain reps and stocks and you can restrict the
records to be taken into account using conditions.

By default, stocktaking (Stocktaking and Reset options) can only be carried out
on the main office. Your administrator can however determine that stock-taking can
be carried out on other stations.
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Before you can begin stock-taking in Aurea CRM web, your administrator needs to
define stock-taking formats in Aurea CRM win. A stock-taking format determines
which stocks are taken into account, which reps are affected, which function (count,
reset, stocktaking, calculate) should be performed etc. Your administrator can also
define conditions applied to this calculation.

When taking stock, select a stocktaking format and restrict the stock-taking time
period using the Date from and Date to fields. You can also enter a Text that is
entered in the stock control records. You can also specify the rep that stocktaking
should be carried out for (not available in Aurea CRM web by default), see To-Do
Types (type 4) in the CRM.core Administrator Guide.

Count

The Count inventory type calculates sum totals for the selected data. This allows
you to determine stocks for a specific time period ("snapshot").

The results are written to the Stock Control info area. The following records are
added:

• One record for the rep that star ted the stocktaking process

• One record for each rep and stock affected by stocktaking: The child item records
contain the calculated sum total, i.e. the stocks at the specified time. These item
records are flagged as having no effect on stock (Entered in Inventory enabled)
as they are purely for informational purposes and do not impact on stocks
themselves.

The Count inventory type can be used by reps on any station; the order item, stock
control item, refunding item, sample and promotional material records included in
the process continue to affect stocks.

Reset

The Reset inventory type removes the selected data from stocks. This allows you
to set par ticular stocks to ‘0’, for example. All order item, stock control item, refunding
item, sample and promotional material records taken into account by the process
are flagged as having no effect on stock (Entered in Inventory enabled); the corre-
sponding quantities are subtracted from stocks.

The process is documented in the Stock Control info area. The following records
are added:

• One record for the rep that star ted the stocktaking process: This record’s key is
entered records taken into account by the stocktaking process, and any stock
control items added as a result.

• One record for each rep and stock affected by stocktaking: The child item records
contain the quantity subtracted from the corresponding stock. These items are
flagged as having no effect on stock (Entered in Inventory enabled), as they are
purely for informational purposes.

By default, the Reset inventory type can only be carried out on the main office. Use
the Take inventory configuration entry (Inventory category) to allow stocktaking
on other stations (possibly restricted to cer tain reps or groups), see CRM.core Ad-
ministrator Guide.
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Stocktaking

The Stocktaking inventory type calculates the sum total for the selected data and
adds new records to the Stock Control info area containing these sum totals. All
order item, stock control item, refunding item, sample and promotional material
records taken into account by the process are flagged as having no effect on stock
(Entered in Inventory enabled). This allows you to archive stocks: The affected
stocks do not change, stock transactions are summarized in the new (stock-effective)
records; "old" order, stock control, refunding, sample and promotional material
records can then be archived and removed from the database.

The following records are added to the Stock Control info area:

• One record for the rep that star ted the stocktaking process: This record’s key is
entered records taken into account by the stocktaking process, and any stock
control items added as a result.

• One record for each rep and stock affected by stocktaking: The sum totals
calculated for each item are entered in the corresponding item records. These
item records impact on stocks and thus replace the order item, stock control item,
refunding item, sample and promotional material records taken into account by
the stocktaking process.

The Stocktaking inventory type can only be carried out on the main office. Use the
Take inventory configuration entry (Inventory category) to allow stocktaking on
other stations (possibly restricted to cer tain reps or groups), see CRM.core Admin-
istrator Guide.

Calculate

The Calculate inventory type recalculates the quantities of the selected stocks
based on the data available locally. The results are written to the Quantity Unit
(number of units), Target number of packs (number of complete packages) and
Target remainder units (remainder units) fields in the affected stock records. No
new stock control records are added.

You can only restrict data by Employee, Stock and Item No. (Condition Item
Master tab) when using the Calculate inventory type; you cannot enter a Date or
Text, >> on page 258.

The Calculate inventory type is purely for informational purposes. It can be used
by reps on any station; the order item, stock control item, refunding item, sample
and promotional material records included in the process continue to affect stocks.

Reps can compare the results to their actual physical stocks by entering their actual
stocks in the Quantity of Counted Basic Units, Number of packages counted
and Remainder units counted fields.

Stocktaking Format

Stocktaking formats can only be created in Aurea CRM win. Define the desired
settings and save the settings as a format.

To define a stocktaking format:

1. Switch to the Stock info area.

2. Select Stocktaking from the context menu.

The Stocktaking dialog opens.
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3. Select the reps whose stocks should be included from the Employee list, or enable
the All check box to include the stocks of all reps.

4. Select the stocks to be included from the Stock list, or enable the All check box
to include all stocks.

5. Enter the stocktaking time period in the Date pane.

6. Select the desired Inventory Type:

• Count: Calculates stocks for the specified time period.

• Reset: Removes the selected data from stocks.

• Stocktaking: Writes stocks to stock archives.

• Calculate: Recalculates stocks.

Note: Note: By default, stocktaking (Stocktaking and Reset options) can only
be carried out on the main office. Use the Take inventory configuration entry
(Inventory category) to allow stocktaking on other stations (possibly restricted
to cer tain reps or groups), see CRM.core Administrator Guide.

7. You can enter information on stocktaking in the Text field. This text is written to
stock control records created within the scope of stocktaking.
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8. Use the Condition Item Master tab to define conditions used to restrict stocktaking
to cer tain items or sectors, product groups, brands or grades: Select the desired
criteria in the Sector, Product Group, Brand, Grade and Item Master list fields.

9. Use the Condition tab to restrict stocktaking using conditions applied to the
Order, Stock Control, Sample, Refunding and Promotional Material info areas:

a. Click on  (Condition) next to the desired info area.

b. Define the condition, see Conditions in the Aurea CRM win User Manual.

c. Enable the Active check box to activate the condition.

Note: Note: Only conditions defined here are applied when taking stocks.
Conditions applied to other info areas, e.g. Order, are ignored.You can only
restrict data by Employee, Stock and Item No. (Condition Item Master tab)
when using the Calculate inventory type; you cannot enter a Date or Text.

10.Click on Save to save your settings as a format. Click on Open to load an existing
format.

11.Click on Close to close the Stocktaking dialog.

All criteria (Employee, Stock, Date and any additional conditions) are combined
using a logical AND when stocktaking . All order item, stock control item, refunding
item, sample and promotional material records that affect stocks and meet the defined
criteria are taken into account.

The results of stocktaking are recorded in the Stock Control info area. The following
records are added:

• A record with the Quantity factor ‘0’ for the rep that star ted the stocktaking
process: The key of this record is displayed in the Inventory No. field in the
Stocktaking dialog and entered in all items included in the stocktaking or added
by the process.

• A record with the Quantity factor ‘+ Qty’ for each rep and stock affected by
stocktaking: the corresponding item records contain the sum totals calculated.

Note: No new stock control records are added when using the Calculate inventory
type. If errors occur or the system crashes while stocktaking, causing inconsistent
data, the process must be reset and repeated using the Update info area
(Maintenance module) to update the affected info areas (Order Item, Stock Control
Item etc.) using the Inventory StNo. and Inventory No. fields, see CRM.core
Administrator Guide. Stocktaking can be carried out in Aurea CRM web using To-
Dos (type 4) assigned to CRM.server, see CRM.core Administrator Guide.

Count
The Count inventory type calculates sum totals for the selected data. This allows
you to determine stocks for a specific time period ("snapshot").
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The results are written to the Stock Control info area. The following records are
added:

• One record for the rep that star ted the stocktaking process

• One record for each rep and stock affected by stocktaking: The child item records
contain the calculated sum total, i.e. the stocks at the specified time. These item
records are flagged as having no effect on stock (Entered in Inventory enabled)
as they are purely for informational purposes and do not impact on stocks
themselves.

The Count inventory type can be used by reps on any station; the order item, stock
control item, refunding item, sample and promotional material records included in
the process continue to affect stocks.

Reset
The Reset inventory type removes the selected data from stocks. This allows you
to set par ticular stocks to ‘0’, for example. All order item, stock control item, refunding
item, sample and promotional material records taken into account by the process
are flagged as having no effect on stock (Entered in Inventory enabled); the corre-
sponding quantities are subtracted from stocks.

The process is documented in the Stock Control info area. The following records
are added:

• One record for the rep that star ted the stocktaking process: This record’s key is
entered records taken into account by the stocktaking process, and any stock
control items added as a result.

• One record for each rep and stock affected by stocktaking: The child item records
contain the quantity subtracted from the corresponding stock. These items are
flagged as having no effect on stock (Entered in Inventory enabled), as they are
purely for informational purposes.

By default, the Reset inventory type can only be carried out on the main office. Use
the Take inventory configuration entry (Inventory category) to allow stocktaking
on other stations (possibly restricted to cer tain reps or groups), >> CRM.core Ad-
ministrator Guide.

Stocktaking
The Stocktaking inventory type calculates the sum total for the selected data and
adds new records to the Stock Control info area containing these sum totals. All
order item, stock control item, refunding item, sample and promotional material
records taken into account by the process are flagged as having no effect on stock
(Entered in Inventory enabled). This allows you to archive stocks: The affected
stocks do not change, stock transactions are summarized in the new (stock-effective)
records; "old" order, stock control, refunding, sample and promotional material
records can then be archived and removed from the database.
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The following records are added to the Stock Control info area:

• One record for the rep that star ted the stocktaking process: This record’s key is
entered records taken into account by the stocktaking process, and any stock
control items added as a result.

• One record for each rep and stock affected by stocktaking: The sum totals
calculated for each item are entered in the corresponding item records. These
item records impact on stocks and thus replace the order item, stock control item,
refunding item, sample and promotional material records taken into account by
the stocktaking process.

The Stocktaking inventory type can only be carried out on the main office. Use the
Take inventory configuration entry (Inventory category) to allow stocktaking on
other stations (possibly restricted to cer tain reps or groups), >> CRM.core Adminis-
trator Guide.

Calculate
The Calculate inventory type recalculates the quantities of the selected stocks
based on the data available locally. The results are written to the Quantity Unit
(number of units), Target number of packs (number of complete packages) and
Target remainder units (remainder units) fields in the affected stock records. No
new stock control records are added.

You can only restrict data by Employee, Stock and Item No. (Condition Item
Master tab) when using the Calculate inventory type; you cannot enter a Date or
Text, >> on page 258.

The Calculate inventory type is purely for informational purposes. It can be used
by reps on any station; the order item, stock control item, refunding item, sample
and promotional material records included in the process continue to affect stocks.

Reps can compare the results to their actual physical stocks by entering their actual
stocks in the Quantity of Counted Basic Units, Number of packages counted
and Remainder units counted fields.

Stocktaking Format

Stocktaking formats can only be created in Aurea CRM win. Define the
desired settings and save the settings as a format.

To define a stocktaking format:

1. Switch to the Stock info area.

2. Select Stocktaking from the context menu.

The Stocktaking dialog opens.

609AUREA CONFIDENTIAL

Stocktaking



3. Select the reps whose stocks should be included from the Employee list, or enable
the All check box to include the stocks of all reps.

4. Select the stocks to be included from the Stock list, or enable the All check box
to include all stocks.

5. Enter the stocktaking time period in the Date pane.

6. Select the desired Inventory Type:

• Count: Calculates stocks for the specified time period, >> on page 256.

• Reset: Removes the selected data from stocks, >> on page 257.

• Stocktaking: Writes stocks to stock archives, >> on page 257.

• Calculate: Recalculates stocks, >> on page 257.

Note: Note: By default, stocktaking (Stocktaking and Reset options) can only
be carried out on the main office. Use the Take inventory configuration entry
(Inventory category) to allow stocktaking on other stations (possibly restricted
to cer tain reps or groups), >> CRM.core Administrator Guide.
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7. You can enter information on stocktaking in the Text field. This text is written to
stock control records created within the scope of stocktaking.

8. Use the Condition Item Master tab to define conditions used to restrict stocktaking
to cer tain items or sectors, product groups, brands or grades: Select the desired
criteria in the Sector, Product Group, Brand, Grade and Item Master list fields.

9. Use the Condition tab to restrict stocktaking using conditions applied to the
Order, Stock Control, Sample, Refunding and Promotional Material info areas:

a. Click on  (Condition) next to the desired info area.

b. Define the condition, >> Conditions in the Aurea CRM win User Manual.

c. Enable the Active check box to activate the condition.

Note: Note: Only conditions defined here are applied when taking stocks.
Conditions applied to other other info areas, e.g. Order, are ignored.You can
only restrict data by Employee, Stock and Item No. (Condition Item Master tab)
when using the Calculate inventory type; you cannot enter a Date or Text.

10.Click on Save to save your settings as a format. (Click on Open to load an existing
format.)

11.Click on Close to close the Stocktaking dialog.

All criteria (Employee, Stock, Date and any additional conditions) are combined
using a logical AND when stocktaking . All order item, stock control item, refunding
item, sample and promotional material records that affect stocks and meet the defined
criteria are taken into account.

The results of stocktaking are recorded in the Stock Control info area. The following
records are added:

• A record with the Quantity factor ‘0’ for the rep that star ted the stocktaking
process: The key of this record is displayed in the Inventory No. field in the
Stocktaking dialog and entered in all items included in the stocktaking or added
by the process.

• A record with the Quantity factor ‘+ Qty’ for each rep and stock affected by
stocktaking: the corresponding item records contain the sum totals calculated.

Note: Note: No new stock control records are added when using the Calculate
inventory type, >> on page 257.If errors occur or the system crashes while
stocktaking, causing inconsistent data, the process must be reset and repeated
using the Update info area (Maintenance module) to update the affected info areas
(Order Item, Stock Control Item etc.) using the Inventory StNo. and Inventory
No. fields, >> CRM.core Administrator Guide.Stocktaking can be carried out in Aurea
CRM web using To-Dos (type 4) assigned to CRM.server, >> CRM.core Administrator
Guide.
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Data for SAP Integration
Learn about the fields for info area required for SAP integration.

Aurea CRM provides the following fields required by SAP in the most important info
areas:

Info AreaField

Special Offer, Offer, Item Master, Order, Stock, Stock SAP
Company Code, Stock Control, Company, Competition, POS
Monitoring, Expenses, Refunding, Promotional Material

SAP Company Code

Special Offer, Item Master, Order, Stock, Stock Control,
Company, Competition, POS Monitoring, Expenses, Refund-
ing, Promotional Material

Sales Org.(C)

Special Offer, Item Master, Order, Stock, Receipt Transac-
tion Type, Stock Control, Company, Competition, POS
Monitoring, Expenses, Refunding, Promotional Material

Sales Channel (C)

Item Master, Order, Order Item, Stock, Stock Control, Stock
Control Item, Company, Competition, POS Monitoring, Ex-
penses, Refunding, Promotional Material

Division(C)

Offer, Offer Item, Order, Order Item, Receipt, Stock Control,
Stock Control Item, Company, Person, Person in Company,
Refunding, Refunding Item, Expenses, Promotional Material

SAP Date

Stock Control, CompanySAP No.

StockNo. packs SAP

StockRemainder units SAP
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Only two of these fields have a function in Aurea CRM:

• The Sales Channel (C) is entered in orders and refunds based on the transaction
type.

• The SAP Company Code field is used in all info areas that use stocks, and is
entered automatically based on the stocks.

613AUREA CONFIDENTIAL

Data for SAP Integration



25
Campaigns and Marketing Activities

Campaigns and Marketing Activities
Learn to plan, execute and monitor marketing campaigns.

A campaign consists of one or more marketing activities. Campaigns target customers
and interests based on information accumulated by sales, service and marketing
employees.

You can:

• Define customer-specific marketing activities (e.g. telephone surveys or mailings).

• Determine the responsible rep (e.g. telemarketing agent, account manager).

• Define the available responses from the target group

• Edit the generated target group

• Generate and edit activities, work orders or mailings

• Generate mass mailings and faxes

• Send SMS and e-mails

• Trigger follow-up activities automatically based on responses

• Monitor the results

Note:  Note: If you are porting campaign templates between development and
production systems, ensure that the field numbers 4 and 15 in the Activity Execution
(AD) record are empty. If they are not empty, then after por ting, manually update
field number 5, else the execution of marketing activities fails.

Marketing Calendar

To add a new campaign:

1. Select  (Marketing) > New Campaign.

2. The following options are available:

• Empty Campaign: Creates a new campaign.

• Use Template: Copies the data from an existing campaign template. You then
need to customize the data in the new campaign:

614AUREA CONFIDENTIAL

Chapter 25: Campaigns and Marketing Activities



Search for and select the desired campaign template.

The date entered in the campaign is not copied. Enter the desired date for the new
campaign and click on OK. The campaign, including all associated marketing activ-
ities, is copied and rescheduled for the new date.

1. Enter the relevant data in the fields, including the name of the campaign, the
type, the rep responsible for the campaign as a whole and the star t and end date.

2. Save the record.

3. Add the marketing activities that make up the campaign.

Quick Campaigns

Quick campaigns allow you to generate a letter for several persons, without needing
to first add a campaign and associated marketing activities.

Quick campaigns are accessible from the result lists for companies, persons, persons
in company and in queries.

• Rows in query results may include data from multiple records, and may therefore
contain multiple recipients that can be used by the quick campaign.

If a row contains multiple possible recipients e.g. multiple records in the FI, FP,
CP and PE info areas, the last record in the query row (in the last info area defined
in the query) is used to determine the recipient.

If a row does not contain any recipients, but contains data from one or more
records, the standard link to the parent record in the last info area defined in the
query is used to determine the recipient (e.g. the company a ticket is linked to).
If several default links are available, e.g. for a company and a person, the recip-
ient is determined in the order KP/CP/PE/FI.

• If the results include several pages, only those (selected) persons on the current
page are included.
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To star t a quick campaign:

1. Start the company or persons search or execute a query that returns companies
or persons.

2. Select the records you wish to send a letter to. If you do not select any rows in
the results list, the quick campaign is executed for all rows.

3. Click on  (Quick Campaign).

4. Select a letter template and click on Load.

Microsoft Word is star ted and you can edit the letter.

The following data is added in the background:

• A campaign of the type Quick Campaign

• A marketing activity

• An activity for each recipient

• The letter document is added to the marketing activity as a document link

5. When you close the document, you are informed of which marketing activity the
letter was linked to. You can click on the link in the message to open the marketing
activity.

Campaigns

A campaign consists of one or more marketing activities that take place sequentially.
You can also add marketing activities that are not par t of a campaign.

Adding Campaigns

To add a new campaign:

1. Select  (Marketing) > New Campaign.

2. The following options are available:

• Empty Campaign: Creates a new campaign.

• Use Template: Copies the data from an existing campaign template. You then
need to customize the data in the new campaign:

Search for and select the desired campaign template.

The date entered in the campaign is not copied. Enter the desired date for the new
campaign and click on OK. The campaign, including all associated marketing activ-
ities, is copied and rescheduled for the new date.

1. Enter the relevant data in the fields, including the name of the campaign, the
type, the rep responsible for the campaign as a whole and the star t and end date.
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2. Save the record.

3. Add the marketing activities that make up the campaign.

Campaign Plan

The campaign plan provides you with a hierarchical overview of the campaign in a
tree view. You can add and edit marketing activities, responses and other records.

To display the campaign plan:

1. Select Campaign Plan from the campaign’s context menu. The tree view is
displayed on the left.

You have the following options in the campaign plan:

• Click on the arrows in the tree view to open and close the nodes in the tree.

• Click on an entry in the tree view to display the record in the area on the right
and edit it.
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• Click on  to open a record’s context menu, in order to add new child records or
delete the record.

• You can create a report containing the campaign’s structure. Click on the desired
export button to do so (e.g.  (Export (HTML)).

Open Campaign Issues

You can display important information on a campaign that concerns you.

To view open campaign issues, select  (Marketing) > Open Campaign Issues.

A list of open campaign issues is displayed. If you need to edit a target group, for
example, this information is displayed next to the generated To-Do in the open
campaign issues.

Campaign Graph

The Graph tab in a campaign or marketing activity record displays the structure of
the campaign graphically. The campaign is displayed at the top. Marketing activities
in the campaign are displayed with rounded corners, responses are displayed in
ovals.

The following options are available:

• Drag the graph to move it.

• Use your mouse wheel to zoom.

• Double-click on an empty area in the graph to revert the zoom level to 100%.

• Double-click on an element in the graph (campaign, marketing activity or response)
to open the corresponding record.
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Marketing Calendar
The marketing calendar is an important tool for managing campaigns. The marketing
calendar displays a graphical overview of activities and campaigns including an
indicator that represents a campaign or marketing activity's progress or success.

To display campaigns and marketing activities in the marketing calendar:

1. Select  (Marketing) > Marketing Calendar. The marketing calendar is
displayed.

Individual elements (campaigns, sales cycles, marketing activities) are displayed
as colored blocks.

Note:  If no end date is entered in a marketing activity, it is displayed as lasting
for a single day.
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The current date is indicated by a ver tical line.

You can edit and display campaigns and activities in a number of ways:

• Use the icons in the header to choose what to display:

• : Campaigns and marketing activities

• : Sales cycles and marketing activities

• : Only marketing activities

• To display or hide the marketing activities that make are part of a campaign, click
on  or  in the left-most column. Click on  or  in the column header to
hide/show all marketing activities for all campaigns.

•  (Edit Settings): Choose whether to color-code elements by type (info area) or
status.

•  (Legend): Displays information on the colors in the calendar

• To configure the time period that is displayed:

• Click on the desired day or star t of the time period in the small calendar in the
sidebar.

• Select the time period that is displayed using the slider in the header: drag the
slider to the left or right or click on the plus and minus signs on either side to
zoom in or out.

• Drag the timeline at the top of the calendar to the left of right to scroll the time
period.

• Select a filter from the drop-down list in the sidebar to determine which elements
should be displayed. You can also define you own filter.

• If the full duration of an element in the calendar is not visible, an arrow is displayed
indicating that the element’s duration exceeds the display area:

• To change an entry’s star t or end, click on the left or right border and drag it to
the desired position:
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• To reschedule an element, click on it and drag it to the desired time.

Click on  (Move linked items) to determine whether activity execution
records and agenda items should also be rescheduled accordingly. For more in-
formation on the affected fields in the activity execution and agenda item records,
refer to the online field help.

• Click on a campaign or marketing activity to display a summary of the record.

• Double-click on a campaign or marketing activity in the marketing calendar to edit
it.

Quick Campaigns
Quick campaigns allow you to generate a letter for several persons, without needing
to first add a campaign and associated marketing activities.

Quick campaigns are accessible from the result lists for companies, persons, persons
in company and in queries.

• Rows in query results may include data from multiple records, and may therefore
contain multiple recipients that can be used by the quick campaign.

If a row contains multiple possible recipients e.g. multiple records in the FI, FP,
CP and PE info areas, the last record in the query row (in the last info area defined
in the query) is used to determine the recipient.

If a row does not contain any recipients, but contains data from one or more
records, the standard link to the parent record in the last info area defined in the
query is used to determine the recipient (e.g. the company a ticket is linked to).
If several default links are available, e.g. for a company and a person, the recip-
ient is determined in the order KP/CP/PE/FI.

• If the results include several pages, only those (selected) persons on the current
page are included.

To star t a quick campaign:

1. Start the company or persons search or execute a query that returns companies
or persons.

2. Select the records you wish to send a letter to. If you do not select any rows in
the results list, the quick campaign is executed for all rows.

3. Click on  (Quick Campaign).

4. Select a letter template and click on Load.
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Microsoft Word is star ted and you can edit the letter.

The following data is added in the background:

• A campaign of the type Quick Campaign

• A marketing activity

• An activity for each recipient

• The letter document is added to the marketing activity as a document link

5. When you close the document, you are informed of which marketing activity the
letter was linked to. You can click on the link in the message to open the marketing
activity.

Campaigns
Learn how to add and manage campaigns.

A campaign consists of one or more marketing activities that take place sequentially.
You can also add marketing activities that are not par t of a campaign.

Adding Campaigns

To add a new campaign:

1. Select  (Marketing) > New Campaign.

2. The following options are available:

• Empty Campaign: Creates a new campaign.

• Use Template: Copies the data from an existing campaign template. You then
need to customize the data in the new campaign:

Search for and select the desired campaign template.

The date entered in the campaign is not copied. Enter the desired date for the new
campaign and click on OK. The campaign, including all associated marketing activ-
ities, is copied and rescheduled for the new date.

1. Enter the relevant data in the fields, including the name of the campaign, the
type, the rep responsible for the campaign as a whole and the star t and end date.
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2. Save the record.

3. Add the marketing activities that make up the campaign.

Campaign Plan

The campaign plan provides you with a hierarchical overview of the campaign in a
tree view. You can add and edit marketing activities, responses and other records.

To display the campaign plan:

1. Select Campaign Plan from the campaign’s context menu. The tree view is
displayed on the left.

You have the following options in the campaign plan:

• Click on the arrows in the tree view to open and close the nodes in the tree.

• Click on an entry in the tree view to display the record in the area on the right
and edit it.
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• Click on  to open a record’s context menu, in order to add new child records or
delete the record.

• You can create a report containing the campaign’s structure. Click on the desired
export button to do so (e.g.  (Export (HTML)).

Open Campaign Issues

You can display important information on a campaign that concerns you.

To view open campaign issues:

1. Select  (Marketing) > Open Campaign Issues.

A list of open campaign issues is displayed. If you need to edit a target group,
for example, this information is displayed next to the generated To-Do in the open
campaign issues.

Quick Campaigns

Quick campaigns allow you to generate a letter for several persons, without needing
to first add a campaign and associated marketing activities.

Quick campaigns are accessible from the result lists for companies, persons, persons
in company and in queries.

• Rows in query results may include data from multiple records, and may therefore
contain multiple recipients that can be used by the quick campaign.

If a row contains multiple possible recipients e.g. multiple records in the FI, FP,
CP and PE info areas, the last record in the query row (in the last info area defined
in the query) is used to determine the recipient.

If a row does not contain any recipients, but contains data from one or more
records, the standard link to the parent record in the last info area defined in the
query is used to determine the recipient (e.g. the company a ticket is linked to).
If several default links are available, e.g. for a company and a person, the recip-
ient is determined in the order KP/CP/PE/FI.

• If the results include several pages, only those (selected) persons on the current
page are included.

To star t a quick campaign:

1. Start the company or persons search or execute a query that returns companies
or persons.

2. Select the records you wish to send a letter to. If you do not select any rows in
the results list, the quick campaign is executed for all rows.

3. Click on  (Quick Campaign).

4. Select a letter template and click on Load.

Microsoft Word is star ted and you can edit the letter.
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The following data is added in the background:

• A campaign of the type Quick Campaign

• A marketing activity

• An activity for each recipient

• The letter document is added to the marketing activity as a document link

5. When you close the document, you are informed of which marketing activity the
letter was linked to. You can click on the link in the message to open the marketing
activity.

Adding Campaigns
To add a new campaign:

1. Select  (Marketing) > New Campaign.

2. The following options are available:

• Empty Campaign: Creates a new campaign.

• Use Template: Copies the data from an existing campaign template. You then
need to customize the data in the new campaign:

Search for and select the desired campaign template.

The date entered in the campaign is not copied. Enter the desired date for the new
campaign and click on OK. The campaign, including all associated marketing activ-
ities, is copied and rescheduled for the new date.

1. Enter the relevant data in the fields, including the name of the campaign, the
type, the rep responsible for the campaign as a whole and the star t and end date.
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2. Save the record.

3. Add the marketing activities that make up the campaign.

Campaign Plan
The campaign plan provides you with a hierarchical overview of the campaign in a
tree view. You can add and edit marketing activities, responses and other records.

To display the campaign plan:

1. Select Campaign Plan from the campaign’s context menu. The tree view is
displayed on the left.

You have the following options in the campaign plan:

• Click on the arrows in the tree view to open and close the nodes in the tree.

• Click on an entry in the tree view to display the record in the area on the right
and edit it.
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• Click on  to open a record’s context menu, in order to add new child records or
delete the record.

• You can create a report containing the campaign’s structure. Click on the desired

export button to do so (e.g.  (Export (HTML)).

Open Campaign Issues
You can display important information on a campaign that concerns you.

To view open campaign issues:

1. Select  (Marketing) > Open Campaign Issues.

A list of open campaign issues is displayed. If you need to edit a target group,
for example, this information is displayed next to the generated To-Do in the open
campaign issues.

Marketing Activities
Learn to plan and manage marketing activities.

Marketing activities are executed in the following steps:

1. Preparation.

2. Define the marketing activity and any additional information.

3. Edit the target group.

4. Generate and edit the data.

5. Monitor the results.

Related marketing activities can be grouped together to form campaigns.

Planning and Preparing Marketing Activities
Learn how to plan marketing activities and surveys.

Before executing a marketing activity, you need to enter its details and create any
necessary documents and add records:

1. Determine how you wish to contact your customers or prospects:

• Mailings: Letters, e-mails, faxes or SMS can be created automatically within
the scope of the marketing activity.

• Telephone: Activity records are automatically generated and can be edited by
telemarketing staff.
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• Combined channels: The customer/prospect is contacted using their preferred
channel.

• Survey: A questionnaire is sent by e-mail and the answers are automatically
saved in Aurea CRM. The survey is filled out by the appropriate rep if the survey
is carried out by telephone.

2. Create the target group using a query.

You do not need to define a target group for follow-up activities and published
adverts: These target groups are built up later. The target group created for a
follow-up activity contains those customers/prospects that responded to the pre-
vious activity in a specific manner.

Note: Target groups can also be generated from selections created in Aurea
CRM win. For more information on selections, see Selections in the Aurea CRM
win User Guide.

3. Determine which labels should be used for letters. A label determines how the
address and greeting in a letter are formatted. You can enter a general label when
defining the marketing activity or enter a specific label for each person.

Note:  Labels are defined in Aurea CRM win, see Label Formats in the Aurea
CRM win User Guide.

4. Determine which database fields you want to merge with the text of the letter or
e-mail.

Note:  A transfer fields format needs to be defined for these fields in Aurea CRM
win, see Defining Transfer Fields in the Aurea CRM win User Guide.

5. To create mass mailings and faxes, create a serial letter in Aurea CRM win, see
Aurea CRM win User Guide.

6. For e-mails:

Note: To send an e-mail in a language other than the default languages, you
should use UTF-16 encoding for the template document. For example, to send
an e-mail in Cyrillic, encode the template document in UTF-16. You can use any
text editor that supports UTF-16, to encode the template document.

a. Create a file containing the e-mail's body text.

b. Verify that e-mail addresses have been entered for the companies/persons in
the target group.
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Note:  Aurea CRM web only supports sending e-mails via SMTP within the scope
of marketing activities.

7. For SMS:

• Define the SMS settings.

• Create a file containing the text message’s body text.

8. For surveys (via telephone or e-mail):

• Add a questionnaire.

Note: To send an e-mail in a language other than the default languages, you should
use UTF-16 encoding for the template document. For example, to send an e-mail
in Cyrillic, encode the template document in UTF-16. You can use any text editor
that supports UTF-16, to encode the template document.

Contents of a Mass Mailing

You can enter the template used by a mass mailing in the following fields:

E-mail: Template Document: If you enter a document in this field, MS Word is
star ted before e-mails are sent, and you can merge transfer fields with the place-
holders in the document template. You can use any document format supported by
your version of Word.

E-mail: Template Document (TXT): Enter an HTML file in this field and use the
syntax described below in HTML mails.

Note: To send email in a language other than the default languages, you should
use UTF-16 encoding for the template document. For example, to send a mail in
Cyrillic, encode the HTML template document in UTF-16.

Notation for HTML Files

Enter the body text to be used by your mailing in an HTML file. You have the following
options:

• Use variables to include field contents in the text, e.g.
<%KPLastName%>

to include the contents of the Last Name field in the Person in Company info
area (KP).

• Use the
<%Greetings%>

element to include the greeting defined in the label format.

• Use the "
url:
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" prefix in front of a field name apply URL encoding to the field. Spaces are then
encoded as "%20", for example.

• The "
html:

" prefix encodes the field as HTML. Characters that are forbidden in HTML are
replaced, e.g. "&" is replaced by "&amp;".

• Use IF, THEN and ELSE statements to compose the e-mail based on the values
stored in specific fields.
<%$IF FICountry = ‘Italy'%>

Text for Italian companies

<%$ELSE%>

Text for all other companies

<%$FI%>

• A period (full stop) is used to denote decimal places; i.e. "12.5" for twelve and
a half.

• The following operators are available for logical expressions: <; <=; >; >=; =;
<>

• You can carry out calculations using +, -, *, / and parentheses, e.g.
(2+FIFreeDec1)*3.

• The following operators can be used in IF statements:

• UCASE converts text to upper case, e.g. UCASE(KPFirstName)

• LCASE converts text to lower case, e.g. LCASE(KPFirstName)

• LEN returns the length of the field contents, e.g. LEN(KPFirstName)

• INSTR returns the (first) position that a string or value occurs at within a text,
e.g. INSTR(KPE-mail,"@aurea.com") returns the value 5 for the e-mail address
"info@aurea.com"; it returns 0 (zero; not found) for "test@hotmail.com".

mmsms.ini File

To configure the system to send SMS within the scope of marketing activities, add
a file named
mmsms.ini

to the
system\db

directory containing the following parameters (contact your SMS provider for details
of your IDs, passwords and an interface description):
[configuration]

profile=MyProfile

Defines the name of the profile that is used.
[MyProfile]
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Profile name (only the profile that is defined in the [configuration] entry is taken into
account)
connectionString=

http://sms.xxxxx.at/api/?application_id=abc123&username=demo&pass=demo1

messageString="message"

dialString="deliverto"

Use the interface description delivered by your provider to define a valid and readable
request. These settings are then added to the URL, e.g.:

http://sms.xxxxx.at/api/?application_id=abc123&username=demo&pass=demo1&mes-
sage=message&deliver to=0043676123456
encoding=1

0 = no encoding, 1 = URL encoding
post=1

Use post=1 to send a request using HTTP POST (otherwise HTTP GET is used).
maxTextLen=300

The maximum length of the message. Longer messages are truncated at this point.
telPrefix=""

The character required by your provider before the international dialing code, e.g.
‘+’.
Err=-1

Use Err=-1 to output error messages from your provider instead of replacing them
with Aurea CRM error messages.
Err3="ERROR 002"

Err4="WRONG USER"

Use these options to link error messages sent by your SMS provider with Aurea
CRM error messages. The error messages in Aurea CRM are output instead of those
from your provider. Example: The documentation supplied by your SMS provider
describes the following error messages: "ERROR 002" occurs if the connection to
the server cannot be established; "WRONG USER" occurs if the login is not recog-
nized.
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The errors in Aurea CRM are as follows:
Err1:

Invalid profile (ini file); internal error message, cannot be linked
Err2:

Message not found; internal error message, cannot be linked)
Err3:

No connection to the server
Err4:

Invalid user
Err5:

Invalid account (verify the user name and password)
Err6:

Login valid, no credit available
Err7:

Invalid or empty message
Err8:

Invalid telephone number
port=n

Enter the number of the port used to send the SMS. If you do not specify a por t, the
standard ports (80 or 443) are used.

Contents of an SMS

Enter the body text to be used by your SMS in a text file. You have the following
options:

• Use variables to include field contents in the text, e.g.
<%KPLastName%>

to include the contents of the Last Name field in the Person in Company info
area (KP).

• Use the
<%Greetings%>
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element to include the greeting defined in the label format.

• Use IF, THEN and ELSE statements to compose the SMS based on the values
stored in specific fields.
<%$IF FICountry = ‘Italy'%>

Text for Italian companies

%$ELSE%

Text for all other companies

%$FI%

• A period (full stop) is used to denote decimal places; i.e. "12.5" for twelve and
a half.

• The following operators are available for logical expressions: <; <=; >; >=; =;
<>

• You can carry out calculations using +, -, *, / and parentheses, e.g.
(2+FIFreeDec1)*3.

• The following operators can be used in IF statements:

• UCASE converts text to upper case, e.g. UCASE(KPFirstName)

• LCASE converts text to lower case, e.g. LCASE(KPFirstName)

• LEN returns the length of the field contents, e.g. LEN(KPFirstName)

• INSTR returns the (first) position that a string or value occurs at within a
text, e.g. INSTR(KPE-mail,"@aurea.com") returns the value 5 for the e-mail
address "info@aurea.com"; it returns 0 (zero; not found) for
"test@hotmail.com".

Contents of a Mass Mailing
You can enter the template used by a mass mailing in the following fields:

E-mail: Template Document: If you enter a document in this field, MS Word is
star ted before e-mails are sent, and you can merge transfer fields with the place-
holders in the document template. You can use any document format supported by
your version of Word.

E-mail: Template Document (TXT): Enter an HTML file in this field and use the
syntax described below in HTML mails.

Note:  Note: To send email in a language other than the default languages, you
should use UTF-16 encoding for the template document. For example, to send a
mail in Cyrillic, encode the HTML template document in UTF-16.
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Notation for HTML Files

Enter the body text to be used by your mailing in an HTML file. You have the following
options:

• Use variables to include field contents in the text, e.g.
<%KPLastName%>

to include the contents of the Last Name field in the Person in Company info
area (KP).

• Use the
<%Greetings%>

element to include the greeting defined in the label format.

• Use the "
url:

" prefix in front of a field name apply URL encoding to the field. Spaces are then
encoded as "%20", for example.

• The "
html:

" prefix encodes the field as HTML. Characters that are forbidden in HTML are
replaced, e.g. "&" is replaced by "&amp;".

• Use IF, THEN and ELSE statements to compose the e-mail based on the values
stored in specific fields.
<%$IF FICountry = ‘Italy'%>

Text for Italian companies

<%$ELSE%>

Text for all other companies

<%$FI%>

• A period (full stop) is used to denote decimal places; i.e. "12.5" for twelve and
a half.

• The following operators are available for logical expressions: <; <=; >; >=; =;
<>

• You can carry out calculations using +, -, *, / and parentheses, e.g.
(2+FIFreeDec1)*3.

• The following operators can be used in IF statements:

• UCASE converts text to upper case, e.g. UCASE(KPFirstName)

• LCASE converts text to lower case, e.g. LCASE(KPFirstName)

• LEN returns the length of the field contents, e.g. LEN(KPFirstName)

• INSTR returns the (first) position that a string or value occurs at within a text,
e.g. INSTR(KPE-mail,"@aurea.com") returns the value 5 for the e-mail address
"info@aurea.com"; it returns 0 (zero; not found) for "test@hotmail.com".
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mmsms.ini File
To configure the system to send SMS within the scope of marketing activities, add
a file named
mmsms.ini

to the
system\db

directory containing the following parameters (contact your SMS provider for details
of your IDs, passwords and an interface description):

[configuration]

profile=MyProfile

Defines the name of the profile that is used.

[MyProfile]

Profile name (only the profile that is defined in the [configuration] entry is taken into
account)

connectionString=

http://sms.xxxxx.at/api/?application_id=abc123&username=demo&pass=demo1

messageString="message"

dialString="deliverto"

Use the interface description delivered by your provider to define a valid and readable
request. These settings are then added to the URL, e.g.:

http://sms.xxxxx.at/api/?application_id=abc123&username=demo&pass=demo1&mes-
sage=message&deliver to=0043676123456

encoding=1

0 = no encoding, 1 = URL encoding

post=1

Use post=1 to send a request using HTTP POST (otherwise HTTP GET is used).

maxTextLen=300

The maximum length of the message. Longer messages are truncated at this point.

telPrefix=""

The character required by your provider before the international dialing code, e.g.
‘+’.

Err=-1

Use Err=-1 to output error messages from your provider instead of replacing them
with Aurea CRM error messages.

Err3="ERROR 002"

Err4="WRONG USER"
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Use these options to link error messages sent by your SMS provider with Aurea
CRM error messages. The error messages in Aurea CRM are output instead of those
from your provider. Example: The documentation supplied by your SMS provider
describes the following error messages: "ERROR 002" occurs if the connection to
the server cannot be established; "WRONG USER" occurs if the login is not recog-
nized.

The errors in Aurea CRM are as follows:

Err1:

Invalid profile (ini file); internal error message, cannot be linked

Err2:

Message not found; internal error message, cannot be linked)

Err3:

No connection to the server

Err4:

Invalid user

Err5:

Invalid account (verify the user name and password)

Err6:

Login valid, no credit available

Err7:

Invalid or empty message

Err8:

Invalid telephone number

port=n

Enter the number of the port used to send the SMS. If you do not specify a por t, the
standard ports (80 or 443) are used.

Contents of an SMS
Enter the body text to be used by your SMS in a text file. You have the following
options:

• Use variables to include field contents in the text, e.g.
<%KPLastName%>

to include the contents of the Last Name field in the Person in Company info
area (KP).

• Use the
<%Greetings%>
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element to include the greeting defined in the label format.

• Use IF, THEN and ELSE statements to compose the SMS based on the values
stored in specific fields.

<%$IF FICountry = ‘Italy'%>

Text for Italian companies

%$ELSE%

Text for all other companies

%$FI%

• A period (full stop) is used to denote decimal places; i.e. "12.5" for twelve and
a half.

• The following operators are available for logical expressions: <; <=; >; >=; =;
<>

• You can carry out calculations using +, -, *, / and parentheses, e.g.
(2+FIFreeDec1)*3.

• The following operators can be used in IF statements:

• UCASE converts text to upper case, e.g. UCASE(KPFirstName)

• LCASE converts text to lower case, e.g. LCASE(KPFirstName)

• LEN returns the length of the field contents, e.g. LEN(KPFirstName)

• INSTR returns the (first) position that a string or value occurs at within a
text, e.g. INSTR(KPE-mail,"@aurea.com") returns the value 5 for the e-mail
address "info@aurea.com"; it returns 0 (zero; not found) for
"test@hotmail.com".

Defining Marketing Activities
Learn to define the format and execution of marketing activities.

To define a marketing activity:

1. Select  (Marketing) > New Marketing Activity.

You can also add the marketing activity to a campaign (either using the campaign’s
context menu or from the Marketing Activities tab).

2. Determine whether you want to create an Empty Marketing Activity or select
Use Template to copy the data from an existing marketing activity.

Note: You can only use marketing activities whose Status is "Template" as a
template.

3. Enter a name in the Marketing Activity field.
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4. Save the record.

5. Enter the following data:

• Responses.

• Reps.

• Details on how the activity is executed.

Responses

You can enter the possible response to a marketing activity, which allows you to:

• Define follow-up activities, for example, to send an offer to those respondents
who react positively to the first telephone contact.

• Review responses and count the number of responses of each type in order to
determine the success of the marketing activity.

To define the follow-up response and assign points to a response:

1. Define two marketing activities.The second marketing activity should be dependent
on a specific response being given to the first one.

2. Add a response to the first marketing activity.

3. Enter the Response (e.g. "Yes, send me an offer").

4. Select the second marketing activity in the Follow-up Marketing Activity field.
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If this response is received, the respondent is automatically assign to the follow-
up activity’s target group.

5. Enter the number of points assigned to this response in the Individual Points
field on the Numbers & Points tab and enter the expected number of responses
in the Number (Target) field. The target and actual points can then be compared
in the statistics.

6. Save the record.

Reps

Add the reps who are responsible for handling the campaign in addition to the rep
responsible for the campaign itself:

1. Click on  (New) on the Reps tab or select New > New Marketing Activity Rep
from the context menu.

2. Enter the desired rep in the Rep ID field.

3. Determine the rep's task(s):

• Telephone: Indicates whether the rep is responsible for making or answering
phone calls within the scope of this marketing activity.

• E-mail: Indicates whether the rep is responsible for processing incoming e-mails
within the scope of the marketing activity.

• Target Group: Indicates whether the rep is responsible for verifying and editing
a portion of the target group. The rep receives a To-Do once the target group
has been generated.
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Note: The Telephone and E-mail fields have no function in the default
configuration.

4. Save the record.

Defining How the Activity is Executed

The Execution (Marketing Activity) info area is used to store all the important in-
formation needed to execute the marketing activity:

• Target group

• Schedule

• Data entered in activities, mailings and work orders

• File formats and other information on mailings, e-mails, SMS and faxes.

To enter the details of how a marketing activity is executed:

1. Select Create / Edit Execution from the marketing activity’s context menu.

2. Select a Marketing Activity Format or select Create Marketing Activity Format
from the context menu to add a new one.

3. Enter the Start Date and Start Time to determine when the marketing activity
should be executed and the target group generated.

4. Use the Base field to determine the basis for the target group. The target group
can be determined using a selection, a global query or a private query.

Note:  Selections are defined in Aurea CRM win.

5. Select a predefined query or selection in the Target group definition field.

Note:  Leave this field empty for follow-up activities. The target groups for
follow-up activities are generated automatically based on responses to previous
marketing activities.

6. Select an option in the Execution Type field.

The following options execute the marketing activity a single time:

• One-off, execute selection/query: When generating the records, the selection
or query is updated and the used to determine the target group.

• One-off, do not execute selection/query: When generating the records, the
selection or query is not updated. Those companies already stored in the
selection are used to generate the target group.

• One-off, only response processing: The target group is generated
automatically based on responses to the previous marketing activity or by
editing the target group manually.
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The following options execute the marketing activity a repeatedly (in the interval
defined in the Repeated: Frequency and Repeated: Frequency (Unit) fields on
the Repeat tab):

• Repeated, always execute selection/query: The existing target group is
deleted each time the activity is executed. The selection or query is updated,
and the results are used to create the new target group.

Note:  If a target group record is marked as inactive (the Inactive field is
enabled), the record remains inactive if the record is still in the selection after
the selection has been refreshed.

• Repeated, execute selection once: The selection is updated when generating
the target group. The selection is not updated when the execution is
subsequently repeated.

• Repeated, never execute selection: The selection is not updated when
generating the target group. The selection is not updated when the execution
is subsequently repeated.

• Repeated, only response processing:The target group is generated
automatically based on responses to the previous marketing activity or by
editing the target group manually.

• Repeated, packages: The target group is generated from the selection or query
the first time the activity is executed. Each time the marketing activity is
executed, records are generated for members of the target group that have not
yet been contacted. The Max. package size on the Automat. tab determines
the maximum number of records in the target group that are processed each
iteration. The marketing activity continues to be executed until all persons in
the target group have been contacted. Typically used for mailings that for
reasons of cost or logistics cannot be handled in one go.

• Repeated, extend selection/query: The selection or query is extended each
time the marketing activity is executed. The existing target group records are
retained. Only those companies/persons returned by the selection/query and
not included in the target group are added to the target group. The marketing
activity is executed for these recently added records. Typically used for mailings
to customers, e.g. to contact all companies that have had their status set to
"Customer" since the last time the activity was executed.

Note:  If you select a query, you need to select an execution type that executes
the query at least once.

7. Enable the Create target group check box on the Target Group tab to use the
selection or query to generate the target group.

8. Enter the time period available for processing the target group in the Edit target
group from, Edit target group until, Edit target group from (Time) and Edit
target group until (Time) fields.

9. Enter the rep assigned to CRM.server in the Executing Rep ID field. If you are
unsure which rep this is, ask your administrator. This ensures that CRM.server
processes the execution automatically.

10.Enable the Start automatically check box.
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11.Define additional options in the following tabs:

• Generate: Enter when records (such as activities) should be generated and
until when responses can be entered.

• Activities: Details on the generated activities and information on surveys

• Mailings: Details on the generated mailings

• Work Orders: Details on the generated work orders.

• Send: Information on the contents of the information that is sent, e.g. the
e-mail’s text; settings for surveys sent out in e-mails.

Note: You cannot generate mail merges in Microsoft Word on the web server.
Once the marketing activity has been executed, you can download the control
file and perform the mail merge locally in Microsoft Word. The control file can
be accessed from the Control Files available below the mask. If you enable
the Save letters option on the Send tab, the customer data in the control file
can be linked to the sent text after the letters have been sent. This allows you
to reconstruct the letter that was sent.

Your administrator can add a button or menu option that you can use to generate
the mail merge in Microsoft Word, see Mail Merge Letters Based on Marketing
Activities in the Aurea CRM web Administrator Guide.

• Repeat: Time period and frequency with which the marketing activity is repeated

• Automat.: Details relating to the automatic execution of the marketing activity;
package size for marketing activities that are carried out in packages

The Log tab displays status information which is entered during the execution of
the activity.

For more information on the individual fields, refer to the online field help.

12.Save the record.

Defining the Marketing Activity Format

You (or the executing rep) can define fur ther details in the marketing activity format:

To define a marketing activity format:

1. Select Create Marketing Activity Format from the activity or execution’s context
menu.

2. Determine how to contact your target group under Preferred Channel:

• Fixed: The channel used for all recipients (phone, letter, e-mail, SMS, fax).

• Variable: The channel entered as the Preferred Channel for the person is
used (assuming that the necessary information is also present, e.g. an e-mail
address).

3. If activities, mailings and/or work orders should be generated within the scope of
the marketing activity, enable the corresponding options under Generate. Activities
are added as appointments for the telemarketing reps or account managers. Work
orders contain tasks to be executed within the scope of regular customer
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appointments. Mailing records provide a log of mailings, the responses and the
results of a letter or e-mail.

• If you have selected a fixed channel or not specified a channel, select the
appropriate type (e.g. Activity for the phone channel).

• If you have chosen variable channels, select all the applicable options. The
first option that is selected in the order mailing, activity, work order is taken
into account (when using the phone channel, only activity or work order).

4. Use the tabs in the lower por tion of the screen to determine fur ther settings for
all channels apart from "Phone":

• Transfer Fields: Select the predefined transfer fields. These fields are
transferred to the mail merge document or control file when generating the
activity.

• Company & Person and Company: Select the label (for printed labels and
greetings in letters, faxes, SMS and e-mails) to use if no label is entered for
the company or person: The label selected in the Company & Person field is
used for person-specific letters and the label selected in Company is used for
company-specific letters.

• Additional Address: The additional address selected here is used. If no
additional address is defined for the company, the company or person’s normal
address is used.

E-mail mailings are sent only to those persons or companies for which an e-
mail address has been entered. The e-mail fields are used in the following order:

For persons:

1. E-mail 1

2. E-mail 2

3. If an address type has been selected in the Additional Address field, the
first additional address found for the person is used.

4. The e-mail address of the person's company (determined as described below).

For companies:

1. If an address type is selected in the Additional Address field and an address
of the same type exists for the company in the Additional Address info area,
the e-mail address entered there is used.

2. E-mail 1

3. E-mail 2

If none of the fields contains an e-mail address, no e-mail is sent to this com-
pany or person.

• Ignore assigned labels: Replaces the label formats defined for companies
and/or persons by a uniform label format.

• Language Transformation: All catalog values are transferred to Microsoft
Word in the language entered for the person.
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• Format: The control file’s format:

• Variable field length/Fixed field length: Determines whether records are
output with separators or using a fixed field length.

• Assign numbers: Records are numbered sequentially.

• Separator: Select the characters used as separators in the control file. Specify
the separator between each Record and Field, and the Field border (at the
star t and end of a field).

5. Save the record. The marketing activity format is transferred to the Marketing
Activity Format field in the execution record.

Surveys in Mass E-mails

Surveys can be integrated in e-mails. Recipients receive an e-mail containing a link
to an HTML page where they can answer the questions. The answers are stored in
Aurea CRM’s database for the corresponding person.
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To generate e-mails with an integrated questionnaire:

1. Define a questionnaire.
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The questionnaire can include questions with multiple and text-based answers.
The following is not supported:

• Skipping questions that depend on the answer to a previous question

• Default answers using data in the database

• Mandatory questions

• Automatically adding records based on answers

• Executing triggers

2. Generate an HTML page based on the questionnaire:

a. Select  (Administration) > SDK (this requires administrator privileges).

b. Select Surveys > External Survey.

c. Enter the first letter of the name of the questionnaire under step 1 (Select a
Survey) and select the desired questionnaire from the list.

d. Click on the download link in step 2 (Options).

e. You can change the content by either editing the HTML file or by editing the
Razor template (web\data\surveys\crm\survey.cshtml) used to generate the
HTML file. For more information, see the ar ticle “EXTERNAL Survey
Architecture” at https://support.aurea.com.

f. Upload the HTML page to the web server so that it is accessible from the link
in the e-mail sent to recipients.
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3. Define a transfer fields format containing the fields in the Person and Person in
Company info areas you want to use in the e-mail.

4. Create the e-mail using person data as in the example below:

The placeholders beginning with "KP" reference the transfer fields in the Person
in Company (KP) info area.

The <%LinkQuestionnaire%> placeholder contains generates a link to the ques-
tionnaire.

5. Add a marketing activity.

6. Add an execution record for the marketing activity and enter data in the following
fields:

• Marketing Activity Format, Execution Type, Base, Target group definition,
>> on page 271.

• Subject: The e-mail’s subject

• E-mail: Template Document: E-mail template for unpersonalized e-mails

• Template Document (TXT): E-mail template for personalized e-mails

• E-mail: Send as: Select "HTML" to ensure that the link to the questionnaire is
displayed correctly.

• E-mail from: The e-mail address used as the sender of the e-mail

• E-mail: not personalized: Enable this option to determine that no personal
information should be included in the e-mail.

• Send questionnaire:Enable this option.
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• Questionnaire (e-mail): Choose the questionnaire you prepared earlier.

• Web server address: Enter the full URL of the HTML file, e.g.
http://my.company.com/Questionnaire/CustomerSatisfaction.html.

7. Switch to the marketing activity format.

• Select E-mail and Activity in the Preferred Channel section.

• Enter the transfer fields format on the E-mail tab.

8. Execute the activity.

Responses
You can enter the possible response to a marketing activity, which allows you to:

• Define follow-up activities, for example, to send an offer to those respondents
who react positively to the first telephone contact.

• Review responses and count the number of responses of each type in order to
determine the success of the marketing activity.
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To define the follow-up response and assign points to a response:

1. Define two marketing activities.The second marketing activity should be dependent
on a specific response being given to the first one.

2. Add a response to the first marketing activity.

3. Enter the Response (e.g. "Yes, send me an offer").

4. Select the second marketing activity in the Follow-up Marketing Activity field.

If this response is received, the respondent is automatically assign to the follow-
up activity’s target group.

5. Enter the number of points assigned to this response in the Individual Points
field on the Numbers & Points tab and enter the expected number of responses
in the Number (Target) field. The target and actual points can then be compared
in the statistics, >> on page 279.

6. Save the record.

Reps
Add the reps who are responsible for handling the campaign in addition to the rep
responsible for the campaign itself:

1. Click on  (New) on the Reps tab or select New > New Marketing Activity Rep
from the context menu.

2. Enter the desired rep in the Rep ID field.
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3. Determine the rep's task(s):

• Telephone: Indicates whether the rep is responsible for making or answering
phone calls within the scope of this marketing activity.

• E-mail: Indicates whether the rep is responsible for processing incoming e-mails
within the scope of the marketing activity.

• Target Group: Indicates whether the rep is responsible for verifying and editing
a portion of the target group. The rep receives a To-Do once the target group
has been generated.

Note: Note: The Telephone and E-mail fields have no function in the default
configuration.

4. Save the record.

Defining How the Activity is Executed
The Execution (Marketing Activity) info area is used to store all the important in-
formation needed to execute the marketing activity:

• Target group

• Schedule

• Data entered in activities, mailings and work orders

• File formats and other information on mailings, e-mails, SMS and faxes.

To enter the details of how a marketing activity is executed:

1. Select Create / Edit Execution from the marketing activity’s context menu.

2. Select a Marketing Activity Format or select Create Marketing Activity Format
from the context menu to add a new one, >> on page 273.

3. Enter the Start Date and Start Time to determine when the marketing activity
should be executed and the target group generated.

4. Use the Base field to determine the basis for the target group. The target group
can be determined using a selection, a global query or a private query, >> on
page 77.

Note:  Selections are defined in Aurea CRM win.

5. Select a predefined query or selection in the Target group definition field.

Note: Note: Leave this field empty for follow-up activities. The target groups for
follow-up activities are generated automatically based on responses to previous
marketing activities.

650AUREA CONFIDENTIAL

Chapter 25: Campaigns and Marketing Activities



6. Select an option in the Execution Type field.

The following options execute the marketing activity a single time:

• One-off, execute selection/query: When generating the records, the selection
or query is updated and the used to determine the target group.

• One-off, do not execute selection/query: When generating the records, the
selection or query is not updated. Those companies already stored in the
selection are used to generate the target group.

• One-off, only response processing: The target group is generated
automatically based on responses to the previous marketing activity or by
editing the target group manually.

The following options execute the marketing activity a repeatedly (in the interval
defined in the Repeated: Frequency and Repeated: Frequency (Unit) fields on
the Repeat tab):

• Repeated, always execute selection/query: The existing target group is
deleted each time the activity is executed. The selection or query is updated,
and the results are used to create the new target group.

Note: Note: If a target group record is marked as inactive (the Inactive field
is enabled), the record remains inactive if the record is still in the selection
after the selection has been refreshed.

• Repeated, execute selection once: The selection is updated when generating
the target group. The selection is not updated when the execution is
subsequently repeated.

• Repeated, never execute selection: The selection is not updated when
generating the target group. The selection is not updated when the execution
is subsequently repeated.

• Repeated, only response processing:The target group is generated
automatically based on responses to the previous marketing activity or by
editing the target group manually.

• Repeated, packages: The target group is generated from the selection or query
the first time the activity is executed. Each time the marketing activity is
executed, records are generated for members of the target group that have not
yet been contacted. The Max. package size on the Automat. tab determines
the maximum number of records in the target group that are processed each
iteration. The marketing activity continues to be executed until all persons in
the target group have been contacted. Typically used for mailings that for
reasons of cost or logistics cannot be handled in one go.

• Repeated, extend selection/query: The selection or query is extended each
time the marketing activity is executed. The existing target group records are
retained. Only those companies/persons returned by the selection/query and
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not included in the target group are added to the target group. The marketing
activity is executed for these recently added records. Typically used for mailings
to customers, e.g. to contact all companies that have had their status set to
"Customer" since the last time the activity was executed.

Note: Note: If you select a query, you need to select an execution type that
executes the query at least once.

7. Enable the Create target group check box on the Target Group tab to use the
selection or query to generate the target group.

8. Enter the time period available for processing the target group in the Edit target
group from, Edit target group until, Edit target group from (Time) and Edit
target group until (Time) fields.

9. Enter the rep assigned to CRM.server in the Executing Rep ID field. If you are
unsure which rep this is, ask your administrator. This ensures that CRM.server
processes the execution automatically.

10.Enable the Start automatically check box.

11.Define additional options in the following tabs:

• Generate: Enter when records (such as activities) should be generated and
until when responses can be entered.

• Activities: Details on the generated activities and information on surveys

• Mailings: Details on the generated mailings

• Work Orders: Details on the generated work orders, >> on page 152.

• Send: Information on the contents of the information that is sent, e.g. the
e-mail’s text; settings for surveys sent out in e-mails.

Note: Note: You cannot generate mail merges in Microsoft Word on the web
server. Once the marketing activity has been executed, you can download the
control file and perform the mail merge locally in Microsoft Word. The control
file can be accessed from the Control Files available below the mask. If you
enable the Save letters option on the Send tab, the customer data in the control
file can be linked to the sent text after the letters have been sent. This allows
you to reconstruct the letter that was sent, >> on page 170.Your administrator
can add a button or menu option that you can use to generate the mail merge
in Microsoft Word, >> Mail Merge Letters Based on Marketing Activities in the
Aurea CRM web Administrator Guide.

• Repeat: Time period and frequency with which the marketing activity is repeated

• Automat.: Details relating to the automatic execution of the marketing activity;
package size for marketing activities that are carried out in packages
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The Log tab displays status information which is entered during the execution of
the activity.

For more information on the individual fields, refer to the online field help.

12.Save the record.

Defining the Marketing Activity Format
You (or the executing rep) can define fur ther details in the marketing activity format:

To define a marketing activity format:

1. Select Create Marketing Activity Format from the activity or execution’s context
menu.

2. Determine how to contact your target group under Preferred Channel:

• Fixed: The channel used for all recipients (phone, letter, e-mail, SMS, fax).

• Variable: The channel entered as the Preferred Channel for the person is
used (assuming that the necessary information is also present, e.g. an e-mail
address).

3. If activities, mailings and/or work orders should be generated within the scope of
the marketing activity, enable the corresponding options under Generate. Activities
are added as appointments for the telemarketing reps or account managers. Work
orders contain tasks to be executed within the scope of regular customer
appointments. Mailing records provide a log of mailings, the responses and the
results of a letter or e-mail.

• If you have selected a fixed channel or not specified a channel, select the
appropriate type (e.g. Activity for the phone channel).

• If you have chosen variable channels, select all the applicable options. The
first option that is selected in the order mailing, activity, work order is taken
into account (when using the phone channel, only activity or work order).

4. Use the tabs in the lower por tion of the screen to determine fur ther settings for
all channels apart from "Phone":

• Transfer Fields: Select the predefined transfer fields, >> on page 266. These
fields are transferred to the mail merge document or control file when generating
the activity.

• Company & Person and Company: Select the label (for printed labels and
greetings in letters, faxes, SMS and e-mails) to use if no label is entered for
the company or person: The label selected in the Company & Person field is
used for person-specific letters and the label selected in Company is used for
company-specific letters.
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• Additional Address: The additional address selected here is used. If no
additional address is defined for the company, the company or person’s normal
address is used.

E-mail mailings are sent only to those persons or companies for which an e-
mail address has been entered. The e-mail fields are used in the following order:

For persons:

1. E-mail 1

2. E-mail 2

3. If an address type has been selected in the Additional Address field, the
first additional address found for the person is used.

4. The e-mail address of the person's company (determined as described below).

For companies:

1. If an address type is selected in the Additional Address field and an address
of the same type exists for the company in the Additional Address info area,
the e-mail address entered there is used.

2. E-mail 1

3. E-mail 2

If none of the fields contains an e-mail address, no e-mail is sent to this com-
pany or person.

• Ignore assigned labels: Replaces the label formats defined for companies
and/or persons by a uniform label format.

• Language Transformation: All catalog values are transferred to Microsoft
Word in the language entered for the person.

• Format: The control file’s format:

• Variable field length/Fixed field length: Determines whether records are
output with separators or using a fixed field length.

• Assign numbers: Records are numbered sequentially.

• Separator: Select the characters used as separators in the control file. Specify
the separator between each Record and Field, and the Field border (at the
star t and end of a field).

5. Save the record. The marketing activity format is transferred to the Marketing
Activity Format field in the execution record.
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Surveys in Mass E-mails
Surveys can be integrated in e-mails. Recipients receive an e-mail containing a link
to an HTML page where they can answer the questions. The answers are stored in
Aurea CRM’s database for the corresponding person.
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To generate e-mails with an integrated questionnaire:

1. Define a questionnaire, >> on page 161.

The questionnaire can include questions with multiple and text-based answers.
The following is not supported:

• Skipping questions that depend on the answer to a previous question

• Default answers using data in the database

• Mandatory questions

• Automatically adding records based on answers

• Executing triggers

2. Generate an HTML page based on the questionnaire:

a. Select  (Administration) > SDK (this requires administrator privileges).

b. Select Surveys > External Survey.

c. Enter the first letter of the name of the questionnaire under step 1 (Select a
Survey) and select the desired questionnaire from the list.

d. Click on the download link in step 2 (Options).
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e. You can change the content by either editing the HTML file or by editing the
Razor template (web\data\surveys\crm\survey.cshtml) used to generate the
HTML file. For more information, see the ar ticle “EXTERNAL Survey
Architecture” at https://support.aurea.com.

f. Upload the HTML page to the web server so that it is accessible from the link
in the e-mail sent to recipients.

3. Define a transfer fields format containing the fields in the Person and Person in
Company info areas you want to use in the e-mail.

4. Create the e-mail using person data as in the example below:

The placeholders beginning with "KP" reference the transfer fields in the Person
in Company (KP) info area.

The <%LinkQuestionnaire%> placeholder contains generates a link to the ques-
tionnaire.

5. Add a marketing activity.
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6. Add an execution record for the marketing activity and enter data in the following
fields:

• Marketing Activity Format, Execution Type, Base, Target group definition,
>> on page 271.

• Subject: The e-mail’s subject

• E-mail: Template Document: E-mail template for unpersonalized e-mails

• Template Document (TXT): E-mail template for personalized e-mails

• E-mail: Send as: Select "HTML" to ensure that the link to the questionnaire is
displayed correctly.

• E-mail from: The e-mail address used as the sender of the e-mail

• E-mail: not personalized: Enable this option to determine that no personal
information should be included in the e-mail.

• Send questionnaire:Enable this option.

• Questionnaire (e-mail): Choose the questionnaire you prepared earlier.

• Web server address: Enter the full URL of the HTML file, e.g.
http://my.company.com/Questionnaire/CustomerSatisfaction.html.
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7. Switch to the marketing activity format (>> on page 273).

• Select E-mail and Activity in the Preferred Channel section.

• Enter the transfer fields format on the E-mail tab.

8. Execute the activity, >> on page 278.

Target Group
Learn how to create and edit target group for marketing activities.

To create a target group, click on Create Target Group in the marketing activity or
execution record.

Note: This button is only active if an execution record has been defined for the
marketing activity and your administrator has defined a CRM.server user ID.
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The following fields are entered automatically:

• Execution status: empty

• Start automatically: enabled

• Executing Rep ID: the CRM.server user ID defined by your administrator

• Starts on: the current date

• Starts at: the current time + 10 seconds

• Create target group: enabled

If the Target group definition field contains an entry, the target group is created.

Note:  If you do not create the target group yourself, it is generated automatically
as the time entered in the execution record (Starts on/at).

The reps assigned to edit the target group receive a To-Do once the target group
has been generated.

Editing Target Groups

To edit a target group:

1. Switch to the Target Group tab in the marketing activity. The target group
generated automatically is displayed.

2. Edit the target group:

• Click on  (Add Company),  (Add Person in Company or Add Person) or

 (Add Company from Favorites, Add Person in Company from Favorites
or Add Person from Favorites) to add fur ther companies or persons to the
target group.

Star t the search and select one or more records in the results list. Select Select
from a selected record’s context menu. The selected records are added to the
target group.

Note: You cannot add a person (PE) to the target group if you have already
added the person to the target group as a person in company (KP).

• Remove records from the target group by enabling the Inactive check box.

Always set the records that should not be included in the target group to Inactive
instead of deleting them from the target group. This ensures that another user
does not add the record to the target group a second time.

Note: The list of target group records includes fields from the Company and Person
info areas. Depending on your configuration, you can sor t records in the list of target
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group members using these fields by clicking on the column header. The sor t order
is not saved; if you reopen this area, the sor t order is reset.

Editing Target Groups
To edit a target group:

1. Switch to the Target Group tab in the marketing activity. The target group
generated automatically is displayed.

2. Edit the target group:

• Click on  (Add Company),  (Add Person in Company or Add Person) or

 (Add Company from Favorites, Add Person in Company from Favorites
or Add Person from Favorites) to add fur ther companies or persons to the
target group.

Star t the search and select one or more records in the results list. Select Select
from a selected record’s context menu. The selected records are added to the
target group.

Note: Note: You cannot add a person (PE) to the target group if you have
already added the person to the target group as a person in company (KP).

• Remove records from the target group by enabling the Inactive check box.

Always set the records that should not be included in the target group to Inactive
instead of deleting them from the target group. This ensures that another user
does not add the record to the target group a second time.

Note: Note: The list of target group records includes fields from the Company and
Person info areas. Depending on your configuration, you can sor t records in the
list of target group members using these fields by clicking on the column header.
The sor t order is not saved; if you reopen this area, the sor t order is reset.
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Executing Marketing Activities
Learn how to run the marketing activities and edit generated records.

To execute a marketing activity:

1. Click on Start Marketing Activity in the marketing activity or execution record.
A message is displayed informing you that the activity is star ted.

Note: This button is only active if an execution record has been defined for the
marketing activity and your administrator has defined a CRM.server user ID.

The following fields are entered automatically:

• Execution status: empty

• Start automatically: enabled

• Executing Rep ID: the CRM.server user ID defined by your administrator

• Edit target group until: The current date (if the field was not empty)

• Edit target group until (Time): The current time plus 10 seconds (if the field
was not empty)

• Gen. Date (Scheduled): The current date

• Gen. Time (Scheduled): The current time plus 10 seconds

• Starts on: the current date (if the field was empty)

• Starts at: the current time + 10 seconds (if the field was empty)

If the date in the Starts on field is between the campaign's star t and end date, the
marketing activity is executed.

1. If you do not star t the activity manually, CRM.server executes the marketing
activity at the time defined in the execution record (Gen. Date (Scheduled) field).

You receive a message relating to the execution of the activity.

The following actions are performed:

• E-mails or SMS are sent to the target group and related information is stored in
a mailing record.

Note: Administrator Information: You can define an e-mail address in the
Configuration info area that all e-mails are also sent to as a blind carbon copy,
see Configuration > Campaigns in the CRM.core Administrator Guide.

• Activities and work orders are generated for fur ther processing.

• Control files for mail merges and faxes are created.
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Check whether the generation was successful:

• If a target group exists, the Executed check box is automatically enabled for each
record that is processed successfully. (This field is not visible in the default
configuration.)

• A log entry is added each time that records are generated for the marketing
activity. Select Go to All Related > All Logs from the context menu to display
the log entries.

You can now edit the generated data:

Editing Generated Records

To edit the records generated for a marketing activity:

• Contact the recipients and store their response(s) in the Response 1 (Marketing
Act.) - Response 5 (Marketing Act.) fields in the activity or mailing. If a follow-up
activity is defined for the response, the customer/prospect is immediately assigned
to the follow-up activity's target group. The result defined for the response in the
Result field in the Response (Marketing Activity) info area is transferred to the
Result field of the activity or mailing.

• If carrying out a survey is par t of executing the activity, call the appropriate person,
select Start Survey from the activity’s context menu and complete the
questionnaire.

• Enter the Time and/or Duration in the activity record.

• Set the status of the activity to "Completed" and enter the appropriate result (e.g.
"Successful").

Editing Generated Records
To edit the records generated for a marketing activity:

• Contact the recipients and store their response(s) in the Response 1 (Marketing
Act.) - Response 5 (Marketing Act.) fields in the activity or mailing. If a follow-up
activity is defined for the response, the customer/prospect is immediately assigned
to the follow-up activity's target group. The result defined for the response in the
Result field in the Response (Marketing Activity) info area is transferred to the
Result field of the activity or mailing.

• If carrying out a survey is par t of executing the activity, call the appropriate person,
select Start Survey from the activity’s context menu and complete the
questionnaire, >> on page 163.

• Enter the Time and/or Duration in the activity record.

• Set the status of the activity to "Completed" and enter the appropriate result (e.g.
"Successful").
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Calculating Statistics
Learn how to monitor the success and status of campaigns and marketing activities
by performing statistical calculations.

You can do this by clicking on  (Calculate) in the campaign or marketing activity
record.

Based on the responses received, the success of a marketing activity is determined
by comparing the actual results with the target results. The success of a campaign
is calculated based on the success of the individual activities that make up the
campaign.

The statistics for a marketing activity are available from the Statistics tab and
contain information on the number of responses, the points scored and statistics
concerning the activities, mailings and work orders generated within the scope of
the marketing activity. You can edit the Weighting field in the statistics to determine
the weighting of the marketing activity within the campaign’s statistics.

The statistics for a campaign are stored in various tabs in the campaign record and
include details on the target number of mailings, activities and works orders and
the total points scored by the responses. Furthermore, an overview of the associated
costs in the default currency is available from the Costs tab.

The following charts illustrate how costs and points are calculated for individual
fields:
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Costs
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Campaign costs calculated based on data entered in the Attendee, Agenda Item
and Equipment info areas are updated whenever you add a new record or edit an
existing one. You can also click on Calculate in the Campaign info area to calculate
the costs.

Costs related to the campaign that are distributed amongst attendees with the par-
ticipation status "Participated" are not updated automatically. Click on Calculate to
distribute these costs.

Points
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Campaign costs calculated based on data entered in the Attendee, Agenda Item
and Equipment info areas are updated whenever you add a new record or edit an
existing one. You can also click on Calculate in the Campaign info area to calculate
the costs.

Costs related to the campaign that are distributed amongst attendees with the par-
ticipation status "Participated" are not updated automatically. Click on Calculate to
distribute these costs.

Points
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Campaign Graph
The Graph tab in a campaign or marketing activity record displays the structure of
the campaign graphically. The campaign is displayed at the top. Marketing activities
in the campaign are displayed with rounded corners, responses are displayed in
ovals.

The following options are available:

• Drag the graph to move it.

• Use your mouse wheel to zoom.

• Double-click on an empty area in the graph to revert the zoom level to 100%.

• Double-click on an element in the graph (campaign, marketing activity or response)
to open the corresponding record.
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26
Campaign Management (Enterprise CRM)
– LSI and FSI
Learn to design and manage marketing campaign in Aurea CRM.

Campaign Management (Enterprise CRM) overview
The Campaign designer allows you to quickly create a campaign in an intuitive way
and uses a graphical representation to make the campaign design process simple.

You can create campaigns and their marketing activities with clear representation
of the works flows involved. Campaigns, marketing activities, and response are
represented as containers in the graphical view.

Note:  Campaign management is an enterprise feature, you need to have enterprise
license for Aurea CRM to use this feature.

Components of the Campaign Management:

• Campaign calendar

• Campaign Designer

Working with Campaign Calendar
The campaign calendar shows all the campaigns and marketing activities.

You can star t a new campaign from this window by clicking the Create New Campaign
button. You can also select and open a campaign shown in this window to open it
in the campaign designer.

The following screenshot shows a campaign calendar.
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The campaign calendar tab at the top is visible when you open any campaign.

Working with Campaign Designer
You can create, edit, and delete campaigns and their marketing activities in the
campaign designer.

You can create a new campaign using an existing campaign as a template or create
a new campaign from scratch.

Creating a new campaign from scratch

To create a new campaign from scratch, perform the following steps:

1. Click the Marketing menu icon, and select New Campaign from the menu.

2. Click Empty Campaign.

3. Enter the following details in the New Campaign window:

Note:  All fields that are in orange are mandatory fields.

• Name – Enter a name for the campaign. (Mandatory field)

• Starts On – Enter the star t date of the campaign. (Mandatory field)
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• Type – Select the type of the campaign: Event; Questionnaire; or User
Satisfaction. (Mandatory field)

• Target Group Size (Target) – Enter the number of recipients expected to
participate in the campaign.

• Ends On – Enter the end date of the campaign.

• Status – Select the status of the campaign. (Mandatory field)

• Costs: Enter the estimated cost of the campaign.

• Currency – Enter the currency in which the campaign cost is estimated.

• Resp.Rep  ID – Enter the ID of the responsible rep for the campaign.

• Budget approval required – Select the check box if an approval is required
for the estimated budget of the campaign.

• Verification required – Select the check box if a verification is required for
the campaign.

4. Click Save. The Campaign Designer opens.

5. To add marketing activity to the campaign, click the context menu on the right of
the campaign container. You can select an existing marketing activity or create
a new marketing activity from scratch.
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• To use an existing marketing activity:

1. From the context menu select Reuse Marketing Activity. The Reuse
Marketing Activity window opens.

2. Search for the marketing activities from a campaign and select it from the
search list.

3. Enter a New Star t Date for the marketing activity, in the resulting window.

Note:  If you do not provide a star t date for the marketing activity then the
star t date on the reused marketing activity is used as star t date.

4. Click OK. The marketing activity and its descendent marketing activities are
added to the campaign designer.

5. Next you can make fur ther additions to the marketing activity.

• To create a new marketing activity:

1. From the context menu select New Marketing Activity. The New Marketing
Activity window opens.
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2. Enter the following details for the new marketing activity:

• Marketing activity – Select the marketing activity type from the following:
Confirmation, Event, Follow-up, Invitation, Survey, Survey-remainder.
(Mandatory field)

• Starts on – The star t date for the marketing activity.

• Ends-on – The end date for the marketing activity.

• Resp.Rep ID – The ID of the rep responsible for the marketing activity.

• Costs – The estimated cost of the marketing activity.

• Currency – Select the currency the cost is estimated in.

• Text – Provide a description and other relevant information in this text
field.

3. Click Save to create the new marketing activity container in the campaign

designer.

Note:  A blue arrow points from the campaign container to the marketing
activity container.

4. In the next step you need to define some responses for this marketing activity.

6. The context menu for the marketing activity container allows you to perform the
following: Define responses, Channel and Format definition; Target group and
Execution definition; Edit Target group; Notify Rep; Edit/View Responses
(Activities); Edit the marketing activity; Delete; Delete (including Generated
Record).

In this case we define a response to the survey marketing activity, we have de-
fined.

7. Select Define Responses from the context menu. A pop-up window is displayed.
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Note: The list of available responses are defined in the catalog entries for
marketing activities. If no entries are present you get the catalog entries window
and you have to define the response catalog entries in that window.

8. Select the responses you want to define and click OK. The responses are added
to the graph view under marketing activity container.

Now you can fur ther define the follow-up marketing activity to the responses de-
fined above.

9. To define a follow-up marketing activity, select the Define Follow-up Marketing
Activity from the context menu for the “No Response” container. The New
Follow-up Marketing Activity window displays.

This window gives you the option to create a new follow-up marketing activity or
use an existing one.

10.To create a new marketing activity or to reuse an existing one, perform the
sub-steps described in step 5. In this case we add a follow-up marketing activity
(Survey Reminder) to the No Response marketing activity.
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11.Next we define the responses to the Survey Reminder follow-up marketing activity.
Select Define Responses from the context menu. The Responses (Survey
Reminder) window opens.

12.Select Finished and No Response options and click OK.

13.Next we want to send the survey reminder to those who have not responded. This
loops the defined actions. To do this, select Define Follow-up marketing activity
from the context menu of the No Response container.
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14.Click Use Existing button.

Note:  Since we want to send a survey reminder from the same campaign named
“Questionnaire” we restrict the search content to the Questionnaire campaign.
By changing the Context to Entire Database you can search for and add marketing
activity from other Campaigns. To do that it is recommended that you use the
Re-use Marketing Activity function described in step 5.

15.Click Start Search and select Survey Reminder from the search result.

16.Next a confirmation follow-up marketing activity is added to the Finished Survey
activity. To do this select Define Follow-up Marketing Activity from the Finished
Survey context menu. To create a new marketing activity, perform the sub-steps
described in step 5. In this case we add a new follow-up marketing activity
(Confirmation) to the Finished Survey activity.
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Viewing a campaign

To view an existing campaign, perform the following:

1. Select Campaigns from the Marketing menu of CRM web.

2. The Search Campaigns window opens. Enter the required criteria and click
Search. The search results displays the list of campaigns.

Notice that the campaigns list shows the status and type of the campaign.

3. Select a campaign and double click it to open it in the campaign designer.
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Deleting a Campaign from designer

To delete a campaign from a campaign designer:

1. Open the campaign in a campaign designer.

2. Click the context menu from the campaign container.

3. Select the Delete option. The Question window pops up with the query “Do you
really want to delete the selected record(s)?”

4. Click OK to confirm the deletion.

Note:  Please note that this deletes the campaign along with all the activities in
the campaign.

Viewing the Campaign Statistics

To view a campaign’s statistics:

1. On the Campaign container, click to expand the container. The Statistics button
is visible.

2. Click the Statistics button or select Statistics from the campaign container
context menu.
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Note: The statistics shown in the Statistics window is calculated in the Edit
Campaign window, as shown in the screenshot below.

Viewing a campaign
Learn how to view an existing campaign.

To view an existing campaign, perform the following:

1. Select Campaigns from the Marketing menu of CRM web.

2. The Search Campaigns window opens. Enter the required criteria and click
Search. The search results displays the list of campaigns.

Notice that the campaigns list shows the status and type of the campaign.

3. Select a campaign and double click it to open it in the campaign designer.
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Creating a new campaign from scratch
This topic guides you to create a new campaign from scratch.

To create a new campaign from scratch, perform the following steps:

1. Click the Marketing menu icon, and select New Campaign from the menu.

2. Click Empty Campaign.

3. Enter the following details in the New Campaign window:

Note:  All fields that are in orange are mandatory fields.

• Name – Enter a name for the campaign. (Mandatory field)

• Starts On – Enter the star t date of the campaign. (Mandatory field)

• Type – Select the type of the campaign: Event; Questionnaire; or User
Satisfaction. (Mandatory field)

• Target Group Size (Target) – Enter the number of recipients expected to
participate in the campaign.

• Ends On – Enter the end date of the campaign.

• Status – Select the status of the campaign. (Mandatory field)

• Costs: Enter the estimated cost of the campaign.

• Currency – Enter the currency in which the campaign cost is estimated.

• Resp.Rep  ID – Enter the ID of the responsible rep for the campaign.
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• Budget approval required – Select the check box if an approval is required
for the estimated budget of the campaign.

• Verification required – Select the check box if a verification is required for
the campaign.

4. Click Save. The Campaign Designer opens.

5. To add marketing activity to the campaign, click the context menu on the right of
the campaign container. You can select an existing marketing activity or create
a new marketing activity from scratch.

• To use an existing marketing activity:

1. From the context menu select Reuse Marketing Activity. The Reuse
Marketing Activity window opens.

2. Search for the marketing activities from a campaign and select it from the
search list.

3. Enter a New Star t Date for the marketing activity, in the resulting window.
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Note:  If you do not provide a star t date for the marketing activity then the
star t date on the reused marketing activity is used as star t date.

4. Click OK. The marketing activity and its descendent marketing activities are
added to the campaign designer.

5. Next you can make fur ther additions to the marketing activity.

• To create a new marketing activity:

1. From the context menu select New Marketing Activity. The New Marketing
Activity window opens.

2. Enter the following details for the new marketing activity:

• Marketing activity – Select the marketing activity type from the following:
Confirmation, Event, Follow-up, Invitation, Survey, Survey-remainder.
(Mandatory field)

• Starts on – The star t date for the marketing activity.

• Ends-on – The end date for the marketing activity.

• Resp.Rep ID – The ID of the rep responsible for the marketing activity.

• Costs – The estimated cost of the marketing activity.
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• Currency – Select the currency the cost is estimated in.

• Text – Provide a description and other relevant information in this text
field.

3. Click Save to create the new marketing activity container in the campaign

designer.

Note:  A blue arrow points from the campaign container to the marketing
activity container.

4. In the next step you need to define some responses for this marketing activity.

6. The context menu for the marketing activity container allows you to perform the
following: Define responses, Channel and Format definition; Target group and
Execution definition; Edit Target group; Notify Rep; Edit/View Responses
(Activities); Edit the marketing activity; Delete; Delete (including Generated
Record).

In this case we define a response to the survey marketing activity, we have de-
fined.

7. Select Define Responses from the context menu. A pop-up window is displayed.
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Note: The list of available responses are defined in the catalog entries for
marketing activities. If no entries are present you get the catalog entries window
and you have to define the response catalog entries in that window.

8. Select the responses you want to define and click OK. The responses are added
to the graph view under marketing activity container.

Now you can fur ther define the follow-up marketing activity to the responses de-
fined above.

9. To define a follow-up marketing activity, select the Define Follow-up Marketing
Activity from the context menu for the “No Response” container. The New
Follow-up Marketing Activity window displays.

This window gives you the option to create a new follow-up marketing activity or
use an existing one.

10.To create a new marketing activity or to reuse an existing one, perform the
sub-steps described in step 5. In this case we add a follow-up marketing activity
(Survey Reminder) to the No Response marketing activity.

11.Next we define the responses to the Survey Reminder follow-up marketing activity.
Select Define Responses from the context menu. The Responses (Survey
Reminder) window opens.
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12.Select Finished and No Response options and click OK.

13.Next we want to send the survey reminder to those who have not responded. This
loops the defined actions. To do this, select Define Follow-up marketing activity
from the context menu of the No Response container.

14.Click Use Existing button.
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Note:  Since we want to send a survey reminder from the same campaign named
“Questionnaire” we restrict the search content to the Questionnaire campaign.
By changing the Context to Entire Database you can search for and add marketing
activity from other Campaigns. To do that it is recommended that you use the
Re-use Marketing Activity function described in step 5.

15.Click Start Search and select Survey Reminder from the search result.

16.Next a confirmation follow-up marketing activity is added to the Finished Survey
activity. To do this select Define Follow-up Marketing Activity from the Finished
Survey context menu. To create a new marketing activity, perform the sub-steps
described in step 5. In this case we add a new follow-up marketing activity
(Confirmation) to the Finished Survey activity.
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Deleting a Campaign from designer
Learn to delete a campaign from designer.

To delete a campaign from a campaign designer:

1. Open the campaign in a campaign designer.

2. Click the context menu from the campaign container.

3. Select the Delete option. The Question window pops up with the query “Do you
really want to delete the selected record(s)?”

4. Click OK to confirm the deletion.

Note:  Please note that this deletes the campaign along with all the activities in
the campaign.

Viewing the Campaign Statistics
Learn to view campaign statistics.

To view a campaign’s statistics:

1. On the Campaign container, click to expand the container. The Statistics button
is visible.
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2. Click the Statistics button or select Statistics from the campaign container
context menu.

Note: The statistics shown in the Statistics window is calculated in the Edit
Campaign window, as shown in the screenshot below.

Working with Marketing Activities
Learn to work with marketing activities.

Creating a marketing activity involves the following steps:

1. Creating channels and formats used in a marketing activity.

2. Adding the target groups to the marketing activity, see  page 722.

3. Defining the execution definition, see  page 722.

4. Executing a marketing activity, see Executing a Marketing Activity

5. Editing and viewing responses to a marketing activity, see Editing/Viewing the
Responses for a Marketing Activity

Defining Channels and Formats used in a Marketing Activity

To define the channels and formats for a marketing activity, perform the following
steps:

1. Open the required campaign in the campaign designer.

2. On the marketing activity container, click OK to expand the container.
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The following screenshot shows the Survey marketing activity container.

The following is a brief description of the components of a marketing activity:
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Channels - The first row shows the available channels of communication for a
marketing activity. The following channels are available:

• Phone

• Letter

• Email
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• SMS
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• Fax

• In-person

The numbers in brackets besides each channel represents the number of target
group entities that is processed using this channel.

Target Group – In this step you can define the target groups (customers etc) who
are to be the participants of this marketing activity.

Execution – In this step, you can execute and star t the marketing activity.

Responses – After the execution of the marketing you can evaluate the responses
from participants.

3. Click on any of the channel icons to open the Channel & Format Definition
window.

693AUREA CONFIDENTIAL

Working with Campaign Designer



The channel and format definition process contains three phases: Define Chan-
nel(s) > Define Format > Define Default Values . The window opens on the
Define Channel(s) phase.

• Define Channels – In this phase you can select the channels that are used to
approach the customers for the marketing activities.

• Define Format – In this phase you can define the formats to be used for each
of the channels you selected in the first phase. For example a template
document for an email or fax, the fields that are used in the generation of a
letter and similar formats for each of the required channels. The fields you want
to include from different CRM info areas in the templates.

• Define Default values – You can define the default values for the marketing
activities that are generated.

4. Provide the following information in the Define Channel(s) phase:

Format Definition

• Format Name – You can give a name to the format definition or retain the
automatically generated name. This field is mandatory.

• Lock – Select this check box to lock the message format for the marketing
activity.

• Private - Select this check box to keep the message generated for the marketing
activity private.

Preferred Channels

• Fixed – You can select one fixed channel.

Note: You cannot select variable channel, if you select a fixed channel.

• Variable (Priority) – You can select multiple channels with variable priorities
for the channels.

• Generate – This selection generates activities for all entities to represent the
successful generation during the marketing activity execution. This is selected
by default and cannot be changed.

Save Channel(s) – Click this button to save the Channel format details you con-
figured on this page.

Load Format – Click this button to open the Channel Formats search window.
Select the required format previously created, from the search result and load it.
You can then edit the format as required.

Proceed – Click this button to go to the next step, Define Format.

Note:  If you have not saved the channel definition, you are prompted to save
the channel configuration details before proceeding.

5. Click Save Channel(s). Click Proceed to open the Define Format window.
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The Define Format window opens with tabs for each of the channel you selected.
You can define the information required for the message formats required for the
selected channels by clicking each of the tabs.

Note: The Phone and In-Person channels do not require and fur ther configuration
information. The remaining channels Letter, Email, SMS, and Fax require fur ther
configuration information you can define in this window. The fields that are in
Orange are mandatory fields. If you do not fill the mandatory fields then you can
still save the channel format but you cannot execute the channel definition.

If you do not fill in a mandatory field and save the channel format, then if you go
back to the Campaign designer you can see that the channels you selected is not
green in color. See the screenshot below. The phone channel is in green color,
but the Letter and Email channels are in grey.

6. Click on the Letter icon and it directly opens the Letter tab in the Define Format
process step. Enter the format details of the channels including all the mandatory
steps.

7. After providing the required information, click Save Default Values. Then click
Proceed to move to the Define Default Values phase.
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You provide a Default Values Name or use the automatically generated one. You
can also search for and load a previously saved default values by using the Load
Default Values button.

8. After entering the default values, click Save Default Values and then click
Proceed to return to the campaign designer window.

Notice that the Phone and Letter channels icons are now in green.

Adding the Target Group and Execution Definition

To define the channels and formats for a marketing activity, perform the following
steps:

1. Open the required campaign in the campaign designer.

2. On the marketing activity container:

• Click to expand the container.

• Click the target group icon to open the Target Group.

and Execution Definition window.
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You can create the target group and define execution type using the following
buttons:

• New Query – Use this to create a target group using the Standard Query
process.

• New Quick Query – Use this to create a target group using the Quick Query
process.

• Load Query – Use this to search for and load a query that is already created
and saved.

• Select/Rework Target Group – Use this to select a different target group or
modify the target group.

• Define Execution Type – This allows you to define the dates until which the
queries are executed to update the target group. You can also define the
execution types.

If you were to star t creating the target group, but stop in between and reopen this
window it also shows the current query you were working on. It now have options
to edit or unlink the current query from the marketing activity. For example:

the above screenshot shows the current query that was being worked on to create
the target group. The flag icon indicates that the current query is a standard type
query.

697AUREA CONFIDENTIAL

Working with Campaign Designer



3. To create the target groups and define the execution type, perform one of the
following:

• Using the New Query button:

1. Click New Query to open the standard New: Query window.

2. Enter the Query Name and the UQL syntax for the query and run the query
to get a list of entities for the target group. These are added to the target
group.

Note:  Instead of using an UQL, you can specify the infoarea, the fields to
search, and the conditions by using the buttons in the Formatted and
Conditions sections.

3. Click Save to proceed to the next step, Define Execution Type window.  In
this window you can specify the following information:

• Edit target group until – Specify the date until the target group can be
updated based on the result of the query.

• Execution Type – Select the execution type from the drop-down list.

4. Click  to open the Create Target Group step window.
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If any of the items in the previous two steps are incomplete, you get warning
messages. For example, if you had not defined the execution type and edit
target group until date fields in the Define Execution Type window then Create
Target Group window displays the incomplete steps as shown below. Also
notice that the Create Target Group tab at the top has a red dot in it instead
of a green dot.

5. Click Create Target Group to complete the creation of the target group
process. A notification window along with some progress indicators are
created as shown in the screenshot below.

The Target Group icon is now orange in color to indicate that the target group
creation is in progress. Also the Target Group row now has date until which
the target group list can be updated. Once the target group is processed
then the channels and target group icons has the target group numbers in
the brackets besides the respective icons.

Once the server creates the target group and updates the marketing activity
is to be executed on the date specified. The icons is displayed in green. See
the screenshot below.
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6. To edit the target group click . The Edit Target Group window opens.
You can use the search queries to add more recipients to the target group.

Note: The target group icon turns Red ( ) after the “Until” date.

• To create the target groups and define the execution type using the New Quick
Query option, perform one of the following:

1. Click the New Quick Query button from the Target Group & Execution
Definition window. The Create Target Group using Quick Query window is
opened.
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2. Select the Root Info Area from the dropdown list.

3. Click Run Query. The query results are listed. Click Finalize Query.

4. Define if the query results are Private Query or Public Query. Enter a name
in Save As … field.

5. Click Save to finalize the results and attach the query results to this marketing
activity. The Create Target Group window opens.

If any of the intermediate process steps are incomplete, you get a warning
message, including if the target group is already created. A sample screenshot
is provided below:

6. Click Create Target Group to complete creating the target group.
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Selecting or modifying the target group
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1. Open the required campaign in the campaign designer.

2. On the marketing activity container:

• Click OK to expand the container.

• Click the target group icon to open the Target Group

• and Execution Definition window.

3. Click Select/Rework Target Group. The Select/Rework Target Group window
displays.
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4. You can search for marketing activities and select the desired marketing activity.
The target group entities for the selected marketing activity are listed below.

5. Double click on the marketing activity to add the target group from the selected
marketing activity to the target group of the current marketing activity. The Exe-
cution Definition window displays.

6. Specify the following information:

• Edit target group until – Specify the date until the target group can be updated.

• Execution Type – Select the execution type from the drop-down list.
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7. Click Proceed. The campaign designer window opens.

8. Click  to view the newly added participant to the target group.

Defining Execution Type

To define an execution type, perform the following:

1. Open the required campaign in the campaign designer.

2. On the marketing activity container:

• Click OK to expand the container.

• Click the target group icon to open the Target Group
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• and Execution Definition window.

3. Specify the following information:

• Edit target group until – Specify the date until the target group can be updated.

• Execution Type – Select the execution type from the drop-down list.

4. Click Proceed. The campaign designer window opens.

Executing a Marketing Activity

To execute a marketing activity, the following conditions should be met:

• All the selected channels and their formats should be defined. The selected
channel icons would be green in color.

• The target groups should be defined. The Target group icons would be green in
color.

• The current date should be within the scope of the star t and end dates of the
campaign.

• The “Edit target group until date” has to be defined. This date is visible besides
the edit target group icon ( ).
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To execute a marketing activity, perform the following steps:

1. Open the required campaign in the campaign designer.

2. On the marketing activity container:

• Click OK to expand the container.

• The following screenshot shows the Survey marketing activity container.

3. Click the  button on the Execution row. A query window pops up asking you to
confirm the operation.

4. Click OK. A server notification informs you that the marketing activity has star ted
and informs you when it is completed.
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The Execute button is now greyed and the date on which the execution star ts
automatically is displayed in brackets besides it.

Note: The edit target group icon is now in red ( ). The abort button is greyed
out once the execution star ts. And reset button is now activated. The Responses
button remains grey until the all the participants have responded.

Editing/Viewing the Responses for a Marketing Activity

To edit or view the responses for a marketing activity, perform the following steps:

1. Click  icon in the responses row. The Edit/View Response (Activities) window
opens.

You can search for specific par ticipants and view/edit their responses.

2. Select a row and click on Response 1 (Marketing Act.) column to activate and
record the response.
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3. Click the drop-down list to select the response type. Click on the + button to add
more response types to the response catalogue entries.

Edit the responses for all the participants.

4. Close the window to come back to the campaign manager window. The response
icon is be green in color. This shows that response for all the participants is
recorded.
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Notice the “(2)” in the response containers for the Survey marketing activity:
Finished Survey and No Response show. This indicates that two participants
completed the survey and two members did not respond.

5. Click the button to expand the Survey Reminder follow-up marketing activity
container for those participants who did not respond to the Survey.
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You can see that two participants who did not respond are already added to the
target group of the follow-up marketing activity.

6. Click  to open the Edit Target Group window for the Survey Reminder
follow-up marketing activity.

You can see that the two members with “No Response” in the Response column
are listed.

Resetting the Marketing Activity Execution

Restar ting a marketing activity is possible if the marketing activity execution is
completed. It results in the following:

• All generated target group entities marked as “Generated” are deleted.

• The target group entities marked as “non Generated” are retained.

• The target group entities are regenerated based on the selection/query attached
to this marketing activity.

• The target group entities that are marked as executed remains in the same state
for the current target group.
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To reset a marketing activity execution, perform the following:

1. Open the required campaign in the campaign designer.

2. On the marketing activity container, click to expand the container.

The following screenshot shows the Survey marketing activity container.

Notice that the execution button and the abort button are in grey. The reset button
is in green and is active.

3. Click  to reset the marketing activity execution. A confirmation window displays.

4. Click OK. The target group is reset and the target group is regenerated. The edit
target group until date is reset.
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Notice that the Target group button is yellow and once the target group generation
is completed, the execution button is active and ready for execution. The colors
of the target group icon and execute button are in green.

Notifying Reps about a marketing activity

To notify reps, perform the following:

1. From the context menu of a marketing activity container, select Notify Rep.

2. The Notify about record opens.
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Enter the following information:

• Recipients – Add the internal and external recipients (reps) who receive the
notification.

• Subject – Edit the subject of the notification email in this text field. You can
also use the automatically generated subject.

• Body – Enter the notification content in the Body field.

• Insert Aurea CRM web link – Select this checkbox if you want to add the
company URL in the notification.

• Request a delivery receipt – Select this checkbox if you want a receipt of
delivery.

• Request a read receipt – Select this checkbox if you want to know if the
notification was read by the recipient.

3. Click Send to send the notification to the selected reps.
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Editing a Marketing Activity

To edit a marketing activity, perform the following:

1. Open the required campaign in the campaign designer.

2. From the context menu of a marketing activity container, select Edit Marketing
Activity.

3. The marketing activity window opens.

4. Click Edit to star t editing the marketing activity.

5. Make the required changes and click Save.

Defining Channels and Formats used in a Marketing Activity
To define the channels and formats for a marketing activity, perform the following
steps:

1. Open the required campaign in the campaign designer.

2. On the marketing activity container, click OK to expand the container.
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The following screenshot shows the Survey marketing activity container.

The following is a brief description of the components of a marketing activity:
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Channels - The first row shows the available channels of communication for a
marketing activity. The following channels are available:

• Phone

• Letter

• Email
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• SMS

• Fax
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• In-person

The numbers in brackets besides each channel represents the number of target
group entities that is processed using this channel.

Target Group – In this step you can define the target groups (customers etc) who
are to be the participants of this marketing activity.

Execution – In this step, you can execute and star t the marketing activity.

Responses – After the execution of the marketing you can evaluate the responses
from participants.

3. Click on any of the channel icons to open the Channel & Format Definition
window.

The channel and format definition process contains three phases: Define Chan-
nel(s) > Define Format > Define Default Values . The window opens on the
Define Channel(s) phase.

• Define Channels – In this phase you can select the channels that are used to
approach the customers for the marketing activities.

• Define Format – In this phase you can define the formats to be used for each
of the channels you selected in the first phase. For example a template
document for an email or fax, the fields that are used in the generation of a
letter and similar formats for each of the required channels. The fields you want
to include from different CRM info areas in the templates.

• Define Default values – You can define the default values for the marketing
activities that are generated.

4. Provide the following information in the Define Channel(s) phase:
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Format Definition

• Format Name – You can give a name to the format definition or retain the
automatically generated name. This field is mandatory.

• Lock – Select this check box to lock the message format for the marketing
activity.

• Private - Select this check box to keep the message generated for the marketing
activity private.

Preferred Channels

• Fixed – You can select one fixed channel.

Note: You cannot select variable channel, if you select a fixed channel.

• Variable (Priority) – You can select multiple channels with variable priorities
for the channels.

• Generate – This selection generates activities for all entities to represent the
successful generation during the marketing activity execution. This is selected
by default and cannot be changed.

Save Channel(s) – Click this button to save the Channel format details you con-
figured on this page.

Load Format – Click this button to open the Channel Formats search window.
Select the required format previously created, from the search result and load it.
You can then edit the format as required.

Proceed – Click this button to go to the next step, Define Format.

Note:  If you have not saved the channel definition, you are prompted to save
the channel configuration details before proceeding.

5. Click Save Channel(s). Click Proceed to open the Define Format window.

The Define Format window opens with tabs for each of the channel you selected.
You can define the information required for the message formats required for the
selected channels by clicking each of the tabs.

Note: The Phone and In-Person channels do not require and fur ther configuration
information. The remaining channels Letter, Email, SMS, and Fax require fur ther
configuration information you can define in this window.
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The fields that are in Orange are mandatory fields. If you do not fill the mandatory
fields then you can still save the channel format but you cannot execute the
channel definition.

If you do not fill in a mandatory field and save the channel format, then if you go
back to the Campaign designer you can see that the channels you selected is not
green in color. See the screenshot below. The phone channel is in green color,
but the Letter and Email channels are in grey.

6. Click on the Letter icon and it directly opens the Letter tab in the Define Format
process step. Enter the format details of the channels including all the mandatory
steps.

7. After providing the required information, click Save Default Values. Then click
Proceed to move to the Define Default Values phase.
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You provide a Default Values Name or use the automatically generated one. You
can also search for and load a previously saved default values by using the Load
Default Values button.

8. After entering the default values, click Save Default Values and then click
Proceed. You are returned to the campaign designer window.

Notice that the Phone and Letter channels icons are now in green.

Adding the Target Group and Execution Definition
To define the channels and formats for a marketing activity, perform the following
steps:

1. Open the required campaign in the campaign designer.

2. On the marketing activity container:

• Click to expand the container.

• Click the target group icon to open the Target Group.
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and Execution Definition window.

You can create the target group and define execution type using the following
buttons:

• New Query – Use this to create a target group using the Standard Query
process.

• New Quick Query – Use this to create a target group using the Quick Query
process.

• Load Query – Use this to search for and load a query that is already created
and saved.

• Select/Rework Target Group – Use this to select a different target group or
modify the target group.

• Define Execution Type – This allows you to define the dates until which the
queries are executed to update the target group. You can also define the
execution types.

If you were to star t creating the target group, but stop in between and reopen this
window it also shows the current query you were working on. It now have options
to edit or unlink the current query from the marketing activity. For example:
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the above screenshot shows the current query that was being worked on to create
the target group. The flag icon indicates that the current query is a standard type
query.

3. To create the target groups and define the execution type, perform one of the
following:

• Using the New Query button:

1. Click New Query to open the standard New: Query window.

2. Enter the Query Name and the UQL syntax for the query and run the query
to get a list of entities for the target group. These are added to the target
group.

Note:  Instead of using an UQL, you can specify the infoarea, the fields to
search, and the conditions by using the buttons in the Formatted and
Conditions sections.

3. Click Save to proceed to the next step, Define Execution Type window.  In
this window you can specify the following information:

• Edit target group until – Specify the date until the target group can be
updated based on the result of the query.

• Execution Type – Select the execution type from the drop-down list.
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4. Click  to open the Create Target Group step window.

If any of the items in the previous two steps are incomplete, you get warning
messages. For example, if you had not defined the execution type and edit
target group until date fields in the Define Execution Type window then Create
Target Group window displays the incomplete steps as shown below. Also
notice that the Create Target Group tab at the top has a red dot in it instead
of a green dot.

5. Click Create Target Group to complete the creation of the target group
process. A notification window along with some progress indicators are
created as shown in the screenshot below.

The Target Group icon is now orange in color to indicate that the target group
creation is in progress. Also the Target Group row now has date until which
the target group list can be updated. Once the target group is processed
then the channels and target group icons has the target group numbers in
the brackets besides the respective icons.

Once the server creates the target group and updates the marketing activity
is to be executed on the date specified. The icons are displayed in green.
See the screenshot below.
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6. To edit the target group click . The Edit Target Group window opens.
You can use the search queries to add more recipients to the target group.

Note: The target group icon turns Red ( ) after the “Until” date.

• To create the target groups and define the execution type using the New Quick
Query option, perform one of the following:

1. Click the New Quick Query button from the Target Group & Execution
Definition window. The Create Target Group using Quick Query window is
opened.
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2. Select the Root Info Area from the dropdown list.

3. Click Run Query. The query results are listed. Click Finalize Query.

4. Define if the query results are Private Query or Public Query. Enter a name
in Save As … field.

5. Click Save to finalize the results and attach the query results to this marketing
activity. The Create Target Group window opens.

If any of the intermediate process steps are incomplete, you get a warning
message, including if the target group is already created. A sample screenshot
is provided below:

6. Click Create Target Group to complete creating the target group.

Selecting or modifying the target group
1. Open the required campaign in the campaign designer.

2. On the marketing activity container:

• Click OK to expand the container.
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• Click the target group icon to open the Target Group

• and Execution Definition window.

3. Click Select/Rework Target Group. The Select/Rework Target Group window
displays.
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4. You can search for marketing activities and select the desired marketing activity.
The target group entities for the selected marketing activity are listed below.

5. Double click on the marketing activity to add the target group from the selected
marketing activity to the target group of the current marketing activity. The
Execution Definition window displays.

6. Specify the following information:

• Edit target group until – Specify the date until the target group can be updated.

• Execution Type – Select the execution type from the drop-down list.

7. Click Proceed. The campaign designer window opens.
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8. Click  to view the newly added participant to the target group.

Defining Execution Type
To define an execution type, perform the following:

1. Open the required campaign in the campaign designer.

2. On the marketing activity container:

• Click OK to expand the container.

• Click the target group icon to open the Target Group
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• and Execution Definition window.

3. Specify the following information:

• Edit target group until – Specify the date until the target group can be updated.

• Execution Type – Select the execution type from the drop-down list.

4. Click Proceed. The campaign designer window opens.

Executing a Marketing Activity
To execute a marketing activity, the following conditions should be met:

• All the selected channels and their formats should be defined. The selected
channel icons would be green in color.

• The target groups should be defined. The Target group icons would be green in
color.
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• The current date should be within the scope of the star t and end dates of the
campaign.

• The “Edit target group until date” has to be defined. This date is visible besides
the edit target group icon ( ).

To execute a marketing activity, perform the following steps:

1. Open the required campaign in the campaign designer.

2. On the marketing activity container:

• Click OK to expand the container.

• The following screenshot shows the Survey marketing activity container.

3. Click the  button on the Execution row. A query window pops up asking you to
confirm the operation.
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4. Click OK. A server notification informs you that the marketing activity has star ted
and informs you when it is completed.

The Execute button is now greyed and the date on which the execution star ts
automatically is displayed in brackets besides it.

Note: The edit target group icon is now in red ( ). The abort button is greyed
out once the execution star ts. And reset button is now activated. The Responses
button remains grey until the all the participants have responded.

Editing/Viewing the Responses for a Marketing Activity
To edit or view the responses for a marketing activity, perform the following steps:

1. Click  icon in the responses row. The Edit/View Response (Activities) window
opens.
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You can search for specific par ticipants and view/edit their responses.

2. Select a row and click on Response 1 (Marketing Act.) column to activate and
record the response.

3. Click the drop-down list to select the response type. Click on the + button to add
more response types to the response catalogue entries.
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Edit the responses for all the participants.

4. Close the window to come back to the campaign manager window. The response
icon is be green in color. This shows that response for all the participants is
recorded.

Notice the “(2)” in the response containers for the Survey marketing activity:
Finished Survey and No Response show. This indicates that two participants
completed the survey and two members did not respond.

5. Click the button to expand the Survey Reminder follow-up marketing activity
container for those participants who did not respond to the Survey.
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You can see that two participants who did not respond are already added to the
target group of the follow-up marketing activity.

6. Click  to open the Edit Target Group window for the Survey Reminder
follow-up marketing activity.

You can see that the two members with “No Response” in the Response column
are listed.
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Resetting the Marketing Activity Execution
Restar ting a marketing activity is possible if the marketing activity execution is
completed. It results in the following:

• All generated target group entities marked as “Generated” are deleted.

• The target group entities marked as “non Generated” are retained.

• The target group entities are regenerated based on the selection/query attached
to this marketing activity.

• The target group entities that are marked as executed remains in the same state
for the current target group.

To reset a marketing activity execution, perform the following:

1. Open the required campaign in the campaign designer.

2. On the marketing activity container, click to expand the container.

The following screenshot shows the Survey marketing activity container.

Notice that the execution button and the abort button are in grey. The reset button
is in green and is active.

3. Click  to reset the marketing activity execution. A confirmation window displays.
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4. Click OK. The target group is reset and the target group is regenerated. The edit
target group until date is reset.

Notice that the Target group button is yellow and once the target group generation
is completed, the execution button is active and ready for execution. The colors
of the target group icon and execute button are in green.

Notifying Reps about a marketing activity
To notify reps, perform the following:

1. From the context menu of a marketing activity container, select Notify Rep.

2. The Notify about record opens.
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Enter the following information:

• Recipients – Add the internal and external recipients (reps) who receive the
notification.

• Subject – Edit the subject of the notification email in this text field. You can
also use the automatically generated subject.

• Body – Enter the notification content in the Body field.

• Insert Aurea CRM web link – Select this checkbox if you want to add the
company URL in the notification.

• Request a delivery receipt – Select this checkbox if you want a receipt of
delivery.

• Request a read receipt – Select this checkbox if you want to know if the
notification was read by the recipient.

3. Click Send to send the notification to the selected reps.
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Editing a Marketing Activity
To edit a marketing activity, perform the following:

1. Open the required campaign in the campaign designer.

2. From the context menu of a marketing activity container, select Edit Marketing
Activity.

3. The marketing activity window opens.

4. Click Edit to star t editing the marketing activity.

5. Make the required changes and click Save.
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Email Campaign Management
Email Campaign Management Using Aurea Campaign Manager (formerly called
Lyris HQ)

As part of a campaign, the marketing activities can be carried out using multiple
channels, like letters, fax, telephone, and email. Generally the email channel is the
most preferred channel for marketing activities. While Aurea CRM provides its own
email channel, it does not provide all the capabilities of a dedicated Email marketing
solution. In order to provide a sophisticated email marketing channel Aurea CRM
is integrated with Aurea Lyris HQ, a full-fledged Email marketing solution. Aurea
CRM Enterprise edition users can use Lyris HQ to handle their email marketing ac-
tivities and take full advantage of the sophisticated email marketing capabilities of
Lyris HQ.

Note:  Aurea CRM Enterprise license enables you to access Lyris HQ features. In
order to use Lyris HQ features you require a separate license for Lyris HQ. Please
contact email:support@aurea.com for more information on licensing Lyris HQ. You
have to enable Lyris HQ in Aurea CRM in order to use Lyris HQ features from Aurea
CRM.

Aurea Campaign Manager (CAM) notifies Aurea CRM of the actions it performs by
using the event flow mechanism to send event notifications. Events are generated
by the Aurea Campaign Manager, when it performs some action on Contacts, Mailing
lists, Segments, and Messages. Events are also generated by user actions, like
opening an email message or clicking a response link provided within the email
message. The event notifications generated by the Campaign Manager is placed in
event queues in the CRM Sync Middleware and received by the CRM.Server listening
for event notifications.

Cross product integration between Aurea CRM and Aurea Lyris HQ allows you to
perform the following tasks:

• Transfer a marketing activity to Lyris HQ.

• Transfer a CRM Target group to Lyris HQ.

• Receive Notifications and updates from Lyris HQ.

The following sections provide more details:
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Transferring a Marketing Activity to Lyris HQ
Learn to transfer market activity to lyris HQ.

As part of a campaign you create one or more marketing activities. These activities
could be conducted via multiple channels with email as one of the marketing chan-
nels. You can then transfer the marketing activity to Lyris and let Lyris HQ handle
the marketing activity through the email channel.

This section describes how to transfer a marketing activity to Lyris, however it does
not explain the full steps involved in creating a new campaign with marketing activ-
ities. For more information on working with marketing activity using the Campaign
Designer, see Working with Marketing Activities on page 689.

You can transfer a marketing activity to Lyris HQ from the campaign designer or
from the standard editor for marketing activities.

To illustrate the process of Lyris HQ as the email marketing channel, we can create
a NewProductLaunchEvent campaign and invite our loyal and potential customers
to the event, as par t of the marketing activity. The invitations are extended using
only the email channel.

Transferring from the Campaign Designer

To transfer a marketing activity to Lyris HQ from the campaign designer, perform
the following:

1. Open an existing campaign or create a new campaign. For more information, see
Viewing a campaign on page 680 or Creating a new campaign from scratch on
page 681. The following screenshot shows the example NewProductLaunchEvent
campaign.

2. From the campaign container context menu select New Marketing Activity. The
New Marketing Activity window displays.
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3. Enter the required details. In this example we create a NewLaunchInvitation as
the Marketing Activity.

4. Click Save to create the new marketing activity container in the campaign designer.

5. Click (email channel). The Channel & Format Definition page displays.

a. Select the E-mail channel radio button under the Fixed column.

b. Select the Activity and Mailing options under the Generate column. These are
optional.
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Note:  If you wish to use multiple channels for the marketing activity, you can
select the E-mail checkbox along with other required channels under the Variable
(Priority) column.

6. Click Save Channel(s).

7. Click Proceed, to go to the format definition phase. The Define Format page
displays.

You can see that Lyris Email channel definition page is available. If Lyris is not
enabled then the standard email channel definition page would be visible. Contact
your CRM administrator to enable the Lyris email marketing channel.

8. Populate the fields as described below. These fields are mandatory in order to
transfer the marketing activity to Lyris.

Note: The Create in Lyris button is activated once all the fields are populated
and the channel format is saved.

• Lyris Mailing List:Click to get a drop-down list of mailing lists in Lyris. Select
the required mailing list. You can also create a new mailing list. To create a
new mailing list, perform the following:

1. Click +. The Create new mailing list in Lyris dialog displays.

A default name (CRM-NewProductLaunchEvent - NewLaunchInvitation) is
provided which is a concatenation of three names: default mailing list prefix
configured in the CRM Designer (CRM-) + the campaign name
(NewProductLaunchEvent) + the marketing activity name
(NewLaunchInvitation).
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In case the marketing activity does not belong to a campaign then the prefix
and the activity name is used. For this example, CRM-NewLaunchInvitation.
You can rename it to a desired name. In this example, we change the name
to CRM- NewLaunchInvitation.

2. Click OK. A new blank mailing list is created in Lyris.

If for some reason the mailing list could not be created in Lyris then the dialog
displays the appropriate error message. For example, the following screenshot
shows the error message that a mailing with the same name already exists.

• E-mail: Send as: Select the desired format of the email you wish to send: HTML
or Text

• E-mail From: Enter the email address of the marketing email sender.

• From Name: Enter the name of the sender.

• Subject: Enter the subject for the email.

Note: The above fields are used as properties of the email messages that are
created in Lyris.

9. Click Save Channel Format(s). After the channel format is saved, the Create in
Lyris button gets activated.

10.Click Create in Lyris.

A dummy message is created in Lyris for the marketing activity. Depending on
your selection for the E-mail Send as field the dummy message is a text or HTML
message. A tick appears besides the lyris icon on successful creation of the
message. And a Detach message button displays. The ids for the mailing list and
message created in Lyris are displayed along with the links to the instances in
Lyris. See the screenshot below.
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Click Detach Message to delete the message created in Lyris. Once the message
is detached, all the attributes of the message are cleared, including the links in
the Lyris Message ID and Lyris Mailing List fields. The corresponding message
created in Lyris is also deleted. If the message is already sent then any responses
received for the message are ignored by Lyris and Aurea CRM does not get any
event corresponding to the message.

11.Click Save Channel Format(s).

12.Click Proceed.

Transferring from the Standard Editor

If you prefer to use the standard editor for creating marketing activities instead of
the Campaign Designer, you can still transfer a marketing activity to Lyris from the
standard editor.

To transfer a marketing activity from the standard editor to Lyris, perform the follow-
ing:

1. Select Marketing > Marketing Activities from the CRM menu. The Search Marketing
activities page displays.

2. Enter the search filters and click Star t Search. The search results list displays.

3. Open the context menu of the required marketing activity from the result list and
select Tab View or Tree View. The Marketing Activity window displays.

Note:  Double clicking a marketing activity from the result list opens the marketing
activity in the campaign designer.

4. Select Create Marketing Activity Format from the context menu. The Marketing
Activity Format window displays.

5. Select the preferred channel. Click the E-mail radio button under Fixed, then click
the Email tab.
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You should see the Lyris Email channel definition page. If Lyris is not enabled
then the standard email channel definition page would be visible. Contact your
CRM administrator to enable the Lyris email marketing channel.

6. The remaining steps are similar to those listed for transferring a marketing activity
to Lyris from the campaign designer, see steps 8 to 10 in the topic Transferring
from the Campaign Designer on page 748.

Making changes to the marketing activity transferred to Lyris

When you modify and save the message details of a marketing activity that is already
transferred to Lyris, the changes are automatically transferred to the corresponding
Lyris instance of the marketing activity’s message.

For example, in the screenshots below, the E-mail from, Lyris From Name and
Subject field values are changed and the channel format is saved. The screenshots
of Lyris show the changes reflected in the corresponding fields of the message.

The values are changed from dirk@ecogreen.com, Dirk, and “New Product Launch
Invitation” to maya@ecogreen.com, Maya, and “New Product Launch Event –
Ecogreen” respectively. The corresponding changes are reflected in the Lyris mes-
sage.
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Note:  Automatic transfer of changes to Lyris can take some time.

Transferring from the Campaign Designer
To transfer a marketing activity to Lyris HQ from the campaign designer, perform
the following:

1. Open an existing campaign or create a new campaign. For more information, see
Viewing a campaign on page 680 or Creating a new campaign from scratch on
page 681. The following screenshot shows the example NewProductLaunchEvent
campaign.

2. From the campaign container context menu select New Marketing Activity. The
New Marketing Activity window displays.
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3. Enter the required details. In this example we create a NewLaunchInvitation as
the Marketing Activity.

4. Click Save to create the new marketing activity container in the campaign designer.

5. Click (email channel). The Channel & Format Definition page displays.

a. Select the E-mail channel radio button under the Fixed column.

b. Select the Activity and Mailing options under the Generate column. These are
optional.

Note:  If you wish to use multiple channels for the marketing activity, you can
select the E-mail checkbox along with other required channels under the Variable
(Priority) column.

6. Click Save Channel(s).

7. Click Proceed, to go to the format definition phase. The Define Format page
displays.
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You can see that Lyris Email channel definition page is available. If Lyris is not
enabled then the standard email channel definition page would be visible. Contact
your CRM administrator to enable the Lyris email marketing channel.

8. Populate the fields as described below. These fields are mandatory in order to
transfer the marketing activity to Lyris.

Note: The Create in Lyris button is activated once all the fields are populated
and the channel format is saved.

• Lyris Mailing List:Click to get a drop-down list of mailing lists in Lyris. Select
the required mailing list. You can also create a new mailing list. To create a
new mailing list, perform the following:

1. Click +. The Create new mailing list in Lyris dialog displays.

A default name (CRM-NewProductLaunchEvent - NewLaunchInvitation) is
provided which is a concatenation of three names: default mailing list prefix
configured in the CRM Designer (CRM-) + the campaign name
(NewProductLaunchEvent) + the marketing activity name
(NewLaunchInvitation).

In case the marketing activity does not belong to a campaign then the prefix
and the activity name is used. For this example, CRM-NewLaunchInvitation.

You can rename it to a desired name. In this example, we change the name
to CRM- NewLaunchInvitation.

2. Click OK. A new blank mailing list is created in Lyris.
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If for some reason the mailing list could not be created in Lyris then the dialog
displays the appropriate error message. For example, the following screenshot
shows the error message that a mailing with the same name already exists.

• E-mail: Send as: Select the desired format of the email you wish to send: HTML
or Text

• E-mail From: Enter the email address of the marketing email sender.

• From Name: Enter the name of the sender.

• Subject: Enter the subject for the email.

Note: The above fields are used as properties of the email messages that
arecreated in Lyris.

9. Click Save Channel Format(s). After the channel format is saved, the Create in
Lyris button gets activated.

10.Click Create in Lyris.

A dummy message is created in Lyris for the marketing activity. Depending on
your selection for the E-mail Send as field the dummy message is a text or HTML
message. A tick appears besides the lyris icon on successful creation of the
message. And a Detach message button displays. The ids for the mailing list and
message created in Lyris are displayed along with the links to the instances in
Lyris. See the screenshot below.

751AUREA CONFIDENTIAL

Email Campaign Management



Click Detach Message to delete the message created in Lyris. Once the message
is detached, all the attributes of the message are cleared, including the links in
the Lyris Message ID and Lyris Mailing List fields. The corresponding message
created in Lyris is also deleted. If the message is already sent then any responses
received for the message are ignored by Lyris and Aurea CRM does not get any
event corresponding to the message.

11.Click Save Channel Format(s).

12.Click Proceed.

Transferring from the Standard Editor
If you prefer to use the standard editor for creating marketing activities instead of
the Campaign Designer, you can still transfer a marketing activity to Lyris from the
standard editor.

To transfer a marketing activity from the standard editor to Lyris, perform the follow-
ing:

1. Select Marketing > Marketing Activities from the CRM menu. The Search Marketing
activities page displays.

2. Enter the search filters and click Star t Search. The search results list displays.

3. Open the context menu of the required marketing activity from the result list and
select Tab View or Tree View. The Marketing Activity window displays.

Note:  Double clicking a marketing activity from the result list opens the marketing
activity in the campaign designer.

4. Select Create Marketing Activity Format from the context menu. The Marketing
Activity Format window displays.

5. Select the preferred channel. Click the E-mail radio button under Fixed, then click
the Email tab.
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You should see the Lyris Email channel definition page. If Lyris is not enabled
then the standard email channel definition page would be visible. Contact your
CRM administrator to enable the Lyris email marketing channel.

6. The remaining steps are similar to those listed for transferring a marketing activity
to Lyris from the campaign designer, see steps 8 to 10 in the topic Transferring
from the Campaign Designer on page 748.

Making changes to the marketing activity transferred to Lyris
When you modify and save the message details of a marketing activity that is already
transferred to Lyris, the changes are automatically transferred to the corresponding
Lyris instance of the marketing activity’s message.

For example, in the screenshots below, the E-mail from, Lyris From Name and
Subject field values are changed and the channel format is saved. The screenshots
of Lyris show the changes reflected in the corresponding fields of the message.

The values are changed from dirk@ecogreen.com, Dirk, and “New Product Launch
Invitation” to maya@ecogreen.com, Maya, and “New Product Launch Event –
Ecogreen” respectively. The corresponding changes are reflected in the Lyris mes-
sage.
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Note:  Automatic transfer of changes to Lyris can take some time.

Transferring a CRM Target group to Lyris HQ
Learn to transfer a CRM target group to Lyris HQ.

Once you have transferred the marketing activity to Lyris, you have to create the
target group and execution definition for the marketing activity, for more information
see Adding the Target Group and Execution Definition on page 722. Next, you can
transfer the target group to Lyris.

Note:  If you try to transfer a target group for a marketing activity before transferring
the marketing activity to Lyris, you are reminded to transfer the marketing activity
first. The following message displays: “Target group transfer cannot be star ted,
because marketing activity has not yet been transferred to Lyris. Please retry after
transferring the marketing activity to Lyris.”

Transferring a target group to Lyris involves the following phases:

1. Pick CRM Fields—select the CRM fields listed for the info areas. These fields
are added as attributes of a contact that is created in Lyris for each of the target
group members transferred to Lyris. The CRM fields are limited to the following
infoareas:

• Company (FI)

• Contact Person (CP)

• Person (PE)

• Person in Company (KP)

2. Map CRM fields—the fields selected in the first step are mapped to equivalent
demographics present in Lyris or new demographics can be created and added
to the Lyris demographics.

3. Create Segment—associate the target group with a segment in Lyris. This is
important because multiple marketing activities can use the same mailing list.
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And segments enables you to identify the mailing list members in the context of
a marketing activity.

4. Overview—this phase displays the number of active target group entities that
are eligible to be transferred to Lyris.

5. Schedule Transfer—this phase schedules the transfer and ensures that the
transfer process remains active until all the entities are transferred to Lyris. For
example, if a connection time out happens during the transfer to Lyris, then CRM
would try again at a later time until the transfer is complete.

On transferring a target group, an instance for each of the target group member is
created in Lyris, using their email contact and demographic details. The target group
members are then added as participants to the corresponding mailing list created
in Lyris. Aurea CRM ensures the inclusion of the target group members to the seg-
ment created in Lyris. You can transfer a target group to Lyris HQ from the campaign
designer or from the standard editor for marketing activities

Transferring from the Campaign designer

To transfer a target group for a marketing activity to CRM designer:

1. Open the marketing activity in the campaign designer.

2. Click in the Target Group row. The Transfer Target Group to Lyris page displays.

3. Click the Pick CRM Fields tab. To select the required CRM fields to be included
as attributes for the contacts in the target group, perform the following:

a. Select the required Infoarea from the Info Area dropdown list.

b. Click the check box to select the required field from each infoarea. You can
search for specific fields by typing the field name in the Search Field Name
filter. You can sor t the displayed fields by name or type by clicking the respective
field headers: Field Name or Field Type.

c. Repeat the above steps to select the required fields from different infoareas.
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The following fields from the infoareas are not displayed:

• The SeqNo, and StatNo fields.

• The fields for which the user does not have view rights.

• The fields containing email addresses. They are automatically transferred.

4. Click Proceed. The Map CRM fields tab gets activated and the following message
displays: Please wait until the mappings between CRM fields and Lyris
demographic mappings are loaded...

Aurea CRM communicates with Lyris server to retrieve the corresponding Lyris
demographics and displays the mapping table.
To map the CRM fields listed in the table with the retrieved Lyris demographics,
perform the following:

a. Click in the Lyris Demographics column to display the list of demographics
retrieved from the Lyris server and select the appropriate demographic for each
of the listed CRM field. The demographics listed available are the ones that
are compatible with the CRM field based on the CRM Field type. See the
screenshot below:

If you cannot find an appropriate Lyris demographic for the CRM field, you can
create a new Lyris demographic. See the next step.

b. To create a new demographic, perform the following:

a. Click +. The Create new demographic dialog displays.

b. Enter a name for the demographic. A suggested name (name of the
corresponding CRM field) is displayed for the demographic to be created in
the Name textbox. You can also specify a name according to your preference.

c. Select the type of the demographic from the Type field.

In the screenshot below a new demographic for the field private customer is
created. It is named CRM.PrivateCustomer and the type selected is a
Checkbox.
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d. Click OK. The new demographic is created in Lyris.

e. To view the mapped demographic attributes in Lyris, open Attributes tab and
select the required mailing list from the List filter. The Attribute column should
show the list of mapped attributes from CRM. See the screenshot below.

5. Click Proceed. The Create Segment tab displays.

6. Click Create Segment. A segment for this mailing list is created in Lyris.

The name of the segment created in Lyris is displayed. Clicking the named URL
opens the required Lyris segment in a new tab. The name generated is a concate-
nation of the name and the record id of the marketing activity.

When the segment for this target group is created in Lyris, it generates the Seg-
ment generated event. You can view the segment information in the Segment tab
of the Edit/View Target group window.

7. Click Proceed. The Overview tab displays.

The number of active target group entities that are eligible to be transferred to
Lyris is mentioned.
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Note:  If there are no target group entities for the email channel available to be
transferred to Lyris, then a message “No target group entities are eligible to be
transferred to Lyris” is displayed. You should go back and create the target group.

8. Click Proceed. The Schedule Transfer tab displays.

9. Click Schedule Target Group Transfer. A tick mark appears signifying that the
transfer process is scheduled.

10.To check the status of the transfer, open the Collaboration > To-Dos menu and
search for the required scheduled activity. The status of the scheduled transfer
should be visible. The following screenshot shows the status of the transfer is In
Progress.

The transfer status changes to Completed, once the target group is transferred
successfully.

11.To view the details of the transfer process, open the scheduled entity from the
To-Do search list. The Related Data tab contains a link to a text file that contains
information about the target group transfer process.

Open the document to find the information on the transfer process.
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12.You can check the contacts created in Lyris for the transferred target group
members. To list the contacts in Lyris and view the contact details created, perform
the following:

a. Open the Contacts tab and select the mailing list from the List filter. The contacts
created for his mailing list is displayed.

b. Click View to open the details of the contact generated. The View Contacts
dialog displays.

The field values of the mapped fields are transferred from CRM and populated
in the corresponding mapped demographics in Lyris

Transferring from the Standard Editor

If you prefer to use the standard editor for creating marketing activities instead of
the Campaign Designer, you can still transfer a marketing activity to Lyris from the
standard editor.

To transfer a marketing activity from the standard editor to Lyris, perform the follow-
ing:

1. Select Marketing > Marketing Activities from the CRM menu. The Search Marketing
activities page displays.

2. Enter the search filters and click Start Search. The search results list displays.

3. Open the context menu of the required marketing activity from the result list and
select Tab View or Tree View. The Marketing Activity window displays.
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Note:  Double clicking a marketing activity from the result list opens the marketing
activity in the campaign designer.

4. Select Related Data > Target Group tab.

5. If there are no items listed in the Target Group Tab, click on the Create Target
Group  link.

6. Once your target group is defined, click the Transfer Target Group to Lyris link.
The Transfer Target Group to Lyris page displays.

7. The rest of the steps to transfer the target to Lyris from the standard editor is
similar to the way the target group is transferred from the Campaign Designer.
Perform the steps 3 to 12 as described in the topic Transferring from the Campaign
designer on page 763.

The remaining sections in this chapter talk about the effect of making changes to
the target group in Aurea CRM and the corresponding changes in Lyris.

Adding or Deleting member(s) from a Target group

When you add a member to or delete a member from a target group that is already
transferred to Lyris, a corresponding member entity is added or deleted from the
corresponding mailing list on Lyris.

Adding a member to the target group
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In the screenshots below, a four th member is added to the target group and the
corresponding change in Lyris is shown.

As visible in the screenshot above, a new member (Travis Conners) is added to the
target group. The user is automatically added to the corresponding mailing list par-
ticipants on Lyris, as shown in the screenshot below.

As you can see the new person is added to the list of active participants in the cor-
responding mailing list.

Deleting a member from the target group

If you delete a member from the target group on Aurea CRM, the corresponding
mailing list member in Lyris is moved from Active members to the Admin Trash
list.

Member Marie Cole is deleted from the target group.

Member Marie Cole is moved from Active Members list to Admin Trash list.
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Activating or deactivating a target group entity

Deactivating a target group member in Aurea CRM, moves the corresponding
member record to the unsubscribed list in Lyris. The following screenshot shows
the person entity (Travis Conners) deactivated (Inactive) in Edit Target Group
window.

The corresponding entity is now moved to the unsubscribed list of member records
in Lyris.

Similarly, activating an inactive member in the Edit Target Group window, moves
the member record in Lyris from the Unsubscribed list to the Active Members list.

Changing the attributes of a target group entity

If the attribute of a target group member already transferred to Lyris is changed,
the changes are automatically transferred to Lyris.

In the following screenshots the last name of person entity Conner is changed to
Smith, and his email id is changed to the same is reflected in Lyris.
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The corresponding changes to the member record in Lyris is shown in the screenshot
below.

Transferring from the Campaign designer
To transfer a target group for a marketing activity to CRM designer:

1. Open the marketing activity in the campaign designer.

2. Click in the Target Group row. The Transfer Target Group to Lyris page displays.

3. Click the Pick CRM Fields tab. To select the required CRM fields to be included
as attributes for the contacts in the target group, perform the following:

a. Select the required Infoarea from the Info Area dropdown list.

b. Click the check box to select the required field from each infoarea. You can
search for specific fields by typing the field name in the Search Field Name
filter. You can sor t the displayed fields by name or type by clicking the respective
field headers: Field Name or Field Type.

c. Repeat the above steps to select the required fields from different infoareas.
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The following fields from the infoareas are not displayed:

• The SeqNo, and StatNo fields.

• The fields for which the user does not have view rights.

• The fields containing email addresses. They are automatically transferred.

4. Click Proceed. The Map CRM fields tab gets activated and the following message
displays: Please wait until the mappings between CRM fields and Lyris
demographic mappings are loaded...

Aurea CRM communicates with Lyris server to retrieve the corresponding Lyris
demographics and displays the mapping table.

To map the CRM fields listed in the table with the retrieved Lyris demographics,
perform the following:

a. Click in the Lyris Demographics column to display the list of demographics
retrieved from the Lyris server and select the appropriate demographic for each
of the listed CRM field. The demographics listed available are the ones that
are compatible with the CRM field based on the CRM Field type. See the
screenshot below:

If you cannot find an appropriate Lyris demographic for the CRM field, you can
create a new Lyris demographic. See the next step.

b. To create a new demographic, perform the following:

a. Click +. The Create new demographic dialog displays.

b. Enter a name for the demographic. A suggested name (name of the
corresponding CRM field) is displayed for the demographic to be created in
the Name textbox. You can also specify a name according to your preference.
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c. Select the type of the demographic from the Type field.

In the screenshot below a new demographic for the field private customer is
created. It is named CRM.PrivateCustomer and the type selected is a
Checkbox.

d. Click OK. The new demographic is created in Lyris.

e. To view the mapped demographic attributes in Lyris, open Attributes tab and
select the required mailing list from the List filter. The Attribute column should
show the list of mapped attributes from CRM. See the screenshot below.

5. Click Proceed. The Create Segment tab displays.

6. Click Create Segment. A segment for this mailing list is created in Lyris.

The name of the segment created in Lyris is displayed. Clicking the named URL
opens the required Lyris segment in a new tab. The name generated is a concate-
nation of the name and the record id of the marketing activity.

When the segment for this target group is created in Lyris, it generates the Seg-
ment generated event. You can view the segment information in the Segment tab
of the Edit/View Target group window.

7. Click Proceed. The Overview tab displays.
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The number of active target group entities that are eligible to be transferred to
Lyris is mentioned.

Note:  If there are no target group entities for the email channel available to be
transferred to Lyris, then a message “No target group entities are eligible to be
transferred to Lyris” is displayed.You should go back and create the target group.

8. Click Proceed. The Schedule Transfer tab displays.

9. Click Schedule Target Group Transfer. A tick mark appears signifying that the
transfer process is scheduled.

10.To check the status of the transfer, open the Collaboration > To-Dos menu and
search for the required scheduled activity. The status of the scheduled transfer
should be visible. The following screenshot shows the status of the transfer is In
Progress.

The transfer status changes to Completed, once the target group is transferred
successfully.

11.To view the details of the transfer process, open the scheduled entity from the
To-Do search list. The Related Data tab contains a link to a text file that contains
information about the target group transfer process.
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Open the document to find the information on the transfer process.

12.You can check the contacts created in Lyris for the transferred target group
members. To list the contacts in Lyris and view the contact details created, perform
the following:

a. Open the Contacts tab and select the mailing list from the List filter. The contacts
created for his mailing list is displayed.

b. Click View to open the details of the contact generated. The View Contacts
dialog displays.
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The field values of the mapped fields are transferred from CRM and populated
in the corresponding mapped demographics in Lyris

Transferring from the Standard Editor
If you prefer to use the standard editor for creating marketing activities instead of
the Campaign Designer, you can still transfer a marketing activity to Lyris from the
standard editor.

To transfer a marketing activity from the standard editor to Lyris, perform the follow-
ing:

1. Select Marketing > Marketing Activities from the CRM menu. The Search Marketing
activities page displays.

2. Enter the search filters and click Start Search. The search results list displays.

3. Open the context menu of the required marketing activity from the result list and
select Tab View or Tree View. The Marketing Activity window displays.

Note:  Double clicking a marketing activity from the result list opens the marketing
activity in the campaign designer.

4. Select Related Data > Target Group tab.

5. If there are no items listed in the Target Group Tab, click on the Create Target
Group  link.

6. Once your target group is defined, click the Transfer Target Group to Lyris link.
The Transfer Target Group to Lyris page displays.
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7. The rest of the steps to transfer the target to Lyris from the standard editor is
similar to the way the target group is transferred from the Campaign Designer.
Perform the steps 3 to 12 as described in the topic Transferring from the Campaign
designer on page 763.

The remaining sections in this chapter talk about the effect of making changes to
the target group in Aurea CRM and the corresponding changes in Lyris.

Adding or Deleting member(s) from a Target group
When you add a member to or delete a member from a target group that is already
transferred to Lyris, a corresponding member entity is added or deleted from the
corresponding mailing list on Lyris.

Adding a member to the target group

In the screenshots below, a four th member is added to the target group and the
corresponding change in Lyris is shown.

As visible in the screenshot above, a new member (Travis Conners) is added to the
target group. The user is automatically added to the corresponding mailing list par-
ticipants on Lyris, as shown in the screenshot below.
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As you can see the new person is added to the list of active participants in the cor-
responding mailing list.

Deleting a member from the target group

If you delete a member from the target group on Aurea CRM, the corresponding
mailing list member in Lyris is moved from Active members to the Admin Trash
list.

Member Marie Cole is deleted from the target group.

Member Marie Cole is moved from Active Members list to Admin Trash list.

Activating or deactivating a target group entity
Deactivating a target group member in Aurea CRM, moves the corresponding
member record to the unsubscribed list in Lyris. The following screenshot shows
the person entity (Travis Conners) deactivated (Inactive) in Edit Target Group
window.
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The corresponding entity is now moved to the unsubscribed list of member records
in Lyris.

Similarly, activating an inactive member in the Edit Target Group window, moves
the member record in Lyris from the Unsubscribed list to the Active Members list.

Changing the attributes of a target group entity
If the attribute of a target group member already transferred to Lyris is changed,
the changes are automatically transferred to Lyris.

In the following screenshots the last name of person entity Conner is changed to
Smith, and his email id is changed to the same is reflected in Lyris.

The corresponding changes to the member record in Lyris is shown in the screenshot
below.
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27
Events

Events
Learn about event planning, management and monitoring in Aurea CRM.

Aurea CRM allows you to depict the thematic and organizational structure of events
by adding events as campaigns and executing the following steps:

• Planning: Estimate the number of par ticipants, select a venue and speakers, and
create an agenda.

• Approval: The responsible persons verify and approve the event (its budget
and/or compliance-relevant aspects).

• Execution: Generate the target group, add any necessary additional customers
to the target group, send out invitations, administrate the participants and organize
hotels, transfers etc.

• Follow-up: You can evaluate the event and calculate the costs.

Your administrator can define campaign templates that support you in planning and
managing your events. These campaign templates can already include marketing
activities, responses and follow-up activities (e.g. responding "Yes, I will attend",
to an invitation automatically assigns the respondent to the follow-up activity "Event"
and automatically adds a participant record).

If the event is held at an external venue (e.g. a hotel), the venue must be entered
as a company in the Aurea CRM database. Furthermore, all par ticipants including
speakers must be present as persons in the database.

For general information on campaigns and marketing activities. Functions specific
to events are described in the following sections.

Planning Events
Learn to add, manage and monitor details of events.

To plan an event:

1. Add a new campaign.

2. Enter yourself in the Resp. Rep ID field in the campaign (so that you receive any
messages concerning the approval of the event).
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3. Add the necessary marketing activities such as sending out invitations, the main
event itself, mailings for persons that cannot attend, and sending out brochures
for persons who did not attend.

4. Add marketing activity responses to the activities and select the corresponding
follow-up marketing activities for the responses.

The values in the Registration and Participation Status fields of marketing ac-
tivity responses are used to manage the marketing activity’s par ticipants. The
records in the original target group are distributed amongst the follow-up marketing
activities.

Example: The event "Customer Event Q3" consists of the initial marketing activity
"Invitation". This marketing activity has two follow-up marketing activities: "Event"
and "Mailing". The "Event" marketing activity in turn has two follow-up marketing
activities: "Survey" and "Brochure":

The following responses need to be defined for the corresponding marketing ac-
tivities in order to assign respondents to the correct follow-up activities and
manage the participants’ Registration and Participation Status.

• Responses to the "Invitation" marketing activity:

• Response "Yes, I will attend": Follow-up Marketing Activity "Event" and
Registration = "Register"

• Response "I can’t make it": Follow-up Marketing Activity "Mailing",
Registration = "Unregister"

• Responses to the "Event" marketing activity:

• Response "Attended": Follow-up Marketing Activity "Survey" and
Participation Status = "Participated"

• Response "Did not attend": Follow-up Marketing Activity "Brochure" and
Participation Status = "Missed"

5. Enter the details of the hotels and venue.

6. Enter information on any required equipment in the Equipment info area.

7. Add the agenda.

8. Select speakers and lecture topics.

9. Create a query that returns the persons and companies that should attend the
event. You can also add participants manually.

10.Switch to the marketing activity, select New/Edit Execution from the context
menu and determine how the marketing activity should be executed.

11.Ask for quotes and enter the estimated costs of the event in the Costs: Entire
event field of the campaign.

12.Execute the event.
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Hotels and Venues

Add hotels, venues and other par tners (e.g. catering, enter tainment) as companies
in Aurea CRM and assign a company type (e.g. "Hotel").

Enter the corresponding company in the Event Location field in the marketing ac-
tivity.

Adding Equipment

If your event requires special equipment not available at the venue, you can enter
information on the equipment.

1. Select New > New Equipment from the marketing activity or campaign’s context
menu.

2. Enter the equipment’s details, such as the type of Equipment, the associated
Costs, the required Quantity etc.

3. Save the record.

Adding Lecture Subjects

Add topics available for all events in the Lecture Subject info area.

To add a new lecture subject:

1. Select  (Marketing) > Topic.

2. Click on Start Search and then on  (New).

3. Enter details on the topic, such as the field, duration and whether the topic
represents a lecture or training subject.

4. Save the record.

Adding Speakers

Add speakers to Aurea CRM as persons and enter a Person Type (e.g. "Speaker")
on the Speaker tab.

If you know this information, you can also enter the speaker’s Fee and Travel flat
rate.
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Assigning Speakers to Lecture Subjects

To assign a subject to a speaker:

1. Switch to the desired person.

2. Select New > New Lecture / Speaker from the context menu.

3. Select the Topic.

4. Save the record.

Creating an Agenda

You can add an agenda for each marketing activity representing an event or track.
Add agenda items to the agenda, such as lectures, coffee and lunch breaks, enter-
tainment etc.

To add an agenda item:

1. Select New > New Agenda Item from the marketing activity’s context menu.

Note: You can add agenda items to campaigns for events consisting of only a
single track.

2. Select the speaker:

a. Click on  (Select) to the next to the Person field.

All persons entered as speakers in the database are listed.

b. Select the desired person.

3. Select the Lecture Subject.

If you have already selected a person, only those lecture subjects assigned to
the selected person are listed. If you have not selected a person, all lecture
subjects are listed.

4. Enter fur ther information, such as the time and location.

5. Switch to the Speaker tab to enter fur ther information such as the date of the
invitation, the date of confirmation and fee.

6. Save the record.

Approving Events

Depending on your internal organization, events may require approval or verification
that they comply with legal provisions.

776AUREA CONFIDENTIAL

Chapter 27: Events



Approval consists of two steps:

1. The rep submits the event for approval.

2. The event needs to be approved or verified by the responsible rep.

• Budget approval: An employee, e.g. head of marketing, must approve whether
the planned event is within budget.

• Verification: An employee, e.g. from the legal department, verifies that the
event complies with the legal requirements. This can be of par ticular relevance
in the pharmaceutical industry.

Note:  Once the status of a campaign is set to "Budget Approval", you cannot execute
the campaign. Only once the campaign has been approved and verified (which
automatically sets the status to "Scheduled") can you execute the campaign.

Requesting Approval/Verification

The rep that scheduled the event must submit the campaign for approval.

To submit an event for approval:

1. Switch to the desired campaign.

2. Switch to the Approval & Control tab.

3. Enable the Budget approval required check box and enter the person responsible
for approving the event in the Budget Approved by ID field.

4. Enable the Verification Required check box and enter the person responsible
for verifying the event complies with legal provisions in the Verified by field.

Note: The campaign’s star t date must be in the future, otherwise the Budget
approval required and Verification Required check boxes cannot be enabled.
If the star t date is not in the future at the time of submission, these check boxes
are disabled automatically by the system (without notification).

5. Save the record.

The campaign is forwarded to the employee responsible for approving/verifying
the event. Your administrator can determine that campaigns requiring approval
or verification are displayed on the responsible rep’s star t page, for example.

You receive a massage when the campaign has been approved or verified.

Approving/Verifying Events

If you are responsible for approving or verifying events, you are informed using a
To-Do record whenever a campaign has been submitted.

By default, Aurea CRM web lists campaigns requiring your approval on the star t
page (You have x To-Do(s)).
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To approve or verify a campaign:

1. Select Expand Linked from the To-Do record’s context menu. The campaign is
opened. Check the data (e.g. whether the campaign is within budget or that legal
provisions are met).

2. Select Approval > Positive or Verification > Positive from the menu. The
campaign is approved or verified, and the event can be executed.

3. Save the record.

A message is sent to the campaign’s rep, informing them that the event has been
approved/verified.

Retracting Approval and Rejecting Events

If you have approved an event, you can retract your approval or verification at a
later date.

To do so:

1. Switch to the desired campaign.

2. Select Approval > Negative or Verification > Negative from the menu.

3. Save the record. The rep responsible for the campaign is sent a corresponding
message.

Executing Events

To execute an event:

1. Switch to the marketing activity you wish to execute.

2. Add the event’s par ticipants.

3. You can determine which lectures participants attend.

4. Upon receiving responses, e.g. to invitations, enter the responses.

5. Once the event has been held, you need to enter whether par ticipants actually
attended the event.

Adding Participants

Event par ticipants are added to marketing activities. Participants can be added au-
tomatically based on a selection or query, or can be added manually. For example,
the participants of a follow-up marketing activity defined for a response can be
generated based on their par ticipation status (e.g. "Registered" or "Participated").

Note: You can also add participants to a campaign. However, these participants
are not taken into account when automatically generating marketing activities (e.g.
follow-up activities). Only records added directly to marketing activities are taken
into account.

To add participants manually:

1. Switch to the desired marketing activity or campaign.

2. Select New > New Participant from the context menu.
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3. Enter details on the participant, e.g.:

• The type of par ticipant (e.g. par ticipant or speaker), par ticipation status (e.g.
registered or confirmed)

• Enter information concerning the participant’s registration date, any cancellations
etc. on the Registration tab

• Enter information on the participant’s accommodation on the Hotel tab, e.g.
name of the hotel, type of room, costs etc.

• Enter information on the Travel Information tab such as the date of arrival
and departure, mode of transportation, whether a transfer is required etc.

4. Save the record.

Creating a Participant Program

To create a program for individual par ticipants, add a participant program:

1. Switch to the desired marketing activity or campaign.

2. Switch to the desired participant (select Go to All Related > All Participants
from the context menu).

3. Select New Participant Program from the context menu in the participant record.

4. Select an Agenda Item.

5. Save the record.

Managing Participants

You can manage participants for each marketing activity in two ways:

• By changing the Participation Status in the participant record (Registered,
Confirmed, Canceled, Participated, Missed).

• By entering responses in the generated activities, mailings or work orders.
Depending on the Registration, Participation Status and Follow-up Marketing
Activity defined for the responses in the planning phase (>> on page 283),
par ticipants are added or edited automatically:

• Registration field:

• Register: A target group and participant record are automatically added
(Participation Status = "Registered" and Registered on = current date) for
the follow-up marketing activity entered (e.g. the event).

• Unregister: A target group record (but no participant record) is automatically
added for the follow-up marketing activity entered (e.g. the mailing).

• Participation Status field:

• Participated: The participations status in the participant record is set to
"Participated" and a target group record is added for the follow-up marketing
activity (e.g. survey).

• Missed: The participations status in the participant record is set to "Missed"
and a target group record is added for the follow-up marketing activity (e.g.
brochure).

• If you change the response at a later date, the target group and participant records
are updated:
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"Yes, I’m coming" -> "I can’t make it": The participant record for the follow-up
activity (event) is set to "Canceled"’, the registration date is deleted and the
cancellation date entered. The target group record added for the original follow-
up activity is deleted, and a new target group record is added for the new follow-
up activity.

Note: Attention: When entering responses, ensure that you only select a single
answer. Multiple responses can lead to undesired results.

Monitoring Event Costs

When holding an event, various costs are accrued, e.g. for renting rooms, transporta-
tion costs etc. You can enter the costs for accommodation (hotel) and transport in
the corresponding participant records. The costs entered for all par ticipants are to-
taled and displayed in the campaign record.

To displayed the costs of a campaign:

1. Switch to the desired campaign.

2. Switch to the Costs tab. The following costs are totaled for all par ticipants:

• Accommodation costs in the Costs: Hotel field.

• Transportation costs in the Costs: Transport field.

3. You can enter any fur ther costs (e.g. rent for the venue and equipment, fees and
travel expenses for speakers) in the Costs: Entire event field.

Hotels and Venues
Add hotels, venues and other par tners (e.g. catering, enter tainment) as companies
in Aurea CRM and assign a company type (e.g. "Hotel").

Enter the corresponding company in the Event Location field in the marketing ac-
tivity.

Adding Equipment
If your event requires special equipment not available at the venue, you can enter
information on the equipment.

1. Select New > New Equipment from the marketing activity or campaign’s context
menu.
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2. Enter the equipment’s details, such as the type of Equipment, the associated
Costs, the required Quantity etc.

3. Save the record.

Adding Lecture Subjects
Add topics available for all events in the Lecture Subject info area.

To add a new lecture subject:

1. Select  (Marketing) > Topic.

2. Click on Start Search and then on  (New).

3. Enter details on the topic, such as the field, duration and whether the topic
represents a lecture or training subject.

4. Save the record.

Adding Speakers
Add speakers to Aurea CRM as persons and enter a Person Type (e.g. "Speaker")
on the Speaker tab.

If you know this information, you can also enter the speaker’s Fee and Travel flat
rate.

Assigning Speakers to Lecture Subjects
To assign a subject to a speaker:

1. Switch to the desired person.

2. Select New > New Lecture / Speaker from the context menu.
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3. Select the Topic.

4. Save the record.

Creating an Agenda
You can add an agenda for each marketing activity representing an event or track.
Add agenda items to the agenda, such as lectures, coffee and lunch breaks, enter-
tainment etc.

To add an agenda item:

1. Select New > New Agenda Item from the marketing activity’s context menu.

Note: Note: You can add agenda items to campaigns for events consisting of
only a single track.

2. Select the speaker:

a. Click on  (Select) to the next to the Person field.

All persons entered as speakers in the database are listed.

b. Select the desired person.

3. Select the Lecture Subject.

If you have already selected a person, only those lecture subjects assigned to
the selected person are listed. If you have not selected a person, all lecture
subjects are listed.

4. Enter fur ther information, such as the time and location.

5. Switch to the Speaker tab to enter fur ther information such as the date of the
invitation, the date of confirmation and fee.

6. Save the record.

Approving Events
Learn how to approve or reject events.

Depending on your internal organization, events may require approval or verification
that they comply with legal provisions.
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Approval consists of two steps:

1. The rep submits the event for approval.

2. The event needs to be approved or verified by the responsible rep.

• Budget approval: An employee, e.g. head of marketing, must approve whether
the planned event is within budget.

• Verification: An employee, e.g. from the legal department, verifies that the
event complies with the legal requirements. This can be of par ticular relevance
in the pharmaceutical industry.

Note: Note: Once the status of a campaign is set to "Budget Approval", you cannot
execute the campaign. Only once the campaign has been approved and verified
(which automatically sets the status to "Scheduled") can you execute the campaign.

Requesting Approval/Verification

The rep that scheduled the event must submit the campaign for approval.

To submit an event for approval:

1. Switch to the desired campaign.

2. Switch to the Approval & Control tab.

3. Enable the Budget approval required check box and enter the person responsible
for approving the event in the Budget Approved by ID field.

4. Enable the Verification Required check box and enter the person responsible
for verifying the event complies with legal provisions in the Verified by field.

Note: Note: The campaign’s star t date must be in the future, otherwise the
Budget approval required and Verification Required check boxes cannot be
enabled. If the star t date is not in the future at the time of submission, these check
boxes are disabled automatically by the system (without notification).

5. Save the record.

The campaign is forwarded to the employee responsible for approving/verifying
the event. Your administrator can determine that campaigns requiring approval
or verification are displayed on the responsible rep’s star t page, for example.

You receive a massage when the campaign has been approved or verified.

Approving/Verifying Events

If you are responsible for approving or verifying events, you are informed using a
To-Do record whenever a campaign has been submitted.
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By default, Aurea CRM web lists campaigns requiring your approval on the star t
page (You have x To-Do(s)).

To approve or verify a campaign:

1. Select Expand Linked from the To-Do record’s context menu. The campaign is
opened. Check the data (e.g. whether the campaign is within budget or that legal
provisions are met).

2. Select Approval > Positive or Verification > Positive from the menu. The
campaign is approved or verified, and the event can be executed.

3. Save the record.

A message is sent to the campaign’s rep, informing them that the event has been
approved/verified.

Retracting Approval and Rejecting Events

If you have approved an event, you can retract your approval or verification at a
later date.

To do so:

1. Switch to the desired campaign.

2. Select Approval > Negative or Verification > Negative from the menu.

3. Save the record.

The rep responsible for the campaign is sent a corresponding message.

Requesting Approval/Verification
The rep that scheduled the event must submit the campaign for approval.

To submit an event for approval:

1. Switch to the desired campaign.

2. Switch to the Approval & Control tab.

3. Enable the Budget approval required check box and enter the person responsible
for approving the event in the Budget Approved by ID field.

4. Enable the Verification Required check box and enter the person responsible
for verifying the event complies with legal provisions in the Verified by field.

Note: Note: The campaign’s star t date must be in the future, otherwise the
Budget approval required and Verification Required check boxes cannot be
enabled. If the star t date is not in the future at the time of submission, these check
boxes are disabled automatically by the system (without notification).

5. Save the record.
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The campaign is forwarded to the employee responsible for approving/verifying
the event. Your administrator can determine that campaigns requiring approval
or verification are displayed on the responsible rep’s star t page, for example.

You receive a massage when the campaign has been approved or verified.

Approving/Verifying Events
If you are responsible for approving or verifying events, you are informed using a
To-Do record whenever a campaign has been submitted.

By default, Aurea CRM web lists campaigns requiring your approval on the star t
page (You have x To-Do(s)).

To approve or verify a campaign:

1. Select Expand Linked from the To-Do record’s context menu.

The campaign is opened. Check the data (e.g. whether the campaign is within
budget or that legal provisions are met).

2. Select Approval > Positive or Verification > Positive from the menu.

The campaign is approved or verified, and the event can be executed.

3. Save the record.

A message is sent to the campaign’s rep, informing them that the event has been
approved/verified.

Retracting Approval and Rejecting Events
If you have approved an event, you can retract your approval or verification at a
later date.

To do so:

1. Switch to the desired campaign.

2. Select Approval > Negative or Verification > Negative from the menu.

3. Save the record.

The rep responsible for the campaign is sent a corresponding message.
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Executing Events
To execute an event:

1. Switch to the marketing activity you wish to execute.

2. Add the event’s par ticipants.

3. You can determine which lectures participants attend.

4. Upon receiving responses, e.g. to invitations, enter the responses.

5. Once the event has been held, you need to enter whether par ticipants actually
attended the event.

Adding Participants

Event par ticipants are added to marketing activities. Participants can be added au-
tomatically based on a selection or query, or can be added manually. For example,
the participants of a follow-up marketing activity defined for a response can be
generated based on their par ticipation status (e.g. "Registered" or "Participated").

Note: You can also add participants to a campaign. However, these participants
are not taken into account when automatically generating marketing activities (e.g.
follow-up activities). Only records added directly to marketing activities are taken
into account.

To add participants manually:

1. Switch to the desired marketing activity or campaign.

2. Select New > New Participant from the context menu.

3. Enter details on the participant, e.g.:

• The type of par ticipant (e.g. par ticipant or speaker), par ticipation status (e.g.
registered or confirmed)

• Enter information concerning the participant’s registration date, any cancelations
etc. on the Registration tab

• Enter information on the participant’s accommodation on the Hotel tab, e.g.
name of the hotel, type of room, costs etc.

• Enter information on the Travel Information tab such as the date of arrival
and departure, mode of transportation, whether a transfer is required etc.

4. Save the record.

Creating a Participant Program
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To create a program for individual par ticipants, add a participant program:

1. Switch to the desired marketing activity or campaign.

2. Switch to the desired participant (select Go to All Related > All Participants
from the context menu).

3. Select New Participant Program from the context menu in the participant record.

4. Select an Agenda Item.

5. Save the record.

Managing Participants

You can manage participants for each marketing activity in two ways:

• By changing the Participation Status in the participant record (Registered,
Confirmed, Canceled, Participated, Missed).

• By entering responses in the generated activities, mailings or work orders.
Depending on the Registration, Participation Status and Follow-up Marketing
Activity defined for the responses in the planning phase (>> on page 283),
par ticipants are added or edited automatically:

• Registration field:

• Register: A target group and participant record are automatically added
(Participation Status = "Registered" and Registered on = current date) for
the follow-up marketing activity entered (e.g. the event).

• Unregister: A target group record (but no participant record) is automatically
added for the follow-up marketing activity entered (e.g. the mailing).

• Participation Status field:

• Participated: The participations status in the participant record is set to
"Participated" and a target group record is added for the follow-up marketing
activity (e.g. survey).

• Missed: The participations status in the participant record is set to "Missed"
and a target group record is added for the follow-up marketing activity (e.g.
brochure).

• If you change the response at a later date, the target group and participant records
are updated:

"Yes, I’m coming" -> "I can’t make it": The participant record for the follow-up
activity (event) is set to "Canceled"’, the registration date is deleted and the
cancelation date entered. The target group record added for the original follow-
up activity is deleted, and a new target group record is added for the new follow-
up activity.
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Note: Attention: When entering responses, ensure that you only select a single
answer. Multiple responses can lead to undesired results.

Adding Participants
Event par ticipants are added to marketing activities. Participants can be added au-
tomatically based on a selection or query, or can be added manually. For example,
the participants of a follow-up marketing activity defined for a response can be
generated based on their par ticipation status (e.g. "Registered" or "Participated").

Note: Note: You can also add participants to a campaign. However, these
participants are not taken into account when automatically generating marketing
activities (e.g. follow-up activities). Only records added directly to marketing activities
are taken into account.

To add participants manually:

1. Switch to the desired marketing activity or campaign.

2. Select New > New Participant from the context menu.

3. Enter details on the participant, e.g.:

• The type of par ticipant (e.g. par ticipant or speaker), par ticipation status (e.g.
registered or confirmed)

• Enter information concerning the participant’s registration date, any cancelations
etc. on the Registration tab

• Enter information on the participant’s accommodation on the Hotel tab, e.g.
name of the hotel, type of room, costs etc.

• Enter information on the Travel Information tab such as the date of arrival
and departure, mode of transportation, whether a transfer is required etc.

4. Save the record.

Creating a Participant Program
To create a program for individual par ticipants, add a participant program:

1. Switch to the desired marketing activity or campaign.

2. Switch to the desired participant (select Go to All Related > All Participants
from the context menu).

3. Select New Participant Program from the context menu in the participant record.
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4. Select an Agenda Item.

5. Save the record.

Managing Participants
You can manage participants for each marketing activity in two ways:

• By changing the Participation Status in the participant record (Registered,
Confirmed, Canceled, Participated, Missed).

• By entering responses in the generated activities, mailings or work orders.
Depending on the Registration, Participation Status and Follow-up Marketing
Activity defined for the responses in the planning phase (>> on page 283),
par ticipants are added or edited automatically:

• Registration field:

• Register: A target group and participant record are automatically added
(Participation Status = "Registered" and Registered on = current date) for
the follow-up marketing activity entered (e.g. the event).

• Unregister: A target group record (but no participant record) is automatically
added for the follow-up marketing activity entered (e.g. the mailing).

• Participation Status field:

• Participated: The participations status in the participant record is set to
"Participated" and a target group record is added for the follow-up marketing
activity (e.g. survey).

• Missed: The participations status in the participant record is set to "Missed"
and a target group record is added for the follow-up marketing activity (e.g.
brochure).

• If you change the response at a later date, the target group and participant records
are updated:

"Yes, I’m coming" -> "I can’t make it": The participant record for the follow-up
activity (event) is set to "Canceled"’, the registration date is deleted and the
cancelation date entered. The target group record added for the original follow-
up activity is deleted, and a new target group record is added for the new follow-
up activity.

Note: Attention: When entering responses, ensure that you only select a single
answer. Multiple responses can lead to undesired results.
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Rating Events
Once an event has been held, you can collect information on how the participants
rated the event using a questionnaire. This rating can then be entered in Aurea
CRM web. Ratings can be entered for the venue, speakers and accommodation.

You can rate the venue, the speakers of the event, and provide an overall rating.

Rating Speakers

Enter the ratings of speakers received from individual par ticipants in the correspond-
ing agenda item of the participant program.

To rate a speaker:

1. Switch to the participant record.

2. Select Go to All Related > All Participant Programs from the context menu.

All agenda items entered for the participant in the participant program are listed.

3. Select an agenda item and enter the rating from the questionnaire in the Speaker
Rating and Lecture Rating fields.

Note:  As evaluations are often anonymous, your administrator can determine that
you can also enter anonymous ratings for agenda items. In this case, you need to
enter the remaining sum total of all ratings and the number of anonymous evaluations
in the additional fields.

Rating the Venue and Hotels

Enter the rating of the venue and accommodation in the participant record.

To rate the venue and hotel:

1. Switch to the desired marketing activity or campaign.

2. Switch to the desired participant (select Go to All Related > All Participants
from the context menu).

3. Enter the rating of the venue in the Rating: Venue field.

4. Switch to the Hotel tab and enter the hotel’s rating in the Rating: Accommodation
field.

Calculating the Overall Rating

You can calculate the average rating of the event, accommodation and speakers
based on all the individual ratings.

Your administrator defines a date. All events with the same or a later star t date are
included in the calculation. The result is the mean of all ratings entered for the
event, accommodation and speakers.
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To calculate the rating, select  (Marketing) >  Calculate Lecture/Speaker

Rating or  (Marketing) >
Calculate Accommodation/Venue Rating from the application menu.

The mean value of all ratings is entered in the Rating field in the corresponding
records:

• Agenda item: Lecture Rating and Speaker Rating

• Lecture subject with the same lecture subject and speaker: Lecture Rating

• Person record of the speaker: Speaker Rating

• Company record of the venue: Rating: Venue

• Company record of the hotel entered for par ticipants: Rating: Accommodation

Note: These Evaluation fields are not write-protected. You can enter the overall
rating manually. Values in the Rating fields are overwritten the next time the
calculation is performed.
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Rating Speakers
Enter the ratings of speakers received from individual par ticipants in the correspond-
ing agenda item of the participant program.

To rate a speaker:

1. Switch to the participant record.

2. Select Go to All Related > All Participant Programs from the context menu.
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All agenda items entered for the participant in the participant program are listed.

3. Select an agenda item and enter the rating from the questionnaire in the Speaker
Rating and Lecture Rating fields.

Note: Note: As evaluations are often anonymous, your administrator can determine
that you can also enter anonymous ratings for agenda items. In this case, you need
to enter the remaining sum total of all ratings and the number of anonymous
evaluations in the additional fields.

Rating the Venue and Hotels
Enter the rating of the venue and accommodation in the participant record.

To rate the venue and hotel:

1. Switch to the desired marketing activity or campaign.

2. Switch to the desired participant (select Go to All Related > All Participants
from the context menu).

3. Enter the rating of the venue in the Rating: Venue field.

4. Switch to the Hotel tab and enter the hotel’s rating in the Rating: Accommodation
field.

Calculating the Overall Rating
You can calculate the average rating of the event, accommodation and speakers
based on all the individual ratings.

Your administrator defines a date. All events with the same or a later star t date are
included in the calculation. The result is the mean of all ratings entered for the
event, accommodation and speakers.

To calculate the rating:

1. Select  (Marketing) > Calculate Lecture/Speaker Rating or 
(Marketing) > Calculate Accommodation/Venue Rating from the application
menu.

The mean value of all ratings is entered in the Rating fieldin the corresponding
records:

• Agenda item: Lecture Rating and Speaker Rating

• Lecture subject with the same lecture subject and speaker: Lecture Rating

• Person record of the speaker: Speaker Rating
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• Company record of the venue: Rating: Venue

• Company record of the hotel entered for par ticipants: Rating: Accommodation

Note: Note: These Evaluation fields are not write-protected. You can enter the
overall rating manually. Values in the Rating fields are overwritten the next time
the calculation is performed.
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Monitoring Event Costs
When holding an event, various costs are accrued, e.g. for renting rooms, transporta-
tion costs etc. You can enter the costs for accommodation (hotel) and transport in
the corresponding participant records. The costs entered for all par ticipants are to-
taled and displayed in the campaign record.

To displayed the costs of a campaign:

1. Switch to the desired campaign.

2. Switch to the Costs tab. The following costs are totaled for all par ticipants:

• Accommodation costs in the Costs: Hotel field.

• Transportation costs in the Costs: Transport field.

3. You can enter any fur ther costs (e.g. rent for the venue and equipment, fees and
travel expenses for speakers) in the Costs: Entire event field.
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28
Customer Service

Customer Service
Learn how to handle customer service tasks.

You can depict the activities of your customer service department in Aurea CRM
web, e.g:

• Handling tickets (inquiries, complaints, bug reports)

• Assign tasks to service employees while taking into account their availability and
qualifications

• Add offers and orders to tickets

• Transfer information from service contracts to offers and orders

You can add child records to tickets and service contracts such as participants,
appointments, tasks, offers, orders etc.

Tickets

You can store information on issues a customer has in tickets, including the cause,
solution, appointments etc. Fur ther important information can be linked to the ticket,
e.g. the product concerned, the end customer, fur ther par ticipants etc.

Adding Tickets

To add a new ticket in the default version of Aurea CRM web:

1. Select  (Products & Service) > New Ticket. The mask used to add new tickets
is displayed.

2. Click on  (Select) next to the End Customer Company and End Customer
Person fields to select the affected company and person. These fields use the
find as you type function.

Note: You need to select an end customer (company or person) in order to save
the ticket.

3. Click on  (Select) next to the Contact Company and Contact Person fields to
select the company or person that is your contact par tner if this is not the same
as the end customer.

4. Enter the number of the ticket in the No. field and select the Priority.

5. Enter a Subject for the ticket.

796AUREA CONFIDENTIAL

Chapter 28: Customer Service



6. Select the Status, Service Level and Type.

7. Click on  (Select) to the right of the Link field to link the ticket to an installed
base.

8. Select the Problem Group and Problem and/or the Item No. and Item name.

9. Enter a description in the Problem Description, Cause and Solution fields.

10.Click on  (Select Rep) next to the Processed by ID to enter the rep responsible
for processing the ticket. Once a rep has been selected, the Processed by ID
field is filled in automatically. The Created by and Created on fields are also
filled in automatically when saving the record.

11.Enable the Escalate Tasks check box to determine that the superior of the
responsible rep receives a message if the ticket is not processed on time.

12.Enter the date the ticket is due for completion in the Due on field.

13.Click on  (Select) next to the Predecessor field to determine the ticket’s
predecessor if this ticket is a sub-ticket of an existing ticket. You can display the
ticket hierarchy.

14.Save the record.

Note:  Predefined participant records may be added automatically depending on
your configuration.

Adding Sub-tickets

You can add sub-tickets to existing tickets, allowing you to create a ticket hierarchy.

When adding a new ticket, you can determine the ticket’s predecessor (i.e. the
parent ticket) in the Predecessor field. You can also add new sub-tickets from ex-
isting tickets.

To add a sub-ticket to the current ticket:

1. Switch to the ticket you want to add a sub-ticket to.

2. You can add the sub-ticket in the following ways:

• Select New > Sub-Ticket from the context menu.

• Switch to the Sub-Tickets tab and click on  (New Sub-Ticket).

The mask used to add new tickets is displayed. The Predecessor ticket is entered
automatically.

3. Enter the ticket’s details.

4. Save the record.

Escalating Tickets

You can determine that tickets are escalated if the responsible rep has not dealt
with the ticket by the deadline. If you are using Aurea CRM web, CRM.server needs
to be running in order to escalate tickets.

To define that a ticket should be escalated if not completed by the deadline:

1. Enable the Escalate To-Do check box.
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Upon saving the ticket, the date and time entered in the Due on and Due at fields
are transferred to the To-Do Until Date and To-Do Until Time fields.

2. Enter the rep who should receive the escalation message in the Resp. Rep field
of the ticket.

If the Status of the ticket has not been set to "Closed" by the deadline, this rep
receives a message.

If you wish to add several tasks to a ticket and escalate the ticket if at least one
task has not been completed on time:

1. Add all the necessary tasks to the ticket.

Note: Your administrator needs to define that tasks can be added to tickets. In
Aurea CRM win, this is defined in the desktop settings, see Link tab in the Aurea
CRM win Administrator Guide.

2. Assign each task to a rep and enable the Create To-Do check box in the task
record.

3. Enter the rep to receive an appropriate escalation message in the Resp. Rep
field of the ticket.

4. Enable the Escalate To-Do and Escalate Tasks check boxes in the ticket. The
date and time entered in the Due on and Due at fields in the ticket are transferred
to the To-Do Until Date and To-Do Until Time fields. You can edit the date and
time.

5. Save the ticket.

If not all the tasks have been completed by the date and time specified in the To-
Do Until Date and To-Do Until Time fields, the rep entered in the Resp. Rep
field receives a message.

Adding Installed Bases

The Installed Base info area allows you to store the products currently used by a
customer. Records can be added manually or imported.

To add an installed base:

1. Select  (Products & Service) > New Installed Base.

2. Switch to the company you wish to add the installed base for.

3. You can also link an installed base to a property or opportunity. To do so, click
on  (Select) next to the corresponding field.

4. Enter the details and save.

5. Add an installed base item for each product in the installed base (select New >
New Installed Base Item from the context menu).

Displaying Hierarchies

You can define hierarchies for tickets, installed bases and tasks. For example, you
can divide tasks up into sub-tasks and add sub-tickets to tickets.
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You can add these child records in these info areas from the parent record. An in-
stalled base may consist of several individual par ts that depend on the main entry,
e.g. in the case of industrial plants with several production lines. When dealing with
customer problems, a fur ther problem may occur for an existing ticket that is solved
together with the existing issue.

The child records are linked to the parent record using the Predecessor field.

These hierarchies can be displayed in a tree.

Within the tree, you can add fur ther child records for any of the entries using the
context menu, or edit existing records.

If more than one customer notifies you of a problem, resulting in more than one
ticket for the same problem that are subsequently linked with each other, these re-
lated tickets are also displayed in the tree.

To display the hierarchy for a record:

1. Switch to the record you wish to display the hierarchy for.

2. Click on  (Hierarchy Tree) in the record’s header or select Hierarchy Tree from
the record’s context menu.

The hierarchy tree is displayed. The record that you opened the hierarchy tree
from is color-coded, and the hierarchy tree displays all records linked to that
record in the hierarchy.

3. Click on a record in the tree to display the record in the area on the right and to
edit it.
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Rep Skills

Rep skills are defined by your administrator. These qualifications can be taken into
account when assigning tickets, >> on page 294. You can use the dispatching
dashboard to create appointments for reps based on their skills, in order to process
tickets.

To search for specific rep skills:

1. Select  (Products & Service) > Rep Skills. The search mask is displayed.

2. Enter your search criteria and click on Start Search. All reps that possess the
qualifications you are searching for are listed.

3. Double-click on an entry to display the rep skills.

Dispatching

You can dispatch service duties to reps (e.g. service employees), and take the
availability and skills of employees into account while doing so.

To create an appointment for a rep as part of a ticket:

1. You can accessing the dispatching function in two ways:

• Select  (Products & Service) > Dispatching Dashboard from the
application menu and select a ticket.

If you wish to limit the tickets listed, click on  (Show/Hide) to the right of the
header. The search mask is displayed and you can define search criteria. The
tickets listed can also be restricted by your administrator.

Accessing the dispatching dashboard in this way allows a dispatcher to plan
appointments for field reps.

• Click on  (Dispatching Dashboard) from within a ticket. In this case, only
this ticket is listed.

Accessing the dispatching dashboard in this way allows helpdesk members to
arrange an appointment with the customer when adding the ticket.

2. The resource view is displayed below the tickets.
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3. In addition to the default functions in the resource view, the following options are
available:

• Select the Skill option under Group reps to group reps by skill in the overview.

• Enable Ticket-Related Reps to display the reps with the skills required to edit
the ticket. When enabled, enable the Combine Skills & Rep Set option and
select a rep group from the Reps and Rep Sets drop-down list to combine the
two options. In this case, only those reps are listed who are assigned to the
selected group and have the necessary skills.

801AUREA CONFIDENTIAL

Customer Service



Note: Note: If you disable Ticket-Related Reps again while Combine Skills
& Rep Set is active, the reps selected in the Reps and Rep Sets window
continue to be displayed.If you select multiple tickets, only those reps who
possess the skills necessary to handle the ticket are displayed.Which tickets
require which skills is defined in Aurea CRM win (Configuration info area,
category: Resources; option: Dispatching).

• You can also display resources required for service tasks, such as special
equipment, and schedule a service appointment based on their availability.
Resources are displayed beneath the reps and use the same sort order and
grouping as reps. The Ticket-Related Reps option also applies to resources;
if enabled, only those resources with the skills assigned to the ticket are listed.

• Drag the ticket to a free time slot to create an activity for the corresponding
rep. The appointment is automatically linked to the company or person entered
in the ticket. The due date and time are displayed using a ver tical red line while
dragging the ticket. Depending on your configuration, the ticket may be removed
from the list of tickets once an activity has been added.

• You can select multiple tickets in the resource view and drag them to a rep. In
this case, an activity is added for each ticket.

• If you select a ticket in the list of tickets, all activities linked to this ticket (or a
ticket in the ticket hierarchy) are highlighted. If you select an activity in the
calendar, all other activities linked to the same ticket (or a ticket in the same
hierarchy) are highlighted:

Note: Administrator Information: Tickets added in Aurea CRM web prior to
version 8.2 do not contain the information necessary to display related records
within the same hierarchy. You can enter this information automatically using
a CRM.server To-Do, see To-Do Types in the CRM.core Administrator Guide.

• If multiple service employees are involved in processing a ticket, select the
activity, click on  (Duplicate Record) in the header to add a copy of the
activity and drag the copy to the desired rep. You can also hold down Ctrl while
dragging the activity to the desired rep to create a copy.

New activities are added for the company/person the ticket was added for and are
linked to the ticket. The ticket's subject is transferred to the activity. The duration
of any activities you add is determined by the Service duration field in the ticket.
If you wish to add an activity with a different duration, enter the Duration under
Activity Defaults.

Note: Note: Additional fields can be transferred from the ticket to the activity, see
Aurea CRM web DispatchingDashboard in the Administrator Guide.
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Tickets
You can store information on issues a customer has in tickets, including the cause,
solution, appointments etc. Fur ther important information can be linked to the ticket,
e.g. the product concerned, the end customer, fur ther par ticipants etc.

Adding Tickets
To add a new ticket in the default version of Aurea CRM web:

1. Select  (Products & Service) > New Ticket. The mask used to add new tickets
is displayed.

2. Click on  (Select) next to the End Customer Company and End Customer
Person fields to select the affected company and person. These fields use the
find as you type function.

Note: Note: You need to select an end customer (company or person) in order
to save the ticket.

3. Click on  (Select) next to the Contact Company and Contact Person fields to
select the company or person that is your contact par tner if this is not the same
as the end customer.

4. Enter the number of the ticket in the No. field and select the Priority.

5. Enter a Subject for the ticket.

6. Select the Status, Service Level and Type.

7. Click on  (Select) to the right of the Link field to link the ticket to an installed
base.

8. Select the Problem Group and Problem and/or the Item No. and Item name.

9. Enter a description in the Problem Description, Cause and Solution fields.

10.Click on  (Select Rep) next to the Processed by ID to enter the rep responsible
for processing the ticket. Once a rep has been selected, the Processed by ID
field is filled in automatically. The Created by and Created on fields are also
filled in automatically when saving the record.

11.Enable the Escalate Tasks check box to determine that the superior of the
responsible rep receives a message if the ticket is not processed on time.

12.Enter the date the ticket is due for completion in the Due on field.

13.Click on  (Select) next to the Predecessor field to determine the ticket’s
predecessor if this ticket is a sub-ticket of an existing ticket.
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You can display the ticket hierarchy.

14.Save the record.

Note: Note:Predefined participant records may be added automatically depending
on your configuration.

Adding Sub-tickets
You can add sub-tickets to existing tickets, allowing you to create a ticket hierarchy.

When adding a new ticket, you can determine the ticket’s predecessor (i.e. the
parent ticket) in the Predecessor field. You can also add new sub-tickets from ex-
isting tickets.

To add a sub-ticket to the current ticket:

1. Switch to the ticket you want to add a sub-ticket to.

2. You can add the sub-ticket in the following ways:

• Select New > Sub-Ticket from the context menu.

• Switch to the Sub-Tickets tab and click on  (New Sub-Ticket).

The mask used to add new tickets is displayed. The Predecessor ticket is entered
automatically.

3. Enter the ticket’s details.

4. Save the record.

Escalating Tickets
You can determine that tickets are escalated if the responsible rep has not dealt
with the ticket by the deadline. If you are using Aurea CRM web, CRM.server needs
to be running in order to escalate tickets.

To define that a ticket should be escalated if not completed by the deadline:

1. Enable the Escalate To-Do check box.

Upon saving the ticket, the date and time entered in the Due on and Due at fields
are transferred to the To-Do Until Date and To-Do Until Time fields.

2. Enter the rep who should receive the escalation message in the Resp. Rep field
of the ticket.

If the Status of the ticket has not been set to "Closed" by the deadline, this rep
receives a message.
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If you wish to add several tasks to a ticket and escalate the ticket if at least one
task has not been completed on time:

1. Add all the necessary tasks to the ticket, >> on page 139.

Note: Note: Your administrator needs to define that tasks can be added to tickets.
In Aurea CRM win, this is defined in the desktop settings, >> Link tab in the Aurea
CRM win Administrator Guide.

2. Assign each task to a rep and enable the Create To-Do check box in the task
record.

3. Enter the rep to receive an appropriate escalation message in the Resp. Rep
field of the ticket.

4. Enable the Escalate To-Do and Escalate Tasks check boxes in the ticket. The
date and time entered in the Due on and Due at fields in the ticket are transferred
to the To-Do Until Date and To-Do Until Time fields. You can edit the date and
time.

5. Save the ticket.

If not all the tasks have been completed by the date and time specified in the To-
Do Until Date and To-Do Until Time fields, the rep entered in the Resp. Rep
field receives a message.

Adding Installed Bases
The Installed Base info area allows you to store the products currently used by a
customer. Records can be added manually or imported.

To add an installed base:

1. Select  (Products & Service) > New Installed Base.

2. Switch to the company you wish to add the installed base for.

3. You can also link an installed base to a property or opportunity. To do so, click
on  (Select) next to the corresponding field.

4. Enter the details and save.

5. Add an installed base item for each product in the installed base (select New >
New Installed Base Item from the context menu).
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Displaying Hierarchies
You can define hierarchies for tickets, installed bases and tasks. For example, you
can divide tasks up into sub-tasks and add sub-tickets to tickets.

You can add these child records in these info areas from the parent record. An in-
stalled base may consist of several individual par ts that depend on the main entry,
e.g. in the case of industrial plants with several production lines. When dealing with
customer problems, a fur ther problem may occur for an existing ticket that is solved
together with the existing issue.

The child records are linked to the parent record using the Predecessor field.

These hierarchies can be displayed in a tree.

Within the tree, you can add fur ther child records for any of the entries using the
context menu, or edit existing records.

If more than one customer notifies you of a problem, resulting in more than one
ticket for the same problem that are subsequently linked with each other, these re-
lated tickets are also displayed in the tree.

To display the hierarchy for a record:

1. Switch to the record you wish to display the hierarchy for.

2. Click on  (Hierarchy Tree) in the record’s header or select Hierarchy Tree from
the record’s context menu.

The hierarchy tree is displayed. The record that you opened the hierarchy tree
from is color-coded, and the hierarchy tree displays all records linked to that
record in the hierarchy.
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3. Click on a record in the tree to display the record in the area on the right and to
edit it.

Rep Skills
Rep skills are defined by your administrator. These qualifications can be taken into
account when assigning tickets, >> on page 294. You can use the dispatching
dashboard to create appointments for reps based on their skills, in order to process
tickets.

To search for specific rep skills:

1. Select  (Products & Service) > Rep Skills.

The search mask is displayed.

2. Enter your search criteria and click on Start Search.

All reps that possess the qualifications you are searching for are listed.

3. Double-click on an entry to display the rep skills.
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Dispatching
You can dispatch service duties to reps (e.g. service employees), and take the
availability and skills of employees into account while doing so.

To create an appointment for a rep as part of a ticket:

1. You can accessing the dispatching function in two ways:

• Select  (Products & Service) > Dispatching Dashboard from the
application menu and select a ticket.

If you wish to limit the tickets listed, click on  (Show/Hide) to the right of the
header. The search mask is displayed and you can define search criteria. The
tickets listed can also be restricted by your administrator.

Accessing the dispatching dashboard in this way allows a dispatcher to plan
appointments for field reps.

• Click on  (Dispatching Dashboard) from within a ticket. In this case, only
this ticket is listed.

Accessing the dispatching dashboard in this way allows helpdesk members to
arrange an appointment with the customer when adding the ticket.

2. The resource view is displayed below the tickets, >>  on page 154.
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3. In addition to the default functions in the resource view, the following options are
available:

• Select the Skill option under Group reps to group reps by skill in the overview.

• Enable Ticket-Related Reps to display the reps with the skills required to edit
the ticket. When enabled, enable the Combine Skills & Rep Set option and
select a rep group from the Reps and Rep Sets drop-down list to combine the
two options. In this case, only those reps are listed who are assigned to the
selected group and have the necessary skills.

809AUREA CONFIDENTIAL

Dispatching



Note: Note: If you disable Ticket-Related Reps again while Combine Skills
& Rep Set is active, the reps selected in the Reps and Rep Sets window
continue to be displayed.If you select multiple tickets, only those reps who
possess the skills necessary to handle the ticket are displayed.Which tickets
require which skills is defined in Aurea CRM win (Configuration info area,
category: Resources; option: Dispatching).

• You can also display resources required for service tasks, such as special
equipment, and schedule a service appointment based on their availability.
Resources are displayed beneath the reps and use the same sort order and
grouping as reps. The Ticket-Related Reps option also applies to resources;
if enabled, only those resources with the skills assigned to the ticket are listed.

• Drag the ticket to a free time slot to create an activity for the corresponding
rep. The appointment is automatically linked to the company or person entered
in the ticket. The due date and time are displayed using a ver tical red line while
dragging the ticket. Depending on your configuration, the ticket may be removed
from the list of tickets once an activity has been added.

• You can select multiple tickets in the resource view and drag them to a rep. In
this case, an activity is added for each ticket.

• If you select a ticket in the list of tickets, all activities linked to this ticket (or a
ticket in the ticket hierarchy) are highlighted. If you select an activity in the
calendar, all other activities linked to the same ticket (or a ticket in the same
hierarchy) are highlighted:

Note: Administrator Information: Tickets added in Aurea CRM web prior to
version 8.2 do not contain the information necessary to display related records
within the same hierarchy. You can enter this information automatically using
a CRM.server To-Do, >> To-Do Types in the CRM.core Administrator Guide.

• If multiple service employees are involved in processing a ticket, select the

activity, click on  (Duplicate Record) in the header to add a copy of the
activity and drag the copy to the desired rep. You can also hold down Ctrl while
dragging the activity to the desired rep to create a copy.

New activities are added for the company/person the ticket was added for and are
linked to the ticket. The ticket's subject is transferred to the activity. The duration
of any activities you add is determined by the Service duration field in the ticket.
If you wish to add an activity with a different duration, enter the Duration under
Activity Defaults, >> on page 152.
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Note: Note: Additional fields can be transferred from the ticket to the activity, >>
Aurea CRM web DispatchingDashboard in the Administrator Guide.
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29
Print Lists

Print Lists
Learn how to fetch partner information from a standard print list.

To access print list, do the following:

1. Select File > Print from the menu.

2. Choose one of the standard lists:

Note: Note: If you do not select a standard list, the current info area's mask/list
is printed.

You can restrict the data that is printed using the Selection criteria.

Aurea CRM win can print the following standard lists:

• Partners not visited

• Partners not scheduled

• Brief par tner history

• Brief history of visits

• Visit statistics

Partners Not Visited

This standard list outputs information on companies that have not been visited. A
company counts as having been visited if an activity of the type "Visit" with the
status "Completed" is stored for the specified time period.

You can limit companies and persons by:
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Rep: One page containing the matching companies is output per rep: If a company
has several account managers, the company is output for each of these reps. If you
do not select any reps, a single list of all companies that have not been visited is
printed.

Product: You can select which product groups (as defined in the Account Manager
info area) to output. If you do not select a product group, all product groups are
output.

From/To: Enter a time period to restrict the output to those companies not visited
during a specific time period (i.e. there are no "Completed" visits over this time pe-
riod).

Partners not scheduled

This option outputs a list of companies where no visits have been scheduled (i.e.
no "Scheduled" visits are stored for the company).

You can limit companies and persons by:

Rep: One page containing the matching companies is output per rep: If a company
has several account managers, the company is output for each of these reps. If you
do not select any reps, a single list of all companies without scheduled visits is
printed.

Product: You can select which product groups (as defined in the Account Manager
info area) to output. If you do not select a product group, all product groups are
output.

Co. Type: Select company types to restrict the output to companies of those types.
If you do not select a company type, all types are output.

Brief History of Visits

This option prints a list of all "Completed" visits for one or more reps.

Enable the Sum only to only output sum totals instead of a complete list of all visits.

Rep: One page containing the matching companies is output per rep: If no rep is
selected, all activities in the selected time period are printed.

Brief Partner History

This option prints an overview of the information stored on your par tners in various
info areas.

Each page contains an overview of the data stored in the Company and Person
info areas. The Activity Overview section includes the number of completed visits
per month.

If contact times have been defined for a company, these times are output. This in-
formation is taken from the Contact Times info area.

You can limit companies and persons by:

• Current partner: Outputs only the current company.

• Selection: Restricts the output to those records in a selection. Click on Load to
choose the selection.

If you leave both options unchecked, information on all par tners is printed.
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Activity: Enable the Activity check box and enter a Quantity to determine how
many activities to print (the most recent activities are printed if you restrict the
number).

Note: Enable the Note check box and enter a Quantity to determine how many
notes to print.

Interests: Prints data in the Interest info area.

Targeting: Surveys carried out for par tners are printed. This information is taken
from the Survey and Survey Results info areas.

Sample: Prints data in the Sample info area.

Sales Group: Prints data in the Account Manager, Contact Times and Activity
info areas:

ExplanationInfo AreaData

A line is output for each account manager.Account
Manager

Product cate-
goryAccount
managerArea-
Class

Only output if a contact times record exists for the
account manager record.

Contact
Times

Visit frequen-
cyVisit code

The last activity (if one exists) involving the repActivityLast activity

Visit Statistics
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This option outputs statistics concerning the "Completed" visits within a cer tain time
period. The following information is included:

• The number of companies in a block and area where a specific rep is the account
manager

• How many A, B and C partners are assigned to account managers

• How often partners were visited in the selected time period

• Visits statistics for par tners that meet specific conditions

The following options are available under Analyze:

• Summary: Outputs one page per rep.

• Detail: Outputs one page per rep, block and product category.

Use the Selection criteria to restrict the companies included in the statistics: If you
do not select a product, area or a block all companies are output.

The options restrict the companies as follows:

• The Block no. and Area need to match the value in the company record.

• The Rep and Product need to match the rep and product category entered in the
Account Manager record linked to the company.

Note: Note: The Area field exists in both the Company and the Account Manager
info areas. However, only the field in the Company info area is taken into account.
The Rep entered person records is also ignored.

The following companies are output:

• Companies where the block number and area match the selection criteria.

• An account manager record has been added for the company that contains at
least one of the selected reps and product category (both criteria need to match
in a single record).

The partners are classified as A, B, C and other par tners. They are classified ac-
cording to the entry in the Account Manager info area (not the entry in the Company
info area). Each category includes a breakdown of the number of par tners that were
never visited, visited once, or visited several times. The percentage values are always
refer to the previous level's entry. "Number of A partners" (=10) is split into "Visited
A partners" and "Not visited A partners". Of the 10 A partners, 8 were visited (80%)
and 2 were not (20%).

You can define up to 10 sets of conditions that are applied to the next columns.
Select Define Conditions > Company/Person in Company to define the conditions
and save them. These conditions need to be assigned to the print list in the Config-
uration info area. The statistics in these columns only apply to the companies that
meet the conditions. The last column contains the companies that are do not match
any of the conditions.

The conditions applied to companies and persons need to be entered in the Config-
uration info area (Lists category), e.g.:

• Column 1: Companies in Austria;Owner;Austria

• Column 2: Companies in Switzerland;Owner;Switzerland
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• ...

• Column 10: Companies in the US;Priority 1;USA

Accessing the Print Lists
1. Select File > Print from the menu.

2. Choose one of the standard lists:

Note: Note: If you do not select a standard list, the current info area's mask/list
is printed.

You can restrict the data that is printed using the Selection criteria.

Partners Not Visited
This standard list outputs information on companies that have not been visited. A
company counts as having been visited if an activity of the type "Visit" with the
status "Completed" is stored for the specified time period.

You can limit companies and persons by:

Rep: One page containing the matching companies is output per rep: If a company
has several account managers, the company is output for each of these reps. If you
do not select any reps, a single list of all companies that have not been visited is
printed.

Product: You can select which product groups (as defined in the Account Manager
info area) to output. If you do not select a product group, all product groups are
output.

From/To: Enter a time period to restrict the output to those companies not visited
during a specific time period (i.e. there are no "Completed" visits over this time pe-
riod).
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Partners not scheduled
This option outputs a list of companies where no visits have been scheduled (i.e.
no "Scheduled" visits are stored for the company).

You can limit companies and persons by:

Rep: One page containing the matching companies is output per rep: If a company
has several account managers, the company is output for each of these reps. If you
do not select any reps, a single list of all companies without scheduled visits is
printed.

Product: You can select which product groups (as defined in the Account Manager
info area) to output. If you do not select a product group, all product groups are
output.

Co. Type: Select company types to restrict the output to companies of those types.
If you do not select a company type, all types are output.

Brief History of Visits
This option prints a list of all "Completed" visits for one or more reps.

Enable the Sum only to only output sum totals instead of a complete list of all visits.

Rep: One page containing the matching companies is output per rep: If no rep is
selected, all activities in the selected time period are printed.

Brief Partner History
This option prints an overview of the information stored on your par tners in various
info areas.

Each page contains an overview of the data stored in the Company and Person
info areas. The Activity Overview section includes the number of completed visits
per month.

If contact times have been defined for a company, these times are output. This in-
formation is taken from the Contact Times info area.

You can limit companies and persons by:

• Current partner: Outputs only the current company.

• Selection: Restricts the output to those records in a selection. Click on Load to
choose the selection.

If you leave both options unchecked, information on all par tners is printed.
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Activity: Enable the Activity check box and enter a Quantity to determine how
many activities to print (the most recent activities are printed if you restrict the
number).

Note: Enable the Note check box and enter a Quantity to determine how many
notes to print.

Interests: Prints data in the Interest info area.

Targeting: Surveys carried out for par tners are printed. This information is taken
from the Survey and Survey Results info areas.

Sample: Prints data in the Sample info area.

Sales Group: Prints data in the Account Manager, Contact Times and Activity
info areas:

ExplanationInfo AreaData

A line is output for each account manager.Account
Manager

Product cate-
goryAccount
managerArea-
Class

Only output if a contact times record exists for the
account manager record.

Contact
Times

Visit frequen-
cyVisit code

The last activity (if one exists) involving the repActivityLast activity
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Visit Statistics

This option outputs statistics concerning the "Completed" visits within a cer tain time
period. The following information is included:

• The number of companies in a block and area where a specific rep is the account
manager

• How many A, B and C partners are assigned to account managers

• How often partners were visited in the selected time period

• Visits statistics for par tners that meet specific conditions

The following options are available under Analyze:

• Summary: Outputs one page per rep.

• Detail: Outputs one page per rep, block and product category.

Use the Selection criteria to restrict the companies included in the statistics: If you
do not select a product, area or a block all companies are output.

The options restrict the companies as follows:

• The Block no. and Area need to match the value in the company record.

• The Rep and Product need to match the rep and product category entered in the
Account Manager record linked to the company.
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Note: Note: The Area field exists in both the Company and the Account Manager
info areas. However, only the field in the Company info area is taken into account.
The Rep entered person records is also ignored.

The following companies are output:

• Companies where the block number and area match the selection criteria.

• An account manager record has been added for the company that contains at
least one of the selected reps and product category (both criteria need to match
in a single record).

The partners are classified as A, B, C and other par tners. They are classified ac-
cording to the entry in the Account Manager info area (not the entry in the Company
info area). Each category includes a breakdown of the number of par tners that were
never visited, visited once, or visited several times. The percentage values are always
refer to the previous level's entry. "Number of A partners" (=10) is split into "Visited
A partners" and "Not visited A partners". Of the 10 A partners, 8 were visited (80%)
and 2 were not (20%).

You can define up to 10 sets of conditions that are applied to the next columns.
Select Define Conditions > Company/Person in Company to define the conditions
and save them. These conditions need to be assigned to the print list in the Config-
uration info area. The statistics in these columns only apply to the companies that
meet the conditions. The last column contains the companies that are do not match
any of the conditions.

The conditions applied to companies and persons need to be entered in the Config-
uration info area (Lists category), e.g.:

• Column 1: Companies in Austria;Owner;Austria

• Column 2: Companies in Switzerland;Owner;Switzerland

• ...

• Column 10: Companies in the US;Priority 1;USA
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